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法律资讯

警告提示系统

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产损

失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。

危险

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。

警告

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。

小心

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。

注意

表示如果不采取相应的小心措施，可能导致财产损失。

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身伤

害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。

合格的专业人员

本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特别

是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危险。

按规定使用 Siemens 产品

请注意下列说明：

警告

Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。必

须保证允许的环境条件。必须注意相关文件中的提示。

商标

所有带有标记符号 ® 的都是 Siemens AG 的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三方出于自

身目的使用这些商标，将侵害其所有者的权利。

责任免除

我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保证印刷品

中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一版本中。

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
德国
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安全性信息 1
Siemens 为其产品及解决方案提供了工业信息安全功能，以支持工厂、系统、机器和网络的

安全运行。

为了防止工厂、系统、机器和网络受到网络攻击，需要实施并持续维护先进且全面的工业信

息安全保护机制。Siemens 的产品和解决方案构成此类概念的其中一个要素。

客户负责防止其工厂、系统、机器和网络受到未经授权的访问。只有在有必要连接时并仅在

采取适当安全措施（例如，防火墙和/或网络分段）的情况下，才能将该等系统、机器和组

件连接到企业网络或 Internet。
关于可采取的工业信息安全措施的更多信息，请访问 https://www.siemens.com/
industrialsecurity 
Siemens 不断对产品和解决方案进行开发和完善以提高安全性。Siemens 强烈建议您及时更

新产品并始终使用最新产品版本。如果使用的产品版本不再受支持，或者未能应用最新的更

新程序，客户遭受网络攻击的风险会增加。

要及时了解有关产品更新的信息，请订阅 Siemens 工业信息安全 RSS 源，网址为 https://
www.siemens.com/cert

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 13
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CFC 中有何新增内容？ 2
CFC V9.0 SP7

与之前版本 V9.0 SP6 相比，版本 V9.0 SP7 中包括以下功能增强或内容更改：

• 现在支持基于控制模块的安全功能。更多相关信息，请参见“工艺组态中的安全功能（故

障安全控制模块） (页 389)”。
• 文档中增加了引用 CM 参数、块变量和全局变量的示例。详细信息，请参见“控制变量

参数上的引用示例 (页 269)”。
• 在工艺编辑器中，对无法关闭的块变量的引用以黄色背景色显示。更多相关信息，请参见

“控制变量参数上的引用 (页 262)”。
• 在工艺编辑器中，可以通过“分配”(Assignment) 列中的输入字段对信号和参数对象的“备

注”(Comment) 属性进行多次分配。更多相关信息，请参见“控制模块的属性和属性值 
(页 224)”。

• 在工艺编辑器中，现在支持 CM 参数（控制变量）的 AS 级互连。

• 将数据从 PCS 7 传输到 PAA 或将数据从 PAA 传输到 PCS 7 时，数据传输对话框中包含对

属于可选控制模块的块变量的内部引用的信息。更多相关信息，请参见“控制变量参数

上的引用 (页 262)”。
• 将数据从 PCS 7 传输到 PAA 或将数据从 PAA 传输到 PCS 7 时，从类型派生的内部 CM 互

连在数据传输对话框中显示属性“互连是类型的副本”(Interconnection is a copy of type)。
更多相关信息，请参见“控制模块的类型/实例同步的更改效果 (页 238)”。

• 同步模板时，现在支持通过数据传输对话框中的新复选框“在目标中删除 > 外部引用”
(Delete at target > External references) 来删除外部引用。

• 使用 TCiR 函数更新块类型时，内部函数会计算所选 CPU 的资源限制。如果类型更新中选

择的块数量超过 CPU 的可用资源限制，则会显示一条消息。更多相关信息，请参见“使

用 CPU 410-5H PA 时的类型更新 (页 120)”和“如何更新多项目中的块/SFC 类型 (页 117)”。
• 下载更改时，通过“修改与下载相关的用户 DB”(Modified user DBs relevant to loading) 选

项改进了已修改用户 DB 的下载行为。更多相关信息，请参见“如何将用户程序下载到目

标系统 (页 407)”。 
• 改进了编译程序时需要创建 OB 的情形。更多相关信息，请参见“将图表编译为程序 

(页 400)”。
• 现在支持在 WinCC Audit 中记录 ES 项目的更改。更多相关信息，请参见“更改日志和 ES 

日志 (页 447)”。

SIMATIC S7 中的 CFC (V9.0 SP7)
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CFC V9.0 SP6
与之前的版本 V9.0 SP5 相比，版本 V9.0 SP6 中包括以下功能增强或内容更改：

• 运行组的处理状态现在也显示在运行系统编辑器的层级窗口中。未激活的运行组和不确

定的运行组用不同的图标显示。

• 对于 AS 级的互连，“图表引用数据”编辑器中的“统计”视图现在还会显示 CPU 每秒

发送和接收的最大报文数的相关信息。

有关详细信息，请参见“图表引用数据”编辑器中的“‘统计’视图的布局”部分。

• 在 V9.0 SP5 更新 4 中，CFC 与 STEP 7 V5.7 或更高版本兼容。

说明

要在 CFC 中使用带有 OCM 属性的块时，除 STEP 7 基本软件之外，还需安装可选产品 S7-
PM Project Messages V5.7。

CFC V9.0 SP5
与之前的版本 V9.0 SP4 相比，版本 V9.0 SP5 中包括以下功能增强或内容更改：

• CM 生成器功能，用于管理项目中实例：

CM 生成器支持用户使用单个 CSV 文件（称为“生成器列表”）来管理项目中的 CMT、
EMT 和 EPHT 实例。首先，从项目中导出生成器列表。然后，在电子表格编辑器（例如，

Microsoft Excel）中编辑此列表。最后，将更新的生成器列表导入到项目中。系统根据该

生成器列表中的内容，创建、更新和/或删除实例。

更多相关信息，请参见“使用 CM 生成器列表创建、更新或删除实例 (页 384)”部分。

CFC V9.0 SP4
与之前的版本 V9.0 SP3 相比，版本 V9.0 SP4 中包括以下功能增强或内容更改：

• 现可使用单个选项卡来“属性 - 块/图表”对话框，“类型更新设置”选项卡 (页 492)设置/
重置“粉色”(Pink) 参数以及要从类型更新中忽略的块参数的其它属性。从“属性 - 输入/输
出”(Properties - Input/Output) 对话框中删除了“忽略类型更新”(Ignore for type update) 
选项。

CFC 中有何新增内容？
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CFC V9.0 SP3
与之前的版本 V9.0 SP2 相比，版本 V9.0 SP3 中包括以下功能增强或内容更改：

• 工艺编辑器中新的信号分配字段：

在工艺编辑器中，控制模块参数/信号 (CV) 的“信号”(Signal) 属性新增“分配”
(Assignment) 字段。

信号处理块（通道块）的输入将分配给工艺块的信号。利用该信号分配，可在信号处理

块和工艺块之间没有直接连接的情况下确定信号处理块。

更多信息，请参见“控制模块的属性和属性值 (页 224)”部分和“控制模块硬件信号（I/O 
变量）的信号处理 (页 250)”的“种类 4”部分。

• 新的“类型更新设置”(Type update settings) 选项卡：

“属性 - 块/图表”(Properties - Block/Chart) 对话框中新增“类型更新设置”(Type update 
settings) 选项卡。在此选项卡中，可在某个块 I/O 的多个属性中进行选择，以将其从工厂

类型同步（类型更新）中排除。

更多相关信息，请参见““属性 - 块/图表”对话框，“类型更新设置”选项卡 (页 492)”
部分。

CFC V9.0 SP2
与之前的版本 V9.0 SP1 相比，版本 V9.0 SP2 中包括以下功能增强或内容更改： 
• 新增“避免隐式死区时间”按钮

在 CFC 中，如果检测到新的互连中存在反馈，则为避免该反馈，将会在块执行序列中执

行自动校正。这种自动校正会生成死区时间。

可通过新按钮来开启/关闭自动校正，以避免生成隐式死区时间。该按钮默认设置为关闭

状态。

更多相关信息，请参见“显示信号处理的反馈（停滞时间） (页 186)”部分。

• 新增“忽略类型更新”选项

添加了一个新选项，用于在同步相应模板时忽略类型更新的参数值。

更多相关信息，请参见““属性 - 输入/输出”对话框 (页 500)”部分。

CFC 中有何新增内容？
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CFC V9.0 SP1
与之前的版本 V9.0 相比，版本 V9.0 SP1 包括以下增强功能或更改内容： 
• 报告

已扩展下载期间的记录功能。 
在“报告”(Reports) 对话框中，可通过“归档”(Archive) 按钮打开相应的对话框以选择和

显示日志文件，其中包含关于下载的详细信息。

除了现有的日志文件之外，新版本中下载相关的相关信息也可保存为 XML 文件格式。必

要时，可在 VXM 中对这些 XML 文件中有关已下载更改的信息进行比较。

更多相关信息，请参见“更改日志和 ES 日志 (页 447)”部分。 
• 有关工艺对象的新属性 

对于工艺对象（如控制模块），已添加“范围下限值”(Low scale value) 和“范围上限值”
(High scale value)。这些属性可以在工艺对象类型中编辑，且仅与模拟信号（输入和输

出信号）相关。 
更多信息，请参见“控制模块的属性和属性值 (页 224)”部分。 

CFC V9.0
与之前的版本 V9.0 相比，版本 V8.2 SP1 包括以下增强功能或更改内容：  
• 工艺组态：

在工艺组态中，使用 Equipment Phase “EPH”对多个下级工厂设备模块进行控制。此时，

下级工厂设备模块 (EM) 将不再永久分配，而是运行根据请求进行分配，之后再释放。

连接 SIMATIC BATCH 时，该工厂设备阶段分配的伙伴位于过程控制端。

更多相关信息，请参见“设备阶段的基础知识 (页 329)”部分。

CFC 中有何新增内容？
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CFC V8.2 SP1
与之前的版本 V8.2 相比，版本 V8.2 SP1 包括以下增强功能或更改内容： 
• 新属性 

– 控制模块的“消息”(Message) 对象，增加了属性“单个确认”(Single 
acknowledgment)、“需要确认”(With acknowledgment)、“触发操作”(Trigger 
action)、“OS 区域”(OS area) 和“批生产 ID”(Batch ID)。

– 控制模块和工厂设备模块中增加了“版本”(Version) 属性。 
这些新属性用于 PCS 7 和 PAA 间的数据交换。

更多相关信息，请参见“控制模块的属性和属性值 (页 224)”部分。

• 互连信号处理的反馈

在 CFC 中互连时可以检测并显示互连信号处理的延迟时间。 
更多相关信息，请参见“互连的布局 (页 82)”部分。

• 通过 XML 格式与 PAA 进行数据交换

现在可以使用新的菜单命令“将所选对象导出到 XML”(Export selected objects to XML) 将
所选工艺对象导出到 XML 文件。  
更多相关信息，请参见“通过 XML 格式与 PAA 进行数据交换 (页 365)”部分。 

CFC V8.2
与之前的版本 V8.1 SP1 相比，版本 V8.2 中包括以下功能增强或内容更改：

• 针对 CFC 块的基于图表的运行组管理

对于激活了基于图表的运行组管理的 CFC，将在单独的运行组中自动管理块，即，CFC 的
块将在永久分配给此 CFC 的运行单元中进行组织。 
当 F 块也在此 CFC 中使用时，不仅会在“标准程序”中自动创建块的运行组，还会为包

含的 F 块创建运行组。 
更多相关信息，请参见“针对 CFC 块的基于图表的运行组管理 (页 203)”部分。

• 块/块类型接口中默认值更改的“RUN 模式下的类型更新” 
当块/块类型接口中的默认值发生更改时，该块可以通过 RUN 模式下的类型更新进行下载。

不再需要为此将 CPU 置于 STOP 模式。  
更多相关信息，请参见“使用 CPU 410-5H PA 时的类型更新 (页 120)”部分。 

• 带故障安全块的 CFC 的安全程序密码提示已发生更改。 
更多相关信息，请参见“CFC 中 F 块的特性 (页 109)”部分。 

CFC 中有何新增内容？
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参见

各个图表的选择性下载 (页 421)
操作员监控 (页 180)
与 PAA 的数据交换概述 (页 362)
组态枚举 (页 174)
设备模块对象的属性 (页 318)

CFC 中有何新增内容？
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简介 3
CFC 是什么？               

CFC（连续功能图）是一个带有图形用户界面的编辑器，是基于 STEP 7 软件包的扩展。用于

创建 CPU 的整个软件结构并使用预组态块。编辑器允许向功能图表中插入块、分配块参数

和互连块。

互连意味着在块与块或其它对象通信期间，可将数值从一个输出传输到一个或多个输入。

工作原理

在 CFC 编辑器中使用图形工具：可将预组态块从块池拖放到图表中。该图表类似一种“画

板”。通过单击鼠标，将块输入与块输出互连。不必考虑诸如算法或机器资源分配等细节，

换言之，可完全专注于组态的技术方面。

块的运行属性分配的是默认设置，可视需要进行个别调整。由于可在图表间复制或移动单个

块或成组块，因而可节省大量时间。块之间的互连被保留。

创建完全部功能后，可单击鼠标生成可执行的机器代码，将此代码下载到目标系统，并使用

调试用的 CFC 调试程序对代码进行调试。

目标系统

CFC 可用于组态各种目标系统。使用 CFC 时用户执行的操作大同小异。

对于不使用 SIMATIC 的目标系统，本帮助文档中的某些章节可能不适用。这尤其会影响对 
STEP7 和 PCS 7 特定块的描述。在这种情况下，请阅读有关其基础应用程序的帮助。

说明

MW0 无法用于操作 S7-300 模块，因为它将在每次调用具有启动特性的块（例如，FC 70 
(RESTART)）时被覆盖。

SIMATIC S7 中的 CFC (V9.0 SP7)
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块池

可从块库、主数据库或其它项目中导入 CFC 中所需的块，或创建自己的块。

说明

CFC 是“向上兼容的”。如果使用 CFC 编辑器以外的其它工具修改程序，将导致出现不一致

的情况。

与早期项目的兼容性

使用当前版本的 CFC 可读取并显示使用早期版本的 CFC 创建的数据。可编辑这些数据。第

一次写访问时，为确保兼容性，这些数据会被转换（在一个系统提示后）。然而，该版本并不

“向下兼容”。不能用 V5.x CFC 编辑器编辑使用 6.0 或更高版本创建或转换的数据。

更多信息

有关创建一个项目并将其下载到 AS 所需的组态步骤的简要说明，请参见以下部分：入门指南 
(页 23)

简介
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入门指南 4
概述   

这一部分介绍了组态 S7 目标系统的步骤：

1. 创建项目结构
在 SIMATIC Manager  中，需要在程序文件夹的层级下为 CFC 创建一个图表文件夹。
通过 SIMATIC Manager  或直接使用 CFC 编辑器，在图表文件夹中创建特定的 CFC 图表。 
在 PCS 7 中，可用“新建项目”(New Project) 向导完成这些步骤。

2. 创建块（可选）
CFC 可使用现成块。这些现成块可来自库、其它程序，或您创建的块类型。在 CFC 中可通过
编译图表创建块类型。

3. 插入和导入块
必须实现项目所需的块类型，而且在有些情况下，要根据使用的目标系统将其导入到项目中。 
将块从其它位置拖放或复制到 S7 程序块文件夹中，便将块从目录插入到了图表中。在图表中
插入一个块会创建一个块实例，其名称在整个图表内唯一。可使用每个块类型创建任意数量
的块实例。当块插入到图表中时，块类型导入到 CFC 数据管理中。

4. 分配参数并将块互连
可为块 I/O 分配参数并将它们互连起来。互连目标是其它块、嵌套图表或共享地址。可在其
互连目标尚未出现在图表文件夹中的块/图表输入处指定文本互连。在互连参考目标可用并通
过菜单命令进行互连之前，互连保持打开状态。

5. 修改运行属性
块的运行属性决定如何将块包括在 PLC 的整个结构处理中。这些属性对目标系统响应的反应
时间、停滞时间或基于时间的结构（例如，控制循环）的稳定性方面起决定性作用。
插入块时，会为每个块分配默认运行属性。块将插入到任务中您指定的位置处。必要时，可
在以后更改块的安装位置及其它属性。

6. 编译 CFC
程序编译时，激活 CPU 的所有图表都转换为机器代码。使用的编译器因目标系统而异；但调
用是相同的。如果编译为块类型，将只编译个别图表。 

7. 下载 CFC 程序
编译后，可将 CFC 程序下载到 CPU 中。 

8. 测试 CFC 程序
可测试编译过的和下载的程序。测试功能的范围和类型因目标系统而异。在测试模式下，您
在线连接到自动化系统。
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CFC 要点 5
5.1 STEP 7 环境中的 CFC

STEP 7 组件      
使用 CFC 时，下列 STEP 7 组件很重要：

• SIMATIC Manager 
SIMATIC Manager  用作中央数据库，并用来协调所有目标系统中的工具和对象。它管理

工具和数据，并用于诸如创建和修改项目结构（CPU、CFC 图表）及启动 CFC 编辑器等。

• STEP 7 工具

这些工具用于为 CFC 创建输入数据和可以从 CFC 引用的 I/O 数据：

– LAD、STL、SCL
用于为 S7 创建块类型的编程语言。使用这些语言创建块类型后，可将它们导入到 CFC 
中并进行组态。

– 符号表

过程信号和其它共享地址（例如位存储器和数据块）分配有符号名称，并输入在 STEP 7 
的符号表中。CFC 可使用这些名称。

• SFC (PCS 7)
用于创建工艺顺控系统的工程设计工具。利用顺控系统，可使用操作和状态更改控制基

本自动化中的功能（这些功能一般使用 CFC 组态）。

CFC 与 SIMATIC Manager 之间的交互

使用 SIMATIC Manager  时，应注意以下几点：

• 只有当特定图表文件夹或项目中没有任何正在 CFC 中编辑的图表时，才能使用 SIMATIC 
Manager  删除图表、图表文件夹和项目。

• 无论使用“新建项目”(New project) 还是“项目另存为”(Save project as) 功能，包含 CFC 
图表的项目均不能保存在磁盘上。

• 只能在 CFC 中生成图表引用数据。如果在 SIMATIC Manager  中生成引用数据，就再也不

能以在线方式将更改内容下载到此程序中。
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组态数据的流程

下图显示 S7 中组态数据的流程，从创建块类型开始，一直到机器代码下载到自动化系统为止。
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组态 S7-CPU 的数据流程

1.（可选）使用 STEP 7 工具（例如 SCL）创建块类型，并保存到 S7 用户程序中。
（可选）使用 LAD/STL 编辑器创建全局数据块并存储在 S7 用户程序中。

2. 在 CFC 编辑器中创建图表，可在其中插入、组态和互连块（这些块取自 S7 用户程序或块库）。

3. 编译 CFC 图表。生成 CFC 程序。
注：在 CFC 中，将带有图表 I/O 的图表作为块类型来编译即可创建块类型。
限制：这些图表不能包含嵌套图表。在 CFC 中创建的块类型也可保存到库中。

4. 将 CFC 程序下载到 CPU 中。

CFC 要点

5.1 STEP 7 环境中的 CFC
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5.2 CFC 中的块

块功能                     
在 CFC 中，可使用预组态块执行特定功能。在图表中插入这些功能块，将其互连并进行组态。

说明

无论输入值是多少，CFC 块的输出的初始值都为“1”。这意味着，只要未处理块，后面的逻

辑就为“1”。

块类型

每个功能块都有一个类型定义，规定以下内容：

• 算法

• 类型名称

• 数据接口（输入和输出参数）

类型名称是功能的缩写词或首字母缩写词，例如：

• CTUD（COUNT UP 和 DOWN）

表示沿触发向上/向下计数器

• COUNT_P
在二进制信号正沿触发的向上/向下计数器（取决于设置）

• ADD_R
将输入值相加的简单函数

类型定义也决定了 I/O 参数的数据类型。在下文中，这些 I/O 参数是作为块 I/O 被引用，因

为在块的图形显示中，它们即是以块 I/O 的形式出现的。

输入或输出的数据类型确定它可接受的值。 
示例：

BOOL：布尔型，值只能为 0 或 1。
STRING：字符串类型，值只能为字符串。 
有关其它数据类型的信息，请参见以下部分：S7 的数据类型 (页 168)

CFC 要点

5.2 CFC 中的块
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块背景

将块插入 CFC 图表时，即会生成此块类型的一个背景。在此上下文中，“背景”是指所选

块类型的背景。 
从一个特殊的块类型可创建任意数目的块被背景。可为这些块背景分配名称，将它们互连并

为它们分配参数，而无需更改特定于类型的功能。

举例来说，此类型背景概念的一个有用方面是，对块类型进行的后续本地更改可自动分布到

所有的块背景。

多背景块

功能可能包括多种子功能。这些子功能以块的形式实现并加以合并，以创建复杂块。例如，

可以是包含一个消息块和一个操作员控制块的控制（内部）块。

多实例块可在 CFC 中通过互连不同的块（功能）并为这些块分配适当的参数来创建。随后

这个图表作为块类型来编译。

含有不同数量的输入的块

CFC 所包含的块的数量是可变的，并可在 CFC 图表中更改。这些块称为类块。例如，AND 块
就是含有可变输入数量的块。

块系列

根据块的功能属性，将块分成组（块系列）。每个块在创建时都分配有一个系列标识符。例

如，下列块构成一个系列：

• 用于调整各种数据类型的转换块

CONVERT（例如 BO_BY、BY_DW、W_DW）

• 多路复用器块 = 
MULTIPLX（例如 MUX8_R、MUXn_DI）

• 具有数学（浮点）运算功能的块

MATH_FP（例如 SQRT、ADD_R）
块系列名称也用作诸如 CFC 目录中的排序标准等。

CFC 要点

5.2 CFC 中的块
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组织块 
CPU 操作系统与用户程序之间的接口通过 S7 中称为组织块 (OB) 的任务形成。这些 OB 用于

执行特定的程序段。例如，有用于以下用途的 OB：
• CPU 启动（冷重启、热重启）

• 过程报警

• 带不同时间基准的循环中断

组织块或任务不代表 CFC 上下文中的块；因为它们即不能插入到 CFC 中，也不能在 CFC 中
编辑。在 CFC 中，调用运行编辑器后，OB 就会按照某一运行顺序显示。

其它差别

块在类型方面也不同。创建块时，必须将其声明为功能块 (FB)、功能 (FC) 或基本操作 (BOP)。
• FB 有存储功能。经过若干处理周期后仍可访问现有数据。为每个块实例创建一个数据块 

(DB)，即可启用数据访问。然而，在复杂块中，FB 包含多个附加的补充 FB，但只包含一

个通用 DB。
• FC 没有存储功能。会直接处理块生成的值。此处不需要数据块。FC 的输出不分配默认值。

• BOP 和 FC 一样没有存储功能。它的基本操作形成了 CFC 程序的一部分，并在编译期间

作为 SCL 语句输入，且用于 AND 和 OR 等基本指令。

说明

CPU 暖启动时，BOP 输入接收池 DB 的上一个值。

特殊情况：重叠块

重叠块插入或移动到没有充足空间的图表中。这种情况下，它们与其它对象完全或部分重

叠。 
重叠块显示为另一种颜色且没有可见的块 I/O。其颜色可在对话框“颜色设置”(Color settings)
中设定。它们在表单栏中的互连和条目也被隐藏，但是仍然存在。重新定位到空闲位置后，

重叠块及其之前的互连都可正确显示。

CFC 要点

5.2 CFC 中的块
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5.3 自动命名

简介   
在此上下文中的自动命名涉及通过 SIMATIC Manager  和/或 CFC/运行编辑器生成、复制或移

动的对象。 

创建

项目中的每一个对象在创建时都会自动分配一个名称。此名称由对象类型名称和附加计数器

组成。计数器在括号中显示。在此要考虑到名称空间内名称的唯一性。适用于下列对象：

对象 名称空间

层级文件夹 (THO) 项目

OS 区域 ID 和 OS 画面名 项目

图表（顶部图表和嵌套图表） 程序

示例：

文件夹名称： S7 程序(1)
图表名称： CFC(1)
OS 画面名称： Picture(1)

复制

在内部复制对象或将对象复制到其它文件夹时，下列情况适用：

如果名称相同，则会出现“覆盖对象”(Overwrite object) 对话框，其中包含“是”(Yes)、“否”
(No) 或“重命名”(Rename) 选项。

• 如果选择“是”(Yes)，则将覆盖对象且保留名称。仅当将数据复制到其它文件夹时，此操

作才有意义，因为其它情况下此操作产生一个零操作。

• 如果选择“否”(No)，系统将复制对象并额外附加一个计数器（没有分隔符）。

再次复制（原始）对象时，附加的计数器将递增。

当复制已经复制的版本时，会附加另一个计数器。

CFC 要点

5.3 自动命名
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示例：

图表： CFC(1) 第一次复制 → CFC(1)(1)
图表： CFC(1) 重复的复制 → CFC(1)(2)
图表： CFC(1)(2) 复制 → CFC(1)(2)(1)

• 如果选择“重命名”(Rename)，将显示另一对话框。在此输入一个新名称或接受在输入字

段中自动分配的默认名称。

移动

移动对象时，复制对象的约定也适用。

下述对象响应不同于上述对象响应：

移动块实例

当在图表中插入块实例时，块自动分配一个编号作为其名称。此名称是连续的。每个新插入

（作为副本或从目录中拖放）的块都会被分配下一可用的更高编号。

更改所复制/移动的块的默认名称时，下列情况适用：

相同的名称将附加一个编号（不带括号）。如果所修改的名称已经以数字结尾，则只会将此

数字递增。

示例：

块： 2 复制 → 3
块： REG 复制 → REG1
块： REG1 复制 → REG2

移动运行组

插入到运行顺序中时，复制的运行组的响应与块实例的响应相同。一个序号会附加到名称，

且不带括号。

CFC 要点

5.3 自动命名
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关于 CFC 应该了解的信息 6
6.1 PCS 7 许可证信息

过程对象（在 PCS 7 中仅与 CFC 相关） 
过程对象是指包含支持报告、操作员控制和监视的块的所有 SFC 和所有块实例。这些是将传

送到 OS 的对象，需要许可证。驱动程序块不记做 PO。

您可在 SIMATIC Manager  中启动一项功能，该功能可以识别已在自动化许可证管理器 (ALM, 
Automation License Manager) 中组态和注册的所有 PO。所得结果显示在“PCS 7 许可证信息”
(PCS 7 license information) 对话框中。这样您便可以检查现有“SIMATIC PCS 7 AS RT PO”许
可证或者是要订购的许可证是否满足项目要求，以及还能添加到项目中的 PO 数。

不同的过程对象数可能使用不同数量的许可证。所需许可证的具体数量取决于块类型的功能。

在模块文件夹中块类型的对象属性中，可以查看许可证的使用信息。 
仅当这些对象可以下载到 AS，才会需要进行计数。不考虑未分配硬件的 S7 程序（在项目级

或在库中）的块实例。

显示 PCS 7 许可证信息

1. 选择多项目或项目。

2. 选择快捷菜单命令“PCS 7 许可证信息...”。
将打开“PCS 7 许可证信息”(PCS 7 license information) 对话框。右侧窗口会显示多项目中所有
过程对象的总数以及每个单项目和工作站中的过程对象数。

3. 在对话框的左侧窗口中，选择“过程对象 (AS RT PO)”(Process objects (AS RT PO)) 许可证。

如果选择单个项目，则仅显示该项目和工作站中的过程对象数。

有关 PO 计数情形的信息，请参见以下部分：计数和记录 PO 许可证 (页 34) 

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 33



6.2 计数和记录 PO 许可证

基本顺序

加载程序在下载期间确定过程对象(PO, process objects) 和 CPU 与 Memory Card 的序列号。

借助于这一号码，将程序分配给 CPU。在 ES 数据管理中为每个已下载的 CPU 创建 PO 信息，

并记录标识符和所用的 PO 许可证数。

在下载过程中，会确定是否已将 PO 许可证用于当前 CPU 并确定所用 PO 许可证的数量。上

次下载期间所标识的 PO 数可从在 ES 数据管理中存储的 PO 信息中读取。当前确定的 PO 数
之间的差异会与“Automation License Manager (ALM)”中可用的许可证数进行比较。如果所

需的 PO 仍包含在此许可证范围内，则会在 ALM 中记录这一差异并执行下载。  
如果当前程序所含 PO 少于先前下载的程序所含的 PO，则通过下载再次增加可用的 PO 许可

证数。如果没有足够的可用许可证，则会由于许可证违规而生成一条相应的消息，必须对此

消息加以确认。现在可终止下载，也可仍然继续。系统会将必需但不可用的许可证数记录为

短缺的许可证数。如果您已经购买了其它许可证，则在下次下载时这些缺失的许可证将包含

在 ALM 中并在其中注册。

CPU 410-5H PA 的 PO 的授权

以下附加属性适用于 CPU 410-5H PA 的 PO 的授权：

• CPU 410-5H PA 的 PO 数通过硬件授权。下载到 AS 中的 PO 数不能大于硬件授权的 PO 数。

• 对于 CPU 410-5H PA，自动化许可证管理器中许可证“AS RT PO”下记录的过程对象 (PO) 数
将与 CPU 中加载的 PO 数进行比较。

如果自动化许可证管理器中许可证记录的 PO 数小于 CPU 410-5H PA 中加载的 PO 数，则

授权不足。仅当从此项目中加载 CPU，并因此在该项目中记录 PO 时，此指示才适用。 
授权不足通过以下内容指示：

– CPU 诊断缓冲区中的一个条目

– 在 SIMATIC WinCC 中循环触发相应的消息。 
在加载操作中检测到授权不足以及加载操作更改差异时，始终能够立即触发此消息。

之后，此消息大约每 6 小时出现一次。 
当重新充分授权过程对象后（例如，购买附加许可证），此消息将不再出现。不会生成

“离开”消息。

关于 CFC 应该了解的信息
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PO 计数期间的各种情形

考虑以下情形：

• 第一次完全下载程序

加载程序确定是否从未下载过此程序。在 ES 数据管理中创建 PO 信息，并为其分配 CPU 
标识数据以及当前 PO 数。在 ALM 中记录当前 PO 数。这将使计数器读取的许可证数减少。

• 将更改下载到同一 CPU 上的程序中

比较 PO 信息中的数据之后，加载程序将确定该程序是否已经下载到同一 CPU 中。然后

确定当前 PO 数，并补齐与上次下载过程所对应的 PO 数之间的偏差。此偏差在 ALM 中
记录。这将使计数器读取的许可证数减少或增加。PO 信息中所存储的 PO 数将被替换为

当前 PO 数。

• 将程序移动到其它 CPU 中
比较 PO 信息中的数据之后，加载程序将确定该程序是否已经下载到另一台 CPU 中。将

输出一条消息，指示如果此下载过程继续，则再也无法取消记录上次下载期间所存储的 PO 
数。此时您可以终止下载过程，并取消注册所用的 PO 许可证。对于选定的图表文件夹，

使用“图表”(Charts) >“取消注册过程对象”(Booking Back Process Objects)。要求：现

有的 CPU 必须处于连接状态。   
继续下载时，PO 信息会被当前所连 CPU 的数据更新。当前 PO 数会得到确定，并且也被

输入到 PO 信息中。此数字在 ALM 中记录。这将使计数器读取的许可证数减少。

关于 CFC 应该了解的信息

6.2 计数和记录 PO 许可证
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• 取消 CPU
如果不想再使用 CPU，则可以重新获取其使用的 PO。对于选定的图表文件夹，使用“图

表”(Charts) >“取消注册过程对象”(Booking Back Process Objects)。 
与 PO 信息进行比较，以验证是否连接了上次下载期间所用的同一 CPU。 
如果未连接，将显示相应的消息，告知无法通过在所连接 CPU 中删除该程序来取消注册

上次下载期间所用的 PO 许可证。此时必须终止此过程，才能在连接“正确的”CPU 后重

复这一过程。 
进行安全检查以验证在连接正确的 CPU 后该程序是否处于未决删除状态。确认后即会删

除该程序。在 ALM 中取消记录存储的 PO 许可证数。然后，初始化 PO 信息，换言之，在

下一次下载过程中，该程序如同新创建般显示。 
如果无法取消注册 PO（例如，由于许可证不再可用），PO 信息会保持不变。您可以在

许可证再次可用后取消注册 PO。

如果未连接任何 CPU 或者所连接的 CPU 不可访问，则在显示相应的消息之后此功能会被

终止。

• 在多个 CPU 中多次使用程序

如果同一程序被下载到多个 CPU 中，则每个所下载 CPU 对应的 PO 计数器数将减少当前的 
PO 数。 
比较 PO 信息中的数据之后，加载程序将确定该程序是否已经下载到另一台 CPU 中。将

输出一条消息，指示如果此下载过程继续，则再也无法取消记录上次下载期间所存储的 PO 
数。此时您可以终止下载过程。否则，系统将用当前所连接 CPU 中的数据更新 PO 信息。

当前 PO 数会得到确定，并且也被输入到 PO 信息中。此数字在 ALM 中记录。这将使计

数器读取的许可证数减少。

关于 PO 使用的注意事项

• 下载到 S7-PLCSIM 和测试 CPU：

这里不进行 PO 计数。

• 删除项目：

删除项目时，不会通知 CFC。因此，您仍无法取消注册任何 PO。

• 删除图表文件夹或层级对象：

如果删除图表文件夹、S7 程序、CPU 或 SIMATIC 站，则此删除顺序将传递给 CFC。在此

情况下，将显示一条警告消息，允许您终止删除过程。

关于 CFC 应该了解的信息

6.2 计数和记录 PO 许可证
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• CPU 有故障：

如果 PO 信息中所存储的数据与 CPU 或存储卡的序列号相符，则用来替换有故障 CPU 的新 
CPU 将被识别为先前的下载目标。对于不允许进行序列号查询的旧版 CPU，会假定连接了

“正确的”CPU。
• 高可用性系统中的 CPU 更换：

在高可用性系统中，如果所用的存储卡不允许查询序列号，并且要更换两个 CPU，则应

该按照以下步骤操作。 
为避免错误注册该高可用性系统的 PO，可以依次更换 CPU。更换一个 CPU 后，必须重新

加载相关的 AS。之后才能更换和加载第二个 CPU。 
有关过程对象 (PO) 的更多信息，请参考以下部分：PCS 7 许可证信息 (页 33) 

关于 CFC 应该了解的信息

6.2 计数和记录 PO 许可证
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6.3 驱动器页面文件

USB 驱动器上的交换文件

包含可用存储空间的页面文件是由 CFC 自动在驱动器上建立的。如果驱动器是 USB 驱动器，

则必须考虑下列情况：

在交换活动期间，为了防止存储媒介性能降低计算机性能，请按下列步骤执行：

1. 通过在 Windows 控制面板中选择“系统”(System) >“硬件”(Hardware) >“设备管理器”
(Device Manager) >“USB 驱动器”(USB Drive) >“属性”(Properties) >“策略”(Policies) ，打开
“系统属性”(System Properties) 对话框。

2. 在“写缓存和安全删除”(Write caching and safe removal) 中，为驱动器选中“优化性能”
(Optimize for performance) 复选框。

3. 删除驱动器前，单击任务栏信息区域中的“安全删除硬件”(Safely Remove Hardware) 按钮。 

关于 CFC 应该了解的信息

6.3 驱动器页面文件
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6.4 S7 CPU 对错误的响应

如果发生数字上溢/下溢或被零除，S7 CPU 将始终继续运行。

对此类状态的响应可借助块算法，通过估算状态字中的状态位来确定。

可在 LAD/STL/FBD 在线帮助中获取更多信息，例如，关于 STL、语句列表、浮点函数和基本

操作方面的帮助。

在相应的“故障排除”帮助主题中描述了库块的响应。

关于 CFC 应该了解的信息

6.4 S7 CPU 对错误的响应
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6.5 移植到新的 CFC 版本

6.5.1 移植到其它 CFC 版本

进一步处理 
您仍可在 CFC V8.x 中按如下方式处理通过 CFC V3.x 到 CFC V7.x 创建的数据：  
• 可使用 CFC V8.x 读取并显示先前版本的 CFC 数据。

• 如果要编辑这些数据，在确认提示后的首次写访问时将转换各个图标文件夹的内容。这

样可确保兼容性。

• 将 ES 数据从版本 5.x 或 6.x 升级到 V8.x 时，如果手动更改了 I/O 的属性，则注意以下事

项：  

说明

升级过程中还会将版本 7.0 中引入的模板集成在项目中。 
此过程期间，I/O 的属性设置为模板的值，例如，当升级到模板的值时，“S7_m_c”=“TRUE”
设置为“FALSE”。
因此，如果在原始版本中手动更改了 I/O 的属性，则需要在升级后检查这些属性，并在必

要时进行调整。

 

关于兼容性的一般注意事项

• 无法将 V8.x 数据转化为先前版本的数据。 
• 不能使用先前版本的 CFC 来编辑通过新版本 CFC 创建的数据。

6.5.2 将 CFC 库块转换为 BOP

简介

从版本 V5.0 开始，可将以前存储在 CFC 库中的块转换为基本操作 (BOP)。
新 BOP 显示在下述的“作为 BOP 的块”(Blocks as BOPs) 列表中。

关于 CFC 应该了解的信息

6.5 移植到新的 CFC 版本
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通过执行基本操作可实现以下目标： 
• 改进 CPU 运行。

• 需要较少的 DB 号。

对于使用低于 V5.0 的 CFC 版本创建的项目（旧项目），将它们转换为 V7.x 时，这些项目不会

自动得到修改，因为这样会影响 CPU 上 S7 程序的更改。

说明

“CFC 库”不再包含当前可用作基本操作的块。 

移植

如果要移植旧项目而不修改现有程序，请按如下步骤操作：

1. 创建一个新的 S7 项目程序，其中包括一个图表文件夹和一个 CFC 图表。

2. 将符号表复制到新的 S7 程序中。 
3. 删除所有当前在符号表中显示为 BOP 的块（更多相关信息，请参考下面的“作为 BOP 的块”

列表）。

4. 双击图表图标。
将打开 CFC 图表。

5. 使用菜单命令“选项”(Options) >“自定义”(Customize) >“编译/下载…”(Compile/
Download…) 打开“编译/下载的设置”(Settings for Compilation/Download) 对话框。

6. 根据先前范围设置编号范围，然后
单击“确定”(OK)。
对话框将关闭。

7. 使用菜单命令“选项”(Options) >“自定义”(Customize) >“复制/移动...”(Copy/Move...) 打开
“复制/移动的设置”(Settings for Copying/Moving) 对话框。

8. 在“连接到地址”(Connections to Addresses) 中，选择选项“包含”(Include)，
然后单击“确定”(OK)。
对话框关闭。

9. 关闭并删除新创建的 CFC 图表。

10.选择旧项目的所有图表（而非图表文件夹！）并
将这些图表复制到新的图表文件夹中。

11.如果项目中包含用户特定块，其 DB 位于为其它应用程序所保留的区域中，则将这些块手动
复制到块文件夹中。

12.将旧 S7 程序名称分配给新 S7 程序。

13.剪切新 S7 程序并
将其粘贴到旧程序的 CPU。
新的 S7 程序将替换旧 S7 程序。

14.选择图表文件夹，然后
选择“编辑”(Edit) >“编译”(Compile) 菜单命令重新编译该程序。

关于 CFC 应该了解的信息

6.5 移植到新的 CFC 版本
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结果

项目被转换为新的 BOP。

否则

如果按照这些步骤执行，那么项目将保持不变。否则：

• 与运行组的互连将丢失，且必须重新定义。

• DB 号分配更改。必要时，必须重新传送 AS-OS 连接数据（“编译 OS”）。

作为 BOP 的块

CFC 包含下列作为 BOP 的块：

ABS_DI EPS_DI MIN2_DI MUX4_I ROR_W
ABS_I EPS_I MIN2_I MUX8_BO RS_FF
DI_DW I_DW MOD_DI MUX8_DI SHL_DW
DI_I I_W MOD_I MUX8_I SHL_W
DIV_DI JK_FF MUX2_BO NEG_DI SHR_DW
DIV_I LIM_DI MUX2_DI NEG_I SHR_W
DW_DI LIM_I MUX2_I ROL_DW SR_FF
DW_R MAX2_DI MUX4_BO ROL_W W_BY
DW_W MAX2_I MUX4_DI ROR_DW W_I

6.5.3 将旧项目移植到增强型运行模型中

简介

可将使用低于 V6.0 的旧版本 CFC 创建的项目轻松地移植到增强型运行模型中，该模型随 CFC 
版本 V6.0 及更高版本提供。 

说明

用户第一次进行写访问以及对提示进行确认后，便会启动移植过程。

关于 CFC 应该了解的信息

6.5 移植到新的 CFC 版本
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步骤

1. 运行编辑器：在周期性任务内为项目中的每个图表创建一个运行组。

2. 将相应图表名称分配给运行组。

3. 在运行顺序中，将每个图表的块移到相应运行组中。

4. CFC 编辑器：设置每个图表的本地安装指针（块安装指针）要执行此操作，请选择一个要附
加更多块的块，然后选择快捷菜单命令“在此之后作为插入位置”(Predecessor for Insertion 
Position)。

5. 运行编辑器：设置程序的全局安装指针（图表安装指针）。要执行此操作，请选择一个运行
组，并在其后面插入下一个图表的运行组。
背景：在移植期间，以前用于指代“在此之后作为插入位置”的“旧”安装指针被传送到图
表安装指针。因此，它可能指向一个并非用于插入附加运行组（图表）的任务或运行组。

6.5.4 将控制块移植到外部视图

将 ES 数据从 V5.x 移植到 V6.x 或 V7.x 时，项目中存在的所有 SFC 控制块 (SFC_CTRL) 都将

被删除，并替换为相应 SFC 图表的外部视图。SFC_CTRL 的参数和块互连在外部视图中激

活。 
运行响应未改变。控制块将从运行顺序中删除，同时 SFC 图表将接管其功能。 

关于 CFC 应该了解的信息

6.5 移植到新的 CFC 版本
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关于 CFC 应该了解的信息

6.5 移植到新的 CFC 版本
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多用户工程 7
7.1 多用户工程

简介    
从根本上讲，允许多个用户对项目或多项目进行工程设计。这一设置允许您对来自不同远程

位置或来自 PC 网络（多用户工程）的目标系统进行组态、测试和调试。

基本选项

• PC 已联网

项目位于服务器或 PC 的已发布驱动器上，多位用户可以同时对项目的特定部分进行组态。

有关多用户工程和所产生结果的详细信息，请参见“在网络中组态 (页 47)” 
• PC 未连接到网络

可将项目拆分成几个段以分别进行编辑，然后再通过磁盘或 ZIP 驱动器之类的工具合并

成一个主项目。

• 多项目中的项目

多项目中的项目存储在一个中央计算机上，且可分割以进行分布式编辑。编辑特定站所

需的项目被传输到相应编辑人员的工作站。因此，一个工作站中可同时存在多个项目。

编辑项目且返回到多项目后，系统必须通过菜单命令“文件”(File) >“多项目”
(Multiproject) >“对齐项目”(Align Projects) 同步所有项目间数据，并执行所需的所有项

目间功能，例如，编译 OS。准备调试多项目时，始终执行该功能。

• 拆分和合并项目数据

从 CFC V6.0 起，可将 S7 程序的图表拆分以形成多个工作项目。V6.0 运行模型的新概念

支持对各个项目图表进行拆分和合并，并支持按图表对运行顺序进行结构化。更多相关

信息，请参见：

– 安装指针的概念和使用 (页 189) 
– 拆分和合并项目数据中的文本互连 (页 162) 

拆分和合并项目数据的过程

1. 将项目的工厂相关部分（单个图表、多个图表）复制到另一项目。
结果：副本范围中未包括的与来源的文本互连已在此副本中生成。

2. 单独编辑复制的部分（添加、删除、更改块和图表）。
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3. 将编辑的工厂相关部分复制回原始项目。
结果：系统首先会删除原始项目中同名的图表。现在，需要从所删除图表获取数据的所有图
表中都存在文本互连。然后系统将图表的副本粘贴到项目中。

4. 通过菜单命令“选项”(Options) >“进行文本化互连”(Make Textual Interconnections) 关闭
所有“打开的”互连。
结果：在其它项目中编辑并复制回源项目的图表中以及由于删除生成文本互连的图表中，再
次进行互连。

多用户工程

7.1 多用户工程
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7.2 在网络中组态

在网络中组态

系统支持工程师站上多用户同时访问定义的项目元素，这些元素存储在中央服务器或工作站

的网络驱动器中。在 CFC 外部始终可以进行多用户访问。  

注意

关于在网络中组态的安全信息

在网络中执行组态时，确保只有获得授权的人员可访问中央服务器或共享驱动器。 
这不应仅通过操作系统和 PC 网络层面的措施加以保证。

有关 PCS 7 中访问保护的信息，请参见《过程控制系统 PCS 7；工程系统》文档中的“通过

访问保护来保护项目/库”部分。 

说明

有关中央服务器上工程师站的更多信息，请参见《过程控制系统 PCS 7；工程系统》文档的

“在网络中组态”部分。

 
多用户模式下的可行方案： 

编辑不同图表文件夹中的各种图表

不同图表文件夹中的不同图表可由多位作者分别在不同工程师站上进行编辑。不会出现相互

干扰的问题。

编辑同一图表文件夹中的各种图表

同一图表文件夹中的不同图表可由多位作者分别在不同的工程师站上进行编辑。与编辑同一

图表相比，这样的相互干扰较少。冲突是无法完全避免的，因为所有图表都访问共享资源，

例如符号表、运行顺序等。

编辑同一图表

如果某个图表已被一个作者打开，而另一个作者也想打开同一图表，则该作者会收到一条消

息。然后，该作者可以决定是要打开此图表，还是等到图表再次关闭。  
如果多个作者处理同一图表，他们可能会相互干扰。因此，建议不这样做。

多用户工程

7.2 在网络中组态
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默认情况下启用通知，但也可以将其禁用。要执行此操作，请在 SIMATIC Manager 中选择

项目，然后选择菜单命令“选项”(Options) >“图表”(Charts) >“打开图表时通知...”(Notice 
when opening charts...)。 

对各种操作的反应

如果出现访问冲突，系统始终执行分配了最高优先级的操作。此时，将中止优先级较低的操

作。操作的优先级：

操作 优先级

短读取操作 3
短写入操作 2
长读取操作 1
长写入操作 1

 
如果用户启动多个分配了同一优先级的操作，则系统执行第一个启动的操作。

• 短读取操作（没有资源使用）包括：

– 打开图表

– 打开运行顺序

– 打开对话框

另外，如果还同时执行其它短读取操作，不会产生任何不利影响。

如果并行执行短写入操作或长写入操作，可能会导致访问冲突，即短读取操作将被取消。

• 短写入操作（没有资源使用）包括：

– 实例化、参数分配、互连等

– 单击“确定”(OK) 关闭对话框

另外，同时执行短或长写入操作时，最后启动的操作可能会发生访问冲突。 
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• 长读取操作（带有资源使用）包括：

– AS-OS 数据传输（编译 OS）
– 显示图表引用数据

如果触发长读取操作时未立即产生访问冲突（原因可能是写入操作已经执行），则执行

此操作时不会产生访问冲突。例外：请参见与系统行为相关的注意事项。

• 长写入操作（带有资源使用）包括：

– 优化运行顺序

– 编译和下载（AS 和 OS）
– 块类型的类型导入和更新/清除

– 更新共享声明

– 生成模块驱动程序

– 回读

– 创建块图标

– 创建诊断画面

– 更新多项目中的 PH
– IEA 和过程对象视图的导入/导出功能

– Version Cross Manager 的 ES 对象的导入/导出功能

如果触发长写入操作时未立即产生访问冲突（原因可能是写入操作已经执行），则执行

此操作时不会产生访问冲突。例外：请参见与系统行为相关的注意事项。

关于步骤的说明

• 如果有多位作者处理同一项目，建议以特定的周期间隔（F5 功能）更新数据。这些更新

可确保所有用户处理相同且一致的项目数据库。

• 建议不要让多位作者同时执行长读取或写入操作。作者最好协调各自的操作计划。例如，

以下情况很难实现：一个作者正在编辑 SFC 类型，而另一位作者正着手编译程序。作者

应负责协调同时发生的操作以及评估此类操作的可行性。只允许一名作者在任何图表文

件夹中执行长操作。因此，如果数据库不一致，建议只启动涉及长操作的工程。

• 无论何时，在同一时间只有一名工作人员可以访问 OS 数据。WinCC 项目管理器禁止一

个以上工作人员访问 OS。
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与系统行为相关的注意事项

• 任何因 CFC 以外的其它应用程序已经访问资源而无法完成的操作都将被取消。可通过 STEP 
7 应用程序（例如 SCL/块或符号编辑器）来启动此访问。消息内容可能会有所不同，具

体取决于触发应用程序。不过，其意义始终相同：在其它激活的应用程序已完成或取消

后，必须重新启动此操作。

示例：您启动了一个迄今已经长期处于激活状态的编译会话，而且编译器要访问符号表。

如果另一作者正在使用此符号表，则编译器会取消操作并生成一条消息，告知您必须关

闭其它应用程序，才能重新启动此操作。

• 如果一位用户在离线模式下编辑数据，而其它用户激活了测试模式，则这些其它用户下

一次激活测试模式以请求重新编译和下载图表到 CPU 时，系统将向其输出一条消息。作

者此时应负责决定是否激活测试模式。这样做的意义大小取决于离线更改；作者应在这

一点上达成一致。

• 当在测试模式下添加或删除监视某个值时，如果系统提示该值正在被另外一个应用程序

使用，则该设置将不会被存储。下一次启动测试模式时，必须重复登录或注销。

• 如果由于离线更改（例如，因为块已被删除）而使得在测试模式下所监视的值再也得不

到更新，系统会在相应的 I/O 处以红色背景显示“#”字符，而不显示这些受监视的值。

• 当某位作者在测试模式下编辑参数时，系统将拒绝由另一位作者启动的所有编译操作，同

时显示一条消息，说明数据当前正由其它应用程序使用。
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启动和操作 CFC 编辑器 8
8.1 启动和关闭 CFC 编辑器

从 SIMATIC Manager 启动 CFC           
执行以下操作以启动 CFC 编辑器： 
双击要打开的 CFC 图表的图标。

CFC 编辑器将启动，并打开图表。

从 Windows 桌面启动 CFC
双击 CFC 编辑器图标（如果有）

或

从“开始”(Start) 菜单中选择程序条目：SIMATIC > STEP 7 > CFC。

说明

单独保存文件功能不可用，因为 CFC 编辑器立即保存所有文件更改。请注意，不能通过不

进行保存即关闭编辑器来撤消或取消在 CFC 编辑器中进行的更改。

应始终通过将整个程序复制到备份项目对所有数据进行备份，然后，可以随时转换回旧版本。

还可以利用这一点归档整个组态。

关闭 CFC
执行以下操作以关闭 CFC 编辑器： 
在 CFC 中，选择菜单命令“图表”(Chart) >“退出”(Exit)。
CFC 编辑器关闭。
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8.2 CFC 编辑器的操作员控制和结构

8.2.1 工作窗口

编辑器允许打开 Windows 允许范围内的任意数目的窗口。每个图表窗口显示一个 CFC 图
表。    
可为同一图表打开多个窗口，例如，跨越表单创建文本互连。选择“窗口”(Window) >“新
窗口”(New Window) >“窗口”(Window) >“排列”(Arrange) >“水平”(Horizontally) 或“垂

直”(Vertically)，可在两个窗口中打开同一图表的清晰视图。菜单命令“排列”(Arrange) >
“层叠”(Cascade) 不适合这个特殊的应用。

前景中的窗口永远是激活的工作窗口。这意味着编辑器的菜单和工具按钮将用于该窗口。例

外：用于打开和关闭窗口的功能， 
在线模式下的标题栏以一种不同的颜色显示（默认设置：青色）。通过菜单命令“选项 > 自
定义 > 视图”(Options > Customize > View) 选项卡，可以在 SIMATIC Manager  中自定义背

景和文本的默认设置。

CFC 允许同时显示图表窗口和下列窗口：

• “动态显示”

• “趋势显示”

• “图表输入/输出”（接口编辑器）

• “运行顺序”（运行编辑器）

8.2.2 块、图表、模板和库的目录

打开和关闭目录

可将从目录中选择的块和图表插入到 CFC 图表中。                 
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有几种打开和关闭目录的方法：

• 单击工具栏中的按钮

或

• 选择菜单命令“视图”(View) >“目录”(Catalog)。
或

• 使用 <Ctrl+K> 快捷键。

有几种打开目录的方法：

• 选择菜单命令“插入”(Insert) >“块/图（从目录）”(Block/Chart (from Catalog))
或

• 在快捷菜单中，选择命令“目录”(Catalog)
或

• 使用 <F2> 键。

定位目录

可按住目录的边将其拖放到屏幕的任意位置。它将显示为一个带有标题栏的独立窗口。 
如果将目录移动到足够接近 CFC 窗口的右边界或左边界，或者双击其标题栏，它将相应地

停驻并共享工作区。停驻后，也可双击目录边缘将目录作为一个独立的窗口打开，然后移动

到任意位置。

转到目录窗口

在目录中，可导航到以下目录：

块目录

图表目录

模板目录

库目录

如果项目包含未放置的块，还会显示未放置的块的目录。此目录不作为默认目录提

供。
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对象搜索

有关搜索的信息，请参见“窗口下部可用的选项”下面的段落。 

块类型目录

可从块系列文件夹的“所有块”(All blocks) 文件夹或从 S7 程序文件夹中选择块，并拖拽到图

表中。也可选择块/新文本/新图表，并使用 <Return> 键将它插入到图表的空闲区域中。 
将 S7 程序块  插入到图表中时，这些块自动导入到 CFC 中，并显示在 CFC 块系列中。块

图标指示对于 CFC 而言块是否为已知块，也就是说，是否已导入。 
未导入的块如下所示：

即使此类型的块已被导入，S7 程序块在 CFC 中仍为未知块。将 S7 程序块插入到图表中时，

总是会先检查该块以确定其是否已导入。 
可以在块系列  之一中找到导入的块。未分配给系列（在标题中表明）的块可在“其它块”
(Other blocks) 文件夹中找到。这些块显示为 。 
在 “所有块”(All blocks) 文件夹中，可找到所有块系列（包括“其它块”）的所有块，这

些块按字母顺序排序。因此，所有导入的块显示两次，但排序顺序不同。

说明

从块系列或从“所有块”(All blocks) 中插入块是将块插入图表的最快方式，因为不执行上述

检查。因此，应始终使用相应系列的导入块。

也可通过位于块系列上部的 “新建文本”(New Text) 图标将一个空文本字段插入到图表中，

例如，当要通过拖放操作在组态上输入注释或备注或使用 <Return> 键选择和应用注释或备

注时。

使用块系列上方显示的 “新建图表”(New chart) 图标，可通过拖放操作来插入嵌套图表或

使用 <Return> 键选择和输入嵌套图表。 
要打开有关块和“新文本”或“新图表”功能的帮助，请选择对象并按 <F1> 键来显示帮助

主题。
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图表目录

目录窗口中的图表布局可不同，具体取决于“自定义布局”(Customize Layout) 对话框中“目

录”(Catalog) 选项卡上的设置。通过菜单命令“选项”(Options) >“自定义”(Customize) >“布
局”(Layout) 可进入这些设置区域。

• 选中“选择活动图表”(Select active chart) 复选框后，活动图表的图表符号  显示为一个

打开的文件夹 。如果当前图表是嵌套的，对应的层级分支也将打开。如果图表在激

活之后没有显示在目录窗口的可视区域中，窗口将滚动到所选的图表出现为止。当关闭

层级分支或移动窗口的可视区域时，所选图表将不再可见，除非再次将其激活（例如，切

换一次图表）。

• 选中该对话框中的“随工厂层级一起显示”(Show with plant hierarchy) 复选框时，图表就

会随着它们的工厂层级一起显示，即，随层级文件夹一起显示，前提是这些图表存在于

工厂层级中。

说明

尽管没有工厂层级，但仍然可以选中“随设备层级一起显示”(Show with plant hierarchy) 
复选框，则目录中不会显示任何条目。

• 如果工厂层级不存在而且未选中“随工厂层级一起显示目录”(Show catalog with plant 
hierarchy) 复选框，则图表就按字母顺序（树形）显示。

• 若复选框中有符号 +，则表示该图表包含嵌套图表。单击此框以扩展此树形层级并显示

图表层级。 
注： 
基础图表是显示在 SIMATIC Manager  中的图表。其中的嵌套图表不会显示在 SIMATIC 
Manager  中。

可选择一个 CFC 图表并将其拖放到您的图表中。插入的图表的布局与块的布局相似。若是

具有图表 I/O 的图表，则还会显示相应的 I/O。图表图标也与块图标不同：

当插入图表时，它和所有嵌套图表一起复制到图表文件夹中。

也可以按住 Shift 键，然后将顶级图表拖放到图表中。在这种情况下，不是复制而是移动顶

级图表。现在，图表不再显示在目录中原来的位置。而是显示在当前图表的层级结构中。 
也可在目录窗口中直接打开图表。选择所需的图表，然后选择快捷菜单命令“打开图表”
(Open Chart)。 

模板目录

基础数据库、下级 PH 文件夹和控制模块类型分层级显示在目录中。
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可以通过拖放的方式将控制模块类型移动到编辑器中以进行工艺连接。

库目录

可用块库通过图标  显示在目录窗口中。它们代表附加块库的集合，显示为块文件夹 。

它们包含的块类型显示为 。

单击加号框打开库，选择一个块并将其拖放到图表中。块将自动复制到激活的 S7 程序中并

导入到 CFC 中。然后它将出现在 CFC 块系列和“所有块”的块目录中。

块在目录中显示两次，但排序顺序不同：

• 按系列排列（例如，  CONTROL 中的 FMT_PID）
以及

• 在“所有块”(All blocks) 文件夹  中按字母顺序

块随以下内容一同显示：

• 块名称（例如，CTRL_PID）
• 块编号（例如，FB 61）
• 块注释（例如，PID 控制）

• 图标注释（如果可用）

如果需要块的相关帮助，可选择该块并用 <F1> 键显示相关的帮助主题。

未放置块的目录

说明

只有当未放置块实际存在时，此目录才可用。

可在此选择未放置的块并将它们重新插入到您的 CFC 图表中。 
未放置的块在最初放置它们的 CFC 图表中排列。可选择一个块并将其拖放到图表中。
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窗口下部可用的选项

• 查找

在块或库的目录中，可输入文本并单击以下按钮来启动搜索：

搜索从在激活的目录窗口中选定的对象开始。系统将对所有文件夹执行搜索，直到找到

指定的对象或搜索循环再次到达选定对象为止。 
在图表目录中可执行图表搜索，例如，搜索一个嵌套图表。如果搜索到指定目标，则该

功能就会展开树形层级并突出显示所选的图表。 
有关此主题的详细信息，请参见“在目录中搜索对象 (页 495)”部分

• 关闭文件夹

如果要关闭所有文件夹，请单击以下按钮： 

 

8.2.3 菜单栏

菜单栏位于应用程序窗口的最上边。其功能影响激活的工作窗口。只能选择在当前情况下能

提供可行功能的菜单命令。例如，仅当至少有一个可删除的对象（例如，一个块、嵌套图表、

连接线或 I/O）被选中时，才可选择菜单命令“编辑”(Edit) >“删除”(Delete)。   
禁用的菜单按钮呈灰色。

该栏只显示与所选的目标系统相关的菜单命令。

8.2.4 工具栏

工具栏位于菜单栏下面。它包含一系列图标，可用来启动频繁使用的菜单栏功能，包括用于

选择表单/总览的下拉列表。将光标放置在图标上但不单击，即可查看该按钮相关的功能。屏

幕上会出现一个小方框，功能的代号（工具提示）显示在其中。该功能的更详细的信息显示

在状态栏上。 
单击按钮即会触发相应功能。禁用的按钮呈灰色。

8.2.5 状态栏

状态栏位于 CFC 窗口底部边沿。它显示重要信息和编辑器状态。其内容随操作员输入和编

辑器状态而变化。
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通过“视图”菜单可隐藏和显示状态栏。

左侧区域

状态栏左侧区域显示上下文的相关信息，例如，菜单命令的描述、提示或错误消息。

中心区域

• “带感叹号 ! 的黄色三角形”图标 
在该图标的右侧显示以文本形式说明的重要消息。  

• 注意事项文本“TCiR：需要下载 !”(TCiR: Download required !)：
此消息表示至少执行了一次“RUN 模式下的类型更新”，现在需要下载到 CPU。  

右侧区域

状态栏的右侧区域包含三个字段：

• 右侧（较大的）域显示当前模式（编辑模式或测试模式）和附加信息：

– 在编辑模式下：

将块插入到运行顺序中所对应的任务、图表名和前导

如果文本“(Start)”附加到运行组名后，则插入位置位于组的开头，即，在现有块之上，

例如，OB 35 Group1 (Start)。
– 在测试模式下：

测试：CPU 状态、断点状态、停止原因

CPU 状态仍由背景颜色指示：

浅绿色 = 运行

红色 = 停止

• 中间、较小的区域显示下列图表信息：

– 在总览中：

图表分区标识符 (A – Z) 和“总览”

– 在表单视图中：

图表分区标识符 (A – Z) 和当前表单编号（表单 1 - 6）（可能由溢出页码补充）

• 如果安装了 SIMATIC Logon Service 且某位用户已登录，则左侧域显示用户名。

8.2.6 快捷菜单

单击鼠标右键将打开一个快捷菜单，其中包含常用菜单栏功能。只能选择对当前应用程序有

用的功能。所有其它功能都呈灰色。可访问各种快捷菜单，具体取决于光标位置或所选对

象。 
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不同菜单调用位置示例：

• 空闲区域

• 块/嵌套的图表

• 文本域（不在编辑模式时）

• I/O
• 图表分区选项卡

• 表单栏条目（小字段）

• 对话框

• 运行顺序、图表输入/输出和目录的窗口
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8.3 键盘和鼠标操作

8.3.1 菜单命令的快捷键

简介

通过使用 <Alt> 键的相应快捷方式可以选择任何菜单命令。

快捷键

按照显示顺序按下以下键：

• <Alt> 键
• 所需菜单的名称中带下划线的字母（例如，<Alt>+<C> 表示“图表”(Chart) 菜单 - 如果菜

单栏中包含“图表”(Chart) 菜单）。将打开该菜单。

• 所需菜单命令的名称中带下划线的字母（例如，<N> 表示菜单命令“新建”(New)）。

还将打开此菜单命令的子菜单。重复上述操作，直到选择了所需的菜单命令。

在输入快捷键的最后一个字符后，即会执行菜单命令。

实例

功能 快捷键

“图表”(Chart) >“新建”(New) <Alt>、<C>、<N>
“编辑”(Edit) >“转到”(Go To)，“表单”

(Sheet)
<Alt>、<E>、<G>、<S>

8.3.2 CFC 图表中的快捷键

概述

可使用下列键在 CFC 图表中导航：  
• 图表窗口
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快捷键 功能

<Tab> 如果选择了单个块：将光标移动到下一个块

（顺序在内部进行定义，用户不能干预）。

如果选择了多个块：所选内容将被取消，并且光标按照内部顺序

移动到下一个块。

在总览中，光标移动到下一页。在表单视图中，光标只在表单内

移动；首先移到正常位置，然后移到重叠块。

<Shift+Tab> 与 <Tab> 相同，但顺序相反。

<向上箭头> 如果选择了输入/输出：

将光标移到下一个较高输入/输出（如果该输入/输出存在；否则

会选择块）。

<向下箭头> 如果选择了块：

选择首个输入（或首个输出，如果只有输出）。

如果选择了输入/输出：

光标移动到下一个较低输入/输出（如果该输入/输出存在）。

<右箭头> 如果选择了某个输入：

将光标移到相对的输出（如果该输出存在；否则

移到最后一个输出）。

<左箭头> 如果选择了某个输出：

光标移到相对的输入（如果该输入存在，否则

移到最后一个输入）。

<Ctrl+向上箭头> 在表单视图中：移动到上一页（例如，从第 2 页到第 1 页）。

<Ctrl+向下箭头> 在表单视图中：移动到下一页（例如，从第 2 页到第 3 页）。

<Ctrl+右箭头> 在表单视图中：移动到右侧的页（例如，从第 2 页到第 5 页）。

<Ctrl+左箭头> 在表单视图中：移动到左侧的页（例如，从第 5 页到第 2 页）。

<Ctrl+Page Up> 如果存在上一个图表分区，则移到上一个图表分区（例如，从 B 
到 A）。

<Ctrl+Page Down> 如果存在下一个图表分区，则移到下一个图表分区（例如，从 B 
到 C）。

<Ctrl+K> 打开和关闭目录。

<Ctrl+F6/Ctrl+Tab> 在打开的窗口间切换。

<Alt+Page Up> 将图表的可视部分向左移动。

<Alt+Page Down> 将图表的可视部分向右移动。

<F6> 将键盘从活动图表切换到目录。
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快捷键 功能

<Shift+F10> 打开选定对象的快捷菜单。

如果选择了多个对象或者没有选择对象，则打开空白区的快捷菜

单。

<Esc> 取消图表中所有现有的选择

（也包括多项选择和闪烁功能）

 
• 互连

快捷键 功能

<Ctrl+X> 输入：将互连复制到剪贴板，并在通过 <Ctrl+V> 将该互连粘贴到另一个

选定输入时，在此输入处删除该互连。

<Ctrl+C> 输入：将互连复制到剪贴板

<Ctrl+C> 输出：将输出复制到剪贴板作为可能的互连源

<Ctrl+C> 表单栏条目：将互连复制到剪贴板

<Ctrl+V> 输入：如果以前在输入/表单栏条目中使用过 <Ctrl+C> 或者在输入中使用

过 <Ctrl+X>，互连将从剪贴板粘贴到选定输入。

<Ctrl+V> 输入：如果以前在输出中使用了 <Ctrl+C>，输入将与此输出互连。

 
• 目录窗口：

快捷键 功能

<Ctrl+Page Up> 从右到左切换目录视图。

<Ctrl+Page 
Down>

从左到右切换目录视图。

<Return>
 

• 在“块”(Blocks) 窗口中：将选定的类型插入到当前图表中

（新文本、新图表或块实例）

• 在“图表”(Charts) 窗口中：打开所选的图表。

• 在“库”(Libraries) 窗口中：导入选中的块并

将块实例放到当前图表中

• 在“未被放置的块”(Unplaced Blocks) 窗口中：将所选块放到

当前图表中

• 在搜索框中：触发搜索。
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快捷键 功能

<F6> 将键盘从目录切换到活动图表。

<Tab> 在操作元素间切换，从上到下或从左到右

（目录视图、搜索框、按钮）

<Shift+Tab> 和 <Tab> 相同，但方向相反。

<向上箭头>
<向下箭头>

从选定对象向上或

向下移到下一个对象

<右箭头>

<左箭头>

扩展选中对象的层级并选择

该层的

第一个对象或在扩展的层级中向上移动一层

<Page Up>
<Page Down>

选择位于窗口上

边缘或下边缘

的对象。

当再次执行该按键时，会相应地移动可见区域

（如果无法显示全部内容）

 
• 运行编辑器窗口：

快捷键 功能

<Tab> 在层级窗口（左窗格）和详细信息窗口（右窗格）之间移动。

<向上箭头>
<向下箭头>

从选定对象向上或

向下移到下一个对象

<右箭头>

<左箭头>

扩展选中对象的层级并选择该层的第一个对象

或在扩展的层级中向上移动一层

<Page Up>
<Page Down>

选择位于窗口上

边缘或下边缘

的对象。

当再次执行该按键时，会相应地移动可见区域（如果无法显示全部内容）
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8.3.3 文本编辑器中的光标移动

用于移动文本光标的键     
用下列键在文本内移动文本光标：

快捷键 功能

<向上箭头> 上移一行或在文本仅包括一行时

向左移动一个字符

<向下箭头> 下移一行或在文本仅包括一行时

向右移动一个字符

<右箭头> 向右选择一个字符

<左箭头> 向左选择一个字符

<Ctrl+右箭头> 向右选择一个字

<Ctrl+左箭头> 向左选择一个字

<Pos1> 到行的开头

<End> 到行的末尾

<Page Up> 到上一页面

<Page Down> 到下一页面

<Ctrl+Home> 到文本的开头

<Ctrl+End> 到文本的末尾

更多信息

更多相关信息，请参见以下部分：国际/德国键盘 (页 69)

8.3.4 菜单栏/快捷菜单中的光标移动

用于移动鼠标指针的键     
用下列键在菜单栏或快捷菜单中移动光标：

快捷键 功能

<F10> 移动到菜单栏

<Shift+F10> 打开快捷菜单
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快捷键 功能

<Alt+X> 选择包含带下划线字符 X 的
菜单

菜单命令中带下划线的字符 选择一个菜单命令

<左箭头> 左移一个菜单命令

<右箭头> 右移一个菜单命令

<向上箭头> 上移一个菜单命令

<向下箭头> 下移一个菜单命令

<Return> 执行选中的菜单命令

<Esc> 退出菜单或返回到文本

更多信息

更多相关信息，请参见以下部分：国际/德国键盘 (页 69)

8.3.5 对话框中的光标移动

用于移动鼠标指针的键     
用下列键移动对话框中的光标：

快捷键 功能

<Tab> 移动到下一个输入字段（从左至右和从上至下）

<Shift+Tab> 向回移动一个输入字段

<Alt+X> 移动到包含带下划线字符 X 的输入字段

箭头键 在选择列表中移动光标

<Alt+向下箭头> 打开一个选择列表

<空格键> 选择一个对象或取消该选择

<Return> 确保输入并退出对话框（相当于“确定”(OK) 按钮）。

<Esc> 退出对话框，而不保存更改（相当于“取消”(Cancel) 按钮）。

更多信息

更多相关信息，请参见以下部分：国际/德国键盘 (页 69)
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8.3.6 通过快捷键选择文本

键命令     
用下列键选择文本：

快捷键 功能 
<Shift+右箭头> 向右选择一个字符

<Shift+左箭头> 向左选择一个字符

<Ctrl+Shift+右箭头> 向右选择一个字

<Ctrl+Shift+左箭头> 向左选择一个字

<Shift+Home> 到行开头的文本

<Shift+End> 到行末尾的文本

<Shift+向上箭头> 向上一行

<Shift+向下箭头> 向下一行

<Shift+Page Up> 到上一页面

<Shift+Page Down> 到下一页面

<Ctrl+Shift+Home> 到文件的开头

<Ctrl+Shift+End> 到文件的末尾

更多信息

更多相关信息，请参见以下部分：国际/德国键盘 (页 69)

8.3.7 通过快捷键访问帮助

用下列键调用帮助：

快捷键 功能

<F1> 打开帮助。

如果有一个当前上下文，例如，选中的菜单命令，则会打开相关的帮助

主题。否则，将显示帮助目录。

<Alt+F4> 关闭“帮助”(Help) 窗口并返回到 
CFC 编辑器
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8.3.8 用于组态的快捷键

简介

下一部分列出了用于组态的快捷键，有经验的用户可使用这些快捷键（而不是菜单命令）以

快速访问特定功能。

在表单视图中的图表表单间移动

在表单视图中，按 <Ctrl> 和 <左箭头>、<向上箭头>、<右箭头>、<向下箭头> 可以浏览表

单。根据箭头方向选择表单。如果在箭头的某个方向上没有表单，则该快捷键不起作用。

在图表视图和表单视图间移动

按下列步骤进行操作以切换视图：

• 在表单视图中：

要切换到总览，请双击表单上的某个空闲点，即，不是双击块、块 I/O、互连或表单栏。

• 在总览中：

要切换到表单视图，请双击表单上的某个空闲点，即，不是双击块、块 I/O、互连或表单

栏。显示通过双击所选的表单的中间位置。

将多个块输入互连到一个块输出

按下列步骤进行操作以创建互连：

• 选择块输出。

• 按下 <Shift> 键并选择块输入。

将建立互连，而且块输出保持选中状态。

• 按下 <Shift> 键并选择下一个块输入。

• 选择最后一个要互连的块输入，而不用按下 <Shift> 键。

选择块组

按下列方法选择块组：

• 按住 <Ctrl> 键并单击任何需要的块。重复这个操作，直到选择了所有需要的块。按住 
<Ctrl> 键时，再次单击选中的块可以取消选择。

• 要选择排列在同一区域中的多个块，将光标置于块外的某处，按住鼠标左键，框选这些

块，然后松开鼠标键。当松开键时，框内所有的块都被选中。
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编辑块组的对象属性

要编辑对象属性，按以下步骤进行操作：

• 通过使用 <Ctrl> 键并单击块或通过使用框选功能来选择要编辑的块。

• 选择菜单命令“编辑”(Edit) >“对象属性...”(Object Properties...)。
将打开用于编辑第一个块的对话框。

• 在对话框中进行所需的输入。

• 单击“确定”(OK)。
将退出此对话框，并打开用于编辑下一个块的对话框。

• 可以单击“取消”(Cancel) 退出此对话框，而不保存更改。这将关闭此对话框。设置的对

象属性没有应用。

8.3.9 鼠标操作

概述

鼠标提供了下列功能：   

 单击 双击 <Ctrl> +
单击

单击 +
拖放

块标题

（也适用于

嵌套图表标题）

选择对象；

取消选择所有其它对

象

打开“属性 - 块”(Properties 
– Block) 或
“属性 - 图表”(Properties – 
Chart) 对话框

选择

块/
嵌套图表

移动

块/嵌套

图表

块体 选择块；

取消选择所有其它对

象

- 选择

块

移动

块

块标题中的

运行属性框

选择块；

取消选择所有其它块

打开“运行顺序”窗口 选择

块

移动

块

输入，输出 选择

输入/输出

打开“属性 – 输入/输出”
(Properties – Input/
Output) 对话框（或者，对

于 STRUCT，则打开“选择

结构元素”(Select Structure 
Element) 对话框）

选择

块/
嵌套图表

移动

互连

（重新连线）
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 单击 双击 <Ctrl> +
单击

单击 +
拖放

嵌套

图表体

选择对象；

取消选择所有其它对

象

打开嵌套图表 选择

嵌套图表

移动

嵌套图表

连接器 信号跟踪 - 跟踪

信号

框

选

连接线 信号跟踪 切换到表单视图或总览 跟踪

信号

框

选

表单栏条目

（小字段）

选择域 从带信号跟踪的表单栏跳

转；

对于地址，打开“修改与地

址的互连”(Modify 
Interconnection to 
Address) 对话框

跟踪

信号 
框

选

表单栏条目

（大字段）

信号跟踪 与针对小域的功能相同 跟踪

信号

框

选

表单上的空闲区域 取消

选择 
切换到表单视图或总览 - 框

选

表单栏的

空闲区域

 -  - -  -

 

说明

请注：对于上述元素，也可以用鼠标右键来调用相应的快捷菜单命令，例如，“从表单栏跳

转”(Jump from Sheet Bar) 或“转到 I/O 模块”(Go to I/O Module)。更多相关信息，请参见以

下部分：快捷菜单 (页 58)

 

8.3.10 国际/德国键盘

国际键盘 德国键盘

<Pos1> <Pos1>
<End> <End>
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国际键盘 德国键盘

<PAGE UP> <Page up>
<PAGE DOWN> <Page down>
<Ctrl> <Ctrl>
<Enter>/<Return> <Enter>
<Del> <Del>
<Insert> 键 <Ins>
<BACKSPACE> <Back>
<向上>
<向下>
<向左>
<向右>

<上箭头>
<下箭头>
<左箭头>
<右箭头>
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组态数据的布局 9
9.1 图表

      
图表表示 CFC 编辑器的基本工作单元。每个图表都有一个在 CPU 中唯一的名称。每个图表

最多由 26 个图表分区 (页 72)组成，每个图表分区包括 6 个表单 (页 73)。
可在 SIMATIC Manager  或直接在 CFC 编辑器中创建图表。

可将其它图表插入到某个图表中。这可生成嵌套深度多达 8 个图表的嵌套图表。使用拖放操

作或通过菜单命令“插入”(Insert) >“新图表”(New Chart)，可插入图表目录中的现有图表

或块目录中的新图表。
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9.2 图表分区

 
可更改 CFC 图表的大小。可通过添加最多 26 个图表分区（A 到 Z）来增加图表大小。可决

定将新图表分区插入到当前图表分区的之前还是之后。每个图表分区由 6 个表单 (页 73)组
成。 
在窗口的底边沿，可通过滚动条中的选项卡选择要编辑的图表分区。状态栏显示当前活动图

表分区的字母，包括表单编号，例如，“A/表单 2”(A/Sheet 2)。

组态数据的布局
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9.3 表单 (Sheets)
每个图表 (页 71)（分区）由 6 个表单组成。在 CFC 编辑器中，它们排成 2 列，每一列包含 3 
个表单。每个表单由一个中心工作区和带有表单和图表引用的表单栏组成。在工作区中，可

定位并互连块。        
每个表单都包含一个内部网格线。块可以按照由网格线所决定的距离在表单内移动。网格线

决定两个连接线之间的最小可能距离。

工具栏包含一个下拉列表 ，从中可选择要编辑的表单。状态栏按如下方式显示当前的

表单编号：它包含图表分区的标识符（字母），由斜线分开，例如，“A/表单 2”(A/Sheet 2)。
更多相关信息，请参见以下部分：表单栏中互连的显示 (页 85) 

组态数据的布局
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9.4 溢出页

如果表单间生成太多的互连，以至于表单栏中没有足够的空间来容纳所有的条目，则自动创

建一个溢出页。溢出页表示表单栏的扩展，不包含其它对象。

组态数据的布局
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9.5 嵌套的图表

  
一个 CFC 图表可插入到另外一个 CFC 图表中（图中图技术）。这允许创建层级结构。与任

何其它图表一样，每个嵌套图表均可单独打开和修改。对象放在表单的工作区中。

可封装图表以供将来使用，也就是说，可为其分配图表 I/O。可单独决定将哪些块 I/O 用于

图表 I/O。

嵌套图表作为图形对象显示在图表中，类似于块。图表符号显示在图表标题中。也包含图表

名称和注释（如果存在注释）。

也可生成不带图表 I/O 的嵌套图表。在这种情况下，只显示标题和空窗体。

组态数据的布局
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9.6 块

概述

块作为图形对象显示在图表中。对象放在表单的工作区中。每个块都占用一个特定区域。如

果块放置成与其它对象或表单栏部分或完全重叠，则这些块以其正常尺寸显示，但不带块 I/O 
且为其它颜色。 
用来显示重叠块的颜色可以在“颜色设置”(Color settings) 对话框中的“重叠块”(Overlapping 
blocks) 选项中设置。  
块也可跨越分割两个表单的水平线而放置。这种情况下，会在分割线的紧下方，插入一个表

示第一标题副本的附加块标题。这允许放置在一个表单上放不下的块。

块显示在图表中，其块 I/O 在块类型中标识为“可见”(S7_visible: = TRUE)。在块的对象属性

对话框中，可指定是要显示还是隐藏块 I/O。

限制：由于空间要求，图表可最多显示一个块的 160 个输入和 160 个输出。

如果超过了 160 的限制，所有其它的 I/O 将自动隐藏。可在块或 I/O 的对象属性中隐藏单个

的 I/O。 
如果隐藏互连 I/O，CFC 将如下响应：

• 对于表单内的互连，将连接伙伴的互连放置到表单栏上。在 I/O 名称后输入文本

“INVISIBLE”。
• 对于表单间的互连，用 I/O 名称之后的文本“INVISIBLE”标记表单栏条目。

• 对于文本互连和到共享地址、运行组和接口（图表 I/O）的互连，不生成表单栏条目。这

些互连只能在块的对象属性中识别（“I/O”选项卡的“互连”(Interconnection) 列）。

• 一个彩色三角形出现在块标题的右上角。（请参见下图中的第 6 项）

图表中的块表示

块显示在图表中，以图形方式分为“窄”或“宽”块。 
下图显示了“宽”块。 

组态数据的布局
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(A) 块头

(B) 块体

(1) 例如，值已由用户组态的 I/O 在此处为“蓝”色。 
更多信息，可参见下面的说明。 

(2) 例如，已分配默认值的 I/O 在此处为“浅灰色”。 
更多信息，可参见下面的说明。

(3) 对于自上次下载到 CPU 后发生变化的 I/O，将更改 I/O 名称的字体颜色（例如，此处为

“红色”）。

更多信息，可参见下面的说明。

(4) 互连的 I/O
(5) 运行时属性字段

(6) 显示互连的 I/O 已设置为“不可见”。 

组态数据的布局
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块的“宽”表示显示如下内容： 
• 块头 (A)：

– 块名称、块类型和注释

– 块的运行时属性字段 (5)。 
有关详细信息，请参见“运行属性框的显示 (页 482)”部分。

块的运行时属性字段的字体颜色 (5)：显示块的下载状态 
运行时属性字段中的字体颜色用于指示块是否已下载到 CPU。 
可以在“颜色设置”(Color settings) 对话框中使用“块插入位置/参数（已更改）”(Block 
insertion position/parameter (changed)) 选项组态此颜色。 
文本颜色示例： 
 -“黑色”字体表示块已下载到 CPU。 
 -“浅灰色”字体（取决于组态）表示块尚未下载到 CPU。

说明

块头中指示下载状态的相关更改 
运行时属性字段中的字体颜色用于指示块是否已下载到 CPU。 
下列更改对此状态显示没有影响： 
• 对块的更改，例如对块 I/O 的更改（请参见上图中的 1、2 和 3） 
• 对相应图表的更改或图表到其它运行组的移动会显示在图表或图表文件夹上。  

– 彩色三角形 (6)（可选）： 
如存在隐藏的互连 I/O，则在右上角显示一个彩色三角形。

– 如果块是工艺类型的一部分，则块标题以“浅绿色”显示（默认设置）。

– 如果将块定义为工艺功能，则块标题以“浅灰绿”显色示（默认设置）。

• 块体 (B)：
– “输入”和“输出”。 

输入和输出显示为可选字段，其中仅包含 I/O 名称（窄表示）或包含 I/O 名称和数据类型

（宽表示）。

– 空闲区域

• I/O：

– 窗体外，每个可互连的输入或输出都有一个 I/O 引脚。例外：对于由于分配了

“S7_link := FALSE”属性而无法互连的输入，可通过缺少的 I/O 引脚进行标识。

此上下文中的“不可互连”指的是既不能与块或嵌套图表的 I/O 互连，也不能与共享

地址互连的输入。但可将此 I/O 互连到其内部图表 I/O，只要 CFC 包含图表 I/O。

– 在正文中，如果将块 I/O 分配给某工艺类型（控制模块、设备模块和设备阶段）的工

艺接口，此块以“浅绿色”突出显示。

– 在正文中，如果将参数值设置为忽略类型更新，块 I/O 将以“粉色”突出显示。

组态数据的布局
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– I/O 状态的颜色表示： 
如果块或图表 I/O 已更改（例如由于组态或互连），则此状态通过该 I/O 的彩色表示

来指示 (1)(2)。 
对于自上次下载到 CPU 后发生变化的 I/O，将更改 I/O 名称的字体颜色 (3)。
将修改的块下载到 CPU 后，这些颜色切换将复位。     
可以在“颜色设置”(Color settings) 对话框中设置颜色。在 CFC 编辑器中，使用菜单

命令“选项 > 自定义 > 颜色...”(Options > Customize > Colors...) 打开该对话框。 

图中编

号 
状态 状态指示方式： “颜色设置”(Color 

settings) 对话框的选项

(1) 值已由用户组态的 I/O
（例如，此处为“蓝

色”）。

块图标中已组态的值/文
本的字体颜色 

“参数文本（已更改）”

(2) 已分配默认值的 I/O
（例如，此处为“浅灰

色”）。

块图标中已组态的值/文
本的字体颜色

“参数文本（默认）”

(3) 自上次下载到 CPU 后
由于互连或组态而发

生变化的 I/O（例如，

此处为“红色”）。 

块图标中 I/O 名称的字体

颜色

“块插入位置/参数（已

更改）” 

 更多相关信息，请参见“如何设置 I/O 参数 (页 141)”部分。

可以使用“选项 > 自定义 > 块/表单栏宽度...”(Options > Customize > Block/Sheet Bar 
Width...) 菜单命令设置块的宽度。这些设置应用于包含当前图表的图表文件夹。 
这些设置作为可在创建新图表文件夹时使用的默认设置保存到注册表 (CurrentUser)。因此，

每个用户可定义一个单独的登录设置。

块的“窄”表示 
“窄”块的表示与“宽”块的块头的表示相似，但包括输入和输出。 
“窄”块显示时不带输入和输出的字段或 I/O 名称，且在块体中没有空闲区域。I/O 仅由 I/O 引
脚表示。不能更改块的宽度。

参见

互连 (页 81)
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9.7 文本

用文本字段输入图表注释。可将一个文本字段放在图表中，就象块一样。 
将文本字段 “新建文本”(New Text) 从块目录拖放到图表中，或者通过菜单命令“插入”
(Insert) >“新建文本”(New Text) 将其插入到图表中的空闲位置。然后单击所选的文本字段

将其打开。文本光标激活，并且可立即开始编辑。会在框的右边缘自动添加一个换行符。如

输入的文本多于框中可显示的，不会自动增加框的大小；而是将文本移动到可视区域之外。

可以手动增加文本框的大小，以使得整个文本都可见。

要更改框的大小，单击框句柄并用鼠标拖动直到达到所需的大小。如更改框的宽度，文本行

的长度会自动调整。 
打开一个文本字段时，文本光标位于单击的位置上。

组态数据的布局
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9.8 互连

概述

互连是下列元素之间的连接： 
• 块/图表输出与另一个块/图表（或同一个块/图表）的一个或多个输入之间的连接，或者块/

图表输出与图表 I/O 的输入之间的连接。

输入和输出的数据类型必须兼容。

互连的块/图表可以位于同一表单中、同一图表的不同表单中或者同一 CPU 上的不同图表

中。

• 块输出到运行组之间的连接

• 块 I/O 到图表中的图表 I/O 之间的连接

• 块输出到 CFC 数据管理之外的对象（例如，共享地址）之间的连接。

另一个互连选项是文本互连。该互连表示到当前图表文件夹中不存在的互连伙伴的路径引用。

相关信息，请参见“使用文本互连 (页 157)”部分。

创建互连后，块或图表 I/O 的颜色表示

如果块或图表 I/O 已更改（例如由于组态或互连），则此状态通过该 I/O 的彩色表示来指示。 
更多相关信息，请参见“块 (页 76)”部分。

说明

块的每一个可互连的输入或输出在图表中显示时都带有一个 I/O 引脚。对于由于分配了

“S7_link := FALSE”属性而无法互连的输入，可通过缺少的 I/O 引脚进行标识。

此上下文中的“不可互连”指的是既不能与块或嵌套图表的 I/O 互连，也不能与共享地址互

连的输入。也不能进行文本互连。

但可将此 I/O 互连到其内部图表 I/O，只要 CFC 包含图表 I/O。
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9.9 互连的布局

简介

本部分描述显示互连时的以下选项：

• 块/图表互连

• 到共享地址、运行组、图表 I/O 的互连和文本互连

• 连接器

• 互连的彩色显示

• 互连信号处理的停滞时间的状态显示

块/图表互连

块/图表互连的布局：

• 当要互连的块和/或图表位于同一个表单中时，将画出一条连接线。如对象不在同一个表

单中，将在表单栏中自动生成引用条目。这些引用包含相应目标 I/O 的标识符。

• 对于互连到多个输入的块/图表输出，将生成分支。分支由一个圆点指示。

• 在一些目标系统中，互连的二进制输入可能已取反。此取反用一个圆点指示。

说明

• 到隐藏 I/O 的互连置于表单栏中。

• 带隐藏互连的块通过块标题右上角的一个彩色三角形指示。

到共享地址、运行组、图表 I/O 的互连和文本互连

将为到共享地址、运行组或图表 I/O 的互连和文本互连生成表单栏条目。 

说明

如果互连开始于随后被隐藏的 I/O 处，则不会有表单栏条目。然后只能在块/图表的对象属性中

（“I/O”选项卡的“互连”(Interconnection) 列）进行互连。
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连接器

如果由于表单空间不足而不能绘制附加线，CFC 将在块/图表 I/O 上插入一个连接器并在表单

栏中输入一个编号。将为相应的连接器分配相同的引用编号。不能显示的多个输出互连将分

配有相同的引用编号。连接器布局的不同指示 I/O 点的位置：

带点的矩形，白色内部区域 表单上的 I/O 点
使用连线的颜色进行填充的矩形 溢出页上的 I/O 点
带点的矩形，使用连线的颜色进行填

充

表单和溢出页上的 I/O 点

要跳转到互连，尤其是在相同位置有两个连接器（表单和溢出页）的情况下，右键单击连接

器并在快捷菜单中选择所需的目标。

如果表单间生成太多的互连，以至于表单栏中没有足够的空间来容纳所有的条目，则自动创

建一个溢出页。溢出页表示表单栏的扩展，不包含其它对象。

如果输出包含多个互连，其中的一些互连可能只显示为一条线。此种情况下，会将一个连接

器附加到该线上。 
利用连接器技术，可以总是显示完整的 CFC 结构，无论结构有多复杂。

互连的彩色显示

CFC 编辑器以颜色显示互连、到输入和输出的块/图表 I/O 点以及表单栏条目。 
• 可以使用菜单命令“选项 > 自定义 > 颜色...”(Options > Customize > Colors...)，根据数

据类型自定义互连颜色。此功能增强了图表布局，并更易于组态连接。 
– “Bool 互连”

– “Byte 互连”

– “（双）字互连”

– “（双）精度互连”

– “Real 互连”

– “定时器互连”

默认颜色根据数据类型或数据类型组的不同而不同。

• 在“自定义显示”(Customize Display) 对话框中，可以设置互连的连接线以彩色显示还是

以黑色显示。 
可通过菜单命令“选项 > 自定义 > 显示”(Options > Customize > Display) 来打开此对话

框。 
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显示互连信号处理的反馈

如果在创建互连期间出现反馈，则会检测到该反馈并将其显示给用户。  
• 以下符号将显示在 CFC 中相应互连处的互连块输入端。

符号以互连线的颜色显示。

有关反馈、显示和可能用户响应的更多信息，请参见“显示信号处理的反馈（停滞时间） 
(页 186)”部分： 
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9.9 互连的布局

SIMATIC S7 中的 CFC (V9.0 SP7)
84 功能手册, 05/2022, A5E41356112-AH



9.10 表单栏中互连的显示

布局

每个表单的左右边缘上均有一个表单栏。表单栏中包含的条目显示在表单视图中。

大型表单栏区域的宽度可变。通过在对话框中选择“选项”(Options) >“自定义”
(Customize) >“块/表单栏宽度”(Block/Sheet Bar Width) 菜单命令，可以设置从 2 个字符到 
50 个字符的宽度。该设置适用于整个图表文件夹。

当存在一个与不在活动表单中的对象的互连时，通常会生成一个表单栏条目。该条目包含两

个域，各占两行。连接类型决定了域内容。

大域

大域包含到所连接对象的引用：

• 块之间的互连：

第 1 行：   图表名称 *)、块名称 *)
第 2 行：   I/O 名称和注释（如存在）（可能被简化）

在表单范围内互连的图表名称之后的圆括号中给出图表分区和表单编号。

对于位于另一 CPU 中的 I/O 的互连，将给出工艺路径，如果 PH 不可用，则给出组件路径。

• 与共享地址的互连

第 1 行：   依照符号表的符号和/或绝对地址值 **)
第 2 行：   来自符号表的注释 **)

• 与运行组的互连：

第 1 行：   运行组的名称和注释（如存在）

第 2 行：   “ENABLE”，任务名称

• 与未放置块的互连

第 1 行：   块名和文本：(NO POSITION)
第 2 行：   I/O 名称和注释（如存在）

• 与图表 I/O 的 I/O（块/图表）互连

第 1 行：   I/O 名称和注释（如存在）

第 2 行：   I/O 类型和数据类型

• 与隐藏 I/O 的互连

第 1 行：   图表名称 *)、块名称 *)
第 2 行：   I/O 名称和文本：(INVISIBLE) 以及输入/输出的注释（如存在）（可能被简

化）
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*) 如在工厂层级 (PCS 7) 中使用图表，则层级路径名会加在图表和块名称之前。如无足

够的空间，则删除路径名的开头。

**
)

符号表并非在所有目标系统中都可用。

说明

根据表单栏宽度，可能会发生无法显示完整文本的情况，即：会根据默认的字符数截断文本。

但是，当将鼠标放在该字段上时，工具提示框将显示完整的文本。

小域

表单栏的小域按下列方法使用：

• 由于表单空间不足而不能绘制到表单栏的连接线时，该域包含连接器引用的编号。

• 彩色三角形指示了连接类型。

ID 互连到 ...
（空白） 块 I/O/图表 I/O（外部）

白色三角形 图表 I/O（内部）

蓝色三角形 共享地址

红色三角形 运行组

黄色三角形 文本互连

绿色三角形 到另一个 CPU 的连接

不能更改小域的宽度。

溢出页中的条目

如果表单栏不能接受与其它表单互连的其它引用条目，将生成一个溢出页。

在溢出页（小域和大域）表单栏中的条目旁还将显示有关所连接 I/O（原点）的信息。

组态数据的布局
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9.11 工具提示

通过将光标放在相关的条目上，可显示关于 CFC 图表某些部分的工具提示。

光标位置 信息

块标题、块体 块类型、块注释

图表标题、图表体 类型（总是“图表”）、图表注释

块标题中的运行属性框 完整任务名称、运行组名称（如可用）

块 I/O/图表 I/O I/O 名称

I/O 类型

数据类型

值（仅限未互连的 I/O）

I/O 注释

表单栏 完整的表单栏条目

（如果 PH 路径过长，则可能被截断）

以下内容适用于测试模式：

• 通过将光标放在 I/O 或互连线上，可从 CPU 中获得活动信息，即使该 I/O 没有注册为可供

监视。此处光标的功能相当于测量工具的“测试棒”。然而，这需要 I/O 可在线更新（例

如，无未连接的 FC 输入）。在一秒的周期内发生更新，而与设置的监视周期无关。 
• 值被在线值取代，并且工具提示的背景颜色从浅黄色变为黄色，因为使用了被监视的 I/O。

• 对于互连显示输出值。

例外：对于与共享地址的互连，显示输入值。在这种情况下，考虑取反。
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9.12 视图

9.12.1 CFC 中的视图

视图

CFC 编辑器提供两种不同的视图用于插入和编辑块/嵌套图表：           
• 总览(Overview)用于复制/移动对象以及插入大型块。

• 由于某些详细信息（例如，I/O 名称）无法在此视图中显示，因此某些功能仅在表单视图

中可用。

更多此内容的相关信息，请参见以下部分：

– 概述 (页 89) 
– 表单视图 (页 89) 

视图间的切换

可通过以下方法在视图间切换：

• 选择菜单命令“视图 > 总览”(View > Overview) 或者“视图 > 表单视图”(View > Sheet 
View)。
CFC 将切换到所选视图

或

• 在工具栏中选择对应总览或表单视图的按钮。

概述

表单视图

或

• 双击图表中的空白处

或

• 在组合框  中选择表单编号以打开所需的表单视图，或者选择星号 (*) 以更改为总览。

组态数据的布局
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9.12.2 概述

“总览”图表视图

总览（图表视图）用于将块复制和移动到嵌套图表或从嵌套图表复制和移动块，并用于插入

大型块。           
也可进行块 I/O 的互连，即使超出了表单边界。也可以工具提示的形式显示不能在图表视图

中显示的有关 I/O 的信息（例如，名称、I/O 类型和数据类型）。 

切换为“图表视图”

要更换为“图表视图”，可使用以下几种方法：

• 选择菜单命令“视图”(View) >“图表视图”(Chart View)。
或

• 在工具栏中，选择图标：

或

• 双击表单视图中图表的空闲点

或

• 在组合框  中选择星号 (*)。

9.12.3 表单视图

表单视图

根据设置的屏幕分辨率和显示大小，图表视图显示完整表单或仅显示部分表单。使用滚动条

滚动显示。          
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切换为“表单视图”

要更换为“表单视图”，可使用以下几种方法：

• 选择菜单命令“视图”(View) >“表单视图”(Sheet View)。
或

• 在工具栏中，选择图标：

或

• 在工具栏的组合框中选择所需表单编号

或

• 双击总览中图表的空闲区域

或

• 在组合框  中选择表单编号。
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创建运行结构 10
10.1 使用图表

10.1.1 如何创建和删除图表

要求                    
在 SIMATIC Manager  中，已创建了一个带有 S7 程序的项目，其中包括一个图表文件夹。

创建图表

通常使用 SIMATIC Manager  创建图表。操作过程如下：

1. 打开项目中的图表文件夹。

2. 选择菜单命令“插入”(Insert) >“S7 软件”(S7 Software) > CFC。
随即插入图表，系统会为其分配一个默认名称，您可根据自己的意图更改该名称。
更多相关信息，请参见以下部分：自动命名 (页 31)

也可以直接在 CFC 编辑器中创建图表。操作过程如下：

1. 在 CFC 编辑器中，选择菜单命令“图表”(Chart) >“新建...”(New...)。
2. 在对话框中，选择项目和图表文件夹。

3. 在“对象名称：”(Object name:) 下，输入新图表的名称。
图表名称的最大长度为 22 个字符（非法字符有： \ / . " %）。

4. 单击“确定”(OK)。
对话框关闭。

结果

图表已创建。

自动创建运行组

创建新图表时，会自动生成一个新运行组，且按照图表安装指针插入到运行顺序中。运行组

名称与图表名称相对应。

修改运行组前，在自动生成的运行组和图表之间存在一定程度的相互依赖性。修改指的是，

例如，重命名和/或随后将其它块插入到此运行组中。
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这种相互依赖可保证运行组名与图表名相同，且当图表重新命名时运行组也自动重命名。此

外，删除图表时，如果运行组因此为空，则也将删除运行组。

如果由于修改运行组而导致这种相互依赖性消失，则自动生成的运行组的响应方式与任何其

它手动插入的运行组相同。

嵌套图表

将新图表插入到现有图表时，则生成嵌套图表。更多相关信息，请参见以下部分：创建嵌套

图表 (页 102)

删除图表

在 SIMATIC Manager  中，可像删除其它对象一样删除图表： 
• 选择图表并按 <Del> 键。

10.1.2 如何打开图表

步骤              
通常在 SIMATIC Manager 中打开图表：

1. 首先，选择项目。其次，选择 S7 程序文件夹，然后打开图表文件夹。

2. 双击所需图表。

图表打开，CFC 编辑器启动。

打开图表的其它方法

“图表”(Chart) 菜单以菜单命令的形式显示最后四个已编辑并关闭的图表。选择这些菜单命

令之一，以打开相应的图表或显示它（如果该图表已打开）。

可按照以下步骤打开未在“图表”(Chart) 菜单中显示的图表：

1. 选择菜单命令“图表”(Chart) >“打开...”(Open...)，或者单击按钮

2. 在对话框中，选择项目和 S7 程序文件夹。

创建运行结构
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3. 打开图表文件夹。

4. 双击所需图表
或者
选择所需图表并单击“确定”(OK) 按钮。
将打开该图表。

在图表目录中，可选择一个图表，然后通过快捷菜单命令“打开”(Open) 或者通过按 
<Return> 键来打开它。将打开该图表。

除在图表目录中打开嵌套图表外，还可以按以下步骤打开这些图表：

• 选择嵌套图表，然后在“编辑”(Edit) 菜单或快捷菜单中选择菜单命令“打开”(Open)。
• 在主体的空闲区域（不是标题或 I/O！）双击也可以打开该图表。重复此步骤，可在树形

结构中操作至最低图表级。

可从嵌套图表打开当前嵌套图表的上一级图表：

• 从“图表”(Chart) 菜单或快捷菜单中选择菜单命令“打开上一级图表”(Open Parent 
Chart)。上一级图表会在嵌套图表位置打开。嵌套图表将被突出显示。

10.1.3 在图表中导航

简介

几个功能可帮助浏览图表。可使用以下选项：      
• 菜单命令“编辑”(Edit) >“跳转到”(Go To) > ...。
• 双击

• 工具栏上的按钮和组合框

工具栏图标

您可以使用以下图标切换到相应视图。 
• 概述

• 表单视图

视图的大小取决于上次打开 CFC 时的设置。
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双击

在某个空闲区域进行双击可更改视图。可从总览更改为表单视图，反之亦然。 
切换到表单视图时，光标位置决定视图的对齐中心。

表单和总览的下拉列表

图表的工具栏也允许您通过下拉列表  切换到所需表单和总览。

图表分区选项卡

图表分区显示在最多 26 个选项卡上，这些选项卡位于窗口底部边界上的滚动条旁。单击这

些选项卡可更改到其它现有图表分区。

转到 (Go To)
菜单命令“编辑”(Edit) >“跳转到”(Go To) > 将打开一个子菜单，其中提供了以下导航选项：

• 插入位置 (Insert Position)
此功能启动运行编辑器，并在运行顺序中显示图表中选择的块。

如果图表中选择了多个块或者没有选择块，将禁用此菜单命令。

• 下一个插入位置 (Next Insert Position)
使用此功能为在运行顺序中选择的块查找更多插入位置。

仅当启动运行编辑器后，并且已在运行顺序中选择了一个块/SFC 图表时，此菜单命令才

启用。

• 图表 (Chart)
使用此功能可打开包含所选块的图表。此块将在打开的图表中突出显示。

仅当启动运行编辑器后，并且已在运行顺序中选择了一个块/SFC 图表时，此菜单命令才

启用。

• 跟踪信号 (Track Signal)
可使用此功能跟踪从嵌套图表的所选图表 I/O 到与此图表 I/O 内部互连的 I/O 的信号。信

号跟踪意味着将打开嵌套图表，且已显示的互连和表单栏条目将闪烁。

仅当选择了与某个块/图表 I/O 内部互连的图表 I/O 后，此菜单命令才启用。

• I/O 模块 (I/O Module)
从表单栏选择共享地址字段后，使用此功能可调用“HW Config”。如果条目未指向模块或

未找到地址，将输出出错消息。
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• 块类型 (Block Type)
使用此命令可从选定的块实例跳转到相应的块类型。如果项目中包括块的源文件，则打

开相关的编程工具（LAD/STL/FBD 或 SCL）。可使用此编程工具对块类型进行编辑。否

则，打开 LAD/STL/FBD 可允许读取块（例如，I/O 的系统属性）。

• 跳回 (Jump Back)
使用此功能，可通过单击表单栏返回到退出的表单。

仅当显示原始图表的窗口仍处于打开状态时，此菜单命令才启用。

• 下一溢出页 (Next Overflow Page)
使用此功能可从当前溢出页或原始+表单跳转到下一溢出页。

此菜单命令仅在存在溢出页时才启用。

• 上一溢出页面 (Previous Overflow Page)
使用此功能，可从当前溢出页面跳转到上一溢出页面，或者从第一个溢出页面跳转到原

始表单。

此菜单命令仅在存在溢出页中启用。

• 原始表单 (Original Sheet)
使用此功能可从表单的溢出页返回到原始表单（带有块/嵌套图表的表单）。

此菜单命令仅在当前处于溢出表单中时才启用。

• 图表分区... (Chart Partition...)
使用此功能可打开一个对话框，其中列出了所有图表分区。选择所需图表分区字母（A 
– Z），然后单击“确定”(OK) 可切换到所需图表分区。

• 表单... (Sheet...)
使用此功能可打开一个包含按钮的对话框，使用这些按钮可选择 6 个表单中的一个。单

击适当的按钮以跳转到所需表单。
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从表单栏跳转

如果一个 I/O 通过表单栏与另一个 I/O 互连，或它位于另一个表单或图表中，则可跳转至互

连伙伴。

• 单一互连

选择互连（I/O/表单栏条目/互连线），然后选择“从表单栏跳转”(Jump from Sheet Bar) 
快捷菜单命令。也可双击表单栏的内容。

将打开包含互连伙伴的相应表单。如果互连伙伴位于另一个图表中，则打开目标图表。互

连闪烁（连接线和表单栏条目）。

• 多个互连

如果 I/O 包含多个输出互连，则在执行表单栏跳转之前，会出现一个含有互连 I/O 列表的

对话框。在此，可双击所需 I/O 或通过“确定”(OK) 确认某个选择，以跳转到互连伙伴的

表单/图表。

信号跟踪

按以下步骤操作以跟踪信号：

从嵌套图表内跟踪信号

1. 在嵌套图表内，将光标放置在表单栏的内容上。

2. 选择快捷菜单命令“从表单栏跳转”(Jump from Sheet Bar)。
将打开上级图表，并且互连闪烁。

信号跟踪至嵌套图表

更多相关信息，请查看前面“转到”部分中的“跟踪信号”。

总览级信号跟踪

单击互连。

所有与图表分区关联的互连线在以下页面上闪烁：

• 总览页

• 所有六页表单

• 所有溢出页

10.1.4 复制/移动图表

简介          
复制完整图表允许您复制或移动已测试的结构或子结构，甚至复制或移动到其它 CPU。 
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复制/移动

在副本中包含资源

复制/移动图表时，如果资源在目标中尚未存在，也将同时复制资源。资源包括下列元素：

• 块类型，FB 和 FC，包括符号

• 系统属性

• 多实例块的调用块

文本互连

将图表复制/移动到另一图表文件夹时，超出图表边界的互连可作为文本互连实现。这些打

开的文本互连可再次关闭。如果将图表和互连伙伴复制/移动到此图表文件夹，或一旦将相

应的图表复制/移动回其原始文件夹，则这些文本互连将形成真正的块互连。 
这包括要复制/移动的图表的文本互连。

嵌套图表的特性：移动或复制嵌套图表时，到图表 I/O 的内部互连不被转换为文本互连，也

就是说，它们将丢失。

更多相关信息，请参见以下部分：使用文本互连 (页 157)
共享地址

复制图表时，请记住，根据默认设置与共享地址的互连也将被复制。可在“复制/移动的设置”
(Settings for Copying/Moving) 对话框中更改此设置。可使用菜单命令“选项”(Options) >“自
定义”(Customize) >“复制/移动...”(Copy/Move...) 打开此对话框。

运行组

复制/移动图表时，未复制图表到运行组的互连。不生成任何文本互连。

系统属性

复制或移动图表时，所复制/移动块的系统属性会与目标中现有块相比较。可根据比较结果

中止复制/移动操作。相关原因在以下部分中进行说明：关于复制块应该了解的知识 (页 135)
（“检查系统属性”下）。
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将图表复制/移动到其它 CPU/库/项目

将图表复制到其它 CPU 时，请记住以下几点：

• 如果目标 CPU 中的块类型与要复制的块类型（块 I/O 的编号、顺序、名称和数据类型）不

兼容，那么将不复制图表。

将显示带有相关块类型列表的日志。

在这种情况下，再次复制图表前： 
– 必须将相关块类型复制到源程序的块文件夹或目标程序的块文件夹。

– 使用菜单命令“选项”(Options) >“块类型...”(Block Types...) 在“图表文件夹”(Chart 
Folder) 框中选择块类型，然后单击“新版本”(New Version)。
将进行集中的块类型更改。

• 已复制的块将保持来自于源 CPU 的块的运行属性。因此，这些块会像安装在源 CPU 中一

样安装在运行顺序中。

如果在目标 CPU 中不存在名称相同的任务，将输出显示缺失任务的日志，且拒绝复制操作。

说明

不建议复制整个图表文件夹，因为不包括资源（例如，FB、FC、共享 DB、符号）且可能

导致程序不一致。

如果不想复制整个程序，可选择并复制图表文件夹中的所有图表。在这种情况下，资源

也被复制。

复制整个程序、CPU 或站不会导致任何不一致。

如果图表为空，则不复制或移动图表运行组。

不同目标系统中的图表

可在不同目标系统间复制和移动 CFC 图表。再次重申，由于不包含块类型，两个目标系统

中使用的块类型必须相同。如果块类型不同，则拒绝复制图表。
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10.2 编辑图表

10.2.1 修改图表属性

使用和调用      
在“CFC 属性”(Properties CFC) 对话框的“常规”(General) 选项卡中，可为当前图表设置诸如

图表名称、作者和注释之类的常规属性。在“版本”(Version) 选项卡中可更改版本号，例如，

在更改图表之后执行。

在 CFC 中，可使用菜单命令“图表”(Chart) >“属性...”(Properties...) 来显示此对话框。 
注：如果在项目属性中激活了项目的版本生成功能，关闭更改过的图表时，系统将自动打开

该对话框的“版本”选项卡。

“常规”(General) 选项卡的内容

“常规”(General) 选项卡包含以下输入和输出域：

• 名称 (Name)
可以在此处显示和编辑当前 CFC 图表的名称。该名称在 CPU 中必须唯一。系统会对此进

行检查。 
允许的最大名称长度是 22 个字节。禁止使用下列字符：/ \ . " %。

说明

指定名称时，请注意，对于 OS 编译，变量名的长度不能超过 128 个字符。此名称包括

层级路径中的文件夹名称、图表名称、块名称、分隔符（句点）和 I/O 名称。

• 项目路径 (Project path)
• 工艺路径 (Technological path)
• 项目存储位置 (Storage location of project)

无法更改显示在此对话框中的路径。只能通过 SIMATIC Manager 进行此操作。只有在项

目中已组态了工厂层级且层级文件夹已分配到 CFC 图表时，工艺路径才可用。

• 作者 (Author)
图表的作者。

• 创建日期 (Date created)
创建的日期
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• 上次修改日期 (Last modified)
最近一次修改的日期。如果图表已被修改，由于可能存在从一个图表到另一个图表的互

连，因此最近修改的日期将应用到同一图表文件夹中的所有其它图表上。这样，将只有

一个全局“上次修改”日期应用到图表文件夹。 
• 注释 (Comment)

可在此处输入注释，该注释将包含在打印的 CFC 图表上。

• “写保护”(Write-protected) 选项

此选项用于启用或禁用图表的写保护。无法在 CFC 编辑器中编辑写保护的 CFC 图表。由

于写保护，将再无法通过 SFC 编辑器改变图表中的任何 SFC 实例。

“版本”(Version) 选项卡的内容

在此选项卡中，可以更改图表的版本号。

版本(Version)：
可使用箭头键分别设置主版本和子版本。无法更改写保护图表的版本。 
可设置的版本号范围是从 0.0001 到 255.4095。新图表始终以版本号 0.0001 开始。设置的

编号不能低于之前保存的版本号。

如果在项目属性中激活了版本生成功能，关闭更改过的图表后，再打开该对话框时将自动带有

“版本”(Version) 选项卡。

数据版本(Data version)：
显示创建程序或最近修改程序所用的软件版本。数据版本取决于产品版本。数据版本由数据

库确定并显示数据结构的当前状态。

10.2.2 如何插入和删除图表分区

简介

如果 CFC 图表的大小不足，可始终通过增加更多图表分区来扩展 CFC 图表。选项卡及底部

滚动条可用来选择所需图表分区。

插入 
插入图表分区时，可决定是将新图表分区插入到当前图表分区前还附加为后一个图表分区。

有两种选择：

创建运行结构

10.2 编辑图表

SIMATIC S7 中的 CFC (V9.0 SP7)
100 功能手册, 05/2022, A5E41356112-AH



在当前图表分区前：

• 选择菜单命令“插入”(Insert) >“图表分区”(Chart Partition) >“当前分区前”(Before 
Active Partition)
或者

打开图表分区选项卡的快捷菜单，然后选择“在当前分区前插入”(Insert Before Active 
Partition) 菜单命令。

作为后一个图表分区：

• 选择菜单命令“插入”(Insert) >“图表分区”(Chart Partition) >“在最后一个分区后”(After 
Last Partition)
或者

打开图表分区选项卡的快捷菜单，然后选择“将图表分区插入到末尾”(Insert Chart 
Partition After Last) 菜单命令。

一个图表最多可包含 26 个图表分区。它们可按字母顺序 (A-Z) 来识别。如果将其它图表分

区插入到现有图表分区前，那么现有图表分区的字母标识符会发生更改。 
例如，如果“CFC1”图表包含一个图表分区，那么将字母“A”分配给它作为 ID。如果在此图表

分区前插入一个附加图表分区，则将“A”标识符分配给新的“第一”图表分区，而原分区的

标识符更改为“B”。
根据视图（表单或总览）的不同，在状态栏中显示带有表单编号或“总览”(Overview) 的当

前图表分区的 ID。
示例： 

B/表单 3 (B/Sheet 3) B/总览 (B/Overview)

删除

只能删除当前图表分区。 
• 选择菜单命令“编辑”(Edit) >“删除图表分区”(Delete Chart Partition)，或者在图表分区

选项卡的快捷菜单中，选择菜单命令“删除图表分区”(Delete Chart Partition)。
如果当前图表分区为空，则将其删除。如果图表分区包含任何对象，则会提示您确认删除。
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10.3 创建嵌套图表

10.3.1 创建嵌套图表

简介    
可将一个 CFC 图表插入到另一个 CFC 图表中。这允许您开发标准化的、可重复使用的、满

足系统需求的模块化程序。

可在编辑模式下打开并修改插入到上一级图表中的（嵌套）图表，然后在测试模式下，在 CPU 
上操作和监视它们。 
包含嵌套图表的图表为顶级图表。在 SIMATIC Manager  中只能查看顶级图表。嵌套图表的

最大嵌套深度是 8（顶级图表 + 7 级嵌套图表）。

图表中的图表

可将 CFC 块目录中的新嵌套图表（符号： “新建图表”(New chart)）拖放到当前图表中，

以做进一步编辑。执行菜单命令“插入”(Insert) >“新图表”(New Chart) 可在图表（在表单

视图中，仅限当前表单）中查找空闲位置并在此位置插入新图表。搜索此空闲区域的方式为：

水平、逐行、从左到右、从上到下（在所有表单的总览中）。

为了以与 CFC 块相同的方式处理图表，图表目录以树形视图显示图表。可从此位置将图表

拖放到当前打开的图表中。插入图表时，如果包含任何嵌套图表，则将图表与所有嵌套图表

复制到当前图表中。

说明

请记住，通过从图表目录中拖放而插入到当前 CFC 图表中的图表是一个副本。此嵌套图表

与原始图表不再有任何关系。对此类图表中进行的修改只影响该图表。

移动图表

也可以按住 Shift 键，然后将顶级图表拖放到图表中。在这种情况下，不是复制而是移动顶

级图表。在目录中，图表不再出现在其原先位置上。而是显示在当前图表的层级中。

互连

如果嵌套图表具有的图表 I/O 带有块或共享地址，则可将其与图表中的其它嵌套图表互连，

或建立文本互连。
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在图表中导航

打开嵌套图表：

1. 选择嵌套图表。

2. 打开快捷菜单并选择命令“打开”(Open)
或
选择菜单命令“编辑”(Edit) >“打开”(Open)
或
双击主体中的空白区（不是标题或 I/O!）。
将打开图表。
重复此步骤，可在树形结构中操作至最低图表级。 

在层级中上移直到顶级图表：

1. 激活嵌套图表。

2. 打开快捷菜单并选择命令“打开上一级图表”(Open Parent Chart)
或
选择菜单命令“图表”(Chart) >“打开上一级图表”(Open Parent Chart)
或
双击表单栏中的某个条目（不是共享地址）。
将打开父图表。

打开图表目录中的图表：

1. 在目录中选择一个图表。

2. 选择快捷菜单命令“打开”(Open)
或
按下 <Return> 按钮。

当前图表在目录中通过其黑色边框来标识。

将嵌套图表复制到其它 CPU
可复制嵌套图表并将它粘贴到另一个 CPU 的图表中。目标图表的“在此之后作为插入位置”

的安装位置应用到该图表所包含的块。将不复制运行组。

有关嵌套图表的更多信息，请参见以下部分：

复制/删除嵌套图表 (页 104)
如何替换嵌套图表 (页 104)
如何创建带有图表 I/O 的图表 (页 105)
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10.3.2 复制/删除嵌套图表

在图表内复制/移动或复制/移动到其它图表

可使用与复制或移动块相同的方法来复制或移动嵌套图表。

复制到图表文件夹

如果要从上一级图表而不是图表文件夹中删除嵌套图表（可能已修改了该嵌套图表，并且希

望以后在别处使用它），则可首先将该嵌套图表复制到图表文件夹中。操作过程如下：

1. 通过选择“编辑”(Edit) >“打开”(Open)
或者
从嵌套图表的快捷菜单中选择“打开”(Open) 命令，打开要复制的嵌套图表。

2. 图表打开后（激活），选择菜单命令“图表”(Chart) >“复制到图表文件夹”(Copy to Chart 
Folder)。

图表将作为顶层图表复制到图表文件夹。如果此图表文件夹中已存在同名的顶层图表，只要

在复制图表前未对其进行修改，则将自动为该图表分配一个新名称（附带消息）。 

删除嵌套图表

可从嵌套图表的上一级图表中删除嵌套图表，方法如下：

• 选择图表并按 <Del> 键。

或

• 选择快捷菜单命令“删除”(Delete)
或 

• 选择菜单命令“编辑”(Edit) >“删除”(Delete)。

10.3.3 如何替换嵌套图表

简介

可用一个嵌套图表替换另一个嵌套图表。在这种情况下，如果可能，则保留“旧”图表间的

互连。 
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应用

在针对不同的应用而将嵌套图表组态为封装功能的情况下，“替换”功能可能会非常有用。

这样的应用可能是：

在嵌套图表中封装了一个（部分）功能，并在此图表中将其互连。例如，此部分功能可能是

一个通风单元的控件，其中包括若干种可用于不同应用领域的变体。这些变体可在全局结构

中被替换，而无需修改互连。

步骤

要替换特定嵌套图表的图表可位于库中、当前图表文件夹中（作为顶级图表）或图表文件夹

的另一个图表中。

1. 打开其中包含要替换的嵌套图表的图表。

2. 打开图表或库目录；如果需要，展开层级树。

3. 将所需图表从目录拖放到要替换的嵌套图表中。 
4. 当光标正好位于要替换的图表上时，松开鼠标按钮。 

系统将提示您确认操作。

5. 单击“确定”(OK)。
只要光标置于要替换的图表内，就将替换嵌套图表。
单击“取消”(Cancel) 中止此操作。

10.3.4 如何创建带有图表 I/O 的图表

简介      
可将 I/O 添加到图表中以实现多种目的，例如：

• 将图表插入到另一个图表中，并让其与其它图表或块互连

• 将图表编译为块类型

步骤

有两种方法可供选择：

• 创建不带分配的图表 I/O
• 创建带有互连的图表 I/O
创建不带分配的图表 I/O
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第一步，创建不引用任何参数的图表 I/O（例如，由于图表尚不包含块和/或其它嵌套图表）。

随后为图表 I/O 分配名称、属性及默认值。

第二步，在图表中插入块/图表，并将它们互连，然后将图表中相应的对象 I/O 分配给图表 I/O。

创建图表 I/O（第 1 步）：

1. 单击工具栏中的按钮

或
选择“视图”(View) >“图表 I/O”(Chart I/Os) 菜单命令。
用于编辑图表 I/O 的对话框将打开并“停驻”在图表窗口的上部。

2. 在左边的层级窗口中，选择所需的 I/O 类型（IN、OUT 或 INOUT）。

3. 在右侧的详细信息窗口中，编辑特定 I/O 类型的空声明行（名称、数据类型、初始值、注释）。
通过组合框选择数据类型。

通过拖放操作分配 I/O（第 2 步）：

1. 将块/图表的 I/O 拖放到具有兼容数据类型的某一图表 I/O。

和已有图标 I/O 互连的另一种方式

无需打开图表 I/O 窗口，即可将放置在图表和/或嵌套图表中的块 I/O 分配给现有图表 I/O。 
1. 选择 I/O，然后在快捷菜单或“插入”(Insert) 菜单中选择菜单命令“与图表 I/O 的互连...”

(Interconnection to Chart I/O...)。
将打开一个对话框，其中显示相关 I/O 类型的所有可用 I/O 的列表（显示 IN 和 IN_OUT 的可用 
I/O，供 S7 下的 IN 使用）。

2. 选择所需的图表 I/O，通过单击“确定”(OK) 退出对话框。

说明

只能分配具有兼容数据类型的未连接 I/O。

也可使用其它方法创建互连。将某个图表 I/O 拖到具有兼容数据类型的块/图表的所需 I/O。请
注意以下信息：

– 对于输出：图表 I/O 必须尚未分配给块/图表 I/O。然而，可将尚未分配的图表输出分

配给已互连的块或图表的输出。

– 对于输入：可将图表 I/O 分配给几个块/图表输入。

如果某个 I/O 已互连，则不能更改其数据类型。

创建带有互连的图表 I/O
第一步是创建图表自身。为此，插入块/图表并将其互连。

第二步，打开图表 I/O 窗口，并通过将图表 I/O 连接到放置在图表中的块/图表 I/O 来定义这

些图表 I/O。将始终创建一个新行，并采用已连接 I/O 的所有属性，例如，名称、属性和初

始值。属性 S7_param 和 S7_link 的限制：如果无法采用数值，则仅创建互连。

如果发生命名冲突（例如，因为在不同块中使用了相同名称），通过递增名称中的数字可使

名称在图表 I/O 中保持唯一。
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将 <Ctrl> 键和拖放操作相结合来创建图表 I/O
1. 单击工具栏中的按钮

或
选择“视图”(View) >“图表 I/O”(Chart I/Os) 菜单命令。
用于编辑图表 I/O 的对话框将打开并“停驻”在图表窗口的上部。

2. 在左边的层级窗口中，单击所需的 I/O 类型（IN、OUT 或 INOUT）。右边的详细信息窗口显
示带有 I/O 的行。如果为新创建的图表 I/O，那么这些行将为空。

3. 在图表的工作窗口中，选择所需的块/图表 I/O，然后按住 <Ctrl> 键并将该 I/O 拖到图表 I/O 右
侧窗口的“名称”(Name) 框中。
随后，该 I/O 及其属性均将被采用。
例外：互连的 I/O 将不会重新分配。

4. 对于图表中所有其它要与图表输入/输出进行互连的块/图表 I/O，请按照相同的步骤进行操作。

按住 <Ctrl> 键时，将某个已存在于图表 I/O 中的 I/O 拖放到图表 I/O 窗口的另一个空行中。一

个编号会自动附加到其名称上。这样就确保了该 I/O 名称的唯一性。

按住 <Ctrl> 键并将某个内部互连的 I/O 拖放到一个新行时，将生成该 I/O 的一个副本。该副

本 I/O 不会与该内部 I/O 互连。

表单栏中的表示

CFC 表单栏显示适用于图表 I/O 的 I/O 名称和注释、I/O 类型以及数据类型。互连的“接口 I/O”
类型由互连线上的小白色三角形来指示。

说明

如果隐藏了与图表接口互连的 I/O，则不会有表单栏条目。这些互连只能在块的对象属性中

识别（“I/O”选项卡的“互连”(Interconnection) 列）。

更改图表 I/O 名称

图表 I/O 名称不需要包括关联块 I/O 的名称。可对其重命名。要对其进行重命名，请选择“名

称”(Name) 框中的名称，然后输入一个新名称。也可以在右侧窗格中双击图表 I/O 行的开始

部分，然后在属性对话框中输入新名称。

系统属性

也可以将系统属性分配给特定图表 I/O，就如同分配给块 I/O 一样。以下规则适用：
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将已放置在图表中的块/图表的 I/O 互连到一个图表 I/O：

• 如果尚未分配属性，图表 I/O 将继承块/图表的属性。

• 图表 I/O 保留已输入的属性。

限制：例如，如果文本属性被保留，那么系统将尝试为这些变量分配 S7_link 和 S7_param 
属性。。

例外：该功能将调整变量的 S7_visible 属性。

除了为图表 I/O 分配系统属性外，不会为带有图表 I/O 的图表分配系统属性。将图表编译为

块类型时，可分配这些属性。

将 I/O 分配给已插入的图表

也可在以后通过添加更多图表 I/O 来扩展带图表 I/O 的图表。如果目标图表是一个嵌套图表

（即，已插入到另一个图表中的图表），添加 I/O 可能会导致定位冲突。在这种情况下，如

同重叠块一样，嵌套图表会显示为浅灰色且不带 I/O 的重叠图表。

将图表定位于某个可用位置后，I/O 和互连将再次可见。

更多相关信息，请参见以下部分：

• 将图表编译为块类型 (页 403)
• 图表 I/O 的互连规则 (页 164)
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10.4 CFC 中 F 块的特性

简介

如果在 CFC 中使用“F 块”，则以下特性可用：  
• 针对 CFC 块的基于图表的运行组管理

当 F 块也在集成于基于图表的运行组管理的 CFC 中使用时，不仅会在“标准程序”中自

动创建块的运行组，还会在“F 程序”中为所包含的 F 块创建运行组。

更多相关信息，请参见“针对 CFC 块的基于图表的运行组管理 (页 203)”部分。  
• 带 F 块的 CFC 的安全程序密码提示

以下部分将介绍该主题。 

带 F 块的 CFC 的密码提示

带故障安全块（F 块）的 CFC 的安全程序密码提示（F 密码提示）在版本 8.2 之前的版本中

显示，例如，在使用 CFC 编辑器打开 CFC 时。

您可在《SIMATIC 工业软件 S7 F/FH 系统组态和编程》手册中的“访问保护”部分找到关于

密码提示的更多信息。 
CFC 打开时的 F 密码提示在版本 8.2 中已被忽略。

自版本 8.2 起，只对安全相关更改显示 F 密码提示，例如，更改安全程序的签名时。因此，

现在不需要 F 密码便可对带故障安全组件的 CFC 的标准程序进行更改。 
无论用户显式还是隐式创建 F 块，都将显示 F 密码提示，例如，在复制操作过程中。  

F 密码提示的应用 
复制带 F 块的 CFC：
• 如果将带 F 块的 CFC 从源项目“A”复制到目标项目“B”，则只需要目标项目“B”的 F 密码。

移动带 F 块的 CFC：
• 如果将带 F 块的 CFC 从源项目“A”移动到目标项目“B”，则首先需要目标项目“B”的 F 密码，

然后需要源项目的 F 密码。
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非安全相关互连： 
• 从 F 块到标准块的互连，例如，可以在没有密码提示的情况下删除转换器。创建需要 F 密

码的此类互连。 
• 当创建和删除从标准块到 F 块的互连时，需要 F 密码。
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10.5 处理块类型

10.5.1 在 CFC 中创建块类型

概要

可以块库的形式购买在 CFC 中使用的块类型，或自行创建。也可以扩展现有块池。   
在 CFC 中，只能通过编译 CFC 图表创建块类型。如果想用 STL/SCL 创建自己的块，可以在

“PCS 7 块”编程指南中找到相关信息。

CFC 图表可以编译为块类型形式以做他用（带图表 I/O）。

创建 CFC 图表、互连块并为所选块 I/O 创建图表 I/O。

编译图表后，块类型即存储在块文件夹中。通过将块类型插入图表（从 CFC 块目录的 S7 文
件夹）或通过菜单命令“选项”(Options) >“块类型...”(Block Types...) 将其导入，可以将块

类型加入到图表文件夹中。在块目录中，块类型显示在为编译指定的系列名下。

通过对象名称 FB xxx 管理块类型。

确保 FB 数目在要运行块的 CPU 所支持的范围内。有关这些范围的信息，请参见参考手册《自

动化系统 S7-400；模块数据》(Automation System S7-400, Module Data)。示例：FB 数 = 
512。因此，可能的最大块编号为 FB 511。
可以为块分配符号名。此名称将自动输入到符号表中。PCS 7 块的标题名和符号名完全相同。

限制和特征

CFC 图表在编译为块类型前，必须满足下列条件：

• 图表不能包含嵌套图表，但可以包含其它用 CFC 创建的块类型。

• 在运行顺序中块只能手动安装一次，也就是说，在分配了“S7_tasklist”系统属性的任务之

外只能手动安装一次。

• 所有块必须手动安装在同一任务中。图表的所有要编译的块必须无间隙的一个接着一个。

它们之间不得有其它图表的块。

• 不能在运行组中安装这些块。

• 无法从外部访问图表中的块，例如，无法使用 WinCC 中的面板进行访问。将在运行期间

初始化这些块。

• 图表中块的结果（值）只应用到运行期间以及所有块都接受处理后生成的块类型的输出。

即使设置 ENO = FALSE，仍会将值应用到输出。
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• 在正在编译的图表中，不能有任何与元件的交叉连接。这种类型的交叉连接是来自另一

图表绕过图表 I/O 的互连。

• 图表 I/O 不应有 EN 输入，因为它是自动生成的。

• 块的信号输入必须应用到图表 I/O。分配信号输入前，必须将相关图表 I/O 取消隐藏。图

表 I/O 会继承块 I/O 属性。分配信号输入后，即可再次隐藏图表 I/O。

• 图表 I/O 处定义的 ENO I/O 的互连将相应地进行转换。如果未定义 ENO，块类型的 ENO I/O 
将在块类型中调用的所有块 I/O 中提供逻辑 AND 运算的结果。

• “S7_tasklist”系统属性代表内部块所有任务列表属性的完整集合。

• 如果图表 I/O 没有连接到包含在图表中的块的 I/O，则在编译期间会显示一条警告。

如果某个带有属性 S7_m_c 的块 I/O 与图表 I/O 连接，则无论是操作块 I/O 还是图表 I/O，

WinCC 操作都会影响相同的变量。

如果多个块 I/O 与一个图表 I/O 互连，则将为它们提供运行期间的值。WinCC 操作将立即

被覆盖，从而使它们变得无效。在编译期间，将识别这一情况并显示警告。

10.5.2 导入块类型概述

简介

以下选项可用于同步 CFC 中使用的块/块类型： 
• 通过目录插入到图表时的后台导入。

• 在 CFC 编辑器中通过“本地类型更新”进行导入：  
项目块文件夹中的已更改块可用于 CFC 数据管理，从而允许您在 CFC 中使用这些块。 
您可在下面的说明中找到更多相关信息。 

• 集中类型更新： 
可以使用称为“集中类型更新”的过程比较主数据库中的所有块/块类型和 SFC 类型，并

更新项目中或多项目的各个项目中使用的这些块/块类型和 SFC 类型。如果项目包含相关

类型的关联实例，则在集中执行类型更新时，也会更新这些类型的关联实例。

更多相关信息，请参见“如何更新多项目中的块/SFC 类型 (页 117)”和“如何更新单项目

中的块/SFC 类型 (页 119)”部分。 
CPU 410-5H PA 的类型更新：

CPU 410-5H PA 支持 RUN 模式下的类型更新。在更改块类型的接口后，可以在 RUN 模式下

更新实例并将其下载到 CPU。
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更多相关信息，请参见“使用 CPU 410-5H PA 时的类型更新 (页 120)”部分。

说明

使用新通道块时进行同步

从较新的库中导入通道块时，有时必须从基本库中导入其它块，并且需要更改相应的接口。 
这也就是为什么必须先同步基本库中的块，然后再编译程序以在 RUN 模式下实现增量下载。 
在这种情况下，若要同步所需的全部块，我们建议您使用 SIMATIC Manager 中的菜单命令

“选项 > 图表 > 更新块类型”(Options > Charts > Update block types)，并设置“在 RUN 模
式下进行下载”(Download in RUN) 选项。

 

使用本地类型更新导入到 CFC 中 
块通过导入而被 CFC 识别。只能在 CFC 中使用这类块。 
可通过两种方式导入块： 
• 通过目录在图表中安装块（在后台导入）

• 通过“本地类型更新”导入：通过 CFC 编辑器中的菜单命令“选项 > 块类型...”(Options 
> Block Types...)。

需要大量不同的块时，本地类型更新通常非常有用，例如，如果要将大量的块从用户程序（块

文件夹）导入图表文件夹中，这种方式十分有用。如果在块文件夹中修改了某些块（类型修

改），而这些块在图表文件夹中以相同的名称存在并且需要在此进行更新，也需要使用此对

话框。以这种类型导入后，由于不再需要从后台导入，因而通过目录进行插入操作就会快得

多。 
提示：已导入的块将同时显示在相关的块系列和“All blocks”文件夹中。以后，应该始终从此

处向图表中插入功能块。

可在“块类型”(Block types) 对话框的“离线块文件夹”(Offline block folder) 框中选择需要的

块，然后通过用鼠标拖动或单击“->”的方式将块导入图表文件夹中。如果块已存在于图表文

件夹中，则显示一条警告消息。如果较旧版本已存在，请按照以下部分列出的步骤进行操作：

导入并使用新版本的块类型 (页 114)。
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通过 SIMATIC Manager 进行导入

要通过 SIMATIC Manager 进行导入，请按照以下步骤进行操作：

1. 在 SIMATIC Manager 中打开相应的库。

2. 从库块文件夹复制块，并将其粘贴到程序块文件夹中。将覆盖所有现有块。

3. 切换到 CFC，然后选择菜单命令“选项”(Options) >“块类型...”(Block Types...)。

处理编号相同的块

在 S7 程序中块编号必须具有唯一性。不允许不同的块类型（符号名和功能）使用相同的对

象名（例如，两个均命名为“FB 61”），即使使用了也会遭到系统拒绝。在这种情况下，必须

更改块编号。

注：对象名称包含块类型“FB”或“FC”以及编号。

导入期间，系统会检测使用此对象名称的现有块。随后将在“块类型”(Block types) 日志中

出现错误消息。如果两个块的符号名不同（例如，现有块名为“CTRL_PID”，而要导入的块名为

“CTRL_xx”），那么在符号表中会自动生成该条目。如果两个块具有相同符号名，则必须自

行在符号表中输入条目。

请确保块编号在 CPU 支持的范围内。更多相关信息，请参见：

• 参考手册《自动化系统 S7-400；模块数据》(Automation System S7-400; Module Data)
• 菜单命令“CPU > 模块信息 > 性能数据”(CPU > Module Information > Performance Data) 选

项卡

此处列出的“FB 数目”也属于块编号的范围。示例：FB 数 = 512。因此，可能的最大块编号

为 FB 511。

10.5.3 导入并使用新版本的块类型

简介

如果要在块类型发生更改后，将 CFC 中已修改的类型应用于之前使用的块类型，则需要将

修改后的块类型导入到图表文件夹中。随后，将根据已修改的块类型来修改 CFC 中使用的

块实例。 
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导入方式有两种： 
• 在后台导入，通过将来自 S7 程序或块库中的已修改块类型插入图表中来实现。

• 使用“本地”类型更新，通过“块类型”(Block types) 对话框中的“选项 > 块类型”(Options 
> Block Types) 菜单命令实现更新。从源文件（“离线块文件夹”(Offline block folder)、
“项目”(Project)）的列表中选择要导入的块，然后将其拖放到“图表文件夹”(Chart folder) 
列表或单击“→”。

使用新版本

如果图表文件夹中存在具有此名称但版本不同的块类型，则会出现“导入新版本”(Import 
New Version) 对话框，其中显示有关这两个块的相应消息和版本信息。 
对于提示“是否确定要使用新版本的块类型？”(Do you really want to use the new version 
of the block types?)，如果选择“是”(Yes)，则会调整相应的所有块实例。如果选择“否”
(No)，则不导入任何内容而且也不会进行修改。 
可以区分以下各种情况：

由于仅更改了 ES 中的内容，因此更改时既不需要下载整个程序，也无需编译新 
OS。示例：将块 I/O 的属性指定为“隐藏”(hidden)。这种情况下，只需要在 CPU 
处于 RUN 模式时下载更改即可。

更改与 OS 相关，因此需要 OS 编译。

示例：编辑消息文本之。

更改中修改了结构。

示例：添加 I/O 和/或消息后。

执行此操作可能会带来以下结果：

• 互连和参数分配可能会丢失。

• 唯一的选择就是下载整个程序，即，必须将 CPU 切换到 STOP 模式。

• 如果块用于操作员监控（即，将在 OS 上监控），则还需要编译 OS。
• 如果要保留 AS 中的参数设置，必须在下一次下载之前回读图表。

相同版本

如果导入的块类型的版本与图表文件夹中的块类型的版本一样，对话框则显示以下内容：

• 消息“离线块文件夹中新版本的块类型与 CFC 中同名的块类型相匹配。不必进行导入。”

• 相同块类型的列表

关于块更改的更多信息，请参见"类型更改对块实例的影响 (页 130)"部分。
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10.5.4 在 CFC 中插入块类型

目录中的块类型

可将所选块类型从库/块目录拖放到图表中。或者，通过按 <Return> 键可将在目录中选择的

块插入到总览图表分区的某个空闲位置或者表单视图中当前表单的某个空闲位置。 
有关搜索块的更多信息，请参见“在目录中搜索对象 (页 495)”部分。

插入块类型

• 从库目录中插入

从库目录中插入的块类型将隐式地导入 CFC 中。

带有已修改系统属性的块 I/O
如果尝试将库中的块插入到图表中，而在将该块复制到块文件夹中时，系统检测到该块

的系统属性与现有块的系统属性不同，则会打开“插入功能块”(Insert function block) 对
话框。 
单击“调整属性”(Adjust attributes) 打开“调整系统属性”(Adjustment of system 
attributes) 对话框，从中可查看具有不同属性的所有 I/O。

单击属性值“源”(source) 或“目标（旧）”(target (old)) 以决定是将“源”属性值还是

“旧”目标的属性值分配给已导入块的 I/O [目标（新）]。
单击“确定”(OK) 以使用当前值覆盖先前使用的属性。两个对话框都将关闭。

• 从块目录插入

将 S7 程序块  插入到图表中时，这些块自动导入到 CFC 中，并显示在 CFC 块系列中。

根据块是否已被 CFC 识别，即是否已导入该块，块图标会以不同的形式显示。 
未导入的块用以下图标表示：

即使此类型的块已被导入，S7 程序块在 CFC 中仍为未知块。这意味着，要将 S7 程序中

的块插入到图表中时，会始终执行检查以确定是否已导入了该块。 
可以在“所有块”(All blocks) 目录  和某一块系列  中找到已导入的块。未分配给系列

（在标题中指示）的块可在“其它块”(Other blocks) 目录中找到。这些块用以下图标表示：

提示：要在图表中定位块，插入块系列中的块是最快捷的方法，因为这些块已被 CFC 识
别，并且不再需要验证。 
如果块类型已被导入，应始终选择此方法。 
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启动块的注意事项

请注意，以下是启动块（例如，控制器块 CONT_C、CONT_S 或 PULSEGEN）与特定 CPU 相
关的信息：

• 对于 S7-3xx 和 S7-4xx CPU，不仅必须在循环中断 OB（例如 OB 35）中调用启动块，而

且还必须在 OB 100（启动 OB）中调用启动块，这样才能处理它们的启动代码。块会自

动安装。

• 使用 S7-3xx CPU 时，请注意 RESTART 块 (FC 70) 必须是在 OB 100 中第一个被调用的块。

每次调用此块时，都会修改内存字 MW 0。因而可使在 OB 100 中调用的块识别启动。MW 
0 不得在 CPU 中的其它位置使用。

编号相同的块

在 S7 程序中，对象名称（块类型 + 块编号）必须唯一。更多相关信息，请参见“导入块类

型概述 (页 112)”部分中的“处理编号相同的块”。

10.5.5 如何更新多项目中的块/SFC 类型

简介

在多项目中，可以使用所谓的集中类型更新，比较各个项目中使用的所有块类型和 SFC 类型

与主数据库的所有块类型和 SFC 类型，并相应地进行更新。同时，还可以更新主数据库的图

表文件夹中的模板。 
如果最新版本始终保存在主数据库中，则可使用更新功能确保在多项目的所有项目或所选项

目中，所有类型或只有某些类型具有相同的当前版本。如果项目包含相关类型的关联实例，

则在集中执行类型更新时，也会更新这些类型的关联实例。

说明

CPU 410-5H PA 的“RUN 模式下的类型更新”

CPU 410-5H PA 支持 RUN 模式下的类型更新。在更改块类型的接口后，可以在 RUN 模式下

更新实例并将其下载到 CPU。
这是 CPU 410-5H PA 程序更改的原因。  
 有关 RUN 模式下类型更新的更多信息，请参见“使用 CPU 410-5H PA 时的类型更新 (页 120)”
部分。
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步骤

请按照以下步骤更新多项目中的块/SFC 类型：

1. 在 SIMATIC Manager 中，选择主数据库的块文件夹或图表文件夹，或者选择要在块文件夹或
图表文件夹中进行更新的块或 SFC。

2. 选择菜单命令“选项 > 图表 > 更新块类型...”(Options > Charts > Update block types...)。
将打开对话框的第 1 页（共 3 页）“选择要检查的 S7 程序”(Select the S7 programs to be 
checked)。其中会列出多项目中的所有现有 S7 程序，并且这些程序已处于选中状态。
满足以下条件时，“RUN 模式下下载”(Download in RUN) 列会显示一个复选框： 
– 此程序在 CPU 410-5H PA 中。 
– 可针对此程序下载相应更改，这就意味着不必下载完整程序。  
通过选中复选框，可在 RUN 模式下对此程序执行类型更新（可能仅限 CPU 410-5H PA）。此
外，“资源”(Resources) 列中会显示“计算...”(Calculate...) 按钮。 

3. 检查选择，根据需要，排除不想在其中更新任何块/SFC 类型的 S7 程序。

4. 单击“下一步”(Next)。
“状态”(Status) 列中的复选标记显示已经检查过的程序。 
检查完成后，将打开对话框第 2 页（共 3 页）。在“选择要进行更新的块类型或 SFC 类型。”
(Select the block types or SFC types to be updated.) 页面中，可显示在库中所选的类型，这
些类型在不同 S7 程序中具有不同的版本。
为了帮助您决定是否选择块，“结果”(Consequence) 列显示了新导入的结果。将显示以下结
果：

– 所有关联实例将被修改（无更多结果）。

– 必须再次编译 OS。
所有关联实例将被修改。然后，可通过菜单命令“选项 > 向导：“编译多个 OS”> 启
动...”(Options > Wizard:"Compile Multiple OSs" > Start...)，或者通过选择 OS 并使

用快捷菜单命令“编译”(Compile) 来启动向导以编译 OS。
– 在 STOP 操作模式下加载整个程序 (Loading entire program in operating mode STOP)

编译之后，将不能再在 RUN 模式下下载更改。所有关联实例将被修改。

使用 CPU 410-5H PA 时，请阅读简介中提供的信息。  
注：更新 SFC 类型时，将在第 2 页（共 3 页）中显示按钮“显示差异”(Show differences)。安
装了“Version Cross Manager (VXM)”附加软件包后，可通过此按钮打开 VXM 以显示有关差异
的详细信息。

5. 检查所选内容，考虑到所产生的结果，可根据需要排除那些不想进行更新的对象。

6. 单击“完成”(Finish)。 
“状态”(Status) 列中的复选标记显示已更新了哪些对象。

说明

TCiR 资源限制检查

单击“完成”(Finish) 时，内部函数会计算所选 CPU 的资源限制。如果类型更新中选择的

块数量超过 CPU 的可用资源限制，则无法继续在 RUN 模式下使用 TCiR 下载过程执行类

型更新。将显示一条消息。

如果要在 RUN 模式下执行类型更改，则必须减少类型更新的块数。
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7. 完成更新后，前进到下一对话框，即第 3 页（共 3 页）“日志”(Log)。在此，可显示所有有
关更新期间所发生的变化以及产生的结果的信息。 
示例：

– 开始类型更新

– 日志路径

– 库

– 所选的对象

– 所选的 S7 程序

– 已更新的对象

– 已删除的互连

– 结束类型更新

说明

选中日志中的条目。中央类型导入可在需要操作的实例中发挥作用，例如，必要时可能

会删除必须在实例中选中和调整的互连。 

8. 如果要打印日志，则单击“打印”(Print)，否则单击“关闭”(Close)。对话框关闭。

如果使用“取消”(Cancel) 停止更新，则所有到此点的更新被保留。这些也都包括在日志中。

更多信息，请参见“如何更新单项目中的块/SFC 类型 (页 119)”部分。

参见

有关向 CPU 410-5H PA 下载程序期间的特别注意事项 (页 429)

10.5.6 如何更新单项目中的块/SFC 类型

简介 
可在所选的各个项目中更新库（并非多项目的主数据库）的块/SFC 类型。如果项目包含相关

类型的关联实例，则在集中执行类型导入时，也会更新这些类型的关联实例。  

步骤

请按照以下步骤更新单项目中的类型：

1. 在 SIMATIC 管理器中打开所需库，例如，PCS 7 库。

2. 在库的块/图表文件夹中，选择要在项目中更新的块/SFC 类型。

3. 选择菜单命令“选项 > 图表 > 更新块类型...”(Options > Charts > Update block types...)。
将打开“打开项目”(Open Project) 对话框。
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4. 选择要在其中更新类型的项目，然后单击“确定”(OK)。
将打开对话框的第 1 页（共 3 页）“更新块类型”(Update block types)。

5. 按照以下部分所述的步骤进行操作：如何更新多项目中的块/SFC 类型 (页 117)（从第 3 步开
始）。

10.5.7 使用 CPU 410-5H PA 时的类型更新

概述

CPU 410-5H Process Automation (CPU 410-5H PA) 支持 RUN 模式下的类型更新。  
在更改块类型的接口后，可以在 RUN 模式下更新实例并将其下载到 CPU。在其它自动化系

统中，只能在 STOP 模式下执行此操作。

使用“本地”和“中央”类型更新实现的更新将在下文段落中进行介绍。 
缩写“TCiR”也用于此功能。它代表“RUN 模式下的类型更改”(Type Change in RUN)。
接口更改的定义

至少满足以下条件之一时，存在接口更改：

• I/O 的数据类型已更改。

• 已添加、移动和/或删除一个 I/O。 
• I/O 的默认值已更改。   
• 已重命名具有消息响应的 I/O（仅可在 STOP 模式下加载）

优点

• 使用 CPU 410-5H PA  时，在接口更改后可更新类型，并可在 RUN 模式下将类型下载到 
CPU。 

• CPU 中以前最多可同时链接 56 个块的限制不适用于 CPU 410-5H PA 。 
接口中名称更改的注意事项

• 无消息响应的 I/O
– 如果在块类型中更改 I/O 名称，并且还执行其它接口更改（例如增加一个 I/O），则同

样不会识别名称更改。 
– 随后使用其它名称的 I/O 将被解释为新 I/O，并因此被分配块类型中的默认值。过程值

将丢失。

• 具有消息响应的 I/O
– 只能在 STOP 模式下进行下载
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维护 RUN 模式下的类型更新功能

如果对块进行了以下更改，则不能再在 RUN 模式下进行类型更新： 
• 具有已组态消息的输入的名称已更改（“Message Event ID”）。

说明

更改关联值

例如，如果在块中调用“ALARM_8P”或“NOTIFY_8P”块并希望在该块中使用附加的关联值，则

可以在 RUN 模式下进行类型更新，但是只有在 CPU 因系统相关原因重启后，此扩展才生

效。 
如果已分配关联值 SD_1 到 SD_5，则会分配最多到 SD_10 的所有关联值。

 

使用初始化相关部分扩展块

当使用初始化所需部分扩展块时，必须考虑以下情况： 
可以在不执行启动的情况下通过 RUN 模式下的类型更新来下载更改，从而初始化扩展。 
为防止这种情况，所需的初始化代码不仅应在启动顺序 (OB100) 中执行，还应该与只初始

化新增加的部分的新顺序中“初始运行位”下的顺序分开。

这需要添加一个相当于“初始运行位”的新日期。在 RUN 模式下进行类型更新后，这将为

初始运行触发初始化顺序的执行。 
如果通过其它更改再次对块进行初始化相关扩展，则必须在另一个初始化顺序中反映此操作，

这意味着该块包含 3 个初始化顺序。

一个初始化相关扩展的示例是向块添加一个“ALARM_8P”实例。这必须在块初始运行时调用。

块/块类型接口中的默认值更改

当块/块类型接口中的默认值发生更改时，不能通过 RUN 模式下的类型更新进行下载，为执

行下载，只能在 CPU 的 STOP 模式下进行该操作。自 CFC V8.2 起，也可以通过 RUN 模式下

的类型更新来下载具有此类更改的模块。  
对于已更改默认值的 RUN 模式下的类型更新，用户可以在以下选项之间进行选择： 
• 块的所有现有实例保留所有之前的默认值。 
• 所有新默认值均应用到块的所有现有实例。
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可以选择“本地”或“中央”类型更新：

• “导入新版本 - 在 RUN 模式下下载更改”(Import new versions - Download changes in RUN) 
对话框中的本地类型更新

在此对话框中，提供了“保留之前的默认值”(The previous default values will be retained) 
和“激活新默认值”(Activate new default values) 选项按钮供您选择。

只有在选中“在 RUN 模式下将更改下载到 CPU”(Download of changes to the CPU in RUN 
mode) 复选框后，选项按钮才可用。 
根据所选选项，可将更改后的默认值应用到块的所有实例，或保留之前的默认值。

设置将应用于具有已更改默认值的所有块/块类型。如果不同的块/块类型需要不同的响应，

则必须单独执行已修改的每个块/块类型的本地类型更新过程。 
此过程在下文段落中进行介绍。 

• “更新块类型”(Update block types) 对话框中的集中类型更新

可以使用被称为类型更新的过程，将各个项目中使用的所有块类型和 SFC 类型与库中的

所有块类型和 SFC 类型进行比较，并相应地对其进行更新。

“更新块类型”(Update block types) 对话框显示已更改的所有块/块类型，可以为每个 S7 程
序的块/块类型决定是否应用更改后的默认值，可以通过“新默认值”(New default values) 
列中的相关复选框进行选择。 
此过程在下文段落中进行介绍。 

应用更改后的默认值时存在以下限制： 
• 只能将块类型的所有更改后的默认值应用于实例。无法仅选择某些更改后的默认值。

• 更改后的默认值只能应用于块类型的所有实例。无法将更改后的默认值应用于某些实例。

说明

在下载至 CPU 过程中应用默认值的作用 
如果应用默认值，则在本地和集中类型更新时，将始终应用默认值。  
这表示由进程更改的值也将在下载至 CPU 的过程中被覆盖。    

要求

• 目标系统包含 CPU 410-5H PA 且可以在线访问。 
• CPU 410-5H PA  固件的版本为 V8.1 或更高版本。 

如果此固件版本不合适，则对话框中相应的选项无法用于加载到目标系统。在这种情况

下，只能进行完整下载。
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• 对于移植的项目，只有在块类型更改并下载到 CPU 之前，至少需要使用 CFC V8.1（或更

高版本）执行完整下载或增量下载，才能实现“RUN 模式下的类型更新”功能。之后，才

能将“在 RUN 模式下下载更改至 CPU”(Download of changes to CPU in RUN mode) 复选

框用于移植的项目。 

本地类型更新时 RUN 模式下的类型更新的原理 
此处说明了本地类型更新的基本过程。中央类型更新的过程将在下文段落进行介绍。 
1. 如果项目块文件夹中的块已更改，则可以使用名为本地类型更新的过程将这些块导入到 CFC 数

据管理中并进行同步。 
为此，项目的 CFC 已在 CFC 编辑器中打开。 

2. 使用菜单命令“选项 > 块类型...”(Options > Block Types...) 打开“块类型”(Block types) 对话
框。随后，在“图表文件夹”(Chart folder) 列表中选择一个块，“新版本 ...”(New Version ...) 
按钮现在可以操作。 
如果块已更改，单击“导入新版本 - ...”(Import new versions - ...) 按钮来打开对话框。
如果选定的块尚未更改，则将在对话框中进行显示，并且可以取消类型更新或继续处理其它
块。 

3. 对于 CPU 410-5H PA  中的 S7 程序，将显示“导入新版本 - 在 RUN 模式下下载更改”(Import 
new versions - Download changes in RUN) 对话框和一个附加的“在 RUN 模式下将更改下载
到 CPU”(Download changes to the CPU in RUN mode) 复选框。使用此选项可激活 RUN 模式
下的下载。 
如果选中“在 RUN 模式下将更改下载到 CPU”(Download of changes to the CPU in RUN mode) 
复选框，则“保留之前的默认值”(The previous default values will be retained) 和“激活新默
认值”(Activate new default values) 选项按钮将处于可操作状态。
在块/块类型界面上使用“在 RUN 模式下更新类型”(Type update in RUN) 更改默认值后，可使
用这些选项按钮指定默认值的处理方式。更多相关信息，请参见上文段落。  
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4. 如果“在 RUN 模式下下载更改至 CPU”选项已启用，则 CFC 编辑器状态栏中会在关闭对话框
后出现一个状态指示器（“!”符号和补充文本），通知您仍需要下载到 CPU。 
此显示对于用户很实用，因为在类型更新后可能无法立即执行下载。例如，可能需要测试和
完成组态，原因是文本互连可能由于类型更新或新接口参数尚未互连而不完整。 
其它组态（甚至是其它类型更新）均可以在类型更新后和下一次下载前直接执行。但是，在 
RUN 模式下下载的功能会由于这些后续的组态操作而失效。因此，在启用了“在 RUN 模式下
将更改下载到 CPU”(Download of changes to CPU in RUN mode) 选项的情况下完成类型更新
后，应尽快执行下载。  

说明

下载前的多次类型更新 
如果下载前执行了多次类型更新并且 RUN 模式下仍可以下载，则每次类型更新都必须启用

“在 RUN 模式下将更改下载到 CPU”(Download of changes to CPU in RUN mode) 选项。

这表示，如果之前的某次类型更新是在禁用此选项的情况下执行的，则无法再在 RUN 模
式下执行后续下载。 

5. 程序随后会像往常一样编译和下载。
如果可以在 RUN 模式下下载，对话框中会提供相应的选项。如果此选项不可用，请检查上述
要求。 
对于接口更改，会进行计算以确定是否可以在一次操作中调整所有已更改的实例。如果该计
算超出了 CPU 的处理能力，会显示相应的消息，用户可以更改或减少要更新的类型数量。 
如果减少数量后仍超出 CPU 的处理能力，则必须像往常一样在 STOP 模式下执行类型更新。 

说明

OS 对更改了接口的块的访问 
下载后，OS 将无法在此状态下对更改了接口的块进行访问，受影响的画面对象将被禁用、

完全不显示或无法操作。这种状态会持续到 OS 完成编译和下载。

但是，在编译和下载 OS 前，从 OS 运行和监视的所有自动化系统都不需要事先更新。这

是可能的，因为结构类型特定于 AS 形成，并可处理不同的块类型。 

 

在 RUN 模式下使用集中类型更新的类型更新原理

1. 在 SIMATIC Manager 中，选择主数据库的块文件夹或图表文件夹，或者选择要在块文件夹或
图表文件夹中进行更新的块或 SFC。 

2. 选择菜单命令“选项 > 图表 > 更新块类型...”(Options > Charts > Update Block Types...)。
将打开对话框的第 1 页（共 3 页）“选择要检查的 S7 程序”(Select the S7 programs to be 
checked)。其中会列出多项目中的所有现有 S7 程序，并且这些程序已突出显示为选中状态。
满足以下条件时，“RUN 模式下下载”(Download in RUN) 列会显示一个复选框： 
– 此程序在 CPU 410-5H PA 中。 
– 可针对此程序下载相应更改，这就意味着不必下载完整程序。 
在 RUN 列的“下载”(Download) 中启用此选项后，在按下“计算...”(Calculate...) 按钮会打开
一个对话框，其中含有在 RUN 模式下下载时所需资源的信息。然后可以将所需资源的信息与 
CPU 中当前可用的资源进行比较，必要时可更改要更新和下载的块类型的选择。 
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3. 检查选择，根据需要，排除不想在其中更新任何块/SFC 类型的 S7 程序。
单击“下一步”(Next)。

4.“状态”(Status) 列中的复选标记指示已检查过哪些程序。 
检查完成后，将打开对话框第 2 页（共 3 页）。 
在“选择要进行更新的块类型或 SFC 类型。”(Select the block types or SFC types to be 
updated.) 页面中，可显示在库中所选的类型，这些类型在不同 S7 程序中具有不同的版本。
“块类型”(Block type) 列中显示受影响的块类型。现在可以选择要更新的块类型。
在“新默认值”(New default values) 列中，您可以确定是否也将更改后的接口块默认值发送到
块实例。选择某行相应的复选框，将更改后的默认值应用到块的所有实例。
类型更新的效果在“结果”(Consequence) 列中显示为用于选择的决定帮助。将显示以下结果：

– 所有关联实例将被修改（无更多结果）。

– 必须再次编译 OS。
所有关联实例将被修改。然后，可通过菜单命令“选项 > 向导：“编译多个 OS”> 启
动...”(Options > Wizard:"Compile Multiple OSs" > Start...)，或者通过选择 OS 并使

用快捷菜单命令“编译”(Compile) 来启动向导以编译 OS。
– 在 STOP 操作模式下加载整个程序 (Loading entire program in operating mode STOP)

编译之后，将不能再在 RUN 模式下下载更改。所有关联实例将被修改。

– “调整所有实例后可在 RUN 模式下下载”(Download in RUN is possible after 
adapting all instances)。
调整所有相关实例并编译程序后，便可在 RUN 模式下下载更改。

仅当使用 CPU 410-5H PA 时才可行。 
注：更新 SFC 类型时，将在第 2 页（共 3 页）中显示按钮“显示差异”(Show differences)。安
装了“Version Cross Manager (VXM)”附加软件包后，可通过此按钮打开 VXM 以显示有关差异
的详细信息。

5. 检查所选内容，考虑到所产生的结果，可根据需要排除那些不想进行更新的对象。

6. 单击“完成”(Finish)。 
“状态”(Status) 列中的复选标记显示已更新了哪些对象。

说明

TCiR 资源限制检查

单击“完成”(Finish) 时，内部函数会计算所选 CPU 的资源限制。如果类型更新中选择的

块数量超过 CPU 的可用资源限制，则无法继续在 RUN 模式下使用 TCiR 下载过程执行类

型更新。将显示一条消息。

如果要在 RUN 模式下执行类型更改，则必须减少类型更新的块数。

完成更新后，前进到下一对话框，即第 3 页（共 3 页）“日志”(Log)。 
7. 继续进行“如何更新多项目中的块/SFC 类型 (页 117)”部分中的步骤 7。 

参见

有关向 CPU 410-5H PA 下载程序期间的特别注意事项 (页 429)
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10.5.8 如何删除块类型

从图表文件夹中删除块类型

调用菜单命令“选项”(Options) >“块类型...”(Block Types...) 打开一个对话框，从中可删除

图表文件夹中不再需要的块类型，必要时，还可删除块文件夹中的块类型。选择块，然后单击

“清除”(Clean up) 以从列表中删除这些块。 

清除

单击“块类型”(Block types) 对话框中的“清除”(Clean up)，可连续打开两个对话框，以从图

表/块文件夹中删除块。 
1.“清除 CFC 中的块”(Clean up blocks in CFC) 对话框

将列出图表文件夹中包含（但未在该图表中使用）的所有块类型。也就是说，没有实例块。

2.“清除块文件夹中的块”(Clean up blocks in block folder) 对话框
这列出了所有保留于离线图表文件夹（但未在该图表中使用）中的块类型（块类型不在图表
文件夹中）。 
这些块类型也可能是从其它块中调用且通常仅存在于块文件夹中的块类型。 

示例： 
虽然在图表文件夹中删除了调用 OP_A_LIM (FB 46) 块的 CTRL_PID (FB 61) 块，但 OP_A_LIM 
块仍存在于块文件夹中。

在每个对话框中选择相应的块，然后使用“确定”(OK) 从各自的目标（图表/块文件夹）中将

其删除。
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10.6 编辑块

10.6.1 编辑块

概述

以下部分包含了有关编辑块的信息：         
• 插入块 (页 127) 
• 指定对象属性 (页 133) 
• 如何复制块 (页 137) 
• 如何移动块 (页 138) 
• 删除块 (页 140) 
• 如何对齐块 (页 141) 
• 如何设置 I/O 参数 (页 141) 
• 关于全局块类型更改应该了解的知识 (页 130) 
 

10.6.2 插入块

10.6.2.1 插入块

插入块意味着选择一种块类型并将其插入图表中。通过以下几种不同的方法，可以轻松地插

入块：

• 从块或库目录中拖放块；

• 如果选择了块，则使用 <Return> 键。 
插入块时，会为其分配一个在图表中唯一的名称。 
所插入的块就是该块类型的一个实例。可使用每个块类型创建任意数量的块实例。

说明

不会传送块实例的块类型注释。
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每个已插入的块均分配有默认的运行属性，用户可对其进行修改。

有关插入块的更多信息，请参见：

块、图表、模板和库的目录 (页 52)
在目录中搜索对象 (页 495)
插入块的设置 (页 128)
定位大型块 (页 129)
插入未放置的块 (页 129)

10.6.2.2 插入块的设置

默认运行属性        
插入块时，还必须指定块的运行属性，例如，运行顺序中块的插入位置。

默认：

块会插入到状态栏中所示的块之后。

状态栏显示下列信息之一：

• 第一次创建图表时，特定 PLC 的默认块

• 要插入的最后一个块

• 由运行顺序指定的块

当前插入点显示在状态栏右侧。它显示以下内容：

• 任务名称 (OB x)
• 图表名称

• 下次在 CFC 图表中插入块时，将在运行顺序中作为前导的块名

更多信息

更多相关信息，请参见以下部分：运行属性 (页 184)
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10.6.2.3 定位大型块

简介

也可插入大型块，即，包含大量可见块 I/O 的块。要执行此操作，在横跨两个或三个连续表

单的水平分隔线上定位该块。功能块的标题也会同时显示在分隔线下方的。

注意

• 如果发生定位冲突，此位置的块将显示为一个浅灰色且不带 I/O 的重叠块。将块插入到表

单边界时会发生定位冲突，结果是第一个表单中仅显示标题而非所有 I/O（为了避免双标

题）。可通过在垂直方向稍微移动块来更改此布局。

这同样适用于“小型块”，即，块体中不包含指定 I/O（如“AND”和“NOR”）的块。

• 如果块对于这三个表单而言过大，则将自动隐藏那些无法显示的 I/O。可见 I/O 的最大数

量可达 160 个输入和 160 个输出。可通过菜单命令“编辑”(Edit) >“对象属性...”(Object 
Properties...) 访问所有 I/O。

提示：为改善总览效果，最好仅显示将用于互联或在测试模式下进行监视的 I/O。

10.6.2.4 插入未放置的块

目录中的未放置块    
可从“未放置的块”(unplaced blocks) 目录中获取未放置的块，并将其重新置于图表中。为

此，请单击按钮

说明

只有当未放置块实际存在时，此目录才可用。

指定块名称和完整路径（图表名称）。这样可看到块源。使用快捷菜单命令“打开原始图表”
(Open Original Chart) 以打开生成块的图表。

也可在活动图表中插入来自另一图表的未放置块。将块再次放置到图表中时，不会重新生成

先前那些到块或表单栏的互连。
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10.6.3 全局块类型更改

10.6.3.1 关于全局块类型更改应该了解的知识

什么是全局块类型更改？

修改块类型的接口描述和/或系统属性并将其导入到 CFC 数据管理中时，可通过此新版本替

换同名的现有块类型，因而对现有块类型进行更新。此类型的所有块实例将更新为这种新的

块类型。 
能否修改全局块类型与 FB 和 FC 相关。BOP 类型为 CFC 内部的组件，因而无法对其进行更改。

在应用更改前，会显示一条警告消息，指出将产生的影响并显示新旧块类型的数据，例如上

次接口修改的名称和日期。此时，单击“否”(No) 可取消更新，而单击“是”(Yes) 则接受更改。

类型的全局修改可能会对块实例产生不良影响。例如，互连和参数设置可能丢失。在这种情

况下，必须手动修改块实例。

由全局类型更改而产生的修改会被记录下来，并在更新后自动显示。也可以通过菜单命令“选

项 > 日志：块类型...”(Options > Logs:Block Types...) 显示此日志。如果需要对功能块实例

进行某项修改时，使用此日志可节省时间，而且还可降低错误风险。

防止块类型更改的情形

如果更改了块类型的类别（例如，FB <--> FC），则不会更改块类型而且会将相应的消息写

入日志中。

更多信息

更多此内容的相关信息，请参见以下部分： 
类型更改对块实例的影响 (页 130)
数据类型扩展后的容许类型导入 (页 132)

10.6.3.2 类型更改对块实例的影响

简介

在 CFC 中，修改块类型的接口描述（块 I/O）或系统属性时，会自动修改所有实例块。应该

考虑接口修改的所有相关影响。
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更改块类型后，块注释将在块实例中进行全局更改（覆盖），而与先前所有实例特定的修改

无关。 

修改块 I/O 
对块 I/O 的修改会影响实例，具体如下所示：

• 添加了 I/O：

实例将相应地进行更新。将设置默认系统属性。如果在增加了块的大小后，此位置的可

用空间不足，则块将显示为重叠块。

对于 PCS 7，可在下面的“对 WinCC 的影响”部分中找到相关信息。

• 删除了 I/O：

该 I/O 将从实例中删除。如果这是一个互连 I/O，则还将删除互连或 SFC 访问。删除的互

连或 SFC 访问会被输入到更改日志中。

有关 PCS 7 的相关信息，请参见下述“对 WinCC 的影响”部分。

• 修改了 I/O 数据类型：

等同于删除 I/O 并创建一个新的 I/O。

有关 PCS 7 的相关信息，请参见下述“对 WinCC 的影响”部分。

• 对 I/O 进行了重命名：

系统不能自动生成对旧名称的引用。因此，等同于删除 I/O 并创建一个新的 I/O。

有关 PCS 7 的相关信息，请参见下述“对 WinCC 的影响”部分。

• 更改了 I/O 的顺序：

会考虑 I/O 的顺序。互连、参数分配和属性将被保留。

对块 I/O 的数值、注释和系统属性的影响

关于更改属性的影响方面的一般准则：更改类型时，会自动更新特定实例所无法更改的内容。

如果没有对实例特定的内容进行修改，则块实例的值、注释和系统属性 (S7_string_0, 
S7_string_1, S7_unit, 
S7_shortcut) 将会进行全局更新。也就是说，系统仅会更改系统默认的值、注释和系统属性

。 
如果更改了块类型的系统属性“S7_archive”，则在导入该类型后不会对现有实例块进行该属

性的更改。

对 WinCC (PCS 7) 的影响

修改块类型数据时，可通过压缩和编译来创建带有新 DB 编号的 DB。为了能够继续进行在

线访问，必须将数据再次传送给 WinCC（OS 编译）。 
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如果此更改影响了用于操作员控制和监视的块 I/O（属性 S7_m_c=true），以下规则适用：

• 在 OS 编译之后，添加的 I/O 将被 WinCC 识别并使用。

• 删除 I/O 后，WinCC 变量不再存在。WinCC 中所有现有的互连也必须删除。

• 更改 I/O 名称时，WinCC 变量名称也会随之更改。必须修改画面元素、块图标以及面板

的互连。

一般而言：任何的 WinCC 修改只有在 OS 编译后方起作用。

说明

对块 I/O 的更改会影响编译和下载。接口修改之后，只能对整个程序进行编译。如果程序中

调用了已修改块类型的一个较早版本，也必须下载整个程序。

10.6.3.3 数据类型扩展后的容许类型导入

数据类型

扩展块类型的数据类型（例如，从 INT 到 DINT）时，如果在不进行转换的情况下可将旧数

据类型映射到新数据类型，所有 I/O 数据将在全局类型更改期间被保留。这适用于以下数据

类型：

BYTE → WORD
BYTE → DWORD
WORD → DWORD
INT → DINT
STRING1n → STRINGn+m

（如：STRING16 → STRING32）

说明

请记住，由于执行全局类型更改，因而到这些 I/O 的互连仍会丢失。
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10.6.4 指定对象属性

10.6.4.1 指定对象属性

以下几部分描述了对象属性的编辑：

如何输入块名称 (页 133)
如何输入注释 (页 134)
如何将块图标分配给特定实例 (页 134)
如何指定 I/O 数量 (页 134)

10.6.4.2 如何输入块名称

简介

插入块时，分配给块一个名称。可修改此名称。块名称在图表中必须唯一。CFC 会验证这种

唯一性。该名称显示在块标题中，并且最多具有 16 个字符。禁止使用的字符：\ / . " %。

说明

PCS 7 中的 CFC： 
请记住，分配名称时，为了传送到 OS，变量名不得多于 128 个字符。此名称包含以下组成

部分：

• 层级路径中的文件夹名称

• 图表名称

• 块名称

• 分隔符（句点）

• I/O 名称（变量名）

编辑块名称

要编辑块名称，请按以下步骤进行操作：

1. 选择一个或多个块，
然后选择“编辑”(Edit) >“对象属性...”(Object Properties...) 菜单命令。

2. 选择“常规”(General) 选项卡。

3. 在“名称”(Name) 输入字段中输入所需的名称。 
4. 单击“确定”(OK) 确认输入。
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关闭该对话框，如果选择了多个块，则出现下一个块的对话框。

10.6.4.3 如何输入注释

简介

注释（用户特定的文本）显示在块标题中。块标题最多可显示 14 个字符的注释。小型块不

显示注释。

步骤

要输入块注释，请按以下步骤进行操作：

1. 选择一个或多个块，
然后选择“编辑”(Edit) >“对象属性...”(Object Properties...) 菜单命令。

2. 选择“常规”(General) 选项卡。

3. 在“注释”(Comment) 输入字段中输入所需文本。 
4. 使用“确定”(OK) 确认输入。

关闭该对话框，如果选择了多个块，则出现下一个块的对话框。

10.6.4.4 如何将块图标分配给特定实例

块图标

用于操作员控制和监视的块可在 WinCC 中以块图标的形式来显示（例如，用于调用面板）。

可将适用于块类型的不同块图标分配给特定实例（例如，用于指示不同类型版本：MOTOR 块
作为电机、风扇或泵）。 
在“特殊对象属性”(Special object properties) 组中，使用最多 16 个字符来指定显示在 
WinCC 中的“块图标”(Block icon) 输入字段中的块图标。

此输入字段只有在选中了“允许 OCM”(OCM possible) 复选框时才启用。

10.6.4.5 如何指定 I/O 数量

简介

可在具有大量同一数据类型输入的块中添加或删除输入（例如，NAND 或 OR）。
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步骤

要更改输入的数量：

1. 选中相应的块，然后选择
“编辑”(Edit) >“I/O 数量...”(Number of I/Os...) 菜单命令。
将打开同名的对话框。

2. 将输入的数量（2 到 120）输入到输入字段中，然后单击“确定”(OK)。

说明

如果对新块的长度而言，可用空间不足，块将显示为可在图表中移动的重叠块。 
只能将 I/O 数量减少到最低的互连 I/O 数。

10.6.5 复制块

10.6.5.1 关于复制块应该了解的知识

简介

可在图表内复制块和嵌套图表，也可将块和嵌套图表复制其它图表中。同时还可复制图表的

多个对象或所有对象。这样即可快速且无误地复制已测试的子结构。

复制块/嵌套图表

复制块/嵌套图表时，必须考虑对互连的下列影响：

• 将保留组中被复制对象间的互连。

• 将删除被复制对象与外部元素间的互连。

• 可能会复制或删除到共享地址的互连，具体要视“复制/移动的设置”(Settings for Copying/
Moving) 对话框中的设置而定。可通过菜单命令“选项”(Options) >“自定义”(Customize) 
>“复制/移动...”(Copy/Move...) 来显示此对话框。

• 如有可能，会保留名称。如果存在冲突，相应的错误编号将附加到名称上。
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被复制块的运行属性

复制块时，其响应与从目录中添加块时的响应基本相同： 
• 所有被复制的块将插入到由当前设置的“在此之后作为插入位置”(Predecessor for 

Insertion Position) 指定的位置处。在周期性任务中块的多个实例会被传送并插入到 OB 的
末端。

• CFC 也会根据各功能块的任务列表自动将该功能块(例如，带启动特性的功能块)插入到不

同的任务中。

• 将不复制运行组。这些运行组的块将依据目标的块安装指针，按照其先前的顺序进行安装。

已更改基于图表的运行组管理的行为（自 V8.2 起）：

在基于图表的运行组管理已激活的情况下将块复制到 CFC 时，无论插入指针的当前位置在哪，

都始终将在运行组末端插入这些块。 

检查块类型和系统属性

复制块时，会将块类型和系统属性与目标中的现有块类型和系统属性进行比较。按照以下规

则执行检查：

块类型

• 检查块类型的系统属性。

• 检查所有 I/O 类型的可用性。

• 检查以下名称/类型的标识：

– I/O 类型名称（例如，MODE）
– I/O 类型（例如，IN_OUT）
– 数据类型（例如，DWORD）
– 如果数据类型是 STRING：检查字符串长度。

– 如果数据类型是 STRUCT：检查数据类型。

• 检查 I/O 的系统属性。

• 检查块类型（SFC 类型，其它类型）在源和目标中是否相同。

块类型的系统属性

• 检查始终可用的系统属性 s7_alarm 和 s7_m_c 是否匹配。
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块 I/O 的系统属性

• 检查始终可用的系统属性 s7_a_type、s7_m_c、s7_link 和 s7_param 是否匹配。

• 检查可选系统属性 s7_server、s7_ts 和 s7_qc 是否可用且是否匹配。

– 如果它们在源中，则必须在目标中可用。

– 如果它们未在源中，则无法在目标中使用。

– 如果它们既在源中又在目标中，则必须具有相同的数值。

• 检查可选系统属性 s7_shortcut、s7_unit、s7_string0 和 s7_string1 是否可用。

– 如果它们在源中，则必须在目标中可用。

• 在项目内进行复制时，会始终包括可选系统属性 s7_enum。如果将块插入到不包含共享

声明中枚举的另一个项目中，则该系统属性将作为数字值插入。

更多信息

更多相关信息，请参见以下部分：

如何复制块 (页 137)
如何移动块 (页 138)

10.6.5.2 如何复制块

要求 
• 目标图表中必须有足够的空间用来粘贴被复制的块。

• 必须打开相应的图表。

• 图表必须位于同一 CPU 中。

• 如果要将块复制到其它表单中，请选择总览，或打开另一个显示目标表单的图表窗口。

– 有关总览的更多信息，请参见“CFC 中的视图 (页 88)”部分 

将块复制到其它表单或图表

有两种复制选择：

拖放

1. 选择要复制的块。

2. 按住 <Ctrl> 键和鼠标按钮，将某一所选块拖放到同一图表或另一图表中的新位置。
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复制/粘贴

1. 选择要复制的块。

2. 单击“编辑”(Edit) >“复制”(Copy) 按钮

所选块将突出显示。

3. 激活要将块复制到其中的图表，然后
单击“编辑”(Edit) >“粘贴”(Paste) 按钮

块将插入到另一图表中的相同位置，向右下方偏移一格。如果此位置已被其它对象占用，这
些块会显示为重叠块。否则会照常显示。 

4. 在重叠的情况下，可将块移动到适当位置。AS 也可以执行重叠块。

将块复制到其它 CPU
可将块从 CPU 复制到外部位置。此操作会影响功能，其影响方式与将图表复制到另一 CPU 的
操作一样。

有关运行顺序中插入位置的更多信息，请参见“关于复制块应该了解的知识 (页 135)”部分 

10.6.6 移动块

10.6.6.1 如何移动块

简介 
可将块移到图表的其它位置或者其它图表。也可一次性移动块组或所有块。 
移动块不会影响任何功能。这意味着互连和运行属性将保持不变。如果可能，块名也保留。

如果存在冲突，相应的错误编号将附加到名称上。

在图表中移动块

可按照以下方式在图表中移动一个或多个块：

1. 选择块。

2. 将所选的块拖放到图表中的新位置。
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在总览中，也可将块移动到其它表单中。

说明

不能在同一图表分区内执行“剪切”和“粘贴”操作。如果将块移动到另一图表分区中，则

该对象插入的位置与其在原始图表分区中的位置一样，即同一表单中的同一位置。

如果对象已处于插入位置并且块在插入后重叠，则它们会以不同颜色显示。可以在“颜色设

置”(Color settings) 对话框中使用“重叠块”(Overlapping blocks) 选项组态颜色。 
如果块不重叠，则会照常显示。在重叠的情况下，可将块移动到适当位置。AS 也可以执行

重叠块。

将块移动到其它图表中

要求

必须打开要将块移动到其中的图表。

这些图表必须位于同一 CPU 中。

将块移动到其它图表中有以下两种选择：

拖放

1. 选择要移动的块。

2. 将块拖放到其它图表中的新位置。

剪切和粘贴

1. 选择要移动的块，然后
单击“编辑 > 剪切”(Edit > Cut) 按钮。

所选块突出显示为浅灰色。

2. 激活要将块移动到其中的图表，然后
单击“编辑 > 粘贴”(Edit > Paste) 按钮。

块将插入到另一图表中的相同位置，向右下方偏移一格。“相同位置”在此上下文中意味着
块也插入到表单编号相同的表单中。
如果此位置已被其它对象占用，这些块则显示为重叠块，否则照常显示。在重叠的情况下，可
将块移动到适当位置。AS 也可以执行重叠块。

说明

选择了菜单命令“编辑”(Edit) >“剪切”(Cut) 之后，如果启动除“粘贴”(Paste) 之外的某

个功能，则会取消该剪切功能。所剪切的块将保留在其原始位置处。
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移动的影响

移动块不会影响任何功能。这意味着互连和运行属性将保持不变。如果可能，块名也保留。

如果存在冲突，相应的错误编号将附加到名称上。

10.6.7 删除块

删除块

可通过 <Del> 键或菜单命令“编辑”(Edit) >“删除”(Delete) 来删除一个或多个块。

删除图表中的块有以下影响：

对互连的影响

删除块时，待删除的块与尚未删除的对象之间的所有互连将丢失。 
如果块输出与不打算删除的块互连，则显示一条警告消息。然后可决定是否继续并删除块。

作为被截断的互连的代替方式，系统会将默认参数值分配给未删除的块的块输入。

对运行属性的影响

以下规则适用于运行组中的默认插入位置：

• 如果选择删除“在此之后作为插入位置”块，前面的对象将继承此属性。

• 删除了运行组中的所有块后，安装指针会移到此运行组的起始位置。

更多信息

更多此内容的相关信息，请参见以下部分：

如何删除块类型 (页 126)
运行属性 (页 184)
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10.6.8 对齐块

10.6.8.1 如何对齐块

简介

系统可对齐插入到图表中的块和已分配互连的块。 

步骤

1. 选择要对齐的块。

2. 选择菜单命令之一“编辑 > 对齐 > 靠左/靠右/靠上/靠下”(Edit > Align > Left/Right/Top/
Bottom)。
所有选择的块将靠左/靠右/靠上/靠下对齐。

结果

块在块图形的可见边界处而不是所选块的边框处进行对齐。最左边、最右边、最上边或最下

边的块决定块的对齐位置。

如果对齐导致冲突（例如，重叠块），则生成出错消息并恢复旧布局。此时，将不对齐这些

块，即便是那些未导致冲突的块也不对齐。 

说明

如果用于对齐的所选块包含重叠块（以其它颜色表示），则禁用此对齐命令。

10.6.9 编辑 I/O

10.6.9.1 如何设置 I/O 参数

定义

就此而言，设置参数是指将参数值分配给块或图表 I/O，如有需要还需分配属性。这些可能

是诸如单位和标识符的文本。系统会根据 I/O 的数据类型验证每个参数值的语法，并验证数

字范围未被超出。  
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分配全局 I/O 参数（块/嵌套图表）

如何编辑对象所有 I/O 的属性：

1. 双击对象 
或 
选择对象，然后选择菜单命令“编辑 > 对象属性...”(Edit > Object Properties...)。
将打开“属性 – 块”(Properties - Block) 或“属性 - 图表”(Properties - Chart) 对话框。

2. 打开“I/O”选项卡。 
此选项卡包含所有输入和输出的列表。
更多相关信息，请参见““属性 - 块/图表”对话框，“I/O”选项卡 (页 486)”部分。

3. 可将表格中的 I/O 进行排序后再设置参数。此排序顺序是临时的，在关闭该对话框后，该顺
序将恢复为原始顺序。 
单击列标题再次对所有 I/O 进行排序。每次单击都将切换字母顺序：升序/降序。带有选择框
的列的排序顺序由以下内容来决定：未激活/激活。“#”列指示对排序顺序的更改。

4. 在未显示为灰色的域中输入内容。

组态单个 I/O
可按如下方法更改单个 I/O 的属性： 
双击所需 I/O
或 
选择所需 I/O，然后选择菜单命令“编辑 > 对象属性...”(Edit > Object Properties...)。 
将打开“属性 - 输入/输出”(Properties - Input/Output) 对话框。

在该对话框中，对话框元素（如输入字段和复选框）的显示会有所不同。具体显示取决于 I/O 
的数据类型和其它属性。某些元素可能为只读（例如“块：”(Block:)），而某些框可能具有

以下属性：

• 完全不可见

• 可见但禁用（显示为灰色且不能编辑）

• 已启用（可编辑）

单位的输入

在相应的属性对话框中，可直接输入单位，或者通过下拉列表选择它。该下拉列表包含了所

有作为 CFC 的基本设置而安装的单位。用户可根据 PCS 7 应用程序来添加或修改这些单位。 
更多相关信息，请参见“组态共享声明 (页 173)”部分。

优点
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使用下拉列表进行选择具有以下优点：

• 单位可在各种应用（例如，过程标签列表、CFC 编辑器和 SFC 编辑器）中具有一致的符号。

• 无需费力地通过键盘输入诸如“°C”之类的特殊字符。

块或图表 I/O 的颜色表示 
如果块或图表 I/O 已更改（例如由于组态或互连），则此状态通过该 I/O 的彩色表示来指示。 
可使用以下显示选项： 
• 值/属性已由用户组态的 I/O：

此状态由块图标中已组态的值/文本的字体颜色指示。 
• 已分配未被用户更改的默认值的 I/O：

此状态由块图标中已组态的值/文本的字体颜色指示。 
• 对于自上次下载到 CPU 后由于互连或组态而发生变化的 I/O：

状态由块图标中 I/O 名称的字体颜色指示。

更多相关信息，请参见“块 (页 76)”部分。

10.6.9.2 如何对输入取反

    
可以取反（块和图表 I/O 的）已互连的二进制输入，这样会使“0”变为“1”以及“1”变为“0”。

使互连二进制输入取反

1. 选择输入。

2. 单击工具栏中的按钮

或
选择菜单命令“编辑”(Edit) >“反相输入...”(Invert Input....)。

或者也可

1. 双击该输入。
将打开“属性 - 输入/输出”(Properties - Input/Output) 对话框。

2. 选中“取反”(Inverted) 复选框。

输入将取反，并通过一个圆点来标识。

创建运行结构

10.6 编辑块

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 143



取消输入取反

再次执行“取反输入”(Invert Input) 功能以取消取反操作。 
也可通过执行以下操作来取消取反操作：

• 删除反相输入的互连

• 将互连移到另一个输入

• 再次互连该输入

注意事项

请注意以下信息：

• 如果将信号从一个取反的输入复制到另一个输入，该新输入将不会自动取反。取反操作

必须显式执行。

• 如果将互连从取反的输入移到未取反的输入，该新输入则不会自动取反。对不再互连的

输入取消取反操作。

• 分配给图表 I/O 的输入无法取反。

补救措施：插入一个 NOT 块。

10.6.9.3 块/图表 I/O 的数值标识符

创建数值标识符    
可使用数值标识符来定义块或图表 I/O 参数值的符号名称（文本）。创建块类型或图表 I/O 
时，可用以下系统属性进行定义：

• “S7_enum”
• “S7_string_0”到“S7_string_25”
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以下系统属性可用于各种不同的值：

• “S7_string_0”和“S7_string_1”专用于二进制值（数据类型：BOOL）
• 从“S7_string_2”至“S7_string_25”用于整数值（数据类型：BYTE、INT、DINT、WORD、

DWORD）
• “S7_enum”用于二进制值和整数值（数据类型：BOOL、BYTE、INT、DINT、WORD、

DWORD）

说明

使用系统属性“S7_enum”时，如果需要，“S7_string_0”到“S7_string_25”类型的系统属性

将无效。

系统属性“S7_enum”要求枚举的对象名称为数值。枚举以“共享声明”的形式包含在项

目中。每个枚举可包含若干个数值。相关信息，请参见以下部分：组态枚举 (页 174)
“S7_enum”和“S7_string_0/1”的文本最多可具有 16 个字符，而“S7_string_2...25”的文本

最多可具有 8 个字符。然而仅显示 8 个字符。如果文本的字符数多于 8 个，则可定义要

显示的字符。这可通过在文本中使用“=”字符来实现。 
• 如果文本中包含等号 (=)，则显示等号右边的前 8 个字符。

示例：Motor=ON；Motor=OFF4567890；显示 ON 或 OFF45678。
• 如果文本中不包括等号，则显示（左侧）前 8 个字符。

在图表中显示和修改数值标识符

在图表中，可指定是显示数值标识符还是绝对值。选择菜单命令“选项”(Options) >“自定义”
(Customize) >“布局...”(Layout...)。在“自定义显示”(Customize Display) 对话框中，可以设

置或重置“参数：数值标识符”(Parameter:Value Identifier) 选项。

在“对象属性”(object properties) 对话框中，可为 I/O 选择已定义的数值标识符。随后，“数

值”(Value) 框将包含一个用于打开下拉列表的附加按钮。从现在开始，该 I/O 上将显示所选

的数值标识符。
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10.7 CFC 中的 SFC

10.7.1 在 CFC 图表中插入 SFC 类型

与块类型相似，可从块目录中将 SFC 类型插入 CFC 图表中。这样将创建可组态和互连的 SFC 
实例。它们以块的形式显示，如同 CFC 实例一样。

SFC 类型在目录中按系列进行列出，并显示在“所有块”(All blocks) 文件夹中。如果未将“系

列”(Family) 属性分配给 SFC 类型，则 SFC 类型将显示在“其它块”(Other blocks) 文件夹中。 

10.7.2 CFC 图表中的 SFC 外部视图

自 V6.0 起，SFC 外部视图将替换控制块 SFC_CTRL。
为了通过 CFC 互连来启用 SFC 图表的控制，需要为 SFC 图表分配一个从 SFC 运行系统接口

派生而来的接口。此 SFC 图表以图表符号作为一个块显示在 CFC 中，类似于嵌套图表。块

名与 SFC 图表的块名相同，且无法在此进行修改。

外部视图显示在 CFC 的一个独立窗口中。在此窗口中，无法插入其它任何对象（例如，块）。

互连可照常在 CFC 中执行，例如，文本互连、到共享地址的互连以及到块/图表 I/O 的互连。 
在本地打印外部视图时，如同打印不带接口的 CFC 图表一样。

说明

可在 SFC 编辑器中以表格形式来打印接口 I/O（打印：外部视图）。
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10.8 创建并使用互连

10.8.1 如何创建块互连

关于块互连的常规信息

块互连是一个块的输出和另一个块或同一个块的一个/多个输入之间的连接。输入和输出的

数据类型必须兼容。 
互连的块可以位于同一表单中、同一图表的不同表单中或者不同图表中。互连伙伴也可以位

于项目的另一个图表文件夹中，或位于同一多项目的另一个项目中。更多相关信息，请参见

“设置 AS 范围的互连 (页 149)”部分。

可在图表总览或表单视图中互连 I/O。

块互连的一种特殊形式就是文本互连，即，互连伙伴可以位于不同图表文件夹中。

当存在一个与不在活动表单中的对象的互连时，通常会生成一个表单栏条目。如果由于表单

栏空间不足而无法在表单中创建条目，将自动创建溢出页。

在表单内互连到隐藏的 I/O 时，也将生成一个表单栏条目。该条目在 I/O 名称后通过文本

“INVISIBLE”进行标记。即使隐藏了超出表单的互连 I/O，此附加文本也会存在于表单栏中。

隐藏 I/O 时，文本互连、到共享地址或运行组的互连都不具有表单栏条目。这些互连只能在

块的对象属性中识别（“I/O”选项卡的“互连”(Interconnection) 列）。这同样适用于两个互连

伙伴都切换为不可见时。

说明

请注意以下信息：

• 如果将 FB 的输出与 FC 的 INOUT I/O 互连，则 FC 将写入 FB 的背景数据块。
当 FB 以其算法读取此输出时（不仅写入），由于 FC 的存在，这可能会导致输出出现问题或
故障。

• 请注意，块输出具有特定的默认值，CPU 启动时如果它们已被执行，则可能会影响其它块。

块的正确启动响应是项目工程师的职责。

SFC 实例的互连

SFC 类型的“块触点”特征会影响 SFC 类型实例的互连创建：在某些条件下，当创建互连时，

会自动完成 SFC 实例与块之间的所有其它块触点互连。

更多相关信息，请参见 SFC 在线帮助或《SIMATIC S7 的 SFC》文档的“块图标”部分。
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步骤

创建块互连的步骤如下所示：

单互连或多互连

1. 选择要互连的输出。

2. 单击要与所选输出进行互连的输入。
可以重复此步骤来为这一输出创建多个互连。
可以按任意顺序选择 I/O。也可以先单击输入，然后再单击输出。多互连也按此方法操作。

顺序互连

1. 选择要互连的输出。

2. 按住 <Shift> 键，然后单击要互连到所选输出的目标输入，按顺序连续进行操作。
对于顺序互连，必须保持其顺序为输出 → 输入。

通过拖放进行互连

1. 单击要互连的输出，并按住鼠标左键。

2. 将光标拖到目标输入。
在此处，可以按任意顺序选择 I/O。也可将一个输入拖到输出来将它们互连。

互连通常显示为一条直线，特殊情况下显示为一个连接器。这种情况发生在由于空间不足而

无法绘制直线或在表单栏中不能创建更多条目时。 

提示

• 通过同时打开若干个窗口的表单视图，可以轻松地创建超出表单或图表边界的互连。

• 也可在总览中创建超出表单边界的互连。

更多信息

有关互连显示的信息，请参见“互连的布局 (页 82)”部分。

有关 S7 互连的相关信息，请参考以下章节：

如何与共享地址互连 (页 151) 
使用文本互连 (页 157) 
如何创建和删除与运行组的互连 (页 163) 
创建到图表 I/O 的互连 (页 163) 
图表 I/O 的互连规则 (页 164) 
数据类型 A、DT、S 和 ST 的互连规则 (页 169) 
与 SFC 图表互连 (页 156) 
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10.8.2 设置 AS 范围的互连

简介

使用 CFC，可以建立指向位于其它自动化系统上的伙伴的互连。互连伙伴始终为块 I/O。AS 
范围的互连的要求：

• 涉及的 PLC 位于同一个项目或多项目中。

• 已通过 NetPro 执行网络组态。

设置 AS 范围的互连  
设置这种互连的方法与设置图表范围互连的方法相同。为此，请打开两个图表并在 CFC 中
排列它们，以方便将源连接到目标。即先单击其中一个图表中要连接的 I/O，然后再单击另

一个图表中的 I/O 伙伴。

对于连接，有一条互连线绘到表单栏。在表单栏的小域中，AS 范围的互连被标记为绿色三

角形。项目/工作站/CPU 类型，或层级路径和图表名称/块/连接在大框中输入。

有关 AS 范围的互连的说明 
• 还可以通过 AS 范围的互连执行从表单栏到跟踪信号的跳转。随后，该互连在另一个图表

中闪烁显示。

• 仅支持 S7 目标系统。

• 不能与地址和运行组进行 AS 范围的互连。

• 不支持 S7-300 CPU。
• 不支持 F 程序且 F 块在 AS 范围内无法进行互连。

• AS 范围互连的最短周期为 200 ms。对于 AS 范围的互连，设置循环中断 OB30 - OB38 的
参数时，循环中断的周期时间必须与优先级相关。周期时间越短，优先级必须越高。

• 在一个 OB 中，2 个伙伴 CPU 间传送的最大数据量是 4800 个字节。

• 不支持 STRING 和 POINTER 数据类型。

• 一个 AS 最多可与 15 个伙伴 AS 进行通信。

• 嵌套图表的 I/O 无法进行 AS 范围的互连。

• H 站与 S7-400 站间不能进行 AS 范围的互连。

• 仅当触点组态为“IN”接口时，才能将所有数据类型的块触点用于 AS 范围的互连，如果触

点组态为“IN_OUT”接口，则无法使用。
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AS 范围互连的最大数量

每个 OB 和伙伴 CPU 间，最多允许发送和接收 200 次 AS 范围的互连。

说明

使用之前版本可以运行的包含 AS 范围互连的程序，在当前版本中可能无法再编译。此时，已

超出了默认设置（即为程序中的 AS 互连保留 30% 的 CPU 最大负载）。如果通过增加默认

值对该值进行修正，那么之后可以再次编译该程序。

可在“编译/下载设置”(Settings for Compilation/Download) 对话框中查看和更改默认值。

移动项目的影响

如果将一个项目从作为 AS 范围互连的源或目标的多项目中移出，则会在 ES 数据库中记录

其互连伙伴。与表单栏的互连将被保留；而表单栏的内容将被删除并由一个问号代替。

重新集成该项目时，如果互连伙伴与之前相比未进行任何更改，则在更新 (F5) 时会自动重

新建立先前存在的 AS 范围的互连。 

说明

从当前（多）项目中移出项目时，若断开连接时从其中一个项目中删除了 AS 范围的互连但

在另一个项目中保留了该互连，将会产生单侧 AS 范围的互连。如果在断开连接时从项目中

删除最后一个 AS 范围互连，则也会删除固有伙伴连接。只要重新连接移出的项目，就会创

建单侧的互连（在 CFC 的表单栏中以问号进行标识）。然后单侧互连会在代码生成器中会

生成一条警告，且该互连不会加载到 AS 中。

有关消除单侧 AS 范围互连的信息，请参见：同步 AS 范围的互连 (页 481)

关于程序的概述 
一旦创建了 AS 范围的互连，就需要编译和加载受影响的 S7 程序。不能手动删除 NetPro 中
的 S7 连接。不能更改 NetPro ID。 
要查看 NetPro ID，请按以下步骤操作：

• 选择图表参考数据。在 CFC 中单击该按钮：

• 在“视图”(View) 菜单中，选择菜单命令“AS 范围的互连”(AS-wide interconnection)。
随即可从表格中读取 NetPro ID。
用户无需采取任何特殊措施来通过 AS 范围的互连执行数据传送。执行加载时，ES 会提供数

据传送所需的块，并加载这些块。这些块并非图表中的实例，也不会在目录中显示。可直接
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从 AS 的相应 OB（OB1 和 OB3x）中调用数据传送。处理指令位于由代码生成器创建的特殊 
DB 中，并从加载程序传送到 CPU。
“IK STATE”块位于 CFC 库的“ELEM_400”文件夹中。该块可集成到程序中，以响应过程中的通

信错误。有关“IK STATE”块的描述，请参见 CFC 基本组成要素的帮助 > AS 范围的块 > IK STATE
如果删除最后一个 AS 范围的互连，则也会删除 NetPro 中的 S7 连接。然后，需要进行编译

和加载。

10.8.3 如何与共享地址互连

简介 
共享地址是 CFC 图表外的互连伙伴，例如，共享数据块、I/O 信号、位存储器、定时器和计

数器。可以用符号形式或绝对地址形式指定地址。但是，必须遵循某些约定。

到共享地址的互连可插入到表单栏中，并由一个蓝色小三角形来标识。

说明

如果互连开始于一个随后切换到隐藏状态的 I/O，则表单栏条目也将被删除。此时，只能在块/
图表的对象属性中识别互连，这些对象属性在“I/O”(I/Os) 选项卡的“互连”(Interconnection) 
列中。
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步骤

1. 选择输入/输出，然后
从快捷菜单中选择命令“互连到地址...”(Interconnection to Address...)
，
或者单击工具栏中的按钮

I/O 处将出现地址选择列表，其中包括：

– 用于编辑共享地址的输入字段（上面一行）

– 当前符号表中适合于所选数据类型的所有符号的表格。

说明

在块 I/O 处打开地址选择列表时，该列表可能会以最小化形式显示，即，只显示输入

字段。使用光标优化选择列表的大小，以使符号表中的各个条目也能显示出来。

2. 按以下方式指定地址：

– 在输入字段中输入符号名称或绝对地址

或

– 选择所需符号。

3. 选择一个符号或双击所选符号所在的行。

4. 在输入字段中按 <Return> 键
或者
单击框外的区域。
关闭地址选择列表。
按 <Esc> 键退出且不保存选择。

结果

将生成指向互连目标的表单栏条目。

输入地址时的注意事项

• 根据语法规则（请参见符号表的“帮助”，“符号表中允许的地址和数据类型”部分），

CFC 可检测输入了绝对地址还是符号地址。

• 绝对地址（取决于地址类型）只能与类型 BOOL、BYTE、WORD 或 DWORD 的块 I/O 互连。

其它数据类型（BYTE -> CHAR；WORD -> INT、S5TIME；DWORD -> DINT、REAL、TOD、
TIME）只能与符号地址互连。为此，还要在符号表（“数据类型”(Data type) 列）中指定

所需的数据类型。

另请参见“符号表中无条目的绝对寻址”。
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• 绝对地址条目不区分大小写，可包含空格，也可不包含空格，例如，e1.1、E1.1 和 e 1.1。
地址值的允许范围取决于 CPU 的类型。绝对地址中的语法书写错误可能导致 CFC 错误地

将条目理解为符号！

说明

务必遵循 CPU 特定的限制。否则无法将已编译的程序下载到 CPU 中，并会显示一条下载

出错消息。

• 在图表的表单栏中，符号地址由双引号括起。这样可检查 CFC 如何解释条目，即，解释

为符号地址还是绝对地址。

• 以下地址无法通过 CFC 访问：

OB、SDB、SFB、SFC、UDT 和 VAT
• 可以访问 DB 元素的绝对地址。以下实例显示了允许的语法：

地址 访问目标

DB10.DW20 数据块 10，字 20
DB20.DX2.1 数据块 20，位 2.1

也容许符号 DB20.DBX2.1 作为输入，但是不接受“B”，因此“B”不显示在

表单栏中。

• 也允许 DB 元素的混合寻址。

示例：DB10.DW11、DB10.Valve、Mixer.DW8 和 Mixer.Valve
• ANY 类型的 I/O（例如，用于 SFB 12/BSEND 的 SD_1）也都可以与完整的数据块（绝对

共享地址如 DB1，或符号共享地址）互连。将传输 DB 的完整长度。因此可传输完整的数

据块。

通过与 DB 元素的互连可访问数据块的单个元素（甚至是 STRUCT）。这样便可对要传输

的数据进行简单的组合和评估。

• 如果要使用符号地址，即使符号包括绝对地址语法，也必须将符号括在双引号中。

示例："Q1.1" 和 "DB10".Valve。

访问符号表

调用菜单命令“选项”(Options) >“符号表”(Symbol Table) 打开用于编辑符号表中条目的符

号编辑器。 
在符号表中创建条目时，请遵守 STEP 7 的约定。
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图表更新

选择菜单命令“视图 > 更新”(View > Update) 或按 <F5> 键，以在活动图表文件夹的 CFC 图
表中更新操作数的名称/地址和块类型。

有关互连的要点

互连共享地址时，请注意以下关系和选项：

• 可将块 I/O 与绝对地址或符号地址互连。如果符号已在符号表中进行了定义并具有注释，

则会在表单栏中看到此符号注释。

还可稍后在符号表中输入符号。CFC 在图表更新时识别符号。

• 如果符号表中共享符号地址尚不可用，则编译期间会输出一条错误警告，并触发以下操

作：

– 输入：生成代码并为互连设置块类型的默认值。

– 输出：在生成的代码中，互连将被忽略。

• 要更改符号的上下文，可从符号表中将符号删除，然后创建一个新的符号。

• 不要将位于过程映像（例如，I5.1）中的启动块的 EN 输入（例如，CONT_S）互连，否

则将不会启用启动功能。

• 如果实例块的 STRUCT I/O 与共享数据块互连，并且随后对该共享数据块的结构名进行了

更改，则在编译期间不会检测到此更改。只有在关闭并重新打开 CFC 图表之后，ES 数据

管理中的更改才会得到更新。

这也适用于基本数据类型名称发生更改的情况。

• 如果符号名称和绝对地址完全相同，在互连过程中将使用绝对地址。

修改与地址的互连

双击表单栏中用于此互连的大型字段，可打开地址选择列表，其输入字段中显示了默认值。

可修改（覆盖）此条目，通过 <Del> 键将其删除或从列表中选择另一个符号。

符号表中不存在符号的绝对寻址

如果符号表中没有用于绝对地址或 DB 编号的符号，则还是可以使用绝对寻址。 
请注意以下规则：

• 地址不得占用为 CFC 图表编译而保留的范围。

• 地址不能位于当前 CPU 中不存在的数值范围内。

• 地址必须与已连接元素的数据类型相匹配。
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有关与共享地址互连的更多信息，请参见：

符号和数据类型之间可能的互连 (页 156)
符号寻址实例 (页 155)
绝对寻址示例 (页 155)

10.8.4 符号寻址实例

符号地址   
以下实例说明了指定符号地址时的选项：

地址 备注

Limit switch 例如访问一个输入位。

绝对地址在符号表中定义。

Recipe.Setpoint 访问一个数据块（配方）。

数据块的结构或类型决定了

数据块元素（设定值）。

"I5.1" 访问名称为 E5.1 的符号。

为避免对名称相同的绝对地址而非

符号寻址，将符号用引号

括起来。

10.8.5 绝对寻址示例

绝对地址

以下示例说明了绝对寻址：

地址 备注

I5.1 访问输入 5.1
i5.1 访问输入 5.1
M6.7 访问存储器位 6.7
MW10 访问存储器字 10
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地址 备注

DB10.DW20 访问数据块 10，数据字 20
DB20.DX2.1 访问数据块 20，位 2.1（语法也可以是：DB20.DBX2.1）

10.8.6 符号和数据类型之间可能的互连

有效数据类型

下表显示了具有指定数据长度的哪些符号可互连到哪些数据类型的块 I/O。必须在符号表中

也输入块 I/O 的相应数据类型。

数据长度 地址符号 块 I/O 数据类型

8 位 IB、QB、MB、PIB、PQB BYTE、CHAR
16 位 IW、QW、MW、PIW、PQW WORD、INT、S5TIME
32 位 ID、QD、MD、PID、PQD DWORD、DINT、REAL、TOD、TIME

10.8.7 与 SFC 图表互连

SFC 访问 (SFC access)
使用动作和转移条件对 CFC 图表中的块 I/O 或嵌套图表进行直接 SFC 访问是一种特殊形式的

互连。此类型的 SFC 访问可在 CFC 图表中“重新连线”，即，可将其从一个 I/O 移动到兼容

数据类型的另一个 I/O 中。如果 I/O 被互连，您可以决定只移动 SFC 访问，还是同时移动该

互连。

• 仅移动 SFC 访问

按住 <Alt> 键将所选 I/O 拖到新 I/O 中。SFC 访问符号将移动到新 I/O 中。不包括现有互

连。 
• 移动互连和 SFC 访问

将所选 I/O 拖至所需的新 I/O 中。用户将收到提示，询问是否包括 SFC 访问。如果单击

“是”(Yse)，则会同时移动互连和 SFC 访问。如果单击“否”(No)，则仅移动互连。 
• 删除 SFC 访问

无法在 CFC 中删除 SFC 访问。
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访问标记

在 CFC 图表中，I/O 处的标记标识 SFC 访问。写入访问和读取访问是以不同的方式表示。

标记具有以下含义：

• I/O 上方的标记 =“读取访问”

• I/O 下方的标记 =“写入访问”

标记的颜色与指示特殊数据类型的互连颜色相同。

SFC 引用

可用下列方法显示 SFC 引用：双击块 I/O 打开“属性 - 输入/输出”(Properties - Input/Output) 
对话框。使用包含 SFC 访问的 I/O 时，此对话框将包含“SFC 访问...”(SFC Access...) 按钮。单

击此按钮打开包含 SFC 引用列表的附加对话框。

引用包含 SFC 图表名称、SFC 对象（步名称/转移名称）和对象类型（步/转移）以及访问类型

（写入/读取）。

双击列出对象的图表名称可打开相关的 SFC 图表，其中会突出显示引用的对象。

10.8.8 使用文本互连

什么是文本互连？ 
文本互连只能在一个块/图表输入处存在，并始终指向 CFC 中的块或图表输出。文本互连保持

“打开”状态，直到关闭它后才转换为“实际”互连。  
可关闭的文本互连等同于使用一个通过路径名来标识互连源（输出）的字符串来对输入进行

寻址。 
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如何创建文本互连？

可通过以下方法创建文本互连：

• 自动创建为包括 PH 路径（如果存在）的路径引用 (chart\block.I/O)，方式为将其复制或

移动到其它图表文件夹。

复制后，会在副本输入处生成文本互连；而移动后，会在所移动的对象处和前一个对象

处生成文本互连（如果相应的输出不再位于同一图表文件夹中）。如果在同一个图表文

件夹中输入不再可用，则会删除输出处的互连。

• 在输入处通过用户操作创建文本互连：选择输入或打开快捷菜单，然后选择菜单命令“插

入”(Insert) >“文本互连”(Textual Interconnection)。
– 作为带 PH 路径（如果存在）的路径引用（chart\block.I/O）。

一旦互连伙伴在图表文件夹中可用，互连就会关闭。如果互连伙伴在以后才可在图表

文件夹中使用，则可通过菜单命令“选项”(Options) >“进行文本互连”(Make Textual 
Interconnection) 关闭该互连。将创建一个实际块互连。

– 创建为互连请求（不包含已定义路径引用的任意字符串，例如，注释）。

此互连请求不能关闭（日志中的警告）；用户必须在项目中手动关闭它。

• 如果由于类型的全局修改使得互连 I/O 的数据类型不再匹配。

请注意，在下列情况下不会创建文本互连：

• 当互连的源被删除时。

在这种情况下，将删除实际互连。

• 当删除或移动与图表 I/O 内部互连的互连源（嵌套图表或块）时。

在这种情况下，图表 I/O 分配将丢失。

• 当类型的全局修改涉及对接口修改重命名时。

注：如果只是更改名称而没有修改接口，则仍保持互连。

表单栏中的表示

对于打开的文本互连，图表文件夹中不存在互连伙伴，或引用与现有的块 I/O 不一致。

表单栏中的大框显示已输入的一行文本。

小框显示一个黄色三角形标识符。
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说明

请注意以下信息：

• 如果带有文本互连的 I/O 被隐藏，则不会有表单栏条目。这些互连只能在块的对象属性中识别
（“I/O”选项卡的“互连”(Interconnection) 列）。

• 带隐藏互连的块通过块标题右上角的一个彩色三角形指示。

通过关闭文本互连，可以将其转换为一个实际互连，即，转换为一个常规块互连。小框不再

显示这个标识符（黄色三角形）。

AS 范围的互连在表单栏中的表示

在表单栏的大区域中会显示 AS 范围互连的路径。在小区域中会显示黄色三角形，指示文本

互连是开放的。

可通过关闭文本互连将其转换为实际互连。小区域中的黄色三角形将被绿色三角形代替。

对于 AS 范围的互连，必须特别注意大区域中路径的语法。区分图表是否集成在工厂层级中

甚为重要。

• 无工厂层级的语法

– Project\\Station\CPU\Program\\Chart\Block.IO
• 含工厂层级的语法：

– Project\\Hierarchy Path\\Chart\Block.IO
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更改文本互连 
可以按如下方式修改现有文本互连：

• 将其重新连接到同一数据类型的其它输入上。

有关此主题的更多信息，请参见如何修改（重新链接）互连 (页 166)部分。

• 编辑表单栏中的文本

双击表单栏中的条目（小框或大框）以打开对话框，可在该对话框中输入新文本。先前

的文本被选中，可输入新文本以将其覆盖。

• 替换文本互连：

– 通过与共享地址的互连

从表单栏选择输入或文本，然后选择快捷菜单命令“互连到地址...”(Interconnection 
to Address...)。
相关信息，请参见以下部分：如何与共享地址互连 (页 151)

– 通过与图表 I/O 的互连

从表单栏选择输入或文本，然后选择快捷菜单命令“互连到图表 I/O...”
(Interconnection to Chart I/O...)。此对话框显示一个列表，其中包括活动图表中所

有已组态的图表 I/O 以及 I/O 类型（IN、OUT 和 IN_OUT）。

关闭打开的文本互连

图表文件夹中所有互连伙伴都可用后，即可将文本互连转换为实际互连。 
使用菜单命令“选项”(Options) >“进行文本互连”(Make Textual Interconnections)，可关

闭当前图表文件夹中的所有文本互连。

无法关闭单个文本互连。 
生成的日志将列出所有已关闭和仍然打开的文本互连。通过菜单命令“日志”(Logs) >“文本

互连”(Textual Interconnections) 选项卡调用此日志。

下列说明适用于编译：

如果有一个或多个文本互连未关闭，则会生成相应的日志条目。可通过菜单命令“日志”
(Logs) >“编译”(Compile) 选项卡查看此条目。

将编译数据，并为相应的输入生成一个替代值（块类型的默认值）。输出处的互连将被忽略。

删除和查找文本互连

使用菜单命令“选项”(Options) >“删除文本互连...”(Delete Textual Interconnections...) 来
打开一个包含所有文本互连的列表的对话框。 
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此对话框允许用户： 
• 可以获得当前图表文件夹中所有现有文本互连的总览。单击“取消”(Cancel) 在不删除互

连的情况下退出对话框。

• 可单击“跳转到”(Go To) 打开在其中实现互连的图表。互连闪烁显示。

• 可以选择文本互连，然后单击“删除”(Delete) 将其从图表文件夹中删除。互连将在没有

任何确认提示的情况下被立即删除。

常规信息

请注意以下信息： 
• 一个文本互连由最大长度为 512 个可视字符的字符串组成。

• 文本互连不能与一个关闭的互连或另外一个文本互连共存。

• 关闭文本互连时，将在日志文件中列出并显示所有的操作和错误消息。通过菜单命令“选

项”(Options) >“日志”(Logs) >“进行文本互连”(Make Textual Interconnections) 选项卡

可打开该日志文件。

• 编译程序时，容许打开文本互连。生成一条警告并执行下列操作：

– 输入：会生成代码并将块类型的默认值应用于打开的互连。

– 输出：在生成的代码中，互连将被忽略。

• 如果带文本互连的 I/O 切换到隐藏状态，则会删除表单栏条目。此时，只能在块/图表的

对象属性中识别互连，这些对象属性在“I/O”(I/Os) 选项卡的“互连”(Interconnection) 列中。

• 如果通过文本互连将 I/O 取反，则此取反不会显示在工艺编辑器中。 

过程对象视图中的文本互连

• 文本互连可以在过程对象视图中创建。 
• 要在过程对象视图中关闭文本互连，需要输入路径引用（chart\block.I/O）。

更多信息

有关文本互连的更多信息，请参见： 
拆分和合并项目数据中的文本互连 (页 162)
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10.8.9 拆分和合并项目数据中的文本互连

简介

将项目拆分为独立的可组态段并在随后将其合并时，请注意下列适用于文本互连的特性和方

面。

顺序和步骤

拆分一个项目（此处称为“主项目”）时，可将部分图表文件夹复制到一个或多个其它图表

文件夹中，例如，复制到不同项目工程师的临时项目（“分支项目”）中。此操作通常涉及

一个或多个（但不是全部）图表的项目间传送。超出图表边界的互连在输入端被转换为文本

互连，并在输出端被删除。

编辑后的图表返回到主项目（复制或移动）时，应用程序可识别主项目中的同名图表。在这

种情况下，会提示您覆盖现有的对象。如果单击“否”(No)，则图表作为副本插入（如果涉

及多个图表，则为“无”(None)）。如果单击“是”(Yes)，则覆盖现有的图表（如果涉及多个

图表，则为“全部”(All)）。在传输来自分支项目的图表之前，会从主项目中删除相应的图表。

在这种情况下，与常规的删除操作（<Del> 键）相反，将生成文本互连。

选择菜单命令“选项”(Options) >“进行文本互连”(Make Textual Interconnections) 可将它

们重新转换为实际互连。 
也可以不将图表复制到其它项目，而是通过“剪切”(Cut) 和“粘贴”(Paste) 来移动图表。但

复制的优点是，经过编辑的图表在返回前都具有完整功能（主）项目的安全级别。

说明

请注意以下信息：

• 不得重命名“断开”互连中的任何互连伙伴，因为这种情况下将无法关闭文本互连。

• 如果同名图表从分支项目返回到主项目，则对主项目中的图表修改会被取消。

• 主项目中可能会无意间生成互连，例如，如果在分支项目中修改了超出图表限制的互连，而
随后仅将一个图表返回到主项目。
示例：图表 CFC_A 包含一个与 CFC_B 图表中的块连接的互连。这两个图表均被复制到分支项
目中，并对其进行进一步编辑。这种情况下，两个图表间的互连会被删除。只有 CFC_A 会返
回到主项目中。主项目的 CFC_B 图表中会生成一个可实际关闭的文本互连。结果：在分支项
目中删除的互连再次出现在主项目中。

• 在复制/移动操作之前生成的文本互连将应用到目标项目。这可以是一个已定义的路径引用（可
关闭），也可以是任意字符串（目标项目中实际组态的互连请求）。

创建运行结构

10.8 创建并使用互连

SIMATIC S7 中的 CFC (V9.0 SP7)
162 功能手册, 05/2022, A5E41356112-AH



10.8.10 如何创建和删除与运行组的互连

概要

可动态启用和禁用运行组。这意味着块的输出值可决定是否执行一个特定的运行组。为此，

可将二进制块输出连接到运行组的使能属性。这种情况下，不考虑运行组的对象属性中“活

动”(Active) 选项的设置。     
表单栏上的红色小三角形指示与运行组的互连。

说明

请注意以下信息：

• 如果互连开始于随后被隐藏的 I/O 处，则不会有表单栏条目。此时，只能在块/图表的对象属
性中识别互连，这些对象属性在“I/O”(I/Os) 选项卡的“互连”(Interconnection) 列中。

• 带隐藏互连的块通过块标题右上角的一个彩色三角形指示。

创建互连

1. 选择要互连的二进制输出，然后选择菜单命令“插入 > 与运行组的互连...”(Insert > 
Interconnection to Runtime Group...)。
将显示“插入与运行组的互连”(Insert Interconnection to Runtime Group) 对话框。其中包含
了所有 CPU 任务和运行组的列表。

2. 从列表中选择包含所需要的运行组的任务。
运行组列表相应地排序。

3. 选择运行组并单击“确定”(OK)。
对话框关闭。便会在表单栏中输入互连。

删除互连

单击表单栏中的小框或大框，然后按 <Del> 键。

将删除与运行组的互连。删除运行组时自动删除互连。 

10.8.11 创建到图表 I/O 的互连

互连图表 I/O
可从块或带图表 I/O 的嵌套图表创建到图表 I/O 的互连。   
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有以下几种选择：

• 将 I/O 与现有图表 I/O 互连

• 在互连的同时创建图表 I/O
表单栏中的白色小三角形指示到图表 I/O 的互连。

有关图表 I/O 的更多信息，请参见：

• 如何创建带有图表 I/O 的图表 (页 105)
• 图表 I/O 的互连规则 (页 164)
 

10.8.12 图表 I/O 的互连规则

互连规则

下列规则适用于互连图表 I/O： 
• 内部互连的块 I/O 不能与图表 I/O 互连。

• 类型 IN 的块输入可以与类型 IN 或 IN_OUT 的图表 I/O 互连。

• 可将数据类型 ANY 的块 I/O 与任何基本数据类型的图表 I/O 互连（例外：不适用于 ANY 和 
POINTER 数据类型）。

• 不同的目标系统上，要互连的 I/O 的数据类型兼容性可能有所不同。如果数据类型不兼容，

互连时会显示一条出错消息。

• 不能组态图表输出参数。

补救措施：在块中设置输出的参数。该值随后会输入到相应的图表输出中。

• FC 输出的结构化数据类型不能与图表 I/O 互连。
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10.8.13 信号跟踪

跟踪互连      
即使表单中显示了多个互连，也可以按下列方法跟踪某个特定互连的路径：

• 单击表单栏中显示的线或大字段。

连接到所选线的所有线和表单栏条目（包括在溢出页中的部分）都将在屏幕上闪烁。也

可以沿分支线和中断连接器进行信号跟踪。

• 可通过嵌套图表的图表 I/O 跟踪与此图表 I/O 内部互连的 I/O 信号。

在快捷菜单中，选择命令“跟踪信号”(Track Signal)。将打开嵌套图表；互连和表单栏的

内容闪烁。

通过打开 I/O 的快捷菜单或表单栏的内容并选择菜单命令“从表单栏跳转”(Jump from 
Sheet Bar)，可跟踪一个将表单栏中的嵌套图表引至界面的互连。随后将打开更高层级

的图表，如果嵌套图表的相关 I/O 未互连，则会选择该图表 I/O。如果图表 I/O 是互连的，

则互连闪烁。

• 要禁止其闪烁，只需单击图表中其它位置即可。

使用“从表单栏跳转”也可实现信号跟踪。 
更多相关信息，请参见以下部分：从表单栏跳转 (页 165) 

10.8.14 从表单栏跳转

    
使用“从表单栏跳转”(Jump from Sheet Bar)，可从表单中的表单栏条目（或溢出页）快速

移动到当前图表中其它表单上的互连块（或其它图表上的互连块）：

• 从表单栏条目或带有单个互连的 I/O 中跳转时，可直接进行跳转。

将打开互连块或嵌套图表所在的表单或图表。通过块互连和互连图表 I/O，可激活信号跟踪

（线闪烁）。如果嵌套图表的 I/O 未互连，则会选择相关的图表 I/O。

如果跳转目标是一个重叠块，则只有此块被取到屏幕中心并被选中。因为不能显示 I/O 和
连接线，所以这种情况下无法进行信号跟踪。

• 如果从带有多个互连的输出的表单栏中跳转，将打开一个对话框，其中含有此输出的互

连列表。双击所需输出，或选择该输出然后单击“确定”(OK) 即可执行跳转。

• 即使已关闭了所选图表或删除了块，也可使用“编辑”(Edit) >“转到”(Go To) >“跳回”
(Jump Back) 菜单命令返回到跳转的起始点。

更多相关信息，请参见以下部分：信号跟踪 (页 165)
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10.8.15 如何复制互连

步骤

要复制互连，请执行下列步骤：

1. 选择互连输入。

2. 按住 <Ctrl> 键和鼠标左键，然后将光标拖到目标输入（相同类型）。到达此输入位置时，松
开鼠标按钮然后再松开 <Ctrl> 键。这样便创建了另一个互连。

复制是一个非常方便的功能，尤其是当互连起源于其它图表中的块时，因为无需从头开始定

位源。

说明

无法在 CFC 中复制 SFC 访问。

10.8.16 如何修改（重新链接）互连

步骤

可在表单视图中修改现有互连。为此，将来自一个 I/O 的互连移动到具有兼容数据类型的另

一个 I/O 中。操作过程如下：

输入

1. 将光标放在要将其互连移动到另一输入的输入上，并按住鼠标键。

2. 将光标拖到目标输入（相同类型）并松开按钮。将重新绘制互连线。

输出

与输入的步骤基本相同。但应用以下规则：

• 如果互连多于一个，则所有互连都将移到此输出。

• 如果从输出到地址的互连被拖到已和相同地址互连的输出，则会显示一条警告。然后您

可决定是否删除原始块的互连。

说明

请注意以下信息：

• 如要修改一个由 SFC 图表访问的互连（请参见块 I/O 标识符），则会出现一条消息，提示
您还要移动 SFC 访问。如果单击“是”(Yes)，则移动互连和 SFC 访问；如果单击“否”(No)，
则只移动互连。

• 如果只想将 SFC 访问移动到数据类型兼容的其它 I/O，请在按住 ALT 键的同时，将带有 SFC 
访问的 I/O 拖到所需的 I/O 处。
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10.8.17 如何删除互连

步骤

按以下步骤删除互连：

多个互连

删除输出的所有互连：

1. 选择输出或互连线，然后选择菜单命令“编辑”(Edit) >“删除”(Delete) 或按 <Del> 键。

2. 如果单击“是”(Yes) 来响应确认提示，则会删除互连。
如果单击“否”(No) 来响应确认提示，则不会删除任何互连。

删除输出的若干互连之一：

1. 选择输入并按 <Del> 键
或
将光标放在输出的表单栏条目上并按下鼠标右键。
即会选择表单栏条目之前的小字段。

2. 在快捷菜单中，选择命令“删除互连”(Delete Interconnection(s))。
将删除与输入的互连。
也可以直接单击表单栏中的小域，然后通过 <Del> 键或菜单命令“编辑”(Edit) >“删除”
(Delete) 删除相关互连。 

单个互连

可按下述方法删除输出、输入、表单栏条目的互连或删除连线：

选择相应的对象，然后

选择菜单命令“编辑”(Edit) >“删除”(Delete) 
或

按 <Del> 键。

文本互连

单个文本互连：

从图表中删除单个文本互连的方法与删除单个互连的方法相同（参见上文）。

所有文本互连：

1. 选择菜单命令“选项”(Options) >“删除文本互连”(Delete Textual Interconnections)。
将打开一个对话框，其中包含一个表，该表列出了当前图表文件夹中所有图表内的所有文本
互连。

2. 在“图表”(Chart) 列中，选择要删除的所有文本互连。

3. 单击“删除”(Delete)。

说明

无法在 CFC 中复制 SFC 访问。
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10.8.18 数据类型和结构

10.8.18.1 S7 的数据类型

以下主题列出了可为其分配参数或可互连的块/图表 I/O 处可以存在的全部 S7 数据类型。   
描述中给出了以下元素： 
• 数据类型的缩写

• 关键字和数据类型

• 取值范围

• 示例条目

• 在图表中以最大长度显示（实例）

图表中显示参数的最大字符串长度限定为 18 个字符。这可确保为块和互连保留了足够的空间。

输入选项不受此限定的影响。

数据类型

• ANY，A (页 473)
• ARRAY (页 473)（在 CFC 中不允许）

• BOOL，BO (页 474)
• BYTE，BY (页 474)
• CHAR，C (页 475)
• COUNTER，CR (页 475)
• DATE，D (页 475)
• BLOCK_DB，DB (页 473)
• DINT，DI (页 476)
• DATE AND TIME，DT (页 476)
• DWORD，DW (页 476)
• BLOCK_FB，FB (页 474)
• BLOCK_FC，FC (页 474)
• INT，I (页 477)
• POINTER，P (页 477)
• REAL，R (页 477)
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• STRING，S (页 479)
• STRING[N]，SN (页 479)
• STRUCT，ST (页 479)
• TIME OF DAY，T (页 480)
• S5TIME，T5 (页 478)
• TIME，TI (页 479)
• TIMER，TR (页 480)
• WORD，W (页 480)
 

10.8.18.2 数据类型 A、DT、S 和 ST 的互连规则

互连规则

以下互连规则适用于结构化数据类型 ANY、STRING、DATE_AND_TIME 和 STRUCT 的块 I/
O：  

 数据类型

互连类型

ANY
STRING、
DATE_AND_TIME、
STRUCT

强制互连用于： FC - OUT，
NIL 随所有其它 I/O 一起传输，这不能通过调用块来

评估（仅与用户编写的 STL 块相关；使用 PCS 7 块
可保证这一点）。

FC - OUT、
FC - IN_OUT、
FB - IN_OUT（带有 
STRUCT） 

互连的目标/源
（地址）：

任何：

CFC 块 I/O、

地址范围、

DB 元素、

整个 DB

DB 元素、

CFC 块 I/O
（FC - OUT 除外）

互连的目标/源
（数据类型）：

任何：除了相同的数据类型 (ANY) 仅限于相同的

数据类型
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到图表 I/O 的互连

FB 的结构化 I/O 和 FC 的结构化输入可与图表 I/O 自由互连。由于 FC 的结构化数据类型没有

自己的资源（背景 DB 中的存储空间），因此 FC 输出不能与图表 I/O 互连。

说明

STEP 7 块或 PCS 7 库不包含带有结构化输出的 FC。

10.8.18.3 结构

布局

结构用于在树形视图中将数据分组，并将这些数据应用于块 I/O。与基本数据类型类似，会

向块视图中的结构分配 I/O 名称和类型“ST”。
结构由若干元素组成，嵌套深度最多为 8 级。允许包含以下元素：

• 基本数据类型（BO、WORD 等）

• 结构

结构元素包含以下信息：

• 类型（基本数据类型，或者“ST”）
• 名称 (Name)
• 值（仅基本数据类型）

互连

只能将具有结构的块 I/O 与其它结构互连，而不能与基本数据类型互连。互连的结构必须是

兼容的，即，其包含的顺序、数据类型和基本数据类型的元素名称必须都一致。结构的名称

可以不同。

只可互连整个块 I/O 结构，而不能互连结构的个别元素。
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结构 (STRUCT) 互连的注意事项

• 为了简化 APL 块和标准块的组合，用以下结构表示例外，因为它们包含两个元素：

– Name.VALUE     [BOOL]
Name.ST     [INT]

– Name.VALUE     [REAL]
Name.ST     [INT]

“Name.VALUE”在这些结构中可以与基本数据类型 BOOL 或 REAL 互连。

“Name.ST”（互连：STRUCT> 基本数据类型）不会被评估或修改为“Name.ST:= 16#80”
（互连：基本数据类型->STRUCT）。

• 不支持全局数据块、AS 范围的互连、F 参数和 CFC I/O。

与共享地址的互连

不能将具有结构的块 I/O 与指向整个数据块 (DBx) 的共享地址互连。可以与 DB 第一级内的

结构互连 (DBx.name_st)。允许基本数据类型 I/O 与 DB 第一级内的基本数据类型 
(DBx.element) 互连。

说明

如果实例块的 STRUCT I/O 与共享数据块互连，并且随后对该共享数据块的结构名进行了更

改，则在编译期间不会检测到此更改。这也适用于更改了基本数据类型名称的情况。只有在

关闭并重新打开 CFC 之后，ES 数据管理中的更改才会得到更新。

编辑结构元素

可显示结构或结构中基本数据类型的对象属性，并进行编辑（分配参数）。

双击块 I/O 显示“选择结构元素”(Select Structure Element) 对话框。在显示的结构中，选择

要编辑的元素，然后单击“属性”(Properties) 按钮或双击该元素打开属性对话框。 
在编辑模式和测试模式下均可打开该对话框。

说明

不能将具有结构的 FC 输出与图表 I/O 互连。
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在动态显示中插入结构

可以在动态显示中插入整个结构或各个结构元素。为此，请按以下步骤进行操作：

1. 使用菜单命令“视图”(View) >“动态显示”(Dynamic Display) 打开动态显示。

2. 在 CFC 中选择块 I/O，然后在快捷菜单中选择“插入到动态显示”(Insert in Dynamic Display) 命
令。
“选择结构元素”(Select Structure Element) 对话框将打开。

3. 如果想插入所有结构元素，请选择顶层；如果只想插入单个元素，请选择该元素。

4. 单击“应用”(Apply)。
对话框将关闭，所选内容插入到动态显示中。
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10.9 共享声明

10.9.1 组态共享声明

简介

在项目中，可存储由不同应用程序使用的共享声明。例如，这些共享声明可以是枚举、单位

和设备属性。这可确保在整个项目中使用同名属性。

组态

创建新项目时，会自动创建共享声明及其包含的“枚举”(Enumerations)、“单位”(Units) 和
“设备属性”(Equipment properties) 文件夹。创建新的多项目时，还会在主数据库中创建共

享声明。 
在 SIMATIC Manager 的组件视图或工厂视图中，可在项目节点下直接创建“共享声明”
(Shared declarations) 文件夹。使用快捷菜单命令“插入新对象”(Insert New Object) >“共
享声明”(Shared Declarations)，可将带有下层文件夹“枚举”(Enumerations)、“单位”
(Units) 和“设备属性”(Equipment properties) 的文件夹插入到项目中。 
可单独删除、复制、移动以及创建“共享声明”(Shared declarations) 文件夹中包含的文件夹。

此文件夹中同一类型的文件夹只能有一个。

选择“共享声明”(Shared declarations) 文件夹时，通过快捷菜单命令“插入新对象”(Insert 
New Object) 可使用以下菜单命令：

• 枚举 (Enumerations)
• 枚举 (Enumeration)
• 单位 (Units)
• 单位 (Unit)
• 设备属性 (Equipment properties)
• 设备属性 (Equipment property)
如果不存在“枚举”(Enumerations)、“单位”(Units) 或“设备属性”(Equipment properties) 
文件夹，则也可插入“枚举”(Enumeration)、“单位”(Unit) 或“设备属性”(Equipment 
property) 对象。同时会自动创建这些文件夹。

如果插入这些文件夹中的一种，则在确认显示的提示后，该类型的现有文件夹将被覆盖。即

使之前重命名了该现有文件夹，它也会被覆盖。 
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插入之后，“枚举”(Enumerations) 文件夹已包含名为“操作状态”(Operating State) 的枚举，

但其中未包含值。枚举用于在 PCS 7 中隐藏消息。 
“单位”(Units) 文件夹已包含随 CFC 一起安装的单位列表。可在需要时对其进行扩展或修改。 
在“设备属性”(Equipment properties) 文件夹中尚不存在任何设备属性。在多项目/主数据库

中，此文件夹是插入类型的文件夹。在工厂层级中，此文件夹是插入设备属性实例的文件夹。

更多信息

更多此内容的相关信息，请参见以下部分：

组态枚举 (页 174)
组态单位 (页 176)
组态设备属性 (页 176)
更新多项目中的共享声明 (页 178)

10.9.2 组态枚举

简介

枚举用于具有系统属性“S7_enum”的块 I/O 或图表 I/O。无论系统属性（值与枚举的对象名称

匹配）的当前值为何，均可使用存在于项目中的枚举的任意对象名称。I/O 对象属性的下拉

列表中提供了这些枚举。

以下具有布尔值和整数值数据类型的 I/O 可以使用枚举：BOOL、BYTE、INT、DINT、WORD 
和 DWORD。

说明

如果将系统属性“S7_string_0”到“S7_string_25”和系统属性“S7_enum”分配给 I/O，则只有枚

举将被用作数值标识符（系统属性“S7_enum”）。

创建枚举

创建新项目时，会自动创建共享声明及其包含的“枚举”(Enumerations) 文件夹，其中带有

一个枚举。创建新的多项目时，还会在主数据库中创建共享声明。

名为“操作状态”(Operating State) 的枚举用于自动隐藏消息，但是它不包含任何值。
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可以通过下列方式生成枚举：

• 在工厂自动化加速器 (PAA) 中创建并随后通将其导入 PCS 7。 
导入 PCS 7 后，枚举存储在主数据库的文件夹“共享声明 > 枚举”(Shared Declarations > 
Enumerations) 中。在这种情况下，项目中的枚举不会自动同步。它们包括在数据传输对

话框的比较中，也可以被修改。   
用户也可以在主数据库和项目中同步枚举。有关同步的更多信息，请参见“更新多项目

中的共享声明 (页 178)”部分。

• 在主数据库或项目中创建枚举。 
该设置将在下文进行介绍。  

创建原则

可在主数据库或项目中通过以下方式创建新的枚举：选择“共享声明”(Shared declarations) 
文件夹，然后选择快捷菜单命令“插入新对象 > 枚举”(Insert New Object > Enumeration)。
也可使用菜单命令“插入”(Insert) >“共享声明”(Shared Declarations) >“枚举”
(Enumeration)。
可在枚举的对象属性中更改对象名和显示名。 
可指定枚举的对象名，以使其与使用此枚举的块 I/O 的系统属性“S7_enum”的值匹配。

说明

在块 I/O 的对象属性或过程对象视图中，将系统属性“S7_enum”分配给 I/O 时，“枚举”
(Enumeration) 框处于激活状态。系统属性的值与项目中现有的枚举名称是否匹配无关紧要。

可随时使用下拉列表将所需枚举分配给 I/O。

编译 OS 时，枚举显示名称可转换为不同语言，并传输到 WinCC。
创建枚举时，会自动输入“0.1”作为版本。可在枚举的对象属性中更改版本。

可将任意数量的值分配给枚举。对于将用于数据类型为 BOOL 的 I/O 的枚举，仅使用两个值。

插入值

可使用快捷菜单命令“插入新对象”(Insert New Object) >“值”(Value) 或菜单命令“插入”
(Insert) >“共享声明”(Shared Declarations) >“值”(Value) 创建新值。

输入的第一个值包含数值 0。该数字随附加值的每次增加而递增。

该值的显示名显示在块 I/O 的对象属性下的“值”(Value) 中。可在此从下拉列表中选择枚举

的每个现有值。

创建运行结构

10.9 共享声明

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 175



如果要在 SIMATIC BATCH 中标识枚举的控制策略，请在“属性枚举”(Properties 
Enumeration) 对话框的“常规”(General) 选项卡中的选择“控制策略”(Control strategy) 选
项。如果选择此选项，枚举和值的符号将改变其显示外观。

检查似然性

可以检查多项目/项目中的任何枚举，以确保枚举值唯一，即，一个枚举值只能分配一次。

更多相关信息，请参见“检查共享声明的似然性 (页 179)”部分。

10.9.3 组态单位

插入单位    
选择“单位”(Units) 文件夹，然后选择快捷菜单命令“插入新对象”(Insert New Object) >“单
位”(Unit) 即可创建新单位。或者，可使用菜单命令“插入”(Insert) >“共享声明”(Shared 
Declarations) >“单位”(Unit)。
如果要撤消对单位的更改或删除添加的单位，请再次插入“单位”(Units) 文件夹。这样，现

有文件夹的内容即会被 CFC 的基本设置覆盖。

对象名称是作为单位显示的文本。在对象属性中，可更改以下内容：

• 名称 (Name)
• 版本 (Version)
• 作者

• 注释 (Comment)

10.9.4 组态设备属性

创建设备属性    
创建新项目时，会自动创建共享声明及其关联的设备属性文件夹。在 BATCH 项目中会使用

这些设备属性（单位参数）。

选择“设备属性”(Equipment properties) 文件夹，然后选择快捷菜单命令“插入新对象”
(Insert New Object) >“设备属性”(Equipment Property)，即可创建新设备属性。或者，可

使用菜单命令“插入”(Insert) >“共享声明”(Shared Declarations) >“设备属性”(Equipment 
Property)。 
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创建设备属性时，请注意以下几点：

• 在共享声明中创建的设备属性是设备属性类型。

• 在工厂层级中创建的设备属性是设备属性的实例。

可根据需要从每种设备属性类型生成任意数量的设备属性实例。

组态设备属性类型

在共享声明中组态设备属性类型。

1. 在“设备属性”(Equipment properties) 文件夹中，选择设备属性，然后选择快捷菜单命令“对
象属性”(Object Properties)。

2. 为设备属性分配一个逻辑名和一个显示名。

3. 从下拉列表中选择所需数据类型。
根据所选择的数据类型，会相应地启用或禁用“枚举”(Enumeration) 和“单位”(Unit) 输入字
段。 
如果选择了“LOCATION”数据类型，则会显示三个附加复选框：“源”(Source)、“目标”(Dest) 
和“经由”(Via)。
注：如果这三个复选框都处于禁用状态，则 SIMATIC BATCH 会忽略此设备属性。

4. 根据要在 SIMATIC BATCH 中执行的操作，进行所需的所有其它设置。

5. 单击“确定”(OK) 完成组态。

组态设备属性实例

在工厂层级中组态设备属性实例。

1. 选择“单位”(Unit) 层级文件夹，然后选择快捷菜单命令“插入新对象”(Insert New Object) 
>“设备属性”(Equipment Property)。

2. 选择“设备属性”(Equipment properties) 文件夹，然后选择快捷菜单命令“插入新对象”
(Insert New Object) >“设备属性”(Equipment Property)。

3. 选择设备属性，然后选择快捷菜单命令“对象属性”(Object Properties)。
4. 在“名称：”(Name:) 框中，从下拉列表中选择设备属性类型。

随即将为该实例自动分配名称，该名称与共享声明中的类型名相同。

5. 可以根据需要编辑作者和注释。

6. 如果设备属性中包含枚举，可使用实例的“值”(Value) 下拉列表将已组态的值分配给此枚举。

7. 单击“确定”(OK) 完成组态。
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10.9.5 更新多项目中的共享声明

更新共享声明

可通过两种方式执行更新：

• 合并多项目中所有项目的共享声明

枚举、单位和设备属性在所有可用项目中均得到更新。这意味着该过程结束后，所有共

享声明对象将存在于每个相关项目中。

• 将项目的共享声明导出到另一个项目

将模板项目的共享声明导出到多项目的选定目标项目中。

步骤

1. 选择多项目，然后选择快捷菜单命令“共享声明”(Shared Declarations) >“在多项目中更新...”
(Update in Multiproject...) 。或者，也可以选择菜单命令“选项 > 共享声明 > 在多项目中更
新...”(Options > Shared Declarations > Update in Multiproject...)
将打开一个对话框，可在其中选择更新类型。

2. 选择 a)“合并多项目中所有项目的共享声明”(Merge the shared declarations of all projects in 
the multiproject) 或 b)“将项目的共享声明导出到另一个项目”(Export shared declarations of 
a project to another project)。
a) 合并多项目中所有项目的共享声明

– 单击“确定”(OK) 启动更新。

b) 将项目的共享声明导出到另一个项目

– 从列表中选择要用作模板以将共享声明导出到另一个项目的项目（或库）。

– 单击“确定”(OK)。
另一个对话框随即打开。其中列出可选择为目标项目的所有项目。 

– 如果您不希望将模板项目的共享声明传送到某特定项目，则一定要记住取消选取此项

目。

– 单击“确定”(OK) 启动导出。

说明

请注意以下信息：

• 主数据库只可用作更新的源。

• 更改模板中单位、枚举或设备属性的名称会导致在进行比较时在目标项目中新建这些
内容。
以前使用的共享声明被保留，以便使用。

• 在目标项目中进行比较期间，模板中删除的单位、枚举或设备属性会被忽略，因此将
保留在其中。

创建运行结构

10.9 共享声明

SIMATIC S7 中的 CFC (V9.0 SP7)
178 功能手册, 05/2022, A5E41356112-AH



结果

更新完成之后，结果以消息形式显示。如果出错，则生成一个完整的日志。 
可以通过选择快捷菜单命令“共享声明”(Shared Declarations) >“显示完整日志...”(Display 
Full Log...) 来查看完整的日志。

10.9.6 检查共享声明的似然性

似然性检查

可以检查多项目的项目和库中的任何枚举，以确保枚举值唯一，即，一个枚举值只能分配一

次。 
为每个单独的项目或库执行此似然性检查。执行多项目中的更新时，势必要在整个多项目中

进行一致性检查。 
如果选择了一个多项目，将逐个检查其中的所有项目和库。 
要启动检查，请按以下步骤操作：

1. 选择一个多项目、项目或共享声明。

2. 从快捷菜单中选择“共享声明”(Shared Declarations) >“验证”(Validate) 命令。

检查结果

• 如果对多项目进行了检查，则会显示一条消息指示该过程结束。此消息会要求您打开本

地项目日志，以便您可以查看是否发生了任何错误。

• 如果对单个项目进行了检查，则检查过程结束后会自动显示日志。如果发生错误，则您

会发现这些错误已记录在日志中，如“枚举类型 'xyz'：值 1 被分配多次”(Enumeration 
type 'xyz': 'value 1 assigned several times)。
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10.10 OS 和 MIS/MES 的组态

10.10.1 操作员监控

简介 
在过程运行期间，CPU 中会生成消息，而这些消息需要传递到 WinCC 操作员控制和监控系

统中。 
通过 CFC 中的消息组态，可直接在块中定义事件相关的消息，编辑其文本并分配属性。

在 AS 组态中，已指定了 OS 中 OS-AS 通信所需的数据，即，用于操作员监控的数据。在 OS 
编译期间将该数据传送到 OS。

消息块

在 CFC 中插入消息块后，会自动生成一条消息。该块预定义的消息结构带有默认属性和消

息文本。这样，CPU 便可在发生事件时发送来自 AS 的相应消息，而无需用户方面的其它组

态。还可以为构成消息的信号分配关联值，此关联值允许在消息文本中输入动态值。

可以通过消息组态功能（特殊属性：“消息”(Messages)）为每个块实例编辑诸如消息类别、

消息类型和消息文本等属性。如果禁用了“消息”(Messages) 按钮，则块将不具有消息功能。

操作员控制块

可通过允许操作员控制的输入来设置和编辑块的 WinCC 属性。为此，可通过在块的对象属

性中单击“操作员监控...”(Operator Control and Monitoring...) 打开对话框。

在块的“对象属性”(Object properties) 部分选择或取消选择“允许 OCM”(OCM possible) 选
项，可修改要进行操作员监控的块实例的这一属性。

块图标的模板

在 WinCC 模板画面中，可为每个作为模板的块类型创建多个块图标。块图标的模板及其变

体位于画面“@PCS7TypicalsBasisLibraryV8.pdl”中。

这样，可指示类型的多种特定变体，例如，用 MOTOR 块指示电机、风扇或泵。 
在“对象属性”(Object properties) 对话框的“块图标”(Block icon) 输入字段中，可定义要在 
WinCC 中显示的该块实例的块图标。可以输入块图标的变型作为变型编号或变型名称。最多

可输入 16 个字符。 
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块图标的变型可以通过图标名称末尾的“/”字符进行区分，例如“<图标名称>/2”。   

变体 备注

1 标准 PCS 7 样式

2 样式类似于 APL 样式。 
另请阅读下面的注释！

<变体名称> 用户自定义变体；

作为块图标名称的用户自定义变体名称；最多 16 个字符

如果选中“创建块图标”(Create block icon) 复选框，则该输入字段将处于活动状态。如果取

消选中“创建块图标”(Create block icon) 复选框，将禁用输入字段。但是，该条目将保留。

说明

块图标的模块及其版本

基本块图标的模板和变体位于画面“@PCS7TypicalsBasisLibraryV8.pdl”中。如表中所述，此画

面中的变体“2”意味着变体“2”的样式与 APL 的样式类似！ 
此画面中的图标不应与 APL 的图标混淆，因为可在画面“@PCS7TypicalsAPLV8.pdl”中找到 APL 
的图标和变体。

 

AS <-> OS 通信

组态消息后，AS <-> OS 通信所需的 OS 数据将下载到一个或多个目标操作员站，在那里图

形对象或面板会使用这些数据。

要启用此传送，必须安装“AS-OS 工程”软件包。使用菜单命令“选项”(Options) >“编译多个 
OS”(Compile Multiple OSs) 向导 >“启动...”(Start...) 在 SIMATIC Manager  中启动编译，或对

于单个 OS 而言，使用菜单命令“编辑 > 编译”(Edit > Compile) 实现编译过程。

说明

请注意，将名称分配给图表/块时，变量名称的字符串长度不得超过 128 个字符才能进行 OS 
编译。该名称由以下部分组成：

• 层级路径中的文件夹名称

• 图表名称

• 块名称

• 分隔符（句点）

• I/O 名称
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10.10.2 组态归档变量

简介

在 CFC 中，可选择要用于操作员控制和监视（系统属性 S7_m_c := 'true'）的块 I/O，以便在 
WinCC 中归档。

在 OS 项目中编译 OS 时，会将标识为与归档相关的 I/O 创建为归档变量。如果过程值归档

尚不存在，则也会自动创建一个过程值归档。

要求：在“编译（多个）OS” (Compile (Multiple) OSs) 向导中，选择“归档变量”(Archive 
tags) 选项，并在 OS 对象属性中选择“创建/更新归档变量”(Create/update archive tags) 设
置。 
如果后来删除了与归档相关的 I/O，或将其更改为“不归档”(No Archiving)，则下次编译 OS 
时，相应的归档变量也将被删除。

如果不再有与归档相关的 I/O 可用且过程值归档中也不包含归档变量时，则会删除过程值归

档。

组态

可在 I/O 的对象属性中（单个 I/O），或在块的对象属性的“I/O”(I/Os) 选项卡中（多个 I/O），

标识要归档的变量。

在输入字段的下拉列表中，可选择是否归档 I/O 以及如何归档：

• “不归档”(No Archiving) (S7_archive := 'false') 
不（再）归档 I/O。

• “归档”(Archiving) (S7_archive := 'shortterm')
将在 OS 上或归档服务器上归档 I/O。

• “长期归档”(Long-term archiving) (S7_archive := 'longterm')
在 OS 上或归档服务器上归档的值将作为长期归档存储在 CD、DVD、MOD、磁带及其它

介质中。 
对于数据类型为 BOOL、BYTE、WORD、DWORD、INT、DINT 和 REAL 的所有具有 OCM 功
能的 I/O，都允许使用系统属性 S7_archive。

说明

如果项目中使用了新的块类型，现有块实例的系统属性“S7_archive”将保持不变。块类型的

新实例会继承这一属性。
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10.10.3 MIS/MES 组态

简介   
企业级 MIS 和 MES 需要自动化等级的特定信息。为确保只传送 MIS/MES 相关的信息，创建

项目时可创建适当的过滤器。 
系统属性“S7_mes := "true"”可用作过滤器。可为要进行操作员控制和监视的块和块 I/O 设置

该系统属性 (S7_m_c := "true")。系统属性由块类型指定，且可在块实例中修改。

组态

有以下组态选项：

• 在“块”(Blocks) 对话框的“常规”(General) 选项卡中，可通过选中和取消选中“MES 相关”
(MES-relevant) 复选框来激活和禁用 MIS/MES 系统的整个块。只有设置了“允许 OCM”
(OCM possible) 时，才可更改此选项。

• 按照以下方式修改可由操作员控制和监视的 I/O 的系统属性：

– 对于多个 I/O：在“属性 - 块”(Properties - Block) 对话框的“I/O”选项卡中

– 对于单个 I/O：在“属性 - 输入/输出”(Properties - Input/Output) 对话框中
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10.11 定义运行属性

10.11.1 运行属性

说明

创建新图表时，将会自动创建运行组，该图表的所有块都将集成在该运行组中。 

块的运行属性

块的运行属性决定了在 CPU 整个结构中如何按照运行顺序执行块。这些属性对目标系统响

应能力具有决定性作用，而其响应能力反映在反应时间、停滞时间、依赖时间的结构（例如，

闭合回路）。 
插入块时，会为每个块分配默认运行属性。从而将块插入到一个任务的运行顺序中。在 S7 中，

任务由一个 OB（Organization Block，组织块）组成。

有关安装指针的更多信息，请参见“安装指针的概念和使用 (页 189)”部分。 
如有必要，块也可安装在任务的运行组中。

说明

创建新图表时，将会自动创建运行组，该图表的所有块都将集成在该运行组中。 

 

运行组

运行组用于构建任务。块按顺序安装到运行组中，可在“对象属性”(Object Properties) 对话

框中为其分配“减速比”(reduction ratio) 和“相位偏移”(phase offset) 属性。 
有关属性的更多信息，请参见“运行属性 (页 208)”部分。

可单独启用和禁用运行组（例如，通过数据类型为“BOOL”的块输出）。不执行已禁用的运行

组中的块。

更多相关信息，请参见“如何创建、编辑和删除运行组 (页 196)”部分。 
基于图表的运行组管理 
借助“基于图表的运行组管理”，CFC 的各个块将基于图表在单独的运行组中自动进行管理，

即，CFC 的各个块以永久分配给该 CFC 的运行单元的形式进行组织。 

创建运行结构

10.11 定义运行属性

SIMATIC S7 中的 CFC (V9.0 SP7)
184 功能手册, 05/2022, A5E41356112-AH



更多相关信息，请参见“针对 CFC 块的基于图表的运行组管理 (页 203)”部分。

更多信息

有关运行属性的更多信息，请参见：

• 显示运行属性 (页 185)
• 修改运行顺序和安装指针 (页 191)
• 安装指针的概念和使用 (页 189)

参见

显示信号处理的反馈（停滞时间） (页 186)

10.11.2 显示运行属性

简介 
显示运行属性相关信息的方法有多种： 
• 显示单个块的运行属性

• 显示整个 CPU 的运行属性

各个块的运行属性

每个块的运行属性都显示在运行显示域中块标题的彩色背景上：

• 上面一行（左侧）： 
块执行显示 (页 209)的标识符

任务名称（例如，OB 35）
• 上面一行（右侧）： 

任务名称或块的采样时间（取决于显示设置）。

采样时间等于任务周期时间乘以运行组的缩小比率。
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• 下部行（斜线左侧）： 
块或运行组在任务中的位置

• 下部行（斜线右侧）： 
如果块安装在运行组中，则为块在运行组中的位置；否则为“-”

提示：将光标放在运行属性框上时，工具提示框会显示任务名称，如果块安装在运行组中，

还会显示运行组的名称。如果在运行属性域中输入采样时间，也会显示任务名称。

整个 CPU
可按如下步骤获得运行顺序的完整视图： 
1. 双击块标题上的运行属性框。 

启动运行编辑器并且在运行顺序窗口打开安装有这个块的任务（第一插入位置）。相关块会
突出显示。

2. 选择菜单命令“编辑 > 运行顺序...”(Edit > Run Sequence...)
或 
单击图标：

运行编辑器和运行顺序一同打开。如果选择了一个块，则将在运行顺序窗口中打开安装有此
块的任务（第一个插入位置）。相关块会突出显示。
也可在此窗口中编辑运行顺序。

3. 选择菜单命令“选项 > 图表参考数据...”(Options > Chart Reference Data...)
或 
单击图标：

启动一个带有其自身窗口和菜单命令/工具按钮的应用程序。 
“运行顺序”(Run Sequence) 视图显示当前 CPU 的完整运行顺序以及注释和运行属性。 
可以通过以下方式启用“运行顺序”视图： 
– 使用菜单命令“视图 > 运行顺序...”(View > Run Sequence) 
– 单击图标：

将打开包含对象的任务。可打印运行顺序列表。 
无法在此窗口编辑运行顺序。

10.11.3 显示信号处理的反馈（停滞时间）

术语定义：

当互连目标的函数/块在程序序列（运行序列）中优先于互连源的函数/块被安排时，会出现

互连反馈。
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意外反馈会导致信号流程出现故障或者计算结果出错。

概述

在块之间手动插入互连时会检查块的序列。当启用“避免隐式死区时间”功能时，在可能的

情况下，会自动更正运行序列，以解析在互连中检测到的反馈，从而避免信号处理过程中出

现死区时间。

• 更正原则：

本质上，在以下优化功能之间进行区分： 
– 在运行编辑器中优化组（优化组/任务...）及所有块。 

在运行编辑器中，可使用运行组快捷菜单中的菜单命令“优化组/任务”(Optimize 
groups/tasks) 启动该优化。  

– 在互连过程中避免反馈/死区时间的并行程序。

对于这种用于避免反馈/死区时间的并行程序，必须在 CFC 编辑器中激活“避免隐式

死区时间”(Avoid implicit dead times)。
该功能的说明如下。 

• 检查：

对于手动互连过程，会首先检查是否存在反馈路径/死区时间。 
检测到的反馈路径/死区时间以图形方式显示，并在相应互连处的互连块输入端显示为符

号。

说明

即使禁用“避免隐式死区时间”(Avoid implicit dead times) 功能，也会对反馈路径进行检

查并在互连处显示检测到的反馈路径。

• 自动更正：

当检测到反馈路径且“避免隐式死区时间”(Avoid implicit dead times) 功能激活时，如果

相关块位于一个共享运行组中，则这些块会在其运行序列中相应地交换。 
如果相关块并非位于一个运行组中，则会进行更正。 
随后，检测到的反馈会在互连过程中进行隐式解析。

• 无自动更正：

即使激活“避免隐式死区时间”(Avoid implicit dead times) 功能，如果未检测到反馈或检

测到不可解析的反馈，也不会在互连过程中对运行序列进行更正。 
如果无法解析反馈，则会通过下述符号进行显示。
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• 关闭自动更正： 
可以取消激活具有“避免隐式死区时间”(Avoid implicit dead times) 功能的自动更正。 
如果无需对运行属性进行更改，关闭自动更正才有意义。

以下部分介绍功能的激活或取消激活状态。 

• 涉及的对象：

在避免反馈路径/死区时间的程序中需要考虑以下对象： 
– 新互连中涉及的两个块。 
– 即所有独立的互连块，这些块构成一个不依赖于外部的独立组。

– 在消除反馈路径/死区时间时，如果已经在运行序列中移动的块继续构成一个无外部关

系的互连块独立组，则仍可将这些块考虑在内。

• 未涉及的对象：

– 更正程序中通常不包括 F 程序。

– 已经存在的互连（无论有无反馈）的状态通常保持不变，即已互连块的相对运行序列

保持不变。 

说明

在 CFC 中使用“避免隐式死区时间”(Avoid implicit dead times) 功能的注意事项 
在 CFC 编辑器中使用之前，请检查菜单命令中“避免隐式死区时间”(Avoid implicit dead 
times) 功能的设置或工具栏中的图标设置。如有必要，禁用该功能以避免不必要的自动更

正。  

启用/禁用“避免隐式死区时间”功能

要激活或取消激活该功能，请在 CFC 编辑器中选择菜单命令“选项 > 避免隐式死区时间”
(Options > Avoid implicit dead times)。
通过选择菜单命令“避免隐式死区时间”(Avoid implicit dead times) 切换该功能。 
或者，也可通过 CFC 编辑器中的符号激活/禁用该功能。

当前状态显示在菜单项左侧或工具栏符号上。
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显示反馈

反馈以图形形式显示给用户：

• 以下符号将显示在 CFC 中相应互连处的互连块输入端。

用户可通过该符号在互连过程中获得视觉反馈。 
更多相关信息，请参见“互连的布局 (页 82)”部分。 

用户响应

要删除反馈的状态显示，需要检查并调整运行编辑器中块的运行序列。

说明

反馈的图形显示对于用户而言是一个组态工具。 
CFC 中出现的反馈可能是所需的/必要的。但也可能由于系统原因而无法解析或只能通过删

除互连来解决。 

10.11.4 安装指针的概念和使用

运行模型概念 
从 V6.0 起运行模型允许运行顺序采用面向图表的架构。所有块将连续插入到运行顺序中。安

装指针确定了下一个要插入到运行顺序中的运行对象的插入位置。应区分图表安装指针和块

安装指针。 
S7 程序中存在以下安装指针： 
• 程序的全局图表安装指针。

• 每个图表的独立本地块安装指针。 
结合为每个图表自动创建的运行组，安装指针的概念确保了更好地实现面向图表的架构。例

如，当为多用户工程分支和合并项目时，此功能允许以面向块的方式处理图表块。这使用户

能够以面向图表的方式进行工作，并可指定块的运行顺序，而无需考虑到其它图表的运行顺

序。 
如果用户未在安装指针中指定其它方法，则将按下列方法插入图表： 
• 新图表在现有图表之后插入。

• 块将直接逐个插入到图表中。
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其它优点： 
• 在面向图表的多用户工程期间，插入位置不会被项目工程师在无意间调整。

• 修改图表时无需修改整个 OB。而只需编译和下载已修改图表的相应运行组。

• CPU 的下载性能会因特定的图表而受到影响。

• 可以在 CPU 运行期间（测试模式下亦可）启用/禁用各个图表，且无需通过外部控制（例

如，SFC）初始化此操作。

图表安装指针 
每个程序都包含其自身的全局“图表安装指针”。该指针可确定以下内容：  
• 下一个创建的新图表的运行组要插入到哪个任务。 

复制图表时，图表插入指针保持不变并且不会被考虑到，因为应用了其复制源的顺序属

性。 
• 下一个创建的图表运行组要插入到运行组或任务级块后面的哪个位置。如果任务中尚不

包含任何运行组，则此位置为“空”。而该指针将指向实际任务。

这种指针只能在运行编辑器中（而不能在 CFC 编辑器中）进行自定义。OB 35 是默认的图表

安装指针。 
可按以下步骤自定义图表安装指针：

1. 在运行顺序中选择一个任务、一个块/SFC 或一个运行组。

2. 选择菜单命令“编辑”(Edit) >“在此之后作为插入位置”(Predecessor for Insertion Position)。

图表安装指针的显示

插入位置的前一个块在运行顺序中通过浅绿色背景突出显示。 

块安装指针

每个 CFC（包括嵌套图表）都包含其自身的局部“块安装指针”。该指针可确定以下内容：

• 下一个新块要插入到哪个任务中。

• 下一个新块要放置到运行顺序中哪个块后面的位置。 
块位置始终有任务编号的唯一链接。

块安装指针在空图表中是“未定义的”。而状态栏中会显示图表安装指针。第一个块插入之

后，会从当前图表安装指针中获取信息。

块安装指针只能在 CFC 编辑器中（而不能在运行编辑器中）进行自定义。默认的起始位置（创

建一个新图表后）是自动生成的图表运行组的起点。
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可按以下步骤自定义块安装指针：

1. 从图表中选择一个块。

2. 选择菜单命令“编辑”(Edit) >“在此之后作为插入位置”(Predecessor for Insertion Position)。
如果基于图表进行插入，在 CFC 中将块定义为“在此之后作为插入位置”(Predecessor for 
Insertion Position)（块安装指针）并在 CFC 中插入新块时，设置的“在此之后作为插入位置”
(Predecessor for Insertion Position) 将保留在定义的块中。

说明

复制和粘贴过程中块安装指针的行为

使用标准函数（如 AND、OR 等）时，块安装指针的行为与插入该指针（例如从模板目录）

时复制到 CFC 期间的行为相同。

将块复制到 CFC 时，块始终会复制到运行组的末尾。此过程不涉及块安装指针，因此块安

装指针保持不变。

块安装指针的显示：

插入位置的前一个块与图表中的其它块不同，因为它以彩色突出显示。块标题中运行属性框

以黑色字体显示在浅绿色背景中。

嵌套图表说明：

在嵌套图表中复制/插入的块始终在运行组的末尾。块安装指针的位置会被忽略。

更多信息

有关移植的信息，请参见以下部分：将旧项目移植到增强型运行模型中 (页 42)

10.11.5 修改运行顺序和安装指针

启动运行编辑器 
调用菜单命令“编辑 > 运行顺序...”(Edit > Run Sequence...) 或单击工具栏中的以下图标来

打开其它窗口： 
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此窗口分为一个层级窗口（左边）和一个详细信息窗口（右边）。此窗口的结构类似于 
Windows 资源管理器且操作方式也相同。 

移动对象

要移动对象（图表、运行组或块），请在窗口中（右窗格或左窗格）选择该对象，然后将其

拖动到要在其后安装所拖动对象的对象上。 
将一个对象拖到一个运行组时：

• 如果树展开为 [-] 形式，则对象安装在运行组内的第一个位置。

• 如果树关闭为 [+]，则对象安装在运行组之后。

• 如果运行组是空的，系统将询问是否要在运行组内安装块。如果单击“是”(Yes)，则安装

在内部，如果单击“否”(No)，则安装在运行组之后。

任何拖拽到运行组内的块/图表上的对象，都将插入到该块/图表之后。

当将一个对象拖拽到一个任务中，对象将插入到现有的安装对象之前。

说明

移动块时，根据运行模型 V6.0 和更高版本检查所有图表块是否只存在于相应的运行组中。如

果将块移到另一个组中，则面向图表的结构将不再存在，这样对于多用户工程中的图表分段

编辑会变得更难或不可能。

删除块

仅当块在运行顺序中安装了多次时，才能从任务中将其删除。必须至少保留一个插入点。如

果仅插入了一个块，则会拒绝删除操作。否则，将删除该块并相应地调整下一个块的运行顺

序。

插入块

使用复制/粘贴功能可在不同任务中安装块和运行组的多个实例。使用相应的菜单命令或工

具栏按钮，或在按住 <Ctrl> 键的同时拖放（更多相关信息，请参考“移动对象”部分）。
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也可通过直接将块从 CFC 中拖放到运行顺序的所需位置来安装块（如果同时显示窗口）。 

说明

请注意以下信息：

• 如果在不同的任务中安装块，意味着不应在一个周期性任务中安装块的多个实例。但是，系
统不会阻止此安装。

• 对于在生成模块驱动程序期间自动插入到运行顺序中、带系统标识符“@”的对象，只能在 
SIMATIC Manager 中使用“选项”(Options) >“图表”(Charts) >“生成模块驱动程序...”
(Generate Module Drivers...) 功能进行编辑；这些对象既不可手动移动也不可手动删除。

自定义安装指针

可按如下所述编辑安装指针：

• 图表安装指针（默认：OB 35）
要编辑图表安装指针，可转至运行编辑器并选择相应的任务 (OB)，或是选择任务级（不

在运行组中）的块，或是选择任务中的运行组。

在运行编辑器中选择“编辑 > 在此之后作为插入位置”(Edit > Predecessor for Insertion 
Position) 菜单命令。

插入位置的前一个块用浅绿色背景的字体突出显示。

• 块安装指针

无法在运行编辑器中设置块安装指针。要编辑块安装指针，请打开 CFC 编辑器并为所有

连续块的默认插入位置选择块。

在图表中选择“编辑 > 在此之后作为插入位置”(Edit > Predecessor for Insertion 
Position) 菜单命令。

插入指针随着每插入一个新块而递增。最后插入的块将成为安装位置的前一个块。复制

块时不会修改插入指针。

如果删除已定义为插入位置前一个块的块，则块插入指针会递减，即指针将被设置为前

一个插入块的位置。这同样适用于将块移动到其它图表的情况。不会修改目标图表中的

该块插入指针。移动后的块将保留其在前一图表中的插入位置。

如果基于图表进行插入，在 CFC 中将块定义为“在此之后作为插入位置”(Predecessor for 
Insertion Position)（块安装指针）并在 CFC 中插入新块时，设置的“在此之后作为插入

位置”(Predecessor for Insertion Position) 将保留在定义的块中。

有关运行顺序的更多信息，请参见以下部分：如何查找插入位置 (页 196)
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10.11.6 优化运行顺序

优化的目的 
此功能用于根据数据流优化程序运行顺序，以便在程序运行期间将 CPU 的死机次数降到最

小。任务和运行组将分别进行优化。

启动

要启动优化过程，在运行编辑器中选择菜单命令 
• “选项”(Options) >“优化运行顺序”(Optimize Run Sequence) 以优化整个运行顺序。

或者，如果您仅希望优化选定的任务或运行组，则可通过以下菜单命令打开快捷菜单

• 优化组/任务 (Optimize Groups/Tasks)。
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选择单个元素

优化运行顺序时，可以优化特定的元素或将其排除在优化范围之外。通过任务的对象属性选

择所选任务的设置。“属性 – 任务”(Properties - Task) 对话框将出现。

• 可以优化整个任务，包括所有启用的运行组。

选项“任务和运行组”(Task and runtime groups)（默认设置）

• 可以只优化任务的已启用运行组。

选项“仅限运行组”(Runtime groups only)
• 可从优化中排除整个任务（包括其运行组）。

选项“无”(None)

说明

请注意以下信息：

• 如果通过快捷菜单命令“优化组/任务”(Optimize Groups/Tasks) 为单个运行组或任务启动
优化过程，则在“属性 - 任务”(Properties – Task) 对话框中所做的选择不会影响该优化。

• 可通过相应运行组的对象属性对话框（选项“优化运行顺序”(Optimize run sequence)）启
用要优化的特定运行组。
这意味着可通过取消选择该选项从优化中排除特定的运行组。

• 优化时不包括所有 F 对象。

• 从优化中排除的任务或运行组可通过符号中的附加元素进行标识。

• ：如果在任务的对象属性中选择“无”(None) 或“仅限运行组”(Runtime groups only) 以
进行运行顺序优化。

• ：如果在运行组的对象属性中未选中“优化运行顺序”(Optimize run sequence) 复选框，
或未激活该任务的优化。

• 不会优化由驱动程序生成器（“生成模块驱动程序”）生成的运行组的内容 (@......)，因
为已为这些组设置了正确的顺序。

如果在模块驱动程序生成后执行优化，则无法保证驱动程序块的运行组的顺序仍为由驱

动程序生成器设置的顺序。因此，在下次编译过程中再次启动模块驱动程序。

优化运行期间会发生什么？

所有任务都分别优化。分别处理任务的运行组。不考虑运行组的减速比和相位偏移。 
数据流量由互连数量决定。这包含所有块到块的互连、到 SFC 图的互连、模块输出和运行组

的 ENABLE 信号间的互连。将忽略全局互连和文本互连。将确定到图表接口的互连是否有实

际互连源。如果不存在这样的连接，即，如果互连在某个接口处终止，则将忽略互连。到其

它任务中块的互连或从 SFC 图表到块 I/O 的访问也将被忽略。

到运行组的互连或来自运行组的互连被看作是运行组自身的互连。运行组在任务级形成一个

虚拟块。运行组内部块间的互连只用于运行组内的优化过程。一方面，这可确保正确地安排

实际运行组，另一方面，可确保该运行组在任务中处于最佳位置。
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为减少编译和下载的组态数据量，在不导致不必要的更改的情况下执行后续优化。

说明

当通过 INOUT 参数连接块时，从输入到输出的数据流可能被颠倒。在优化运行顺序时无法

对此加以考虑。

补救措施：这种情况下，必须手动优化运行顺序并从优化中移除相应运行组。

10.11.7 如何查找插入位置

步骤

在运行编辑器中，可按如下步骤搜索对象的插入位置：

1. 选择“编辑”(Edit) >“查找...”(Find...) 菜单命令。
将打开一个对话框。 

2. 使用选项按钮选择搜索对象（任务、组、SFC 或块）。
可输入完整的名称或仅输入首字母。 

结果

搜索结果显示在窗口中。如果未找到与搜索关键字相匹配的对象，则显示一条消息。

10.11.8 如何创建、编辑和删除运行组

什么是运行组？ 
运行组是可选的，而且会在创建一个新图表时自动创建。运行组用于组织或分割任务。块在

运行组中按顺序安装。 
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运行顺序中使用以下运行组：

• 标准运行组：

有两种类型的标准运行组：

– 在运行顺序中手动创建。

例如：

– 创建图表时会自动创建。

例如：

基于图表（托管运行组）：  
非基于图表（非托管运行组）：  

• 扩展运行组：

除标准运行组外，这类运行组会在标准运行组（基于图表）的块移动到的其它循环 OB 时
自动创建。

例如：

“V1101”是插入 OB35 的标准运行组（默认情况下）。在运行顺序中，如果手动将块（如 
OR）从 OB35 移动到 OB36，则会在 OB36 中创建一个名为“V1101_1”的新扩展组，同时

该块会插入到此运行组中。

• 驱动程序生成器创建的运行组：

编译程序时，生成模块驱动程序期间自动创建。

例如：

• 系统在 OB 100 中创建的运行组：

编译程序时，系统自动创建。

例如：
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• 故障安全运行组：

除标准运行组外，这类运行组会在故障安全块插入图表时，在同一 OB 中自动创建。在运

行顺序中，故障安全块插入相应的故障安全运行组中，其它块插入标准运行组中。

例如：

“FMC1101”是图表的标准运行组。如果将故障安全块（如 F_START）插入图表，则会在

同一 OB 中创建名为“FMC1101_F” 的新故障安全运行组，同时该块会插入此运行组中。

• 系统创建的故障安全运行组：

除标准运行组和故障安全图表的故障安全运行组外，这类运行组将在编译故障安全程序

时自动创建（取决于故障安全块）。

例如：

此运行组可用于：

• 删除或重新连接所选块以在 AS 上执行。

使用数据类型为“BOOL”的块输出激活或禁用运行组；对未互连的运行组，使用运行组对

象属性中的“活动”(Active) 选项激活或禁用运行组。

• 以特定缩小比率（即，每第 n 个周期数）和/或相位偏移执行所选块。这改善了 CPU 上的

负载平衡。
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• 可在较小单元中排列包含大量安装块的任务。在改进的运行模型 V6.0 及更高版本中，此

操作通过在运行组中自动以图表级插入图表块来实现。（每个运行组一个图表）

优点：编译每个任务时，将不会创建一个“庞大的”FC，而是根据运行组的数量创建若干

“较小的”FC。
如果以后修改了程序，将只为实际包含已修改块的运行组/FC 分配“修改的”ID。也就是

说，编译更改和在线下载更改的所需时间将显著减少。

• 所有具有启动相关性的块将被安装到 OB 100 的运行组中。

安装块时，会在现有运行组中进行搜索。如果未找到任何内容或已达到该运行组的最大

块数目，则将创建一个新的块。通常会创建运行组的名称，例如，“@@OB100@@(2)”。
可为插入到运行组中的对象分配运行属性。更多相关信息，请参见“运行属性 (页 208)”部分。

基于图表的运行组管理中的运行组 
借助“基于图表的运行组管理”，CFC 的各个块将基于图表在单独的运行组中自动进行管理，

即，CFC 的各个块以永久分配给该 CFC 的运行单元的形式进行组织。

此 CFC 的运行组中不能包含其他 CFC 的块。这减少了对选择性下载的依赖。 
为具有启动特性的实例化块创建图表时，除了标准任务（例如，OB 1）中的运行组外，还会

在启动任务 OB 100 中自动创建一个相应的运行组。 
基于图表的运行组管理已激活的 CFC 识别： 
• 运行组中关联 CFC 的名称在运行编辑器中用括号括了起来，可据此通过基于图表的运行

组管理识别运行组到 CFC 的分配。 
• 对于基于图表的运行组管理中的 CFC，在图表文件夹或 CFC 的属性中选择“基于图表插入”

(Chart-based insertion) 选项。

CFC 的集成和移植： 
• 当选择了图表文件夹属性中的“基于图表插入”(Chart-based insertion) 选项后，新的 CFC 

图表创建后可自动激活基于图表的运行组管理。

• 对于使用 PCS 7 V8.1 及更高版本创建的 PCS 7 项目，自动启用"基于图表插入"(Chart-based 
insertion) 选项。对于使用 V8.1 之前的版本创建的现有 PCS 7 项目，该选项仅适用于启

用选项后新创建的图表。 
• 不会自动激活现有 CFC 的基于图表的运行组管理。 

要激活现有 CFC 的基于图表的运行组管理，可在 SIMATIC Manager 中使用图表文件夹或

各个图表的快捷菜单中的菜单命令“图表 > 基于图表的运行组管理”(Charts > Chart-based 
runtime group management)。关联的运行组也将自动修改。   

有关现有 CFC 的基于图表的运行组管理和移植的更多信息，请参见“针对 CFC 块的基于图

表的运行组管理 (页 203)”部分。
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如何创建运行组？

有两种方法创建运行组：

• 自动

周期性任务的运行组（例如，用于 CFC）：在创建一个新 CFC 后，会自动生成一个新运

行组，且按照图表安装指针插入到运行顺序中。自动生成和手动创建运行组属性有以下

不同：

自动生成的运行组和图表构成一种依赖关系，这种关系一直维持到运行组的名称被修改。 
这个依赖关系确保了运行组和图表具有相同的名称。修改图表名称时，运行组的名称自

动更新。 
当这种依赖关系不再存在时（由于运行组名称的修改），自动生成的运行组和其它手动

插入的运行组的响应一样。

OB 100： 
如果使用具有启动特性的块，则它们不仅安装到循环 OB 中，还安装到 CFC 创建的运行

组的 OB 100 中。运行组中最多安装 10 个块。需要安装更多的块时，可创建更多运行组。

基于图表的运行组管理： 
当 CFC 中基于图表的运行组管理激活后，每个运行组最多 10 个块的规则不再适用。  
驱动程序生成器： 
创建模块驱动程序时，会同时创建带有“@...”标识符的运行组，并且这些运行组只能由驱

动程序生成器处理。 
基于图表的运行组管理：

如果在图表文件夹的属性中选择“基于图表插入”(Chart-based insertion) 选项，则在为具

有启动特性的实例化块新建 CFC 图表时，除了标准任务（例如，OB 1）中的运行组外，还

会在启动任务 OB 100 中自动创建相应的运行组。 
更多相关信息，请参见上文段落，“基于图表的运行组管理中的运行组”。   

• 手动

通过菜单命令“新建”(Create New) 或“复制”(Copy) 可随时手动创建运行组。复制并粘

贴到运行顺序中的运行组名称附加一个不带括号的连续编号。

创建新运行组 
为了创建运行组，按下面步骤进行：

1. 选择菜单命令“编辑 > 运行顺序...”(Edit > Run Sequence...) 或单击按钮

运行编辑器打开并显示运行顺序窗口。

2. 在左侧窗口中，选择要将运行组安装到的任务或作为运行组默认插入位置的对象。

3. 选择菜单命令“插入 > 运行组...”(Insert > Runtime Group...)。
将打开“插入运行组”(Insert Runtime Group) 对话框。
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4. 在相应的框中输入名称和注释。
可以大写或小写字母输入名称。

5. 输入运行属性值。如果目标系统不支持此功能，将禁用“缩小比率”(reduction ratio) 和“相
位偏移”(phase offset) 属性并显示为灰色。

6. 如有必要，可修改预设选项：

– 优化运行顺序（相关信息，请参见：优化运行顺序 (页 194)部分）

– 激活（运行组在测试模式下处于激活状态）

例外：F 系统的程序将总是设置为“激活”状态。

7. 单击“确定”(OK) 关闭对话框。
将在所需点插入运行组。

命名运行组

该名称的最大长度是 22 个字符。

建议只使用 18 个字符以便为自动重命名预留一些空间，例如，复制期间通过自动添加字符串

“(1)”以避免名称冲突。

运行组 命名约定

标准运行组

（基于图表（托管）或非基于图表

（非托管））

图表名称作为运行组名称。

扩展运行组

（其它循环 OB 中的扩展运行组）

带扩展名“_x”（其中 x 为 1、2、3、4 等）后缀的图表名

称作为运行组名称。

故障安全运行组 带扩展名“_F”后缀的图表名称作为运行组名称。

说明

如果复制期间名称已存在：

如果复制运行组并粘贴，则带“(x)”（其中 x 为 1、2、3、4 等）后缀的图表名称将作为所复

制运行组的名称。

例如：

如果存在名为“ChartName”的运行组，并且若创建了此运行组的副本，则复制的运行组名称为

“ChartName(1)”，因为名称“ChartName”已存在。此外，如果再次粘贴（创建另一个副

本），则下一个复制的运行组将命名为“ChartName(2)”。但是，如果从“ChartName(2)”运行

组创建副本，则复制的运行组将命名为“ChartName(2)(1)”。
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说明

如果复制期间超出了名称的最大长度：

如果复制名称具有 22 个字符（最大长度）的运行组并粘贴，则所复制的运行组名称将从该

字符串的末尾缩短，直到可以附加“~(x)”（其中 x 为 1、2、3、4 等）。

例如：

如果存在名为“ChartNameMotorControlA”（22 个字符）的运行组，并且若创建了此运行组

的副本，则复制的运行组名称为“ChartNameMotorCont~(1)”。
在名称已存在的情况下，根据命名的一般规则，新名称应为“ChartNameMotorControlA(1)”
（25 个字符），但这超出了 22 个字符的最大允许长度。因此，使用上述方法将名称缩短为 22 
个字符。

编辑运行组

1. 选择左侧或右侧窗口中的运行组，然后
选择菜单命令“编辑”(Edit) >“对象属性...”(Object Properties...)。

2. 在“属性 - 运行组”(Properties - Runtime Group) 对话框中，修改现有值（名称、注释、相位
偏移和缩小比率）。

请勿编辑带有“@...”标识符的运行组。这些对象是生成模块驱动程序时创建的，只能由驱动

生成器控制。当不再需要时，将由驱动程序生成器再次删除。

您可以编辑 OB100 (@@OB100@@...) 中由系统创建的运行组。

说明

重命名运行组

• 如果重命名运行组，图表名称不会改变。

• 如果重命名图表，新图表名称将指定为标准运行组的名称。
注意：对于非基于图表的（非托管）运行组，这仅适用于重命名标准运行组的情况。非托管
图表的标准运行组重命名重命名后，图表的重命名将不会对运行组名称产生任何影响。

激活和禁用运行组

通过选中/取消选中运行顺序中的“激活”(Active) 复选框激活或禁用供编辑使用的运行组。此

功能只影响没有互连的运行组。
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删除运行组

只能删除不包含对象的运行组。 
1. 选择运行组，然后

选择菜单命令“编辑 > 删除”(Edit > Delete) 或按 <Del> 键。

2. 使用菜单命令“编辑”(Edit) >“删除空运行组”(Delete Empty Runtime Groups)，在确认提示
后可删除当前 S7 程序的所有空运行组。

说明

如果删除的运行组被选为“在此之后作为插入位置”，默认的插入位置将移到被删除的

组之前的任务的下一个元素或移动到任务的开始（如果没有其它元素存在）。

10.11.9 针对 CFC 块的基于图表的运行组管理

概述

组态期间，将针对“标准程序”在周期性任务中自动安装 CFC 的块。此外，将根据块类型

的任务列表将块安装到相应的运行组中。 
CFC 和运行组的定义彼此独立，因为其中编程了块调用的运行组没有对 CFC 的明确引用。即

使在创建 CFC 时，隐式创建了相应的运行组并在该组中设置了对运行组或块的“安装指针”，

亦如此。 
此外，也无法保证一个 CFC 的块仅包含在一个运行组中。 
基于图表的运行组管理

对于“基于图表的运行组管理”，将在基于图表的单独运行组中自动管理 CFC 的块。这意

味着，CFC 的块将在永久且唯一分配给此 CFC 的运行单元中进行组织。 
• 这要求在图表文件夹或 CFC 的属性中启用“基于图表插入”(Chart-based insertion)。更多

相关信息，请参见下文段落，“集成新的 CFC ...”。 
• 将 CFC 分配给运行组：

对于集成了基于图表的运行组管理的 CFC，“标准程序”的运行组与此 CFC 的名称相同。 
运行组中关联 CFC 的名称在运行编辑器中用括号括了起来，可据此识别运行组到 CFC 的
分配。 
此 CFC 的运行组中不能包含其他 CFC 的块。 
根据 CFC 中使用的块创建相应的运行组。 
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• 为 CFC 的运行组命名：

为周期性任务中标准程序的运行组分配 CFC 的名称。 
周期性任务的运行组接收到标准程序的名称，后缀为下一个可用数字，例如“(1)”。 
当重命名基于图表的运行组管理 CFC 时，将同时重命名关联的运行组。 

• 具有启动特性的块：

为具有启动特性的实例化块创建图表时，会在启动任务 OB 100 中自动创建一个相应的运

行组。OB 100 中 CFC 的运行组将基于 CFC 的名称自动接收到下一个可用名称。 
• 效果： 

– 改善了每个 CFC（SCD - 选择性下载到 PLC）的下载单元的处理并通过更好的概览对每

个独立图表进行了本地执行优化。 
– 如果使用 F 块，则将自动管理标准和 F 程序。

– 因此，CFC 的程序彼此独立管理，尽管它们的块在 CFC 的数据流图表中一起显示。

• 共存；

集成了激活的基于图表的运行组管理的 CFC 可与其中未集成的 CFC 共存于一个项目中。 
• “选择性下载”功能的要求：

基于图表的运行组管理为可选项，但要使用 CFC/SFC 的“选择性下载”功能，则必须使

用该管理。 
选择性下载仅适用于基于图表的运行组管理已激活的图表。在该图表的运行组中插入 CFC 
的新块，可以减少在选择性下载中还需要包括的关联图表的数量。 

使用 F 块：

当 F 块也在集成于基于图表的运行组管理的 CFC 中使用时，不仅会在“标准程序”中自动

创建块的运行组，还会在“F 程序”中为所包含的 F 块创建运行组。 
• 在这种情况下，无需再手动将 F 块移至单独的运行组中。 
• F 块的运行组名称包含 CFC 的名称和后缀“_F”。 

在运行编辑器中显示

运行编辑器中运行组的显示取决于相应的 CFC 中是否已激活基于图表的运行组管理。

未激活相应 CFC 的基于图表的运行组管理。 
已激活相应 CFC 的基于图表的运行组管理。 
未激活含有 F 块的相应 CFC 的基于图表的运行组管理。 
已激活含有 F 块的相应 CFC 的基于图表的运行组管理。 
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在基于图表的运行组管理中集成、移植和管理 CFC
• 集成新 CFC

当选择了图表文件夹属性中的“基于图表插入”(Chart-based insertion) 选项后，新的 CFC 
创建后可自动激活基于图表的运行组管理。 
对于使用 PCS 7 V8.1 及更高版本创建的 PCS 7 项目，自动启用"基于图表插入"(Chart-based 
insertion) 选项。对于使用 V8.1 之前的版本创建的现有 PCS 7 项目，该选项仅适用于启

用选项后新创建的图表。在图表文件夹的属性中启用后，此选项可对图表文件夹中的所

有图表产生影响。

• 移植现有 CFC
不会自动激活现有 CFC 的基于图表的运行组管理。 
可在 SIMATIC Manager 中使用图表文件夹或各个图表的快捷菜单中的菜单命令“图表 > 基
于图表的运行组管理”(Charts > Chart-based runtime group management) 执行此操作。

关联的运行组也将自动修改。 
可以移植整个图表文件夹或数个选定的图表。 
自 PCS V6.x 起，除周期性运行组外，还会在 OB 100 中自动创建运行组。这些运行组中

最多放置 10 个块。为降低选择性下载的依赖性，应根据图表创建或重新排序 OB 100 中
的运行组。切换到基于图表的运行组管理所需的工作量少于之前的版本。不过，事先应

确定减少对选择性下载的依赖性是否可证实恢复 OB 100 中现有运行组所需工作量的合理

性。

说明

移植后的运行组 
将 CFC 移植到基于图表的运行组管理期间，关联的运行组也将自动修改。执行该步骤操

作后，还可导致运行组为空且不再包含于基于图表的运行组管理中。在 OB 1 和 OB 100 中
不会自动删除这些运行组。可在 CFC 运行编辑器中通过菜单项“编辑 > 删除空运行组”(Edit 
> Delete Empty Runtime Groups) 删除空运行组。  
移植期间不会在循环中断中创建空运行组，因为这些空运行组会移植期间发生转换。   

• 删除 CFC
如果删除基于图表的运行组管理已激活的 CFC，则会将所有块和所有关联运行组一并删

除。 
• 重命名 CFC

如果重命名基于图表的运行组管理已激活的 CFC，则将重命名所有关联运行组。关联运

行组的所有名称由 CFC 名称和为此附加的数字构成。 
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从基于图表的运行组管理中移除 CFC
也可禁用 CFC 中已激活的基于图表的运行组管理。  
可在 SIMATIC Manager 中使用图表文件夹或各个图表的快捷菜单中的菜单命令“图表 > 基
于图表的运行组管理”(Charts > Chart-based runtime group management) 执行此操作。

可通过此命令禁用图表文件夹或单个选定图表的基于图表的运行组管理。 

说明

转换前，请注意需要启用基于图表的运行组管理才能使用 CFC/SFC 的“选择性下载”功能。

 

复制 CFC
在 SIMATIC Manager 中复制 CFC 时，包含在图表中的块的所有运行属性基本保持不变。 
• 复制集成了基于图表的运行组管理的 CFC 时，CFC 副本的基于图表的运行组管理也保持

激活状态，即使未在关联图表文件夹中选择“基于图表插入”(Chart-based insertion) 选项

也是如此。  
• 复制基于图表的运行组管理已禁用的 CFC 后，其副本中的该项设置也保持禁用状态。 

移动 CFC
在 SIMATIC Manager 中，移动基于图表的运行组管理已激活的 CFC 时，其操作与上述 CFC 复
制操作相似。   
在工厂层级移动 CFC 时，只会更改 PH 节点的分配。移动的 CFC 本身保持不变。  

在 CFC 间移动块 
• 在基于图表的运行组管理处于未激活状态的两个 CFC 之间执行移动操作： 

在基于图表的运行组管理处于未激活状态的 CFC 之间移动块时，只会更改图表关联性。块

的运行属性（即运行组）不更改。 
• 在基于图表的运行组管理处于激活状态的两个 CFC 之间执行移动操作： 

块会安装到已分配给目标图表并从之前 CFC 的运行组中移除的运行组中。
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• 将块从未集成基于图表的运行组管理的 CFC 中移动到集成了基于图表的运行组管理的 CFC 
中：  
可以进行此更改。 

• 将块从基于图表的运行组管理已激活的 CFC 中移动到未集成基于图表的运行组管理的 CFC 
中：

可以进行此更改。

 

移动和复制运行组

• 移动

在集成了基于图表的运行组管理的 CFC 中，只能在 CPU 中以及两个周期性任务之间移动

关联的运行组。

• 复制

不支持复制基于图表的运行组管理已激活的 CFC 中的运行组。

但是，可以如前所述复制未集成基于图表的运行组管理的 CFC 中的运行组。

在运行组之间移动和复制块调用

移动块调用：

• 从集成了基于图表的运行组管理的 CFC 的运行组中移动：

仅当目标运行组属于相同 CFC 的另一个周期性任务时，才可以移动集成了基于图表的运

行组管理的 CFC 的运行组的块调用。 
在任务下，可以直接移动集成了基于图表的运行组管理的 CFC 的运行组中的块调用。随

即会自动创建该 CFC 的另一个运行组。   
• 在未集成基于图表的运行组管理的两个 CFC 的运行组之间执行移动操作：

在未集成基于图表的运行组管理的 CFC 的运行组间移动块调用时，只会更改块的运行属性

（即，运行组）。图表关联不会更改。

• 从未集成基于图表的运行组管理的 CFC 的运行组中移动到集成了基于图表的运行组管理

的 CFC 的停机组中：

无法进行此更改。 
• 从集成了基于图表的运行组管理的 CFC 的运行组中移动到未集成基于图表的运行组管理

的 CFC 的停机组中：

由于目标运行组和 CFC 间没有明确关系，因此无法执行此更改。 
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复制块调用：

• 仅在将块调用复制到相同 CFC 的非周期性任务的运行组中时，才可复制集成了基于图表

的运行组管理中的 CFC 运行组的块调用。 
只有块要在不属于相关块类型的任务列表的其它非周期性任务中运行时，这部分内容才

有用。 
• 可以在未集成基于图表的运行组管理的 CFC 的运行组间复制块调用。

• 将块调用从未集成基于图表的运行组管理的 CFC 的运行组中复制到集成了基于图表的运

行组管理的 CFC 的停机组中以及相反操作： 
无法进行此更改。 

   

参见

各个图表的选择性下载 (页 421)

10.11.10 运行属性

属性  
一个运行组被分配以下属性：

• 使能属性 (页 494)
• 减速比 (页 499)
• 相位偏移 (页 495)
运行组将这些属性传递到它所包含的所有对象中。

创建运行组时，会分配这些属性。也可以后在对象属性中修改缩小比率和相位偏移。可通过

互连控制使能属性。

注意

使用减速比和相位偏移

如可能，仅在那些在自定义周期内（即，在循环中断中）运行的任务中使用缩小比率和相

位偏移。要非常小心地处理所有其它任务，特别是硬件中断 OB 和任何特殊 OB。在此，不

应更改默认设置“缩小比率=1”和“相位偏移=0”。
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10.11.11 块执行的显示

简介

在 CFC 中，会显示那些未执行的块。将通过块标题的运行属性字段进行显示。 

编辑模式

在编辑模式下（离线），通过以下形式对块进行标识：

• 块已执行（无标识）

以下块按上述方式标识：

– 其 EN 输入没有互连并被静态地设置为 1 的块。

– 位于没有互连且被静态激活的运行组中的块。

– 对其块 EN 及其运行组 EN 无 SFC 写访问的块。

• 块未执行（带感叹号的红色方块）

以下块按上述方式标识：

– 其 EN 输入没有互连并被静态地设置为 0 的块。

– 位于没有互连且被静态禁用的运行组中的块

– 在测试模式下：与 EN 块或 EN 运行组的互连写入“0”时。

• 块执行不确定（带问号的黄色方块）

以下块按上述方式标识：

– 以上列出项中未包含的块（例如，由于其 EN 已互连或有 SFC 访问［或者其运行组已

互连或存在 SFC 写操作］），以及其执行状态不是静态的块。
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测试模式

在测试模式（在线）中，CFC 获得块和运行组的使能值并将其用于控制显示。此处有两种状

态：

• 块已执行 

（无标识）如果块的 EN 和组的 EN 设置为“1”。
• 块未执行 

（带感叹号的红色方块）如果块的 EN 或组的 EN 设置为“0”。

10.11.12 CFC 中的处理

10.11.12.1 处理 CFC 编辑器中的块

处理 CFC 编辑器中非托管图表中的块

• 复制/实例化（来自库）

块安装指针可确定主插入位置。将其设置为插入的块或最近插入的块（多个块的情况下）。

• 移动（限在同一个 CPU 中）

块将移动到新图表。运行顺序不变。

• 删除

块安装指针设置为运行顺序中前面的块。

处理 CFC 编辑器中托管图表中的块

• 复制

不考虑块安装指针。在运行顺序中，将块插入到标准运行组中最近的前一个块之后。

• 实例化（来自库）

块安装指针可确定主插入位置。将其设置为插入的块。

• 移动（限在同一个 CPU 中）

块移动到目标图表并插入到标准运行组中。从源图表中删除块。

• 删除

块安装指针设置为运行顺序中前面的块。
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10.11.12.2 处理运行编辑器中的块

处理运行编辑器非托管图表中的块

• 复制

将块将插入选定的目标位置。

• 移动

将块将插入选定的目标位置。如果块安装指针在源图表中设置为已移动的块，则它将移

动到原有对象的块。 
• 删除

如果有其它插入，则删除块实例。最后一个插入位置无法删除。块安装指针设置为原有

对象的块。

处理运行编辑器托管图表中的块

• 复制

循环 OB 拒绝双重插入。可以在非循环 OB（例如，OB100）中进行附加插入。 
• 移动

块仅可在同一图表的运行组中插入目标位置。如果 OB 为目标位置，则会创建一个新的运

行组。拒绝图表外的目标位置。

• 删除

如果有其它插入，则删除块实例。最后一个插入位置无法删除。
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10.11.12.3 处理 SIMATIC Manager 中的图表

处理 SIMATIC Manager 中的非托管图表

• 复制/移动（目标位置无冲突）

在所选目标位置处的插入按照源（运行组的图形和名称）中指定的方式进行。如果出现

命名冲突，运行组名称将通过添加后缀 “(x)”（其中 x 是 1、2、3、4 等）自动解析。

在内部-AS 操作中，保留内部互连，外部互连（输入）转换为文本互连。

复制运行组属性。

与运行组的互连丢失。

• 复制/移动（使用“覆盖”）

在所选目标位置处的插入按照源（运行组的图形和名称）中指定的方式进行。如果出现

命名冲突，运行组名称将通过添加后缀 “(x)”（其中 x 是 1、2、3、4 等）自动解析。

在内部-AS 操作中，保留内部互连，外部互连（输入）转换为文本互连。

复制运行组属性。

处理 SIMATIC Manager 中的托管图表

• 复制/移动（目标位置无冲突）

在所选目标位置处的插入按照源（运行组的图形和名称）中指定的方式进行。如果出现

命名冲突，运行组名称将通过添加后缀 “(x)”（其中 x 是 1、2、3、4 等）自动解析。

在内部-AS 操作中，保留内部互连，外部互连（输入）转换为文本互连。

复制运行组属性。

不复制运行组的名称。

• 复制/移动（使用“覆盖”）

在所选目标位置处的插入按照源（运行组的图形和名称）中指定的方式进行。如果出现

命名冲突，运行组名称将通过添加后缀 “(x)”（其中 x 是 1、2、3、4 等）自动解析。

在内部-AS 操作中，保留内部互连，外部互连（输入）转换为文本互连。

目标位置中先前存在的外部互连丢失。 
在 CFC 编辑器中覆盖分层图表时，将保留外部互连。参数按设置中的设置执行（分层图表

的参数设置）。

说明

在 CFC 编辑器中，您可以使用“选项 > 自定义”(Options > Customize) 菜单项下的“复制/移
动”(Copy/Move) 菜单命令打开“复制/移动设置”(Settings for Copying/Moving) 对话框。通过

此对话框，您可以控制复制/移动块和图表时的行为。
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工艺组态 11
11.1 组态和管理控制模块

11.1.1 有关控制模块及其类型的基本信息

简介

组态控制模块类型和控制模块的方式可以与组态过程标签类型和过程标签的方式相同。控制

模块及其类型具有以下优势：

• 当类型与实例之间存在差异时，可使用同步。同步类型和实例时，实例特定的扩展会加

以管理，而且不会丢失。因此，可以在自动化系统中无扰动地加载更改。

有关同步的更多信息，请参见“用于同步控制模块类型及其实例的相关属性 (页 235)”部分。

• 控制模块类型可以包含可选块。如果创建了控制模块类型的不同实例，则可将可选块插

入不同版本的不同实例中。

• 使用控制模块类型和控制模块，可与工厂自动化加速器 (PAA) 进行扩展数据交换。

控制模块类型的组件

控制模块类型包含：

• 工艺接口。

可以任意包含以下对象：

– 子控制模块；可能多个

– 控制变量；可以包含多个以下对象： 
参数  
信号  

– 消息；可使用多个

– 命令；可使用多个

– 状态；可能多个

• 分配的 CFC 及其可能组件，例如，块、子图表。

更多相关信息，请参见“设备模块和控制模块的数据对象概述 (页 294)”部分。
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创建控制模块的类型和实例

可以在 SIMATIC Manager 中通过项目库的工厂视图创建控制模块类型，或直接在 CFC 编辑

器中创建控制模块类型。此外也可以通过转换过程标签类型得到。

下图给出了将控制模块类型创建为新模块类型或通过从过程标签类型移植来创建控制模块类

型以及创建关联实例的概览。

 
类型和实例的命名

• 主数据库中控制模块类型的名称必须唯一，这点与工厂设备模块的类型一样。 
• 控制模块类型与主数据库中的以下对象共享名称空间：  

– 工厂设备模块的类型

– 全局命令和状态 
因此，控制模块与工厂设备模块类型不能同名。

• 控制模块类型的名称： 
该名称的最大长度是 22 个字符。 
建议只使用 18 个字符以便为自动重命名预留一些空间，例如，复制期间通过自动添加字

符串“(1)”以避免名称冲突。
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说明

如果复制期间名称已存在：

如果复制图表并粘贴，则带“(x)”（其中 x 为 1、2、3、4 等）后缀的图表名称将作为所复制

图表的名称。

例如：

如果存在名为“ChartName”的图表，并且若创建了此图表的副本，则复制的图表名称为

“ChartName(1)”，因为名称“ChartName”已存在。此外，如果再次粘贴（创建另一个副

本），则下一个复制的图表将命名为“ChartName(2)”。但是，如果从“ChartName(2)”图表创

建副本，则复制的图表将命名为“ChartName(2)(1)”。

说明

如果复制期间超出了名称的最大长度：

如果复制名称具有 22 个字符（最大长度）的图表并粘贴，则所复制的图表名称将从该字符

串的末尾缩短，直到可以附加“~(x)”（其中 x 为 1、2、3、4 等）。

例如：

如果存在名为“ChartNameMotorControlA”（22 个字符）的图表，并且若创建了此图表的副

本，则复制的图表名称为“ChartNameMotorCont~(1)”。
在名称已存在的情况下，根据命名的一般规则，新图表名称应为

“ChartNameMotorControlA(1)”（25 个字符），但这超出了 22 个字符的最大允许长度。因

此，使用上述方法将名称缩短为 22 个字符。

有关创建新控制模块类型的更多信息，请参见“如何创建控制模块类型 (页 217)”部分。

有关创建新控制模块实例的更多信息，请参见“如何创建控制模块实例 (页 220)”部分。

有关通过移植来创建控制模块类型的信息，请参见“过程标签类型移植器帮助”。

编辑控制模块类型

控制模块类型及其关联实例可在 CFC 编辑器（工艺编辑器）中各自的窗口内进行编辑。

更多相关信息，请参见“编辑控制模块类型 (页 218)”和“编辑控制模块实例 (页 221)”部分。
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复制和移动控制模块时的特性

• 移动控制模块时以下特性适用： 

所需操作 操作是否适用？

在两个 PH 层级文件夹之间移动 ✓
从项目中移动到主数据库（组件视图） -
移动到另一个图表文件夹（组件视图） 在同一子项目的不同 CPU 之间移动时可用。

 
• 复制控制模块时以下特性适用： 

所需操作 操作是否适用？

在两个 PH 层级文件夹之间复制 ✓
从 PH 层级文件夹复制到主数据库（工厂层

级）

✓
注：在此会在主数据库内从实例中创建一个

新类型

控制模块类型的可选块和互连

可在控制模块类型中将块定义为可选，这意味着创建关联的控制模块时，可为每个实例选择

可选块和互连。 
示例：工艺编辑器中带可选块的控制模块类型
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控制模块类型的其它特性

• 在控制模块类型中，可通过将多个互连拖放到一个输入处定义备选路径；而该操作在 CFC 
中不支持。执行该操作的前提条件是，在待组态为互连目标的控制模块类型中，激活“可

选”(Optional) 属性。 
• 在 CFC 编辑器中，属于控制模块类型定义的元素（例如块和参数）用绿色突出显示。为

此，可以自定义所用的颜色。

11.1.2 如何创建控制模块类型

要求

已使用  SIMATIC Manager 创建带主数据库的多项目。
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步骤

要在 SIMATIC Manager 中创建控制模块类型，请按以下步骤操作：   
1. 在项目中打开库。

2. 使用菜单命令“视图 > 工厂视图”(View > Plant view) 切换到工厂视图。

3. 右键单击文件夹选择菜单命令“插入新对象 > 控制模块类型”(Insert new object > Control 
module type)。
随即插入控制模块类型，系统会为其分配一个默认名称，您可根据自己的意图更改该名称。 

结果

已创建控制模块类型。可以在新窗口中指定控制模块类型的结构，并在 CFC 中分配相应的

对象或属性。

更多相关信息，请参见“编辑控制模块类型 (页 218)”部分。

11.1.3 编辑控制模块类型

要求

至少创建了一个控制模块类型。有关创建控制模块类型的更多信息，请参见“如何创建控制

模块类型 (页 217)”部分。

在 CFC 编辑器中编辑控制模块类型 
如果是首次创建或打开控制模块类型，则将在 CFC 编辑器中打开新的编辑窗口。此工艺编

辑器提供以下操作选项：  
工艺编辑器的左侧部分显示了以层级方式排列的控制模块类型的对象。 
可以在此处编辑以下对象：

• 控制模块

• 作为控制变量：

– 信号

– 参数

• 消息

• 命令

• 状态
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可以通过快捷菜单创建、复制和删除这些对象。要创建这样一个对象，请通过右键单击较高

级别的控制模块打开快捷菜单，然后选择一个新对象。也可以通过拖放将块从 CFC 编辑器

插入到该控制模块的层级中。

说明

有关组态消息的信息，请参见“设备模块和控制模块的数据对象概述 (页 294)”部分中的“控

制模块或子控制模块消息的组态注意事项”说明。

  
属性和分配位于工艺编辑器的右侧部分。显示的属性取决于在左侧窗口中选择的对象。根据

属性，可以通过从 CFC 编辑器拖放自由文本或通过下拉菜单填充文本域。无法编辑灰显的框。

有关各属性的更多信息，请参见“控制模块的属性和属性值 (页 224)”部分。

控制变量“参数”和“信号”的数据类型

控制变量的变量类型为“参数”或“信号”，具体取决于为其分配的块 I/O。 
只有 REAL、BOOL、INT 和 DINT 数据类型对“信号”变量类型有效，因为这些数据类型定

义了 I/O 通道请求。  
有关故障安全控制模块的数据类型，请参见“AUTOHOTSPOT”。
然而，分配的驱动程序块中的数据类型也可能为 BYTE 或 WORD（对于原始值）。在这种情

况下，数据类型映射如下：

• 驱动程序块中的 BYTE 相当于控制变量中的 BOOL
• 驱动程序块中的 WORD 相当于控制变量中的 REAL

工厂自动化加速器 (PAA) 中函数的交换

例如，可以使用 PAA 中的简单函数为控制模块组态互锁逻辑。在与 PAA 进行数据交换后，这

些函数即映射到控制模块。AND、OR、XOR 和 NOT 函数/标准函数已在 PCS 7 中预先定义。

如果已创建控制模块，则可以在模板目录的“模板”(Templates) 选项卡上使用这些函数。

用户也可以定义其它函数/标准函数。这通过创建一个控制模块来实现，该模块具有与 PAA 中
的定义完全对应的接口。控制模块和控制变量的名称以及它们的数据类型必须精确匹配。必

须选中“函数”(Function) 属性对应的复选框。PCS 7 特定的函数执行在相应的 CFC 中定义。 
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函数连同标准数据类型可分配给一般数据类型 ANY_BIT、ANY_NUM、ANY_REAL 或 
ANY_INT。这些数据类型通过控制变量的“数据类型”(Data type) 属性显示在工艺编辑器中。

如果在 CFC 中将一般数据类型的控制变量分配给某个块 I/O，则以下规则适用：

• ANY_BIT 被分配 BOOL、BYTE、WORD 或 DWORD。
• ANY_NUM 被分配 REAL、INT 或 DINT。
• ANY_REAL 被分配 REAL。
• ANY_INT 被分配 INT 或 DINT。
只能分配满足上述规则的块 I/O。用户必须手动执行分配。

CFC 编辑器中的显示

• 在 CFC 编辑器中，控制模块采用颜色编码。下列对象会被标记： 
– 属于控制模块类型的块和互连

– 可选的块和互连

– 分配给控制模块类型的连接

为此，可以自定义所用的颜色。为此，请选择“选项 > 自定义 > 颜色...”(Options > 
Customize > Colors...)。在下一个“颜色设置”(Color Settings) 对话框中，选择“对象”
(Objects) 下的“控制模块类型块和 I/O”(Blocks and I/Os of the control module type) 对
象。

• 不属于标准函数的块在 CFC 编辑器中也采用颜色代码。

为此，可以自定义所用的颜色。为此，请选择“选项 > 自定义 > 颜色...”(Options > 
Customize > Colors...)。在接下来的“颜色设置”(Color Settings) 对话框中，选择“对象”
(Objects) 下的“函数”(Function) 对象。

• 对于面向类型更新忽略了值属性的块参数，在 CFC 编辑器中采用颜色编码。

为此，可以自定义所用的颜色。为此，请选择“选项 > 自定义 > 颜色...”(Options > 
Customize > Colors...)。在接下来的“颜色设置”(Color Settings) 对话框中，选择“对象”
(Objects) 下的“忽略类型更新的值”(Ignore value for type update)。

11.1.4 如何创建控制模块实例

要求

• 用户已在多项目的主数据库中创建控制模块类型。

• 已在控制模块类型中定义了可选的控制模块。
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步骤

要在 SIMATIC Manager 中创建控制模块实例，请按以下步骤操作：

1. 打开“工厂视图”(Plant View) 中的主数据库。

2. 右键单击层次结构文件夹（主数据库）中的控制模块类型，然后在快捷菜单中选择“复制”
(Copy)。
或者，选择控制模块类型，然后按键盘上的 Ctrl+C。

3. 右键单击要在其中创建已复制控制模块类型的实例的工厂层级文件夹（项目），然后在快捷
菜单中选择“粘贴”(Paste)。
或者，选择层级文件夹，然后按键盘上的 Ctrl+V。

还可通过将控制模块类型从主数据库拖放到工厂层级文件夹（项目）中，轻松创建控制模块

实例。

结果

随即创建控制实例，系统会为其分配一个默认名称，可根据自己的意图更改该名称。

可以通过实例化类型以及复制现有实例来进一步创建多个实例。

更多相关信息，请参见“编辑控制模块实例 (页 221)”部分。

11.1.5 编辑控制模块实例

要求

至少创建了一个控制模块实例。有关创建控制模块实例的更多信息，请参见“如何创建控制

模块实例 (页 220)”部分。

在 CFC 编辑器中编辑控制模块实例

控制模块实例的编辑方式类似于控制模块类型。有关编辑控制模块类型的更多信息，请参见

“编辑控制模块类型 (页 218)”部分。

控制模块实例的常规行为

控制模块实例源自其对应的控制模块类型。因此，不能在实例中更改源自控制模块类型的对

象。但是，可以在实例中另外插入块和互连（通常称为“实例特定的块”和“实例特定的互

连”）。可以更改在实例中额外插入的对象。
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更改实例的块参数

可以更改实例特定的块的块参数。

在以下情况下，也可以更改源自控制模块类型的实例的块参数：

• 参数是控制模块接口（即工艺 I/O）的一部分。

• 这些参数不包括在类型实例同步中（即“粉色”(Pink) 参数）。

• 这些参数与操作系统中的操作员监控 (OCM) 相关（系统属性“S7_m_c”=TRUE）。

11.1.6 在控制模块的类型中组态命令或状态

简介

命令和状态只能在控制模块的类型（不是实例）中定义。 
命令和状态通过名称标识，可以有多个名称。可以在工艺编辑器中单独或统一选择和复制。 
有关命令和状态的更多信息，请参见“设备模块和控制模块的数据对象概述 (页 294)”部分。

要求

已在主数据库中创建控制模块类型。

步骤

1. 在 CFC 编辑器中，打开主数据库中的控制模块类型。 
2. 在工艺编辑器中选择控制模块类型的图标。

3. 从快捷菜单中选择“插入新对象”(Insert new object) 命令。
快捷菜单中将显示所有可用对象。 

4. 选择“命令”(Command) 或“状态”(Status) 菜单命令。
所选对象随即插入并显示为图标。 
– 命令

– 状态 

自动为新状态创建名称为“OUT”的下级“参数”对象。该参数的数据类型为 BOOL，用

作形式输出参数。 
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5. 在工艺编辑器中选择“命令”(Command) 或“状态”(Status) 的图标。
将显示相关属性。 
组态属性，例如名称、注释和作者。 

6. 在工艺编辑器中选择“命令”(Command) 或“状态”(Status) 的图标。 
在快捷菜单中，选择菜单命令“属性”(Properties)。 
将打开“属性”(Properties) 对话框。 
对于“命令”(Command)，对话框的结构与步组态对话框的结构相似；对于“状态”(Status)，
对话框的结构与转移条件组态对话框的结构相似。

7. 为命令或状态组态所需的条件。 
还可以使用“浏览”(Browse) 按钮打开选择对话框。所有可使用的参数（即，只要标识符为
“S7_contact = true”的块 I/O）都会显示在此对话框中 
有关详细信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部分。

8. 选择需要的参数。单击“应用”(Apply) 按钮以应用之前在“属性”(Properties) 对话框选择的行
中的所选参数。 
在“属性”(Properties) 对话框中，将自动选择下一行条件，且选择对话框保持打开状态。根
据需要，重复此步骤来组态其它条件。 
单击“关闭”(Close) 关闭选择对话框。

9. 单击“关闭”(Close) 关闭“属性”(Properties) 对话框。 
如果需要，将显示应用组态的提示。确认此提示。

结果

命令和/或状态已在控制模块类型中定义。 
下级参数可能也已为这些对象选择性地插入。 
自动为状态创建名称为“OUT”的参数。

11.1.7 实现特定命令/状态的特别注意事项

概述

简介

可通过如下方式定义命令/状态：

• 在控制模块的类型（而不是实例）中定义，或在“控制模块（基本要求）”中定义。

这些命令和状态特定于这些对象。

• “全局”定义，即使用 SIMATIC Manager 在主数据库中定义。

“特定”命令/状态的条件

在以下条件下，下文关于实现“特定”命令和状态的说明适用： 
• 命令/状态为控制模块类型的下级元素
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实现的配置 
如果以上条件之一适用，则以下实现是必需的。

• 在具有下级命令/状态的基本要求或控制模块类型中，块类型在“分配的块”属性中配

置。 
块类型可在基本要求或控制模块类型的“分配的块”属性中进行选择。 

• 这意味着，在下级命令/状态中只能使用 ID 为“S7_contact = true”且属于该分配的块类型

的块 I/O。

参见

在控制模块的类型中组态命令或状态 (页 222)
设备模块和控制模块的数据对象概述 (页 294)

11.1.8 控制模块的属性和属性值

属性和属性值

在工艺编辑器的左侧部分中，控制模块或工厂设备模块中的对象在树形结构中以层级方式显

示，例如“参数”(Parameter) 或“消息”(Message)。 
右侧部分列出了当前在树中所选对象的属性。 
 
有关所有后续表格中“数据交换”列的说明

该列指示某个属性是否包含在与工厂自动化加速器 (PAA) 进行的数据交换中。
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较高级别控制模块的属性

属性的显示取决于在工艺编辑器中打开的是控制模块的类型还是实例。 

属性 属性值的说明 数据交换

分配的图表 不可编辑 -
名称 可编辑

转发给相关对象。

获取所分配图表的名称作为默认值。

类型的原始名称始终存储在实例中。如果实例的名称和类

型的名称相同，则类型的名称更改会自动传递给实例。

✓

注释 可编辑

转发给相关对象。

-

操作图标 可编辑

根据分配转发到块的块图标（用于 WinCC）。

-

作者 可编辑

不转发给相关对象。

-

版本 可编辑 ✓
功能标识符 可编辑

传递给工艺编辑器中分配的对象，例如块。

传感器/执行器/控制器级（过程变量）上的控制模块 (CM) 
通常使用工厂标识码或公司特定代码等标准命名。在整个

工厂中，CM 名称是唯一定义的。设备控制的缩写通常由

过程变量号补充，例如 M301、VlvL402 等。

除了 CM 名称（过程变量名称）之外，功能标识符 (FID) 
还支持使用编码标准或公司特定代码描述 CM 的功能。典

型示例包括 PIC、TIC、GAS702 等。功能标识符可以替代

分配给工艺块名称属性的 CM 名称。在这种情况下，如果

块属性中启用了“OCM 可用”（操作员控制和监视）选

项，则功能标识符将被转发到操作员站 (OS)。

-

位置标识符 可编辑

转发给所分配图表的 DOCPRO 页脚“符合位置的代码字

段”。

-
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属性 属性值的说明 数据交换

采样时间 (ms) 可编辑

所分配图表的所有块均已安装在 OB 中并配有最适合的采

样时间。输入内容无效时，将输入稍大的最小有效值。

运行时编辑器会相应地调整。

✓

F 程序采样时间 (ms) 可编辑

当在 CFC 中至少使用一个 F 块时，可以选择性地显示此属

性。 
如果 CFC 中已激活基于图表的运行组管理，则相应的运行

组将用于 F 程序。

✓

函数 可在类型中编辑

用于将控制模块标识为函数。

-

函数名称 显示函数名称。

• 无法在控制模块的类型中编辑。

当“函数”属性启用时，“名称”属性的值将自动应

用。 
• 可在实例中编辑。

-

基本要求 可编辑

仅适用于类型。

函数不能是基本要求。 

✓
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属性 属性值的说明 数据交换

控制模块类型 不可编辑

不转发。

-

支持类型实例行为 可编辑

对于控制模块类型的每个实例，此属性的默认设置为 
TRUE。这意味着实例与其类型链接，并且包含在类型实例

同步中。

可通过禁用此属性来有选择地从类型实例同步中排除实

例。为某一实例禁用此属性不会消除对该类型的内部引用

及与该类型的关系。这样即可编辑实例，而无论其类型如

何。

可以通过激活此属性将实例包含在类型实例同步中。激活

此属性可重新建立实例与其类型之间的链接，从而将实例

包含在类型实例同步中。

备注：

• 仅在例外情况下（例如，测试、调试、选择或逐步更新

实例时）禁用此属性。

• 长时间禁用此属性可能导致实例与其类型不一致。因

此，在同步工厂类型之前，请检查差异。

✓

 

下级控制模块的属性

属性 属性值的说明 数据交换

分配的块 不可编辑 -
名称 可编辑

转发给相关对象。

获取默认值“控制模块”。

✓

注释 可编辑

传递给工艺编辑器中分配的对象，例如块。

-

操作图标 可编辑

根据分配转发到块的块图标（用于 WinCC）。

-

可选 为此控制模块的选项激活选中复选框。 ✓
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属性 属性值的说明 数据交换

设为默认选项 仅在“可选”(Optional) 属性激活后才可编辑

如果为某一类型的某个控制模块激活此属性，则该可选控

制模块（CM 变型）将默认激活，同时创建该类型的实例。

-

作者 可编辑

不转发给相关对象。

-

函数 可在类型中编辑

用于将控制模块标识为函数。

-

函数名称 显示函数名称。

• 无法在控制模块的类型中编辑。

当“函数”属性启用时，“名称”属性的值将自动应

用。 
• 可在实例中编辑。

-

控制模块类型 不可编辑

显示控制名称。

-

 

“信号”/“参数”对象的属性

属性 属性值的说明 数据交换

分配的 I/O 不可编辑 -
互连到 可编辑

显示互连。

✓

引用 CM 参数 可编辑

可以绝对或相对寻址。

与“信号”不相关。 

✓

引用块变量 可编辑

可以绝对或相对寻址。

与“信号”不相关。

✓

引用全局变量 可编辑

可以绝对或相对寻址。

与“信号”不相关。

✓
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属性 属性值的说明 数据交换

名称 可编辑

不转发。

✓

注释 可编辑

属性值被转发到分配的块参数。

可以通过“分配”(Assignment) 列中的输入字段对块参数进

行多次分配。

将备注从 PAA 导入 PCS 7 时，更改的备注会自动转发到分

配的块参数。

✓

信号 可编辑

右键单击文本域并使用菜单命令“新信号互连”(New Signal 
Interconnection) 打开 CFC 的符号表。此值将转发到所分

配 I/O 的“互连”属性。

✓

值 可编辑

转发给所分配 I/O 的“值”属性。

该属性不适用于“信号”。

✓

范围下限值 可编辑（在类型中） 
仅与“REAL”数据类型的模拟信号（输入和输出信号）相

关。 
对于二进制信号，输入字段将被锁定。

与“参数”不相关。

✓

范围上限值 可编辑（在类型中） 
仅与“REAL”数据类型的模拟信号（输入和输出信号）相

关。 
对于二进制信号，输入字段将被锁定。

与“参数”不相关。

✓

取反 选中此复选框可对控制变量取反。仅当存在互连时才能选

中该框。

注：

只有当“取反”(Negation) 属性的值为 TRUE 时，才能进行

数据交换。

如果通过手动编辑 XML 文件将“取反”(Negation) 属性的

值设置为 FALSE，则不会写入 XML 中的条目。

✓
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属性 属性值的说明 数据交换

文本 0 可编辑

转发给所分配 I/O 的“文本 0”属性。

只有在编辑其系统属性设置为 S7_string_0 且数据类型

为“BOOL”的 I/O 时，此选项才可见。 

✓

文本 1 可编辑

转发给所分配 I/O 的“文本 1”属性。

只有在编辑其系统属性设置为 S7_string_1 且数据类型

为“BOOL”的 I/O 时，此选项才可见。

✓

枚举 通过下拉菜单选择

转发给所分配 I/O 的“枚举”属性。 
仅当为 I/O 分配系统属性 S7_enum 时，此选项才可见。

✓

单位 通过下拉菜单选择

对于信号：

单元仅与“REAL”数据类型的模拟信号相关。

除单元文本外，还会在方括号中显示符合“过程控制设备

规约”标准的唯一标识号。

自动转发到 CFC 程序中相关通道块的单位参数。

对于参数：

通常与“INT”数据类型的独立单位参数相关。

参数值必须优先设置为符合“过程控制设备规约”标准的

唯一标识号。请注意，在这种情况下，“单位”(Unit) 特性

为空。

或者，可以使用属性“单位”(Unit) 通过文本组态单元。在

这种情况下，“值”(Value) 属性必须设置为 0。请注意，传

统参数仅可使用特性“单位”(Unit) 通过文本进行组态。

✓

操作标识符 可编辑

转发给所分配 I/O 的“标识符”属性。为此必须组

态 s7_shortcut 属性。

✓

IO 类型 通过下拉菜单选择

必须与所分配 I/O 的 IO 类型相匹配。

-
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属性 属性值的说明 数据交换

数据类型 通过下拉菜单选择

必须与所分配 I/O 的数据类型相匹配。

✓

变量类型 “信号”或“参数”（通过下拉菜单选择）。 
转发给所分配的 I/O。

✓

控制模块类型 不可编辑 -

“消息”对象的属性 

属性 属性值的说明 数据交换

分配的消息 不可编辑 -
名称 可编辑

不转发给相关对象。

获取默认值“消息”。

✓

消息类别 不可编辑

此值继承自所分配单个消息的属性“消息类别”(Message 
class)。

-

优先级 可编辑

只能使用数字。输入内容无效时，将输入值“0”。会转发给

所分配单个消息的“优先级”属性。

✓

消息标识符 必须手动指定。

如果输入了有效的消息标识符（例如，SIG1），则只要所

分配的块有消息响应，就会自动应用消息类别、事件和来

源属性。

-

事件 不可编辑

继承自所分配单个消息的“事件”属性。

-

信息 会转发给所分配单个消息的“信息文本”属性。 -
来源 会转发给所分配单个消息的“来源”属性。 -
单个确认  可编辑

如果消息应作为单个消息确认，则选中该复选框。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对
话框中编辑该属性。

✓
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属性 属性值的说明 数据交换

需要确认 可编辑

如果生成的消息需要确认，则选中此复选框。此复选框是

否选中，决定了在“PCS 7 消息组态”(PCS 7 message 
configuration) 对话框的“消息类别”(Message class) 列是

只显示可确认的那些类别还是不能确认的那些类别。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对
话框中编辑该属性。

✓

触发操作 可编辑

选中该复选框后，此消息将触发标准的“GMsgFunction”，
可通过 PCS 7 的“全局脚本”编辑器来编辑该函数。该函

数可在“全局脚本”的函数浏览器中的“标准函数/报警”
(Default functions/alarm) 下找到。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对
话框中编辑该属性。

✓

OS 区域 不可编辑

从中可指定消息的区域分配。

如果未指定文本或区域或已定义为关键字 $$AREA$$，则

在通过 OS 编译传输数据时，将会对层级文件夹的相应属

性进行评估并将其存储在 OS 消息文本中。 
可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

批生产 ID 不可编辑

从中可指定消息的批生产 ID
如果输入批生产 ID 的关键字 @1%s@，在通过 AS-OS 连接

组态传输数据时，将对相应属性进行评估并将其作为“批

生产名称”存储在 OS 消息文本中。

可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

 

说明

由于对其它属性的依赖性，可能无法编辑某些属性。
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“命令”对象的属性

属性 描述 数据交换

名称 可编辑

不转发。

获取默认值“命令”。

✓

注释 可编辑

不转发。

✓

作者 可编辑

不转发给相关对象。

✓

 

“状态”对象的属性

属性 描述 数据交换

名称 可编辑

不转发。

获取默认值“状态”。

✓

注释 可编辑

不转发。

✓

作者 可编辑

不转发给相关对象。

✓

 

“分配”列

根据工艺编辑器左侧的所选对象，可以在“分配”(Assignment) 列中将图表、块、块 I/O（参

数/信号）或消息分配给所选对象的属性。

可通过从 CFC 编辑器中进行拖放来分配块和参数。可通过在所选字段的快捷菜单中选择“添

加图表 CM”(Add Chart CM) 菜单命令来分配图表。

参见

设备模块对象的属性 (页 318)
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11.1.9 比较并同步控制模块的类型和实例

简介

创建实例时，控制模块的类型和实例是相同的。 
类型或其相关实例发生更改时，可能需要同步类型和实例。 
比较和同步

同步期间，会将项目中某一类型的所有实例与主数据库中的相应类型做比较。这样可显示出

控制模块的类型与其实例（过程工程级）之间以及 CFC（程序级）等相关对象之间的差别。 
与同步相关的属性和关系成为比较结果的一部分。另一方面，通常在实例中修改的属性和关

系将从比较中排除，不会显示在比较结果中。

比较结果的显示基于工厂层级节点下方的控制模块实例。因此，除了上述对象，比较对话框

中还将显示控制模块的高级对象。这些对象仅作为导航或定向之用。

说明

自 CFC V9.0 起，工艺对象（例如控制模块 (CMT)）的类型实例同步需要 V9.0 及更高版本的 
VXM 许可证。 
有关同步的更多信息和说明，请参见“有关工艺对象类型实例同步的说明 (页 377)”部分。   

包括的对象

工厂级控制模块的类型和实例的同步中包括以下下级对象：

• 子控制模块

• 控制变量：

– 参数

– 信号

• 消息

• 命令和状态

说明

控制模块类型同步期间的二进制值符号文本行为

只有为 CFC 块（例如互锁块）块参数的类型中的“文本 0”(Text 0) 或“文本 1”(Text 1) 属性

输入文本时，二进制值（BOOL 数据类型）的符号文本才会在实例中同步。如果块参数的类

型中的这些属性存在空格或空字符串，则此块参数的“文本 0”(Text 0) 或“文本 1”(Text 1) 不
会同步。
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步骤

1. 在工厂视图中选择项目。

2. 打开快捷菜单并选择菜单命令“设备类型 > 同步...”(Plant types > Synchronize...)。 
打开“同步设备类型”(Synchronize plant types) 对话框。 

3. 在表的左侧列中，选择想要比较和同步的控制模块或设备模块的类型。

4. 单击“同步...”(Synchronize...) 按钮启动比较。 
比较中仅包括相关属性和关系。更多相关信息，请参见“用于同步控制模块类型及其实例的
相关属性 (页 235)”部分。 

5. 显示比较结果。
比较结果中将突出显示以下对象： 
– 实例中添加的对象（例如子函数、消息、函数和函数块）将标记为附加对象。 
– 已删除对象。

– 属性已修改的对象。 
6. 在比较结果中，根据相应类型选择要同步的实例。 

选中或清除对话框左侧相应对象旁边的复选框。 
7. 通过“同步模板”(Synchronize templates) 图标启动同步。 

将同步所选实例。
如果实例特定的扩展没有应用到类型的对象，则会得以保留。 

结果

已完成控制模块的类型与其实例之间的比较，并且已同步所选实例。

有关类型/实例同步的更多信息，请参见“控制模块的类型/实例同步的更改效果 (页 238)”部
分。  

11.1.10 用于同步控制模块类型及其实例的相关属性

简介

对类型及其实例执行身份检查以同步控制模块及其类型。此检查限制为根据类型实例概念不

会在实例中修改的属性和关系。     
对这些属性和关系进行精确比较后才能在类型和实例之间同步，以确保兼容性和一致性。 
结果的比较和显示

与同步相关的属性和关系成为比较结果的一部分。另一方面，通常在实例中修改的属性和关

系将从比较中排除，不会显示在比较结果中。

PCS 7 中提供了数据传送对话框来显示用于同步的比较结果。在此对话框中启动实际的同步

过程。
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比较结果的显示基于工厂层级节点下方的控制模块实例。因此，除了上述对象，比较对话框

中还将显示控制模块的高级对象。这些对象仅作为导航或定向之用。

与同步相关的属性和关系的总览

下表列出了所有对象及其要同步的属性和关系：

对象 相关属性  相关关系

控制模块 - • 分配的块（块实例或子 CFC）
• 分配的名称

• 分配的注释

• 分配的功能标识符

• 分配的块图标

控制变量 • 取反（仅限互连的输入）

• 名称

• 变量类型（参数/信号）

• 数据类型

• 注释

• 操作标识符

• 单元

• 枚举

• 互连

• 分配的 I/O（块变量）

消息 • 名称

• 消息标识符

分配的消息

块实例 • 名称

• S7_mes
• 块类型（函数/函数块）

块类型（函数/函数块的实例）
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对象 相关属性  相关关系

块变量/块 I/O • 取反（仅限互连的输入）

• 名称

• 注释

• I/O 类型

• 数据类型

• 值

• S7_edit
• S7_visible
• S7_mes
• S7_archive
• S7_enum
• S7_string0
• S7_string1
• S7_shortcut
• S7_unit

互连源

子 CFC • 名称

• 版本

• 作者

 - 

CFC 的接口  -  - 
CFC 的
接口参数

• 名称

• 注释

• I/O 类型

• 数据类型

• 值

• S7_edit
• S7_visible
• S7_mes
• S7_archive
• S7_enum
• S7_string0
• S7_string1
• S7_unit

 

块消息 • 消息标识符

• 消息类型

 

子消息 消息标识符（子消息编号）  
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参见

有关控制模块及其类型的基本信息 (页 213)

11.1.11 控制模块的类型/实例同步的更改效果

概述

可以从现有和实例化的控制模块中添加、编辑或删除块、互连、I/O 和消息。可通过执行同

步将这些更改传递给控制模块的现有相应实例。 

说明

在类型实例同步中排除实例

如果在工艺编辑器中实例的“支持类型实例行为”(Support type instance behavior) 属性未激

活，则实例不会与其类型同步。

更多相关信息，请参见“控制模块的属性和属性值 (页 224)”部分。

同步期间的响应取决于： 
• 更改的类型（参数值、互连）

• 更改的位置（类型或实例）

• 已修改参数的属性：

– 工艺 I/O 中的参数

– OS 相关参数的“S7_m_c”属性

– 其它属性，例如“注释”(Comment) 等。 
特别是，如果满足下列任一条件，则不会从类型实例同步中隐式排除块参数：

• “S7_m_c”属性 = TRUE。
• “S7_contact”属性 = TRUE。
• 参数位于工艺 I/O 内。

• 参数在外部互连。

工艺组态

11.1 组态和管理控制模块

SIMATIC S7 中的 CFC (V9.0 SP7)
238 功能手册, 05/2022, A5E41356112-AH



• 参数由驱动程序生成器管理。

• 参数被标记为“粉色”(Pink) 参数（即，对于类型更新，该参数值将被忽略）。

说明

在类型实例同步中排除块参数

可使用“类型更新设置”(Type update settings) 选项卡从类型实例同步中显式排除块参数

的各种属性（例如，值、注释、标识符、单位等）。

更多相关信息，请参见““属性 - 块/图表”对话框，“类型更新设置”选项卡 (页 492)”
部分。

说明

“浅绿色”和“粉色”参数的系统行为

分配给某工艺类型（CM、EM 或 EPH）的工艺接口的块参数（即，工艺 I/O 中的块参数）以

“浅绿色”突出显示。通常针对每个实例分别对此类参数进行参数设置，因此，此类参

数的值从类型实例同步中隐式排除。

值属性设置为忽略类型实例同步的块参数以“粉色”突出显示。此类参数的值从类型实

例同步中排除。

如果块参数同时处于工艺 I/O 中，则将参数值设置为从类型更新中忽略，块参数将以“浅

绿色”突出显示。在这种情况下，行为和功能特性均得到保证。如果参数以“浅绿色”

突出显示，则属性将从工艺 CM 参数传播到分配的块参数（或反之）。如果参数以“浅

绿色”、“粉色”或同时以这两种颜色突出显示，则该参数值将从类型实例同步中排除。

说明

同步控制模块的类型和实例时的系统行为

可在 http://support.automation.siemens.com 的条目 ID 99861834 下找到有关在控制模块

的类型和实例之间进行同步期间的系统行为的详细信息。
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下表的图例

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

操作或更改的简要描述

 
如果同步前只在控制模块的类型中进

行更改，此单元格将包含同步后实例

中的结果描述。 

如果同步之前已在实例中进行更改，

此单元格将包含同步的效果描述。

备注：

• 原则上，在类型基础上进行实例化

的对象更改通常会在实例中被拒

绝。

• 原则上，直接添加到实例中的对象

更改通常不会同步到类型中。此等

更改称为“实例特定性更改”。

 

注意

未提到的对象和属性

对于此描述中未提到的对象和属性，在项目中执行类型实例同步之前，必须验证这些对象

和属性是否符合项目的要求。 

控制模块类型 CFC 中的更改

当插入新 FB 和/或 FC 块时，下列内容通常适用于同步行为：

• 如果新插入对象置于控制模块类型的主运行组中，同步时，它们会直接插入到实例中与

类型相同的前一个块之后。

• 实例中的插入指针会被忽视并且不会更改。

此规则的例外情况在下表中描述。

不会同步下列内容： 
• 对象的图形属性，如块位置、互连的图形历史

• 文本域

• FB/FC 块代码中的更改。这些更改通过“更新块类型”功能同步。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操作

更改运行顺序

 
不会同步此更改。 
必须在实例中手动合并此更改。

备注： 
可以使不同的前一个块显现在比较对

话中。启动同步时，在“同步工厂类

型”(Synchronize plant types) 对话框

中选择“包含运行顺序”(with run 
sequence) 选项。

不会同步此更改。 
必须在实例中手动合并此更改。

备注： 
可以使不同的前一个块显现在比较对话中。

启动同步时，在“同步工厂类型”
(Synchronize plant types) 对话框中选择

“包含运行顺序”(with run sequence) 选项。

插入块

 
在实例中插入对象。

实例中的对象和类型中的对象具有相

同的前一个块。

在实例中保留对象。

（实例特定性更改）

删除块

 
从实例中删除对象。 • 如果对象位于类型中：

在实例中再次创建对象。实例中的对象和

类型中的对象具有相同的前一个块。

• 否则（实例特定性更改）：

对象仍保持删除状态。

插入子控制模块

 
在实例中插入对象。 
实例中的对象和类型中的对象具有相

同的前一个块。

在实例中保留对象。

（实例特定性更改）

删除子控制模块

 
从实例中删除对象。 • 如果对象位于类型中：

在实例中再次创建对象。实例中的对象和

类型中的对象具有相同的前一个块。

• 否则（实例特定性更改）：

对象仍保持删除状态。

插入子图表

 
在实例中插入对象。

实例中的对象和类型中的对象具有相

同的前一个块。

在实例中保留对象。

（实例特定性更改）

删除子图表

 
从实例中删除对象。 • 如果对象位于类型中：

在实例中再次创建对象。实例中的对象和

类型中的对象具有相同的前一个块。

• 否则（实例特定性更改）：

对象仍保持删除状态。

更改图表注释 保留实例中的文本。 保留实例中的文本。
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说明

有关插入位置的限制

如果在类型中新插入对象并将其置于单独运行组的首位，类型/实例同步后，实例中的新对

象安装不正确。 
如果在类型中新插入对象，将其组态为“可选”并置于单独运行组的任何给定位置，则在实

例中激活变型时，该对象安装不正确。

同步后需要在实例中检查插入位置，必要时进行调整！ 

 

工艺 I/O 中的更改

• 工艺 I/O 中的对象

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操作

插入块

 
在实例中插入对象。 在实例中保留对象。 

备注：新对象到内部对象的互连被视为同步的

外部互联，因此不会更改。 
删除块

 
从实例中删除对象。 • 如果对象位于类型中：

在实例中再次创建对象。

• 否则（实例特定性更改）：

对象仍保持删除状态。

插入参数

 
参数插入到实例的工艺 I/O 中。 • 如果参数插入到工艺 I/O 的顶层或由类型得

到的子控制模块之下：

采用类型的设置。 
• 如果参数插入到工艺 I/O 的实例特定性子控

制模块之下：

保留实例中的设置。

备注：实例特定性参数不允许置于顶层。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操作

删除参数

 
参数从实例的工艺 I/O 中删除。 • 如果从工艺 I/O 的顶层或由类型得到的子控

制模块之下位置删除参数：

在实例中再次创建参数。

• 否则（实例特定性更改）：

参数仍保持已从工艺 I/O 中删除的状态。 
更改参数注释 参数注释显示在同步结果中，由实例

的类型采用相关文本。 
在类型的注释字段为空时，同步结果

中不会指示差异。 

无法实现实例特定的参数注释。

参数注释显示在同步结果中，由实例的类型采

用相关文本。 

插入信号

 
信号插入到实例的工艺 I/O 中。 • 如果信号插入到工艺 I/O 的顶层或由类型得

到的子控制模块之下：

采用类型的设置。 
• 如果信号插入到工艺 I/O 的实例特定性子控

制模块之下：

保留实例中的设置。 
备注：实例特定性信号不允许置于顶层。

删除信号

 
信号从实例的工艺 I/O 中删除。 • 如果从工艺 I/O 的顶层或由类型得到的子控

制模块之下位置删除信号：

在实例中再次创建信号。

• 否则（实例特定性更改）：

信号仍保持已从工艺 I/O 中删除的状态。 
插入子控制模块

 
在实例中插入对象。 在实例中保留对象。 

备注：新对象到内部对象的互连被视为同步的

外部互联，因此不会更改。 
删除子控制模块 从实例中删除对象。 • 如果对象由类型得来：

在实例中再次创建对象。

• 否则（实例特定性更改）：

对象仍保持删除状态。

插入子图表

 
在实例中插入对象。 在实例中保留对象。 

备注：新对象到内部对象的互连被视为同步的

外部互联，因此不会更改。 
删除子图表

 
从实例中删除对象。 • 如果对象由类型得来：

在实例中再次创建对象。

• 否则（实例特定性更改）：

对象仍保持删除状态。
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• 工艺 I/O 中的“可选”(Optional) 属性

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

为工艺 I/O 中的对象分配“可选”
(Optional) 属性。

对象在实例中保持可见并且在变型中

激活。 
备注：因对话框不可用而无法在实例

中执行。 
为工艺 I/O 中的对象删除“可选”
(Optional) 属性。

如果对象尚未激活，则在实例中可

见。 
对象不再位于“变型”中。 

备注：因对话框不可用而无法在实例

中执行。 

将对象拖入工艺 I/O 中的类型

中，并为对象分配“可选”
(Optional) 属性。 

对象在实例中保持可见并且在变型中

未激活。 
如果该选项激活，则实例中的对象是

重复的，但不会在顺序中正确安装。

建议避免此操作。 

备注：因对话框不可用而无法在实例

中执行。 

 

更改值和互连

 
• 输入参数的值更改

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

更改工艺 I/O 中输入参数的值。 保留实例中的值。 保留实例中的值。

更改带有“S7_m_c”属性的输入

参数的值

保留实例中的值。 保留实例中的值。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

更改设置了“忽略值”(Ignore 
value) 属性的输入参数值（“粉

色”(Pink) 参数）

保留实例中的值。 保留实例中的值。

 

其它参数的值更改 类型的值传递到实例。 类型的值传递到实例。

 

 
• 内部或外部互连

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

将外部互连添加到工艺 I/O 中的

“参数”(Parameter) 对象

实例中无更改。

不应用类型互联。

备注：

此操作无法在类型中执行。

实例中无更改。

不应用类型互联。

为工艺 I/O 中的“信号”对象添

加外部互联（IO 变量）

实例中无更改。

不应用类型互联。

备注：

此操作无法在类型中执行。

实例中无更改。

不应用类型互联。

添加内部互连 
- 以及工艺 I/O 中的两个参数

应用类型互连。

互联如在实例中存在，则将被覆盖。

• 如果类型中存在互联：

将覆盖实例中的互联。

• 否则（实例特定性更改）：

保留实例中的互联。

删除内部互联 
- 以及工艺 I/O 中的两个参数

删除实例中的互连。 • 如果类型中存在互联：

该实例中无法删除互连。

• 否则（实例特定性更改）：

实例中的互联仍保持已删除状态。

添加内部互连

- 仅工艺 I/O 中的输入参数

实例中无更改。

不应用类型互联。

实例中无更改。

不应用类型互联。

删除内部互联 
 - 仅工艺 I/O 中的输入参数

实例中无更改。

不应用类型互联。

实例中无更改。

实例中的互联仍保持已删除状态。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

添加内部互连

- 非工艺 I/O 中的输入参数

应用类型互连。 备注：该实例中无法创建互连。

删除内部互联 
 - 非工艺 I/O 中的输入参数

删除实例中的互连。 备注：该实例中无法删除互连。

添加内部互连

 - 如果参数带有“S7_m_c”属性

应用类型互连。 • 如果类型中存在互联：

应用类型互连。

• 否则（实例特定性更改）：

互联从实例中删除。

删除内部互联

 - 如果参数带有“S7_m_c”属性

删除实例中的互连。 • 如果类型中存在互联：

应用类型互连。

• 否则（实例特定性更改）：

实例中的互联仍保持已删除状态。

在“粉色”输入参数上添加内部

互连

实例中无更改。

不应用类型互联。

实例中无更改。

不应用类型互联。

在“粉色”输入参数上删除内部

互连

实例中无更改。

不应用类型互联。

实例中无更改。

实例中的互联仍保持已删除状态。

添加另一个内部互连 应用类型互连。 • 如果类型中存在互联：

应用类型互连。

• 否则（实例特定性更改）：

互联从实例中删除。

删除另一个内部互联 删除实例中的互连。

 
• 如果类型中存在互联：

应用类型互连。

• 否则（实例特定性更改）：

实例中的互联仍保持已删除状态。

说明

用于数据交换的内部 CM 互连

同步模板时，实例上的内部 CM 互连仅在派生自相应 CM 类型的情况下才会显示在数据传输

对话框中。

但是，将数据从 PAA 传输到 PCS 7 或将数据从 PCS 7 传输到 PAA 时，从类型派生的内部 CM 
互连在数据传输对话框中显示属性“互连是类型的副本”(Interconnection is a copy of type)。
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块属性的更改

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操

作

情形：在同步之前在实例中执行了操

作

更改块组 保留实例中的文本。 保留实例中的文本。

更改块注释 保留实例中的文本。 保留实例中的文本。

更改“块图标”(Block icon) 类型的设置不传递到实例。 不更改实例中的设置。

更改“允许 OMC”(OCM 
possible)（块）

类型的设置不传递到实例。 不更改实例中的设置。 

更改“操作员授权级别”
(Operator authorization level)
（块）

类型的设置不传递到实例。 不更改实例中的设置。

更改“MES 相关”(MES-relevant)
（块）

类型的设置传递到实例。 将设置从类型传递到实例。（= 重置）

更改块的消息类别 类型的设置不传递到实例。 保留实例中的设置。

更改“启用回读”(Readback 
enabled)（块）

类型的设置传递到实例。 将设置从类型传递到实例。（= 重置）

 

块 I/O 属性的更改

 

操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操作 情形：在同步之前在实例中执行了

操作

更改“枚举”(Enumeration)
（块 I/O） 

• 如果类型中的“枚举”(Enumeration) 
字段为空，通常保留该实例中的输

入。

• 如果类型中的“枚举”(Enumeration) 
字段包含文本，通常将该文本信息传

送到实例中。

• 如果类型中的“枚举”
(Enumeration) 字段为空，通常

保留该实例中的输入。

• 如果类型中的“枚举”
(Enumeration) 字段包含文本，

通常将该文本信息传送到实例

中。

更改“单元”(Unit) 
 - 工艺 I/O 中的参数上

实例中无更改

不应用类型单元。

实例中无更改

不更改单元。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操作 情形：在同步之前在实例中执行了

操作

更改“单元”(Unit)
 - 在带有“S7_m_c”属性的参数上

实例中无更改

不应用类型单元。

实例中无更改

不更改单元。

更改“单元”(Unit)
 - 其它参数

• 如果类型中的“S7 单元”(S7_unit) 字段

为空，则该实例中相应的输入通常保

持不变。

• 如果类型中的“S7 单元”(S7_unit) 字段

不为空，则通常将字段中的内容传送

到实例中。

• 如果类型中的“S7 单元”
(S7_unit) 字段为空，则该实例

中相应的输入通常保持不变。

• 如果类型中的“S7 单元”
(S7_unit) 字段不为空，则通常

将字段中的内容传送到实例中。

更改“标识符”(Identifier)（块 I/
O）

如果类型中的“标识符”(Identifier) 字段

为空，则该实例中相应的输入通常保持

不变。 

如果类型中的“标识符”(Identifier) 
字段为空，则该实例中相应的输入

通常保持不变。 
更改“文本 0”(Text 0) 或“文

本 1”(Text 1)（块 I/O）

• 如果类型中的“文本 0”(Text 0) 或
“文本 1”(Text 1) 字段为空，则该实

例中相应的输入通常保持不变。

• “空”状态时的注意事项： 
如果块中控制模块内类型内没有显式

输入，则该块中“文本 0”(Text 0) 和
“文本 1”(Text 1) 字段将视为“空”。

• 如果类型中的“文本 0”(Text 0) 或
“文本 1”(Text 1) 字段包含文本，通

常将该文本信息传送到实例中。

• 如果类型中的“文本 0”(Text 0) 
或“文本 1”(Text 1) 字段为空，

则该实例中相应的输入通常保

持不变。

• “空”状态时的注意事项： 
如果块中控制模块内类型内没

有显式输入，则该块中“文本 
0”(Text 0) 和“文本 1”(Text 1) 
字段将视为“空”。

• 如果类型中的“文本 0”(Text 0) 
或“文本 1”(Text 1) 字段包含文

本，通常将该文本信息传送到

实例中。
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操作 同步后实例中的结果 
情形：在同步之前在类型中执行了操作 情形：在同步之前在实例中执行了

操作

更改“不可见”(Invisible)（块 
I/O） 

• 类型的“可见”(visible) 设置传递到实

例。

• 只有在“同步工厂类型”
(Synchronize plant types) 窗口中选

择了“使用图形坐标”(with graphic 
coordinates) 选项时，类型的“不可

见”(invisible) 设置才会传输到实例。

• 类型的“可见”(visible) 设置传

递到实例。

• 只有在“同步工厂类型”
(Synchronize plant types) 窗口

中选择了“使用图形坐标”(with 
graphic coordinates) 选项时，

类型的“不可见”(invisible) 设
置才会传输到实例。

 
 

更改“归档”(Archive)（块 I/O） • 如果设置类型中的“归档”(Archive) 
设置为“不归档”(No archiving)，则

该类型的“归档”(Archive) 设置不会

应用到该实例中且该实例中的设置保

持不变。

• 如果设置类型中的“归档”(Archive) 
设置为“归档”(Archiving) 或“长期

归档”(Long-term archiving)，则该类

型的“归档”(Archive) 设置将应用到

该实例中。

• 如果设置类型中的“归档”
(Archive) 设置为“不归档”(No 
archiving)，则该类型的“归档”
(Archive) 设置不会应用到该实

例中且该实例中的设置保持不

变。

• 如果设置类型中的“归档”
(Archive) 设置为“归档”
(Archiving) 或“长期归档”
(Long-term archiving)，则该类

型的“归档”(Archive) 设置将应

用到该实例中。

说明

同步系统属性 S7_archive
如果在项目库中的 CMT 块上更改了系统属性 S7_archive 并执行类型同步，CMT 的所有实例

都将继承该属性。如果在实例中更改了该属性，将通过同步覆盖该属性。

参见

“属性 - 输入/输出”对话框 (页 500)
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11.1.12 控制模块硬件信号（I/O 变量）的信号处理

简介

本部分概括介绍了控制模块 (CM) 中硬件信号（I/O 变量）与信号/参数 (CV) 的信号处理以及

互连。
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要求

下列要求适用于 PCS 7 中的信号处理：

• 只有过程映像的地址才允许将 (I, Q) 用作 I/O 地址。

• 在 CFC 编辑器中，必须为每个要处理的输入和输出值定义“硬件信号”（I/O 变量）：  
– 硬件信号（I/O 变量）在 CFC 的过程变量中由表单栏中的图标（例如，“Feedback 

open”）和信号处理块（例如“Pcs7Diln”）表示。

– 硬件信号（I/O 变量）的名称由表单栏中的输入内容确定，例如，“Feedback open”。
– 对于输入值，必须使用一个信号处理块（“通道驱动程序”）来将硬件信号（I/O 变

量）的原始值转换成标准化值。标准化值将在信号处理设备的相应的输出（例如，

“PV_Out”）处输出以便进行进一步处理。 
输出值反之亦然。 

– 通常，每个硬件信号（I/O 变量）只使用一个信号处理块。 
 下图显示了输入值的硬件信号（“I/O 变量”）的示例。 
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概述 
控制模块的信号 (CV) 与硬件信号（I/O 变量）的互连

只有确定相关信号处理块（通道驱动程序）后，才可以将控制模块的信号 (CV) 与硬件信号（I/
O 变量）互连。 
互连的起点始终是控制模块的信号 (CV)。互连的目标是相关信号处理块的输入或输出。使

用工艺编辑器中的“取反”属性来取反信号之间的互连。 
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下列块输入或输出可以连接到硬件信号（I/O 变量）： 
• 变体 1： 

硬件信号分配至信号处理块的输入（通道块）：

在此情况下，所选硬件信号直接分配至通道块的输入。这种互连是通过工艺编辑器中的

信号 (CV) 实现的。

组态：

– 通过将通道块输入从 CFC 编辑器拖放到工艺编辑器中的“已分配 I/O”(Assigned I/O) 属
性的“分配”(Assignment) 字段，将通道块输入分配给信号 (CV)。

– 右键单击“信号”(Signal) 属性的“属性值”(Attribute value) 字段，并在工艺编辑器中

选择硬件信号，可将硬件信号的符号名称分配给信号 (CV)。
信号 (CV) 的信号属性值决定硬件信号。信号 (CV) 的 I/O 分配将硬件信号分配给通道块的

输入，从而建立起硬件信号与通道块输入间的互连。

示例：

在工艺编辑器中，控制模块信号 (CV)“FeedbackOpened”具有以下分配：

– 通道块的输入 (FbkOpen.PV_In) 分配至“已分配 I/O”(Assigned I/O) 属性。

– 硬件信号（符号名称：Feedback open）分配至“信号”(Signal) 属性。

• 变体 2：
硬件信号分配至工艺块的输入（驱动、控制或监视块）：

在此情况下，通过确定互连的通道块，将所选择硬件信号分配至工艺块的输入。这种互

连是通过工艺编辑器中的信号 (CV) 以及 CFC 编辑器中工艺块和通道块之间的互连实现的。

组态：

– 在 CFC 编辑器中，通道块的输出和工艺块的输入之间互连。
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– 通过将工艺块输入从 CFC 编辑器拖放到工艺编辑器中的“已分配 I/O”(Assigned I/O) 属
性的“分配”(Assignment) 字段，将工艺块输入分配给信号 (CV)。

– 右键单击“信号”(Signal) 属性的“属性值”(Attribute value) 字段，并在工艺编辑器中

选择硬件信号，可将硬件信号的符号名称分配给信号 (CV)。
通道块和工艺块之间的互连决定用于硬件信号的通道块。信号 (CV) 的信号属性值决定分

配至确定通道块输入的硬件信号。信号 (CV) 的 I/O 分配将硬件信号分配给工艺块的输入，

从而通过确定的通道块建立起硬件信号与工艺块输入间的互连。

示例：

在 CFC 编辑器中，通道块的输出 (FbkOpen.PV_Out) 与工艺块的输入 
(Valve.FbkOpen) 互连。

在工艺编辑器中，控制模块信号 (CV)““FeedbackOpened”具有以下分配：

– 工艺块的输入 (Valve.FbkOpen) 分配至“已分配 I/O”(Assigned I/O) 属性。

– 硬件信号（符号名称：Feedback open）分配至“信号”(Signal) 属性。
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• 变体 3：
硬件信号分配至逻辑块的输入：

在此情况下，通过确定互连的通道块，将所选择硬件信号分配至逻辑块的输入。这个变

体还用于互连另一个控制模块的硬件信号。如果逻辑块和通道块在同一图表中，则此变

体的方法与变体 2 中描述的方法相同。如果逻辑块和通道块不在同一图表中，则需要将

两个控制模块互连。

组态：

– 第一个图表（带通道块和工艺块）中的组态与变体 2 所述相同。

– 在第二个图表中（带逻辑块），通过将逻辑块输入从 CFC 编辑器拖放到工艺编辑器中

“已分配 I/O”(Assigned I/O) 属性的“分配”(Assignment) 字段，将逻辑块输入分配到

参数 (CV)。
– 右键单击“信号”(Signal) 属性的“属性值”(Attribute value) 字段，并在工艺编辑器中

选择硬件信号，可将硬件信号的符号名称分配给参数 (CV)。
第一个图表的通道块输出和第二个图表的逻辑块输入自动互连。这是由于通道块已在第

一个图表中确定，同时两个图表中使用的硬件信号相同。因此，第二个图表（带逻辑块）

使用第一个图表中的确定通道块输出进行互连。在第二个图表（带逻辑块）中，参数 (CV) 
的 I/O 分配将硬件信号分配至逻辑块的输入。从而通过确定的通道块建立起硬件信号与逻

辑块输入间的互连。

示例：

第一个图表“ValveLean”中的组态与变体 2 所述相同。

在第二个图表“ValveLean1”中，控制模块参数 (CV)“Permit”在工艺编辑器中具有以下分

配：

– 逻辑块的输入 (Permit.In01) 分配至“已分配 I/O”(Assigned I/O) 属性。

– 硬件信号（符号名称：Feedback open）分配至“信号”(Signal) 属性。
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• 变体 4：
通道块未直接连接到工艺块时，硬件信号分配至工艺块的输入：

在此情况下，通过将通道块输入作为信号分配插入到工艺块输入，将所选择硬件信号分

配至工艺块的输入。这种互连是通过工艺编辑器中的信号 (CV) 以及 CFC 编辑器中工艺块、

中间块和通道块之间的互连实现的。

组态：

– 在 CFC 编辑器中，通道块的输出和中间块的输入之间互连，然后从中间块的输出连接

到工艺块的输入。

– 通过将工艺块输入从 CFC 编辑器拖放到工艺编辑器中的“已分配 I/O”(Assigned I/O) 属
性的“分配”(Assignment) 字段，将工艺块输入分配给信号 (CV)。

– 右键单击“信号”(Signal) 属性的“属性值”(Attribute value) 字段，并在工艺编辑器中

选择硬件信号，可将硬件信号的符号名称分配给信号 (CV)。
– 通过将通道块输入从 CFC 编辑器拖放到工艺编辑器中的“信号”(Signal) 属性的“分配”

(Assignment) 字段，将通道块输入作为信号 (CV) 的信号分配插入。

信号 (CV) 的信号分配决定通道块。信号 (CV) 的信号属性值决定分配至工艺块输入的硬

件信号。信号 (CV) 的 I/O 分配将硬件信号分配给工艺块的输入，从而通过信号 (CV) 的信

号分配直接建立起硬件信号与工艺块输入间的互连。
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示例：

在 CFC 编辑器中，通道块的输出 (FbkOpen.PV_Out) 与取反块的输入 (Negation.In) 
互连，取反块的输出 (Negation.Out) 连接到监视块的输入 (Monitoring_DI.In)。
在工艺编辑器中，控制模块信号 (CV)“FeedbackOpened”具有以下分配：

– 工艺块的输入 (Monitoring_DI.In) 分配至“已分配 I/O”(Assigned I/O) 属性。

– 硬件信号（符号名称：Feedback open）分配至“信号”(Signal) 属性。

– 通道块的输入 (FbkOpen.PV_In) 作为信号分配插入“信号”(Signal) 属性的“分配”
(Assignment) 字段中。

 
互连规则

当互连单一控制器的信号/参数 (CV) 与硬件信号（I/O 变量）时，要遵从特定的规则。

支持控制模块信号/参数 (CV) 之间的下列互连： 
• 参数作为输入 - 参数作为输出

• 参数作为输入 - 信号作为输出
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下列信号/参数 (CV) 可在工艺编辑器中通过“信号名称”(Signal name) 属性象征性地分配给

硬件信号（I/O 变量）。

• 作为输入的信号 
• 作为输入的参数

• 作为输出的信号

“BOOL”数据类型的互连或数字硬件信号（I/O 变量）的分配可以取反。 

11.1.13 以 XML 格式实施控制模块硬件信号（I/O 变量）的信号处理

简介

控制模块中的信号需要有关信号处理块和工艺块的信息，以便于能够支持控制模块信号的互

连。 
该信息以 XML 格式提供。 
以 XML 格式定义下列信息：

• 所有信号处理块（所谓的通道驱动程序）的条目

除块定义外，此处至少包含一个“原始值”-“标准值”分配。  
• 工艺块的条目 

除块定义外，此处定义该块（要访问 I/O 块的值，因此需要驱动程序连接）的所有 I/O。 
置备 
• 对于 PCS 7 高级过程库 (APL) 的通道驱动程序和块，此信息在“SignalBlocksAPL_8x.xml”文

件中以 XML 格式提供，该文件位于“<安装目录>\\Siemens\STEP7\S7data
\SignalProcessing”目录中。 

• 对于用户定义的驱动程序块或者不包含在 PCS 7 高级过程库 (APL) 中的驱动程序块，此信

息必须由用户以 XML 文件形式提供，该文件位于“<安装目录>\Siemens\STEP7\S7data
\SignalProcessing”目录中。  

针对这些用户定义的驱动程序块，下面以示例的形式显示 XML 格式的实施原则。

以 XML 格式实施的原则 
基于给定的具有很少块的组态示例，显示以 XML 格式实施的原则。 
对于用户定义的驱动程序块，示例的相应名称、值和类型必须替换为所需数据。  
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组态示例

组态示例仅需要几个块： 
• Pcs7DiIn：数字量输入的信号处理块

• Pcs7DiOu：数字量输出的信号处理块

• VlvL：阀控制（其具有需要驱动程序连接（通道请求）的 I/O）的工艺块 
  
下图显示控制模块的 CFC 中的块和信号流。 

2

1

1

1

2

2

2 1

 
块 I/O 的定义

下列表格显示示例中使用的块以及信号流中涉及的 I/O： 
• 信号处理块（通道驱动程序）Pcs7DiIn 和 Pcs7DiOu

下表显示每个信号处理块的原始值和标准化值（过程值）的 I/O。  
相应的 XML 名称显示在括号中。  
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信号处理块 原始值 
(RawValue)

标准化值 
(ProcessValue)

名称

(SignalBlock 
Name)

信号类型

(Signal 
Type)

数据类型 
(DataType)

I/O 名称

(RawValue 
Name)

I/O 类型

(Section)
I/O 名称

(RawValue 
Name)

I/O 类型

(Section)

Pcs7DiIn 输入 数字量 PV_In 输入 PV_Out 输出

Pcs7DiOut 输出 数字量 PV_Out 输出 PV_In 输入

 
• 工艺块 VlvL 的信号

下表显示来自示例的 I/O，该示例需要 VlvL 块的通道连接。

相应的 XML 名称显示在括号中。

工艺块名称 
(ProcessBlock Name)

信号名称

(Parameter 
Name)

I/O 类型 
(Section)

数据类型 
(DataType)

VlvL FbkOpen 输入 数字量

 FbkClose 输入 数字量

 Ctrl 输出 数字量

XML 格式示例组态的实施

表格显示对应于上表的块及其 I/O 的 XML 定义。  

<?xml version="1.0" encoding="utf-8"?>
<SignalBlocks Version="x.y" xmlns="http://www.siemens.com/
Simatic/PCS7/SignalBlocks/1.0">

<!-- Definition begin -->

  <SignalBlock Name="Pcs7DiIn">
    <Signal Type="Input" DataType="Digital">
      <RawValue Name="PV_In" Section="Input"/>
      <ProcessValue Name="PV_Out" Section="Output"/>
    </Signal>
  </SignalBlock>
  <SignalBlock Name="Pcs7DiOu">
    <Signal Type="Output" DataType="Digital">
      <RawValue Name="PV_Out" Section="Output"/>
      <ProcessValue Name="PV_In" Section="Input"/>
    </Signal>
  </SignalBlock>

<!-- Signal-processing blocks -->
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  <ProcessBlock Name="VlvL">
    <Parameter Name="FbkOpen" Section="Input" DataType="Digital"/
>
    <Parameter Name="FbkClose" Section="Input" 
DataType="Digital"/>
    <Parameter Name="Ctrl" Section="Output" DataType="Digital"/>
  </ProcessBlock>

<!-- Technological block and its 
I/Os -->

</SignalBlocks> <!-- Definition end -->

11.1.14 控制变量参数上的引用

简介

所谓的技术引用用于与工艺级别上（例如，PAA 中）的过程控制系统交换不完整的工厂描述

（包含到其它过程变量的已建立关系）。 
这些引用可用于参数，此参数被组态为控制模块（“CM”）或者工厂设备模块（“EM”）的控制

变量（“CV”）。 
引用不能用于信号。 
文本化互连与参数引用之间的差别

• 文本互连只能在一个块或图表输入处存在，并始终指向 CFC 中的块或图表输出。

文本互连只能指定为绝对互连，而不能指定为相对互连。 
• 参数上的引用可以引用其它过程变量的输入参数和输出参数。它在工艺级别上使用，并

且不能映射到 CFC 的文本化互连。 
参数引用可指定为绝对引用和相对引用。 

参数引用的类型

有几种类型的控制变量参数引用，每一种类型在参数的相应属性中进行组态： 
• 对控制模块/工厂设备模块参数的引用：“引用 CM 参数”属性

• 对块变量的引用：“引用块变量”属性 
• 对全局变量的引用：“引用全局变量”属性

说明

“控制变量的参数”表达

以下描述使用“控制变量的参数”这一表达作为“组态为控制模块/工厂设备模块的控制变

量的参数”的简称。“控制变量的参数”表达不是指控制模块或 CFC 的接口参数。
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概述

下面对以下各项进行了介绍： 
• 组态参数引用

• 参数引用的语法

• 数据交换的引用

• 引用的复制行为

• 完成打开的引用： 
– “引用 CM 参数”类型 
– “引用块变量”类型 
– “引用全局变量”类型 

组态、更改和删除参数引用

• 基于下面所描述的语法，可以在 PAA 中的工艺级别上和 CFC 的工艺编辑器中手动输入引

用。

– 要在 CFC 的工艺编辑器中创建新的引用，应在参数中选择所需属性，例如，“引用块

变量”(Reference block variable)。可以使用“新引用”(New Reference) 快捷菜单命令

输入引用。 
– 通过拖放操作创建“引用 CM 参数”：

可用鼠标将另一个控制变量的参数拖动到要组态的控制变量参数的“引用 CM 参数”
(Reference CM parameter) 字段中。将自动创建包含其它控制变量参数的路径信息的

引用。

说明

CFC 的块名称或块参数都不能用于在工艺编辑器中创建“引用 CM 参数”。相反，应

使用工艺编辑器中的块名称或块参数。   
如上文所述，仅控制变量的参数间才能提高拖放操作组态组态“引用 CM 参数”。为

此，所需控制模块/工厂设备模块的工艺编辑器必须可见。 

– 在 CFC 的工艺编辑器中，通过将光标置于所需参数属性上可更改现有引用。这会打开

一个对话框，可在其中编辑引用。 
– 要删除引用，在参数相应属性的快捷菜单中提供了命令。

• 对于要互连到控制模块/工厂设备模块的参数，也可相对于其自身层级节点定义该参数的

寻址。 
相对寻址通过字符串“..\”来启动，其层级基于具有参数（引用将组态到该参数）的控制模

块/工厂设备模块的参数。字符串“..\”从工厂层级中的此起始点开始向上寻址节点。“..\”字
符串会一直重复，直到到达源和目标参数之间的公共层级节点。然后开始向下寻址，直

到层级中的所需目标参数。 
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• 允许引用输入和输出端上的参数，这与互连不同。 
– 在输入端，引用只能组态为值或互连。

– 在输出端，可组态多个引用。 
这种情况下，可同时使用各种类型的引用：“引用 CM 参数”、“引用块变量”和“引

用全局变量”。

说明

在控制模块或工厂设备模块的输入端，通常不允许添加多个 CM 引用的互连；但在特殊

情况下，可以添加多个互连。

可选子 CM 的多个输出的“引用 CM 参数”属性可引用同一个 CM 输入。此时，不允许

在同一个 CM 实例中同时启用可选子 CM 的多个块；否则，同步这些 CM 时将导致严重

冲突。

• 不支持对 STRUCT 数据类型的从属元素的引用。

• “引用块变量” 
通常，在工程级别上（例如，PAA 中）的两个参数间进行互连。然而，为了避免在 PCS 7 
端重新组态并且必须通知工艺级别上的所有 CFC 块变量，CFC 块变量也可直接连接到控

制变量的参数。为此，引用组态到控制变量参数上的块变量。 

在工艺级别 PAA 和 CFC 的工艺编辑器中，可根据 PCS 7 语法直接输入对 CFC 块变量参数

的引用（包括工厂层级的路径）。

通常，已经在工程级别（例如 PAA）上进行输入。 
以下选项可用于在 CFC 的工艺编辑器中组态“引用块变量”(Reference block variable)： 
– 手动输入： 

使用工厂层级，对控制模块/工厂设备模块中实际参数的引用可输入为绝对项目路径。 
手动输入的引用不会进行语法或语义检查，未经验证即被保存！ 
还会自动尝试关闭对于块变量的新引用，因此，使其进入 CFC 块固定的互连中。

说明

如果新引用可以关闭，并指向已经分配有文本互连的块变量，则块变量现有的文本互

连将由新引用代替！

如果针对定义的互连目标（即文本互连）新引用无法关闭，则该引用以黄色背景色突

出显示。

– 拖放块参数： 
可以使用鼠标将块参数从 CFC 拖放到控制变量参数的“引用块变量”(Reference block 
variable) 字段中。将自动创建对块参数的引用。 

–
 在输入端“引用块变量”只能组态为值、互连或另一种引用的备选项。 

– 仅控制模块 / 工厂设备模块的输出端支持多次“引用块变量”。

– 控制模块 / 工厂设备模块的输出端不支持多次“引用块变量”。
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• “引用全局变量” 
此类引用能够组态到全局数据池（S7 共享 DB）的连接。 
在 PAA 和 CFC 工艺编辑器的工艺级别，可在 STEP 7 编程模型的上下文内输入对共享数

据块元素的引用。可以以符号形式输入引用，也可基于 STEP 7 语法按地址输入引用。 
–

在输入端，对块变量的引用只能组态为值、互连或另一种引用的备选项。 
–

在控制模块/工厂设备模块的输出端，也允许多次引用全局变量。

– 从控制变量参数到数据池元素的引用直接映射到相关 CFC 块 I/O 处的 S7 地址互连。

– 仅当工艺编辑器中的参数分配给块参数时，才能组态全局变量的引用。

如果要互连到 CFC 块 I/O 的参数分配在以后进行，则与数据池引用相关的条目将作为 S7 
地址互连自动传递。如果一个或多个数据池的引用因数据类型不兼容等原因而无法应用，

则拒绝分配。

参数引用的语法 
• 对工艺级别上控制模块/工厂设备模块的输入和输出参数都可以进行引用。 
• 使用工厂层级，对控制模块/工厂设备模块中实际参数的引用可输入为绝对项目路径或相

对项目路径。

• 以下语法用于引用 CM 参数。

– 绝对路径：

(NameOfProject\{NameOfPlantHierarchyFolder\}{NameOfCM\|
NameOfEM\|NameOfEPH\}(NameOfCM.NameOfCV|NameOfEM.NameOfCV|
NameOfEPH.NameOfCV)

– 相对路径前面带有“..\”字符串序列：

('..\'{'..\'}{NameOfPlantHierarchyFolder\}{NameOfCM\|
NameOfEM\|NameOfEPH\}(NameOfCM.NameOfCV|NameOfEM.NameOfCV|
NameOfEPH.NameOfCV)
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• 下列语法用于引用块变量：

– 目标块变量位于同一个图表中：

NameOfBlock.NameOfBlockVariable
– 目标块变量位于嵌套图表中：

{NameOfSubCFC\}NameOfSubCFC.NameOfSubCFCInterfaceVariable
– 目标块变量位于同一项目或不同项目中的不同图表中

（AS 级互连）：

NameOfProject\\{NameOfPlantHierarchyFolder
\}NameOfPlantHierarchyFolder\
\NameOfCFC'.'NameOfCFCInterfaceVariable

– 目标块变量位于同一项目或不同项目中的嵌套图表中

（AS 级互连）：

NameOfProject\\{NameOfPlantHierarchyFolder
\}NameOfPlantHierarchyFolder\\{NameOfSubCFC
\}'.'NameOfSubCFCInterfaceVariable

• 下列语法用于引用全局变量：

– (NameOfGlobalDB|('DB' DBNumber)).NameOfDBElement
有关语法发详细信息，请参见“AUTOHOTSPOT”。

数据交换的引用

•
使用所述控制变量在 PCS 7 与 PAA 之间进行数据交换期间，双向交换对控制模块/工厂设

备模块参数的引用。 
• 通过 XML 文件的数据交换：

在 XML 文件中输入以下引用：在控制模块/工厂设备模块的参数上直接组态的引用或通过

复制操作隐式创建的引用。 
• 无法针对数据交换自动生成引用。

•
当从 PAA 或使用 XML 文件传递时，PCS 7 中的引用存储在控制模块/工厂设备模块的控制

变量中。这样，在工艺编辑器中引用可作为控制变量参数的属性显示出来。

• 因为引用只能保存为备选项，当传递引用时，会删除参数或现有互连上的分配。

• 当在自动化接口 (AI) 的数据传输对话框中交换和比较数据时，不会关闭打开的引用，即

使存在在参数引用中输入的互连伙伴。

• 如果参数没有分配给 CFC 块 I/O，数据交换日志将包含一个条目。
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• 将数据从 PCS 7 传输到 PAA 或将数据从 PAA 传输到 PCS 7 时，如果块变量的内部引用的

互连源是属于可选控制模块的块的一部分，则数据传输对话框中的引用路径带有前缀

“OPTION:NameOfSubCM\\”字符串。以下语法用于显示参考路径：

{OPTION:NameOfSubCM\\}{NameOfSubCFC
\}NameOfSubCFC.NameOfSubCFCInterfaceVariable |
{OPTION:NameOfSubCM\\}NameOfBlock.NameOfBlockVariable

• 当从 PAA 或使用 XML 文件传递时，不会传递对块变量的内部引用。只有输入的内部引用

与数据交换相关。数据交换时不考虑输出的内部引用。 
• 当从 PAA 或使用 XML 文件传递时，默认不删除外部引用或互连。但是，可以选择使用数

据传输对话框中的“在目标中删除 > 外部引用”(Delete at target > External references) 复
选框删除外部引用或互连。对于输入，仅当外部引用可在目标系统上关闭、且目标系统

上的引用打开时不考虑外部引用时，才会覆盖外部引用。

引用的复制行为 
• 仅当复制“引用 CM 参数”类型引用时，才会尝试保持在工艺级别上组态的控制变量参

数间的所有互连。 
例如，如果在 SIMATIC Manager 中复制控制模块/工厂设备模块及其 CFC 实施，将针对输

入和输出上控制变量的互连确定相对引用，并将其存储在控制模块/工厂设备模块副本的

控制变量中。

• 复制行为与复制目标无关。

• 默认情况下，启用复制操作期间引用的传递和创建，但可以选择将其禁用。 
为此，在 SIMATIC Manager 的菜单“选项 > 图表 > 复制/移动的设置”(Options > Charts > 
Settings for Copying/Moving) 中提供一个选项。

完成打开的“引用 CM 参数”类型引用 
•

当从 PAA 或使用 XML 文件传递时，PCS 7 中的引用存储在控制模块/工厂设备模块的控制

变量中。这样，在工艺编辑器中引用可作为控制变量参数的属性显示出来。 
• 在工艺编辑器中或通过 SIMATIC Manager 中的集合指令，可以随时手动关闭每个引用。 

为此，针对在 SIMATIC Manager 的工厂视图中选定的项目，提供菜单命令“选项 > 工厂

类型 > 关闭 CM 参数引用”(Options > Plant types > Close references to CM parameters)。
此菜单命令也显示在项目的快捷菜单中。 

• 只有当可以建立从一个控制变量的参数到另一个控制变量的参数的连接时，才能够关闭

引用。 
• 当关闭操作成功时，进行参数上的引用。 
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•
如果无法关闭引用，会在日志中输入相应信息。 

• 日志： 
日志列出成功完成的引用和在此时保持打开的引用。通过菜单命令“选项 > 工厂类型 > 日
志”(Options > Plant types > Logs) 可访问日志。此菜单命令也显示在项目的快捷菜单中。

完成打开的“引用块变量”类型引用 
•

当从 PAA 或使用 XML 文件传递时，对块变量的引用存储在 PCS 7 控制模块/工厂设备模

块的控制变量中。这样，在工艺编辑器中引用可作为控制变量参数的属性显示出来。 
• 当从 PAA 导出到 PCS 7 时，尝试解析这些引用并将其映射到 CFC 互连。

• 从 PAA 到 PCS 7 的数据交换之后或者在 CFC 的工艺编辑器中手动输入之后不能关闭的每

个引用，可以手动关闭。

为此，针对在 SIMATIC Manager 的工厂视图中选定的项目，提供菜单命令“选项 > 工厂

类型 > 关闭块变量引用”(Options > Plant types > Close references to block variables)。此

菜单命令也显示在项目的快捷菜单中。

• 在主数据库中，可使用菜单命令“选项 > 工厂类型 > 关闭块变量引用”(Options > Plant 
types > Close references to block variables) 手动关闭所有已打开的对块变量的引用。

•
如果无法关闭引用，会在日志中输入相应信息。例如，一个可能的原因是到相关块输入

中的另一个 CFC 块的互连已经存在。

• 日志： 
日志列出成功完成的引用和在此时保持打开的引用。通过菜单命令“选项 > 工厂类型 > 日
志”(Options > Plant types > Logs) 可访问日志。此菜单命令也显示在项目的快捷菜单中。

• 即使在关闭过程之后，块变量引用也会保留，无论是否创建模块互连。 
• 在 PAA 端，块变量引用通常保持“打开”状态，因为在工程级别上，PCS 7 特定块变量

不被定义所识别。换言之，仅引用的文本存储在控制变量相关参数的属性中。
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完成打开的“引用全局变量”类型引用 
•

当从 PAA 或者通过 XML 文件进行传递时，对 PCS 7 中全局变量的引用映射到 CFC 中相关

块 I/O 的地址互连。 

如果无法关闭引用，会在日志中输入相应信息。通过菜单命令“选项 > 工厂类型 > 日志”
(Options > Plant types > Logs) 可访问日志。

• 如果未将参数分配到 CFC 块 I/O，会在日志中报告这一情况，并且对全局变量池的引用仍

会存储在控制模块的控制变量 (CV) 中。

• 因为引用只能保存为备选项，当传递引用时，会删除参数或现有互连上的分配。

• 然而，当全局 DB 尚未完全创建或尚未在符号表中输入全局 DB 的符号名称时，S7 地址互

连可以关于其地址保持“打开”。

此种情况下，用户必须随后将 S7 地址互连与符号表和全局 DB 进行比较。因为其 PCS 7 限
制，在 CPU 范围内定义全局变量引用。

最迟在 S7 编译器构建期间自动执行同步。无法解析对全局 DB 中全局变量的引用时，在 S7 
编译器的日志中会报告这一情况。

在 CFC 中通过组合键“Ctrl + F5”，可随时启动与符号表的手动同步。

• 对全局变量的引用在 PAA 端保持打开。换言之，仅引用的文本存储在控制变量参数的属

性中。

11.1.15 控制变量参数上的引用示例

会为 CM 输入以及 CM 输出定义对 CM 参数的引用（工艺语言级别的文本参考）。这些参考

可定义为包含用户项目的绝对路径或相对路径。

对 CM 参数的引用（绝对路径）

输入 CM 参数的绝对路径的语法如下：

<Project>\<PlantHierarchyPath>\<CMObjectPath>.<CV>

说明

• 在工艺编辑器中，可以通过选择控制变量快捷菜单中的“复制为路径”(Copy as path) 选项，将
控制变量的项目路径复制到剪贴板。

• 与 CFC 块变量（对块变量的引用）的语法定义相反，工艺互连或对 CM 参数的引用语法不包
含任何双反斜杠。

• 输入和输出参数之间以及输出信号和输入信号之间都可以互连。

工艺组态

11.1 组态和管理控制模块

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 269



示例 → 引用控制变量 IN1：

图例 语法元素 描述

① <Project> 目标项目的名称：Prj
② <PlantHierarchyPath> 目标 CM、EM 或 EPH 的工厂层级路

径：ProcessCell\Unit\Function
③→④ <CMObjectPath> 目标 CM、EM 或 EPH 处控制变量的路径 

(③\④)：CMi1\S1
⑤ <CV> 目标控制变量的名称：IN1

语法结构如下：

<Project
>

\ <PlantHierarchyPath> \ <CMObjectPath>  <CV>

① \ ② \ ③ \ ④  ⑤
对目标控制变量 IN1 的引用的绝对路径结构如下：

Prj\ProcessCell\Unit\Function\CMi1\S1.IN1

对 CM 参数的引用（相对路径）

对 CM 参数的引用的相对路径取决于目标控制变量的工厂层级。

可以实现以下情况：

• 目标控制变量位于公共工厂层级中。

• 目标控制变量位于上位工厂层级中。

• 目标控制变量位于下游工厂层级中。
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说明

相对路径

相对路径由源和目标的相关控制变量路径组合而成。源不隐式表示输出参数，目标不隐式表

示输入参数。源和目标可以是输入或输出参数，具体取决于互连的绘制方式。

• 互连源
源是指要创建引用的控制变量。在源端，路径从源控制变量向上读取到其 CM、EM 或 EPH。
源路径因工厂类型（CM、EM 或 EPH）、其从属控制模块及其工厂层级而异。因此，源路径
的所有元素都替换为双点。因此，相对路径中的源路径通过双点和反斜杠的相应顺序表示
（“..\”）。

• 互连目标
目标指的是引用要达到的控制变量。在目标端，路径从目标 CM、EM 或 EPH 向下读取到其从
属控制模块，直到到达目标控制变量。目标路径始终是目标控制变量的绝对路径。

● 情形：目标控制变量位于公共工厂层级中

在公共工厂层级中输入 CM 参数的相对路径的语法如下：

<CMObjectPathSource>\<CMObjectPathDestination>.<CV>

示例 → IN1（源）到 OUT2（目标）的引用：

图例 语法元素 描述

①→②→③ <CMObjectPathSource> 源 CM、EM 或 EPH 处控制变量的路径 (①\②
\③)：..\..\..

④→⑤ <CMObjectPathDestinati
on>

目标 CM、EM 或 EPH 处控制变量的路径 (④\⑤)：
CMi2\S2

⑥ <CV> 目标控制变量的名称：OUT2
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语法结构如下：

<CMObjectPathSource> \ <CMObjectPathDestination>  <CV>
① \ ② \ ③ \ ④ \ ⑤  ⑥

源控制变量 IN1 的引用到目标控制变量 OUT2 的相对路径结构如下：

..\..\..\CMi2\S2.OUT2

● 情形：目标控制变量位于上位工厂层级中

在上位工厂层级中输入 CM 参数的相对路径的语法如下：

<CMObjectPathSource>\<DeltaPlantHierarchyPathSource>
\<CMObjectPathDestination>.<CV>

示例 → IN1（源）到 OUT2（目标）的引用：
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图例 语法元素 描述

①→②→③ <CMObjectPathSource> 源 CM、EM 或 EPH 处控制变量的路径（相对路

径）(①\②\③)：..\..\..
④→⑤ <DeltaPlantHierarchyPathSource

>
表示向上方向的源工厂层级的增量路径（相对路

径）(④\⑤)：..\..
注：

从源 CM、EM 或 EPH 的工厂层级向上读取路径，

直到在源控制变量和目标控制变量之间实现公共

工厂层级。

在本例中，源代码控制模块的工厂层级路径为

“ProcessCell\Unit\Function”，目标控制模块的

工厂层级路径为“ProcessCell”。

因此，向上方向源工厂层级的增量路径为 ④\⑤
（即 Function\Unit），因为源和目标之间的

公共工厂层级为“ProcessCell”。

⑥→⑦
 

<CMObjectPathDestination> 目标 CM、EM 或 EPH 处控制变量的路径（绝对路

径）(⑥\⑦)：CMi2\S2

⑧ <CV> 目标控制变量的名称：OUT2

语法结构如下：

<CMObjectPathSour
ce>

\ <DeltaPlantHierarchyPat
hSource>

\ <CMObjectPathDestin
ation>

 <CV>

① \ ② \ ③ \ ④ \ ⑤ \ ⑥ \ ⑦  ⑧
源控制变量 IN1 的引用到目标控制变量 OUT2 的相对路径结构如下：

..\..\..\..\..\CMi2\S2.OUT2

● 情形：目标控制变量位于下游工厂层级中

在下游工厂层级中输入 CM 参数的相对路径的语法如下：

<CMObjectPathSource>\<DeltaPlantHierarchyPathDestination>
\<CMObjectPathDestination>.<CV>

示例 → OUT2（源）到 IN1（目标）的引用：
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图例 语法元素 描述

①→②→③ <CMObjectPathSource> 源 CM、EM 或 EPH 处控制变量的路径（相

对路径）(①\②\③)：..\..\..
④→⑤ <DeltaPlantHierarchyPathDestinatio

n>
表示向下方向的目标层级文件夹的增量路径

（绝对路径）(④\⑤)：Unit\Function
注：

路径从在源和目标之间不通用的层级文件夹

中向下读取，直到达到目标控制变量的工厂

层级。

在本例中，源代码控制模块的工厂层级为

“ProcessCell”，目标控制模块的层级路径为

“ProcessCell\Unit\Function”。

因此，向下方向目标工厂层级的增量路径

为 ④\⑤（即 Unit\Function），目标

控制变量的工厂层级为“ProcessCell\Unit
\Function”。

⑥→⑦
 

<CMObjectPathDestination> 目标 CM、EM 或 EPH 处控制变量的路径

（绝对路径）(⑥\⑦)：CMi1\S2

⑧ <CV> 目标控制变量的名称：OUT2

语法结构如下：

<CMObjectPathSour
ce>

\ <DeltaPlantHierarchyPat
hDestination>

\ <CMObjectPathDestin
ation>

 <CV>

① \ ② \ ③ \ ④ \ ⑤ \ ⑥ \ ⑦  ⑧
源参数 OUT2 的引用到目标参数 IN1 的相对路径结构如下：

..\..\..\Unit\Function\CMi1\S1.IN1
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引用块变量

块变量的引用路径取决于目标块/接口变量的位置。

可实现以下语法： 
• 目标块变量位于同一个图表中：

<Block>.<BlockVariable>

• 目标块变量位于嵌套图表中：

<SubCFCPath>.<SubCFCInterfaceVariable>

• 目标块变量位于同一项目或不同项目中的不同图表中（AS 级互连）：

<Project>\\<PlantHierarchyPath>\\<CFC>\<Block>.<BlockVariable>

• 目标块变量位于同一项目或不同项目中的嵌套图表中（AS 级互连）：

<Project>\\<PlantHierarchyPath>\
\<SubCFCPath>.<SubCFCInterfaceVariable>

● 情形：目标块变量位于不同项目的嵌套图表中（AS 级互连）：

输入块路径/接口变量的语法如下：

<Project>\\<PlantHierarchyPath>\
\<SubCFCPath>.<SubCFCInterfaceVariable>

示例 → 引用图表接口变量 OUTxx（目标）：

图例 语法元素 描述

① <Project> 目标项目的名称：Prj
② <PlantHierarchyPath> 目标图表的工厂层级路径：ProcessCell

\Unit\Function
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图例 语法元素 描述

③ <SubCFCPath> 嵌套图表的路径：CMi1\C11\C12
④ <SubCFCInterfaceVariabl

e>
目标的图表接口变量（图表 I/O）的名

称：OUTxx

语法结构如下：

<Project> \\ <PlantHie
rarchyPat

h>

\\ <SubCFCP
ath>

 <SubCFCInterfaceVari
able>

① \\ ② \\ ③  ④
对目标图表接口变量 OUTxx 的引用的路径结构如下：

Prj\\ProcessCell\Unit\Function\\CMi1\C11\C12.OUTxx

引用全局变量

输入全局变量引用路径的语法如下：

<DB>.<DBVariable>

示例 → 引用全局变量 Var1：

图例 语法元素 描述

① <DB> 目标数据块的名称：DB99
② <DBVariable> 目标数据块变量的名称：Var1

语法结构如下：

<DB>  <DBVariable>
①  ②
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对全局变量 Var1 的引用的路径结构如下：

DB99.Var1

11.1.16 可选块互连的组态示例

简介

控制模块可包含“可选”块。 
在主数据库中的控制模块类型，这些可选块只能定义为“可选”。

如果在项目中创建了这一类型的不同实例，可使用“形式选择”(variant selection) 定义每个

实例中所包含的可选块。 
可在下文中找到可选块与非可选块之间互连的组态示例的说明。这些实例还显示了可选块对

互连的影响。

 
应用形式

下图显示了可使用控制模块类型的可选块在类型实例中选择的应用形式。

• 应用形式“A” 
在该应用形式中，CFC 包含目标块“Valve”以并仅有一个“Intlck01”块。  

• 应用形式“B” 
该应用形式包含块“Valve”及两个块“Intlck01”和“Intlck02”。 

为将“Intlck”块的输出信号与“Valve”块的“Intlck”输入互连，还添加了逻辑块“AND”。  

工艺组态

11.1 组态和管理控制模块

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 277



要求： 
应用形式所需的可选块输入和输出必须在控制模块类型的工艺编辑器中作为“参数”进行组

态和互连。    
 

组态示例 1 
在本组态示例中，可选块在控制模式类型中进行如下组态： 
• 在组态形式 1 中，块“Intlck01”定义为可选。 
• 在组态形式 2 中，块“Intlck02”和“AND”定义为可选。 
• “Valve”块不可选。  
实例中的形式选择：

• 对于带有一个“Intlck”块的应用形式“A”，在该实例中仅激活组态形式 1。
• 对于带有多个“Intlck”块的应用形式“B”，在该实例中组态形式 1 和 2 都会激活。    
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该组态示例的属性

组态：

对于这一组态方法，两个可用的应用形式的互连目标会在工艺编辑器的“互连到”
(Interconnection to) 属性下的子控制模块“Valve”的“Intlock”参数中输入。

• 对于只有一个“Intlck”块的应用形式“A”：“CMT11\Intlck01.Out"
• 对于带有多个“Intlck”块的应用形式“B”：“CMT11\AND.Out" 

工艺编辑器的结构布局：
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下表列出了工艺编辑器中的相关结构。为组态形式 1 和 2 各创建一个子控制模块“Option_x”。
要互连的可选块输入与输出从属于参数。    

符号 名称/符号 名称/符号 参数名称 备注

“CMT11”   组态示例 1 的控制模块

 
“Option_1”  组态形式 1 的参数子控制模块 

“Intlck01_Ou
t”

“Intlck01”块，“Out”输出的参数

“Option_2”  组态形式 2 的参数子控制模块 
“Intlck02_Ou
t”

“Intlck02”块，“Out”输出的参数

“And_Out” “AND”块，“Out"”输出的参数

“Valve”  作为互连目标的“Valve”块的子控制模块 
“Intlock” “Valve”块，“Intlck”输入的参数

 
对实例中形式选择的影响：

如果应用形式的可选块在该控制模块类型“CMT11”的实例中激活，则激活的时序顺序十分重

要。只有这样，才可正确自动互连“Valve”块的“Intlck”输入。 
其原因为，块输入中仅可存在一个互连。 
如果首先激活带有可选“Intlck01”块组态形式 1，则会在“Intlck01”块的“Out”输出与“Valve”块
的“Intlck”输入之间建立互连。在激活组态形式 2 后，不再能建立“Valve”块的“Intlck”输入与

“AND”块的“Out”输出之间已组态的互连。     
因此，对于组态形式“B”，必须先激活带有可选块“Intlck02”和“AND”的组态形式 2。在这种情

况下，“Valve”块的“Intlck”输入会自动与“AND”块的“Out”输出互连。只有这样，带有可选

“Intlck01”块的组态形式 1 才可激活，且“Intlck01”块的“Out”输出才可与“AND”块的“In1”输入

之间互连。 

组态示例 2
在本组态示例中，可选块在控制模式类型中进行如下组态： 
• 在组态形式 1 中，块“Intlck01”定义为可选。 
• 在组态形式 2 中，块“Intlck02”定义为可选。 
• 块“Valve”和“AND”不可选。  
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实例中的形式选择：

• 对于带有一个“Intlck”块的应用形式“A”，在该实例中仅激活组态形式 1。
• 对于带有多个“Intlck”块的应用形式“B”，在该实例中组态形式 1 和 2 都会激活。 

该组态示例的属性

组态：

• 使用这种组态方法，“互连到”(Interconnection to) 属性下的一对互连目标，即在“Valve”
块的“Intlck”参数中的组态示例 1，在任何参数中都不需要。  

• “AND”块不可选并始终存在。 
• 将可选“Intlck”块的“Out”输出分配给“AND”块的不同输入。  

工艺编辑器的结构布局：

工艺组态

11.1 组态和管理控制模块

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 281



下表列出了工艺编辑器中的相关结构。为组态形式 1 和 2 各创建一个子控制模块“Option_x”。
要互连的可选块输入与输出从属于参数。

符号 名称/符号 名称/符号 参数名称 备注

 
“CMT22”   组态示例 2 的控制模块

 
“Option_1”  组态形式 1 的参数子控制模块

“Intlck01_Ou
t”

“Intlck01”块，“Out”输出的参数

“Option_2”  组态形式 2 的参数子控制模块

“Intlck02_Ou
t”

“Intlck02”块，“Out”输出的参数

“"InputSel
ection”

 作为互连目标的“AND”块的子控制模块

“And_In1” “AND”块，“In1”输入的参数

“And_In2” “AND”块，“In2”输入的参数

 
对实例中形式选择的影响：

如果应用形式的可选块在该控制模块类型“CMT22”的实例中激活，则激活的时序顺序并不重

要。 
由于已将可选“Intlck”块的“Out”输出分配给“AND”块的不同输入，因此自动互连不会发生冲突。

  

11.1.17 设备模块/设备阶段中控制模块的组态选项

概述

可将控制模块分配到设备模块/阶段。 
组态选项
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可使用以下组态选项分配控制模块：

• 将要分配的控制模块集成为设备模块/阶段类型的组件，因此可将其用作下级对象。 
如果此控制模块可用作主数据库中的类型，则为该下级对象“控制模块”(Control module) 
组态“控制模块分配”(Control module assignment)。所谓的“角色”(role) 也在“控制模

块分配”(Control module assignment) 中定义。 
如果此控制模块不能用作主数据库中的类型，则可将其集成为设备模块/阶段中的下级对

象，甚至不需要相关的“控制模块分配”(Control module assignment)。例如，此类型的

控制模块对于互锁或计算很有意义。

说明

已通过“控制模块分配”(Control module assignment) 分配了“角色”(role) 的控制模块不

可指定为“可选”(optional)。

更多相关信息，请参见“在类型中集成并分配控制模块 (页 286)”部分。

• 该控制模块不是设备模块/阶段的组件。

随后为该控制模块组态“控制模块（基本要求）”(Control module (basic requirement)) 和
“控制模块分配”(Control module assignment) 对象。

– “控制模块（基本要求）”(Control module (basic requirement)) 的摘要中介绍了要分

配的控制模块的最低要求，例如所需命令或有关状态的反馈。

如果在类型中将控制模块组态为“控制模块（基本要求）”(Control module (basic 
requirement))，则必须在实例中分配项目的特定控制模块。更多相关信息，请参见

“将控制模块实例分配给设备模块/阶段 (页 288)”部分。

– 所谓的“角色”(role) 也在“控制模块分配”(Control module assignment) 中定义。

更多相关信息，请参见“将控制模块组态并分配为基本要求 (页 284)”部分。

可选控制模块

可以在设备模块/阶段的类型中将控制模块指定为可选。 
这意味着，也可以根据实际的工厂忽略设备模块/阶段的实例中的该控制模块。

说明

忽略定义为过程变量（如计算、互锁等）的可选控制模块时，用户必须确保该实例中禁止使

用某些控制策略。

命令和状态

通过使用命令和状态，可在设备模块/阶段的顺控程序中对控制模块进行寻址。

更多相关信息，请参见“在控制模块的类型中组态命令或状态 (页 222)”部分。

转换至“基本要求”(basic requirement)
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属于设备模块/阶段类型的组件的控制模块可定义为“基本要求”(basic requirement)。为此，

需对控制策略的“基本要求”(Basic requirement) 属性进行设置。之后，控制模块将不再是

设备模块/阶段类型的组件。完成此步骤后，即可在基本要求中实现控制模块的属性。除基

本要求外，还应按照上文组态选项部分所述来组态“控制模块分配”(Control module 
assignment)。 

参见

设备阶段的基础知识 (页 329)
设备模块的基础知识 (页 290)
组态和管理设备阶段概述 (页 343)
组态和管理设备模块概述 (页 307)

11.1.18 将控制模块组态并分配为基本要求

简介

在设备模块/阶段的工艺编辑器中组态设备模块或设备阶段的控制模块分配。 
组态取决于要分配的控制模块是已否作为组件集成到设备模块/阶段类型中。 
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可实现以下组态：

• “组态 1”(Configuration 1)： 
将要分配的控制模块集成为设备模块/阶段类型的组件。 
为此，组态以下对象： 
– 作为设备模块/阶段中的对象的控制模块，由如下图标表示：

– “控制模块分配”对象，由如下图标表示：

更多相关信息，请参见“在类型中集成并分配控制模块 (页 286)”部分。

• “组态 2”(Configuration 2)： 
要分配的控制模块不是设备模块/阶段类型的组件。

为此，组态以下对象： 
– 相应的“控制模块（基本要求）”对象，由如下图标表示：

基本要求从理论上描述了要分配的控制模块的最低要求。

– “控制模块分配”对象，由如下图标表示：

在“控制模块分配”中分配和组态相应的控制模块或者基本要求和“角色”。 
以下部分介绍了“组态 2”的步骤，其中要分配控制模块不是类型的组件。 
更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。

要求

已在主数据库中创建设备模块/设备阶段类型。 

步骤

1. 在 CFC 编辑器中打开所需设备模块/阶段类型。

2. 例如，在工艺编辑器中选择设备模块类型的图标。

3. 从快捷菜单中选择“插入新对象 > 控制模块（基本要求）”(Insert new object > Control module 
(basic requirement))。 
控制模块要求随即插入并显示为图标。

4. 在组态编辑器中选择控制模块要求的图标。 
将显示相关属性。 

5. 组态属性，例如名称和功能标识符。  
6. 在工艺编辑器中选择设备模块类型的图标。

工艺组态

11.1 组态和管理控制模块

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 285



7. 从快捷菜单中选择“插入新对象 > 控制模块分配”(Insert new object > Control module 
assignment)。 
控制模块分配随即插入并显示为图标，同时包含以下附加信息。

8. 在组态编辑器中选择新创建的控制模块分配的图标。将显示相关属性，如“控制模块分配”
(Control module assignment) 和“角色”(Role)。 
为“控制模块分配”(Control module assignment) 属性组态基本要求，由于此相关控制模块并
未集成为该类型的组件，因此不存在特定控制模块。 
要组态“已分配控制模块”(Assigned control module) 属性，在工艺编辑器中将上面创建的基
本要求拖放到“控制模块分配”对象中。 
“控制模块分配”(Control module assignment) 属性中将显示新建的分配。

9. 使用相同的名称组态属性的“角色”。
“角色”表示将如何在此类型环境中使用相关的控制模块或基本要求。 
必要时输入注释。 

10.如果要在此“控制模块（基本要求）”(Control module (basic requirement)) 下组态“状态”
(Status) 等下级元素，请在工艺编辑器中选择“控制模块（基本要求）”(Control module (basic 
requirement)) 的图标。

11.从快捷菜单中选择“插入新对象”(Insert new object) 命令。 
快捷菜单中将显示所有可用元素。 
选择相应的菜单命令插入所需对象，如“命令”(Command)。
根据需要重复此步骤，添加更多下级元素。

12.组态下级元素的属性。 

结果

已完成设备模块/阶段类型的“基本要求”(Basic requirement) 和“控制模块分配”(Control 
module assignment) 的组态。

在本例中，控制模块不是设备模块/阶段类型的组件；基本要求从理论上对其进行了描述。 

11.1.19 在类型中集成并分配控制模块

简介

在设备模块/阶段的工艺编辑器中组态设备模块或设备阶段的控制模块分配。

组态取决于要分配的控制模块是已否作为组件集成到设备模块/阶段类型中。 
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可实现以下组态：

• “组态 1”(Configuration 1)： 
将要分配的控制模块集成为设备模块/阶段类型的组件。 
为此，组态以下对象： 
– 作为设备模块/阶段中的集成对象的控制模块，由如下图标表示：

– “控制模块分配”对象，由如下图标表示：

在控制模块分配中分配和组态相应的控制模块和“角色”。  
• “组态 2”(Configuration 2)： 

要分配的控制模块不是设备模块/阶段类型的组件。

为此，组态以下对象： 
– “控制模块分配”对象，由如下图标表示：

– 相应的“控制模块（基本要求）”对象，由如下图标表示：

更多相关信息，请参见“将控制模块组态并分配为基本要求 (页 284)”部分。

以下部分介绍了“组态 1”的步骤，其中要分配控制模块是类型的组件。

更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。

要求

主数据库中提供以下类型： 
• 设备模块/阶段类型

• 控制模块类型

步骤

1. 在主数据库中，导航到所需设备模块/阶段类型并在 CFC 编辑器中将其打开。 
2. 要组态相关控制模块，在主数据库的模板目录中导航到所需控制模块类型。 
3. 在工艺编辑器中将所需控制模块类型拖放到设备模块/阶段类型中。

4. 控制模块随即插入并显示为图标。

5. 例如，在工艺编辑器中选择设备模块类型的图标。
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6. 从快捷菜单中选择“插入新对象 > 控制模块分配”(Insert New Object > Control Module 
Assignment)。 
控制模块分配随即插入并显示为图标，同时包含以下附加信息。

已分配控制模块的名称 "(" <角色> ")"
7. 选择新创建的“控制模块分配”的图标。 

将显示相关属性，如“控制模块分配”(Control Module Assignment) 和“角色”(Role)。
8. 要组态“控制模块分配”(Control Module Assignment) 属性，在工艺编辑器中将上面创建的控

制模块拖放到“控制模块分配”对象中。 
“控制模块分配”(Control Module Assignment) 属性中将显示新建的分配。  

9. 使用相同的名称组态属性的“角色”。
“角色”表示将如何在此类型环境中使用相关的控制模块或基本要求。
必要时输入注释。 

结果

已将控制模块集成到设备模块/阶段类型中并组态了“控制模块分配”(Control module 
assignment)。
该控制模块现在是设备模块/阶段类型的组件。

11.1.20 将控制模块实例分配给设备模块/阶段

简介

可在设备模块/设备阶段类型中将控制模块组态为类型的组件或者“控制模块（基本要求）”
(Control module (basic requirement))。 
1. 如果控制模块集成为类型的组件，则创建实例时将复制该控制模块。 
2. 如果在类型中将控制模块组态为“控制模块（基本要求）”，则必须在实例中分配项目的特

定控制模块。 
以下部分介绍了选项“2”的步骤。 

要求

• 主数据库中包含所需的设备模块/阶段类型。 
• 在该类型中将控制模块组态为“控制模块（基本要求）”并组态相应的“控制模块分配”

(Control module assignment)。  
• 通过该类型创建实例。 
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步骤

1. 在 CFC 编辑器中，打开符合上述要求的所需实例。 
2. 在 CFC 编辑器中打开要分配的控制模块。

3. 为获得更好的总览，请调整这两个打开的窗口，使其处于可见状态。 
4. 在工艺编辑器的控制模块窗口中，选择该控制模块的图标。

5. 将该图标从实例的窗口拖放到工艺编辑器中所需控制模块分配的图标上。

6.“控制模块分配”(Control module assignment) 属性的属性列表中将显示新组态的分配。
同时，将自动创建实例和相关控制模块之间的互连。 
使用该属性的快捷菜单可删除分配或跳转到控制模块。   

说明

如果删除“控制模块分配”属性中的条目，则将同时删除所有相关互连。 

结果

已在设备模块/阶段的实例中分配了特定控制模块。 
已在实例和相关控制模块之间创建互连。 

参见

组态和管理设备阶段概述 (页 343)
组态和管理设备模块概述 (页 307)
设备模块/设备阶段中控制模块的组态选项 (页 282)
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11.2 组态和使用设备模块

11.2.1 设备模块的基础知识

简介

术语

根据 ISA-88 标准，国际语言环境中使用英语术语 "Equipment Module (EM)" 和 "Equipment 
Phase (EPH)"。在德语国家/地区中，使用术语“Technische Einrichtung”（“工厂设备模块”）

和“Technische Funktion”（“工厂设备阶段”）。有关“ISA-88”标准中的分类的更多信息，请

参见“ISA-88 标准中的设备模块分类 (页 304)”部分。 
工厂设备模块的概念

“顺序控制”(Sequential control) 也是工厂设备模块的一个组件。控制策略、设定值、其它参

数以及具有顺控的实际程序控制均在“顺序控制”(Sequential control) 中定义。顺控的动作

和转换条件通过命令和状态来描述。

控制模块用于将工厂设备模块分配给控制回路级的传感器和执行器。对于步和转换条件编程，

可以在控制模块中专门定义命令和状态，也可以在主数据库中全局定义命令和状态。 

在 PCS 7 中，工厂设备模块与控制模块之间系统说明中的工艺级组态映射将在指定块之间的

相应 CFC 互连中自动实现为自动化级映射。 
尽管控制模块也可用于连续过程，但最好还是与工厂设备模块一起用于批生产过程。
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工厂设备模块的基础知识

简要概述

下面内容简要介绍了工厂设备模块和控制模块的数据对象，以及全局命令或状态。 
更多相关信息，请参见“设备模块和控制模块的数据对象概述 (页 294)”部分。 
工厂设备模块的元素

• “顺序控制”(Sequential control)，包括其顺控和参数说明，在工厂设备模块中必须始终可

用，且仅可使用一次。

  可以选择性包含以下对象：

• 控制模块，设备模块类型的组成部分，可使用多个

• 控制模块分配；可使用多个

• 控制模块要求（作为基本要求），其中定义了控制模块的最低要求。 
不可标记为可选，可使用多个

• “工厂设备模块分配”(Equipment module assignment)；可使用多个

• “工厂设备模块（基本要求）”(Equipment module (basic requirement))；作为基本要求，

其中定义了工厂设备模块的最低要求；可使用多个

• 下列对象可作为控制变量，可使用多个：

– 参数  
– 信号  

• 消息；可使用多个

控制模块的元素

控制模块包含以下可选对象：

• 子控制模块；可能有多个

• 命令；可使用多个

• 状态；可使用多个

• 下列对象可作为控制变量，可使用多个： 
– 参数  
– 信号  

• 消息；可使用多个

命令和状态
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“命令”(Command) 和“状态”(Status) 对象可按如下方式定义：

• 在控制模块的类型（而不是实例）中定义，或在“控制模块（基本要求）”中定义。

这些命令和状态特定于这些对象。 
• 全局定义，即，使用 SIMATIC Manager 在主数据库中定义。

这些全局命令和状态通常基于工厂设备阶段，可在工厂的所有工厂设备阶段中使用。

有关更多信息，请参见“设备模块和控制模块的数据对象概述 (页 294)”中有关控制模块数

据对象和全局定义数据对象的表格。

工厂设备模块中的控制模块

可将控制模块分配到工厂设备模块。 
更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。 

工厂设备模块的类型和实例

类型/实例概念适合重复使用的场合。类型/实例概念的优势在于，它可以在中央位置对类型

进行更改，然后通过同步实例传送这些更改。 
• 当类型与实例之间存在差异时，可使用同步。同步类型和实例时，实例特定的扩展会加

以管理，而且不会丢失。因此，可以在自动化系统中无扰动地加载更改。

• 工厂设备模块和控制模块的类型和实例包含在与工厂自动化加速器 (PAA) 之间的数据交

换中。

类型和实例：

• 使用下列选项，工厂设备模块的类型仅可在 PCS 7 项目的主数据库中创建： 
– 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中 
– 在 PAA 中创建并在随后通过自动化接口 (AI) 导入。 
在主数据库中，组态工厂设备模块类型以便在 PCS 7 项目中使用。可以使用 SIMATIC 
Manager 在主数据库中复制和删除该类型。

• 实例是指重复使用工厂层级的工厂描述中的类型。

将类型从主数据库复制到工厂层级中某一节点下的项目中，便可轻松创建类型的实例。  
将控制模块分配给实例时，将同时创建到控制回路级和特定控制模块的连接。 

下图显示了类型和实例的创建方法。
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类型和实例的命名

• 此类型的名称在主数据库中是唯一的，这点与控制模块类型完全一样。 
• 工厂设备模块的类型与以下对象共享主数据库中的名称空间：  

– 控制模块的类型

– 全局命令和状态 
因此，工厂设备模块类型和控制模块类型不能同名。

• 工厂设备模型类型的名称： 
该名称的最大长度是 22 个字符。

建议只使用 18 个字符以便为自动重命名预留一些空间，例如，复制期间通过自动添加字

符串“(1)”以避免名称冲突。

• 工厂设备模块类型的实例通过工厂层级分层次进行寻址。因此，较高级别的单元都是唯

一的。

说明

如果复制期间名称已存在：

如果复制图表并粘贴，则带“(x)”（其中 x 为 1、2、3、4 等）后缀的图表名称将作为所复制

图表的名称。

例如：

如果存在名为“ChartName”的图表，并且若创建了此图表的副本，则复制的图表名称为

“ChartName(1)”，因为名称“ChartName”已存在。此外，如果再次粘贴（创建另一个副

本），则下一个复制的图表将命名为“ChartName(2)”。但是，如果从“ChartName(2)”图表创

建副本，则复制的图表将命名为“ChartName(2)(1)”。
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说明

如果复制期间超出了名称的最大长度：

如果复制名称具有 22 个字符（最大长度）的图表并粘贴，则所复制的图表名称将从该字符

串的末尾缩短，直到可以附加“~(x)”（其中 x 为 1、2、3、4 等）。

例如：

如果存在名为“ChartNameMotorControlA”（22 个字符）的图表，并且若创建了此图表的副

本，则复制的图表名称为“ChartNameMotorCont~(1)”。
在名称已存在的情况下，根据命名的一般规则，新图表名称应为

“ChartNameMotorControlA(1)”（25 个字符），但这超出了 22 个字符的最大允许长度。因

此，使用上述方法将名称缩短为 22 个字符。

类型和实例的比较和同步

相关信息，请参见“比较并同步设备模块的类型和实例 (页 313)”部分。

与 PAA 的数据交换

利用自动化接口 (AI) 的导入功能（基本功能），可将使用 PAA 定义的工程级工厂设备模块

的类型传送到 PCS 7 过程控制系统。关联的顺控、转换条件和动作会随类型一同导入。

这样，便可将在 PAA 中生成的工程级数据以工厂设备模块的形式导入到 PCS 7 中，进而输

入到自动化层。此处，数据显示为顺控 (SFC) 和自动化程序 (CFC)。
更多相关信息，请参见“与 PAA 的数据交换概述 (页 362)”部分。

11.2.2 设备模块和控制模块的数据对象概述

简介

下面的表格将介绍： 
1.“工厂设备模块”(Equipment module) 的数据对象

在工艺编辑器中的图标：

2.“顺序控制”(Sequential control) 的数据对象
在工艺编辑器中的图标：

3.“控制模块”(Control module) 的数据对象 
在工艺编辑器中的图标：
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工厂设备模块的数据对象

工厂设备模块由以下元素组成，这些元素可以为一个或多个。 

说明

在工厂设备模块中不能定义任何“命令”和“状态”对象。这些对象可以专门为控制设备类

型或基本要求定义，也可以定义为“全局”对象。更多相关信息，请参见下表。 

 

对象/图标 描述

顺序控制

    
顺序控制定义了顺控及其参数描述（例如设定值、控制策略、参数、消息）。

顺序控制可能仅存在于工厂设备模块中一次。

每个工厂设备模块必须且只能分配一个顺序控制。

下面的表格“顺序控制的数据对象”(Data objects of the sequential control) 介绍

了这些元素。

控制模块

   
控制模块可组态为工厂设备模块类型的组件。 
可以存在多个控制模块。

可选控制模块： 
• 在主数据库中的类型中，控制模块只能定义为“可选”。  
• 在工厂设备模块类型下的第一个子级别上，控制模块只能定义为“可选”。    
• 工厂设备模块下的控制模块嵌套深度限制为最多 3 层。 

这意味着工厂设备模块最多只能有两层子控制模块，例如，层级“工厂设备

模块 > 控制模块 > 子控制模块”(Equipment module > Control modules > Sub-
control modules)。

注：

属于工厂设备模块类型的组件的控制模块可定义为“基本要求”。为此，需在工

艺编辑器中设置“基本要求”(Basic requirement) 属性。随后该控制模块便不再

是工厂设备模块类型的组件，并且该控制模块的块也将从模型中删除。 
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对象/图标 描述

控制模块分配

   
如果要在顺控中对控制模块进行控制，则必须将工厂设备模块分配给控制模块。

分配将组态以下内容： 
1.“角色”(role)。

所谓的控制模块“角色”在工厂设备模块类型中设置，而不是在控制模块中

设置。

“角色”指示了所分配的控制模块在此类型的上下文中的使用方式，例如，分

配的“阀”控制模块的“角色”为“出口”。  
“角色”用于在顺控的操作和转换条件中寻址目标控制模块。

2. 控制模块或启用控制模块作为基本要求的链接。

– 当控制模块集成在工厂设备模块的类型中时，此控制模块即已分配。  
– 如果控制模块未集成在类型中，则分配相应的基本要求。  

要分配的控制模块的具体要求在“控制模块（基本要求）”下自行指定，

如下所述。

可以为分配提供注释。

可以有多个分配。 
如果组态“控制模块分配”，还必须创建相应的基本要求或集成到类型中的控制

模块。

工厂设备模块分配

   
分配将组态以下内容： 
1.“角色”(role)。

工厂设备模块的类型定义了工厂设备模块的“角色”(role)，但特定的工厂设备

模块除外。

“角色”(role) 指示了所分配的工厂设备模块在此类型的上下文中的使用方式，

例如，分配的“阀”(valve) 工厂设备模块的“角色”(role) 为“出口”(outlet)。  
“角色”(role) 用于在顺控的操作和转换条件中寻址目标工厂设备模块。

2. 启用工厂设备模块或控制模块作为基本要求的链接。

– 如果已在工厂设备模块类型中组态了链接的工厂设备模块，则分配该工厂

设备模块。  
– 如果未在类型中组态链接的工厂设备模块，则分配相应的基本要求。  

要分配的工厂设备模块的具体要求在“工厂设备模块（基本要求）”
(Equipment module (basic requirement)) 下自行指定，如下所述。

可以为分配提供注释。

可以有多个分配。 
如果组态“工厂设备模块分配”(Equipment module assignment)，还必须创建相

应的基本要求或集成到类型中的下级工厂设备模块。
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对象/图标 描述

控制模块（基本要求）

   
“控制模块（基本要求）”从理论上描述了要分配的控制模块的最低要求。 
尤其是，要求包括了必要的命令以及状态反馈。

• 可以有多个基本要求。 
• 工厂设备模块类型中需要基本要求，以便能使用命令和状态，例如在顺序逻

辑中使用。

• “命令”(Command) 和“状态”(Status) 对象可在基本要求中定义。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部分。 

• 基本要求不能定义为可选。 
工厂设备模块（基本要求）

 

“工厂设备模块（基本要求）”(Equipment module (basic requirement)) 从理论上

描述了要分配的工厂设备模块的最低要求。 
尤其是，要求包括了必要的命令以及状态反馈。

• 可以有多个基本要求。 
• 工厂设备模块类型中需要基本要求，以便能使用命令和状态，例如在顺序逻

辑中使用。

• “命令”(Command) 和“状态”(Status) 对象可在基本要求中定义。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部分。 

• 基本要求不能定义为可选。

参数

   

 

• 可以有多个参数。

• “参数”对象可以用作： 
– 工厂设备模块或控制模块的子对象。

– 命令和状态的形式参数。 
在“顺序控制”(Sequential control) 中，这些形式参数定义了特定参数或常

量的占位符，这些参数或常量位于顺控的操作和转换条件中的使用点。 
• “值”和“信号”属性以及“互连”关系只能作为替代内容输入。

• 只有输入参数允许“信号”属性，输出参数禁用该属性。

• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

对于输入参数，“取反”属性与参数互连或信号有关。
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对象/图标 描述

信号

   
• 可以有多个信号。

• 在工艺编辑器中，信号属性的表示方式与参数的表示方式相同。但是，

“值”、“枚举”、“操作标识符”、“单位”和“互连”值或关系的输入字

段被禁用。 
• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

它适用于信号的“信号”属性。

消息

   
工厂设备模块默认可生成消息。

• 可以有多个消息。

• 可以直接在工厂设备模块下组态消息。然后这些消息将仅适用于相关 CFC 中 
SFC 类型的块实例。要分配相应的消息，必须将 SFC 类型的这一块实例的消

息输入设置为可见。 

顺序控制的数据对象

“顺序控制”(Sequential control) 由以下元素组成，这些元素可以为一个或多个： 

对象/图标 描述

参数

用于参数说明

   

• “顺序控制”(Sequential control) 的参数说明对应于“特性”(characteristics)，
这些特性在 SFC 类型中设置。 

• 在工程级 (PAA) 集成环境中，对数据交换模型中的过程工程所需的参数和属

性有一定限制。

• 参数可用作“顺序控制”(Sequence control) 的子对象，以定义为“顺序控制”
(Sequence control) 在外部和内部与顺控相连的各个变量。

更多相关信息，请参见此表格结尾处。 
• 控制策略

   
使用控制策略可以定义各种过程工程步骤。

顺控的控制基本上是控制策略的功能。控制策略对于高级配方控制级别（批生

产系统）非常重要。

属性：

• 名称  
• 编号  
• 注释  
• 分配的设定值   

在 PAA 数据交换模型中，通过关系（分配的控制策略）将设定值分配到控制

策略。
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对象/图标 描述

• 设定值 设定值可在过程工程中通过手动操作指定，也可以用高控制级别系统（批生产

系统）指定。

设定值会分配给单独的控制策略。除设定值外，实际（过程）值始终作为控制

变量提供。

属性：

• 名称  
• 数据类型  
• 注释  
• 下限  
• 上限  
• 单位  
通常在工厂设备模块的实例中确定或调整上限、下限和（测量）单位。 

• 过程值/实际值 
   

工厂设备模块中的过程值集成用于控制顺控，例如使用实际值来分步使能顺控。 
属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
单位通常在工厂设备模块的实例中设置。

• 控制值

   
连接外部控制模块时需要使用控制值，无法通过控制模块触点直接访问控制值。

属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
单位通常在工厂设备模块的实例中设置。

• 参数

   
参数用于对实例中“顺序控制”(Sequential control) 的行为施加影响，例如通过

选项施加影响。这些参数还可用于设置特定实例的限制。

属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
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对象/图标 描述

• 位存储器

   
临时存储值时需要位存储器。其仅在顺序控制系统中本地使用。

属性：

• 名称  
• 数据类型  
• 注释  

• 定时器

   
定时器用于时间监视或计算运行时间等用途。

属性：

• 名称  
• 注释  

• 注释文本

   
注释文本用于用户界面等用途。

属性：

• 名称  
• 文本  

• 块触点

   
例如，块触点用于 AS 级互连。

属性：

• IN
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对象/图标 描述

• 位置文本

   
位置文本用于显示操作员站的当前过程状态。 
属性：

• 名称  
• 显示文本  

顺控

   
过程工程任务在顺序逻辑中定义。这通过顺控来描述。必须为“顺序控制”
(Sequential control) 每个状态的每个控制策略定义行为。

顺控有一个起始步和一个结束步。

顺控可包括以下元素，这与 SFC 类型相似：

• 步

• 转换条件

• 选择分支

• 并行分支

• 循环

• 跳转

选择分支和并行分支都会以对称方式再次合并。

为 PAA 中的过程工程级的步骤定义的操作通过列表形式的命令来描述。用于此

用途的命令在控制模块（例如电机、阀）中集中提供。命令可在全局定义，也

可通过添加在 EMT 下的 CMT 引用（作为基本要求）。

转换条件在工艺类型和 PAA 中的过程工程级设置为表达式，这些表达式使用状

态和逻辑标准函数，结果为布尔值。 
为此，由电机、阀等控制模块提供的状态以及在工厂设备模块中定义的状态都

可用于此用途。 

 
用作步和转换条件组态的各个变量的参数

在顺控中，步和转换条件组态可能需要各种单独的变量，例如实际值、限值或类似变量。 
要创建这些单独的变量，应在工艺编辑器中选择相应 SFC 类型的块实例的所需块 I/O，并将

其拖动到“顺序控制”(Sequential control) 中。“参数”对象将自动创建。这些单独变量的

名称已预定义，不可更改。  
在工厂设备模块的实例中对这些单独变量进行互连和分配参数。

控制模块的数据对象

可为一个工厂设备模块分配一个或多个控制模块。 
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与工厂设备模块连接时，应该能通过工厂设备模块顺控的命令和状态访问控制模块，这一点

特别重要。

控制模块由以下元素组成，这些元素可能也可能不存在：

对象/图标 描述

命令 
   

• 命令只能在控制模块的类型（不是实例）中定义为控制模块的对象，因此

是类型特定的。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部
分。 

• 一个命令可以带一个或多个形式参数。

• 控制模块命令通过其名称确定。 
• 每个命令都有属性“注释”(Comment) 和“作者”(Author)。
• 可以有多个命令。

命令示例：

定义一个名为“打开”的命令用于打开阀。

命令也可以附带参数，例如，当实例中最初已了解某些信息（值、变量）时。 
一个带参数命令的示例是指定电机速度：

• “Set_Motor_Speed(Speed)” 
状态

   
• 状态只能在控制模块的类型（不是实例）中定义为控制模块的对象，因此

是类型特定的。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部
分。 

• 一个状态可以带一个或多个形式参数。

• 控制模块的状态通过其名称确定。 
• 每个状态都有属性“注释”(Comment) 和“作者”(Author)。
• 可以有多个状态。

状态示例：

为阀的关闭状态创建一个名为“已关闭”的状态。
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对象/图标 描述

参数

   

 

• 可以有多个参数。

• “参数”对象可以用作：

– 工厂设备模块或控制模块的子对象。

– 命令和状态的形式参数。在“顺序控制”(Sequential control) 中，这些形

式参数定义了特定参数或常量的占位符，这些参数或常量位于顺控的操

作和转换条件中的使用点。

•  “值”和“信号”属性以及“互连”关系只能作为替代内容输入。

• 只有输入参数允许“信号”属性，输出参数禁用该属性。

• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

对于输入参数，“取反”属性与参数互连或信号有关。

信号

   
• 可以有多个信号。

• 信号定义 I/O 通道请求。

• 在工艺编辑器中，信号属性的表示方式与参数的表示方式相同。但是，

“值”、“枚举”、“操作标识符”、“单位”和“互连”值或关系的输入

字段被禁用。 
• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

它适用于信号的“信号”属性。

• 属性“范围上限值”、“范围下限值”和“单位”是模拟信号的主要部分。

• 范围和单位由系统隐式链接，如果需要也可以从通道驱动块显示分配给相

应的块变量。

• 与通道驱动块单位参数相关的相应范围不需要定义为独立 CM 参数。

子控制模块 
   

• 控制模块可从属于其它控制模块。 
• 可以有多个子控制模块。

• 控制模块的嵌套深度限制为最多 2 层。 
这意味着控制模块只能有一层子控制模块。  

• 只有控制模块/工厂设备模块类型下第一个子级别的子控制模块可定义为“可

选”(optional)。更多相关信息，请参见以上工厂设备模块数据对象表。

消息

   
• 工厂设备模块默认可生成消息。

• 可以有多个消息。

• 阅读后面的信息来组态消息。  

 
控制模块或子控制模块消息的组态注意事项

应该始终在同一控制模块或控制模块类型中组态消息以及相关的报告块。这也适用于子控制

模块。  
如果直接在控制模块类型中创建消息，而相关报告块包含在该类型的子控制模块中，则将此

控制模块类型的实例从 PAA 导出到 PCS 7 后，消息不会分配给报告块。
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使用项目快捷菜单中的“工厂类型 > 同步”(Plant types> Synchronize) 功能即可解决缺少分

配的问题。但是，为避免导出后出现分配丢失的问题，应将此组态注意事项考虑在内。  

参见

设备模块的基础知识 (页 290)
有关控制模块及其类型的基本信息 (页 213)
组态全局命令或状态 (页 378)
全局“命令”(Command) 和“状态”(Status) 的数据对象概述 (页 382)

11.2.3 ISA-88 标准中的设备模块分类

概述

根据 ISA-88 标准 (IEC 61512-1)，设备模块分类到物理工厂模型中的单元下。 
• 使用 SIMATIC BATCH 时，必须按照 ISA-88 在设备层级中将节点标识为设备模块。这就是 

PCS 7 环境中不支持按照现有标准将设备模块直接分类到过程单元下的原因。 
• 控制模块既可处于设备模块下，也可直接处于单元下的级别。

下图显示了设备模块在所谓的 ISA-88 标准物理模型中的位置。其中显示了三个可能的 PCS 7 
项目组态示例。 
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ISA-88 标准的术语

过程单元

工厂或过程单元包含创建批生产所需的所有设备。过程单元通常被分成生产线。生产线由特

定批次使用的所有单元和其它设备组成。各批次的生产线可能保持不变，也可能各有不同。

在 PCS 7 多项目中，只能创建一个“工厂”层级文件夹。此类示例包括聚合车间、印染作业

和多功能车间。

单元

单元是一组独立的设备模块，通常位于重要处理设备（如混合容器和反应釜）附近。 
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单元具有以下特点： 
• 单元可执行一项或多项关键过程活动，如反应、结晶和配制溶液。

• 单元彼此间相对独立地运行。

• 在批生产处理流程中的某一时刻，单元常常包含一批完整的物料。

• 在给定的时间内，单元无法处理多个批生产。

设备模块

设备模块可由控制模块和下级设备模块组成。设备模块通常位于过程设备（如过滤器）中。 
设备模块的特征：

• 可以属于某一单元，也可以包含过程单元中的一组独立设备。

• 可以执行有限次的具体辅助性处理功能，如定量给料或称重。

• 可以有选择地包含某个批生产的原料。

控制模块

控制模块通常为传感器、执行器、其它控制模块以及可从控制工程角度作为单个设备进行操

作的相关过程设备。 
控制模块也可由其它控制模块组成。例如，定量给料控制模块可定义为几个自动开关阀控制

模块的组合。

参见

设备模块的基础知识 (页 290)
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11.2.4 创建、组态和管理设备模块

11.2.4.1 组态和管理设备模块概述

概述

• 组态 
使用下列选项，工厂设备模块的类型仅可在 PCS 7 项目的主数据库中创建：

– 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中 
– 在工厂自动化加速器 (PAA) 中创建并随后通过自动化接口 (AI) 导入 
在主数据库中，组态工厂设备模块类型以便在 PCS 7 项目中使用。 
更多相关信息，请参见“组态设备模块（类型） (页 308)”部分。

• 管理

可在 SIMATIC Manager 中复制和删除工厂设备模块类型。 
• 组态工厂设备模块的顺序控制

更多相关信息，请参见“组态设备模块的顺序控制 (页 310)”部分。

• 位于工厂设备模块类型上的控制模块

控制模块可在工厂设备模块中分配为下级对象，或集成到工厂设备模块中。 
更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。 

• 创建实例

将工厂设备模块类型从主数据库复制到工厂层级的节点中，即可创建实例。 
更多相关信息，请参见“创建设备模块类型的实例 (页 312)”部分。 

• 类型/实例同步

类型或其相关实例发生更改时，可能需要同步类型和实例。 
更多相关信息，请参见“比较并同步设备模块的类型和实例 (页 313)”部分。 

• 工厂设备模块实例中的控制模块

如果在类型中将控制模块组态为“控制模块（基本要求）”(Control module (basic 
requirement))，则必须在实例中分配项目的特定控制模块。

更多相关信息，请参见“将控制模块实例分配给设备模块/阶段 (页 288)”部分。
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11.2.4.2 组态设备模块（类型）

简介

使用下列选项，工厂设备模块的类型仅可在 PCS 7 项目的主数据库中创建： 
• 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中 
• 在工厂自动化加速器 (PAA) 中创建并随后通过自动化接口 (AI) 导入 

更多相关信息，请参见“与 PAA 的数据交换概述 (页 362)”部分。 
可以使用 SIMATIC Manager 在主数据库中复制和删除该类型。

在主数据库中，组态工厂设备模块类型以便在 PCS 7 项目中使用。 
下面介绍该步骤。

要求

• 已在 SIMATIC Manager 中打开包含主数据库的多项目。

操作步骤

1. 使用菜单命令“视图 > 工厂视图”(View > Plant View) 打开工厂视图。

2. 导入工厂设备模块后，转到第 4 步。

3. 如果想要创建新的工厂设备模块类型，在主数据库的工厂视图中导航到想要在其中创建对象
（例如“过程变量类型”(Process tag types)）的目录。
从快捷菜单中选择“插入新对象 > 工厂设备模块（类型）”(Insert New Object > Equipment 
Module (Type)) 命令。 
转到第 5 步。 

4. 在主数据库的工厂视图中，导航到目标目录，即在导入后创建或存储工厂设备模块类型（例如
“过程变量类型”(Process tag types)）的目录。 
可以将类型移动或复制到用户在主数据库中创建的另一个目录，并在该目录下组态属性。

5. 右侧窗口中以相应的图标显示工厂设备阶段类型。

6. 双击图标。CFC 编辑器随即打开，可以在该编辑器中组态工厂设备模块类型的属性。 
打开工艺编辑器。该类型具有多种属性，例如“名称”(Name)、“作者”(Author)、“注释”
(Comment)。 
输入所需的属性数据。 

7. 如果要组态该类型下的下级元素，请在工艺编辑器中选择工厂设备模块类型的图标。
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8. 从快捷菜单中选择“插入新对象”(Insert New Object) 命令。 
快捷菜单中将显示所有可用元素。 
– “控制模块”(Control Module)；用于子控制模块 
– “控制模块（基本要求）”(Control module (basic requirement))；作为基本要求，其中

定义了控制模块的最低要求

– “控制模块分配”(Control module assignment)
– “工厂设备模块分配”(Equipment module assignment)
– “工厂设备模块（基本要求）”(Equipment module (basic requirement))；作为基本要

求，其中定义了工厂设备模块的最低要求

– “参数”(Parameter)
– “信号”(Signal)
–  “消息”(Message) 
– “顺序控制”(Sequential control)； 

顺序控制可能仅存在于工厂设备模块中一次。因此，只有当此工厂设备模块中当前不

存在“顺序控制”(Sequential control) 对象时才能启用菜单命令。相关组态信息，请参

见“组态设备模块的顺序控制 (页 310)”部分。 
9. 选择相应的菜单命令插入所需对象，如“参数”(Parameter)。 
10.根据需要重复此步骤，添加更多下级元素。 

结果

已组态工厂设备模块类型。 
已插入下级元素，如参数和控制模块。 

说明

属性或分配的值等对象仍需在工艺编辑器中组态。

参见

将控制模块组态并分配为基本要求 (页 284)
在类型中集成并分配控制模块 (页 286)
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11.2.4.3 组态设备模块的顺序控制

简介

顺序控制可能仅存在于工厂设备模块中一次。

• 当创建一个新的工厂设备模块时，会自动创建一个“顺序控制”(Sequential control) 对象

和一个相关的 SFC 类型。这个分配的 SFC 类型定义了顺控及其参数描述（例如设定值、控

制策略、参数、消息）。 
• 如果在工厂设备模块中删除并重新添加“顺序控制”(Sequential control) 对象，则必须再

次为该对象分配 SFC 类型。   
• 只要工厂设备模块中存在关联的“顺序控制”(Sequential control) 对象，就无法在主数据

库的“图表”(Charts) 目录中删除为“顺序控制”(Sequential control) 对象分配的 SFC 类
型。   

要求

• 已在 SIMATIC Manager 中打开包含主数据库的多项目。

• 工厂设备模块类型在主数据库中可用，并按照“组态设备模块（类型） (页 308)”部分所

述进行组态。 

操作步骤

1. 在 CFC 编辑器中，打开主数据库中的工厂设备模块类型。 
2. 在工艺编辑器中选择工厂设备模块类型的图标。

全部已知对象都显示在此图标下。
在新创建的工厂设备模块中，“顺序控制”(Sequential control) 对象和相关的 SFC 类型自动可
用。 
如果“顺序控制”(Sequential control) 对象已经存在，在工艺编辑器的“已分配块”(Assigned 
block) 属性的“已分配”(Assigned) 列下检查是否存在相应的条目。如果因此分配了相应的条
目和 SFC 类型，转至第 6 步。 

3. 如果“顺序控制”(Sequential control) 对象不可用，则从快捷菜单中选择“插入新对象”(Insert 
New Object) 命令。快捷菜单中将显示所有可用对象。 
选择菜单命令“顺序控制”(Sequential control)。 
顺序控制随即插入并显示为图标。 

由于每个工厂设备模块只能分配一个顺序控制，之后工厂设备模块快捷菜单中的相应菜单命
令会处于禁用状态。

4. 在工艺编辑器中选择“顺序控制”(Sequential control) 的图标。右侧窗口中将显示相关属性。 
选择“已分配块”(Assigned block) 属性。当手动创建顺序控制时，在“分配”(Assignment) 列
中无条目，因此也不存在已分配的 SFC 类型。 
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5. 打开 CFC 编辑器中的块目录以分配 SFC 类型。 
将所需 SFC 类型从块目录中拖放到 CFC 编辑器的图表窗口中。新插入的 SFC 类型在 CFC 中显
示并在“已分配块”(Assigned block) 属性中进行引用。 
如果在块目录中无 SFC 类型，则在组件视图下主数据库的“图表”(Charts) 文件夹中创建需要
的 SFC 类型。

6. 如果要组态该顺序控制的下级元素，请在工艺编辑器中选择顺序控制的图标。
从快捷菜单中选择“插入新对象”(Insert New Object) 命令。快捷菜单中将显示所有可用对象。
在当前版本中只能选择“参数”(Parameter)。 

7. 在快捷菜单中，选择“参数”(Parameters) 菜单命令。 
将打开“工厂设备阶段的参数”(Parameters of the equipment phase) 对话框。所有可用的参
数都将在此对话框中显示。 
选择所需的参数，然后单击“插入”(Insert)。参数随即插入并显示为图标。组态该参数的属性。

8. 参数也可用作步和转换条件组态的单独变量，例如实际值、限值。 
要创建作为单独变量的参数，应在工艺编辑器中选择相应 SFC 类型的块实例的所需块 I/O，并
将其拖动到顺序控制中。
将自动创建“参数”(Parameter) 对象。这些单独变量的名称已预定义，不可更改。更多相关
信息，请参见顺序控制数据对象表中的“设备模块和控制模块的数据对象概述 (页 294)”部
分。 

结果

“顺序控制”(Sequential control) 对象在分配工厂设备模块类型和 SFC 类型时组态。 
如果需要，可创建作为该顺序控制子对象的参数。  

说明

对于分配的 SFC 类型，仍需在 SFC 编辑器中组态顺控和特性等内容。

 

11.2.4.4 设备模块中的控制模块

概述

可将控制模块分配到设备模块。 
可使用以下组态选项： 
• 将要分配的控制模块集成为设备模块类型的组件，因此可将其用作下级对象。 

为此，将控制模块作为一个对象直接在设备模块中组态。还可以组态能够在其中定义“角

色”(Role) 的“控制模块分配”(Control module assignment)。  
• 该控制模块不是设备模块类型的组件。

随后为该控制模块组态“控制模块（基本要求）”(Control module (basic requirement)) 和
“控制模块分配”(Control module assignment) 对象。
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更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。

11.2.4.5 创建设备模块类型的实例

概述

设备模块类型存储在主数据库中。

可在主数据库中复制类型，或复制到项目中以创建实例。 
在主数据库中复制设备模块类型时的属性

• 在主数据库内复制类型时，将创建一个新类型，同时复制包括基本要求在内的原始类型

的所有组件。

• 此外，无论该类型中已分配的控制模块是类型的组件还是基本要求，都会同时复制其中

定义的控制模块分配。

创建实例（从主数据库复制到项目）时的属性

• 将设备模块类型从主数据库复制到工厂层级的节点中，即可创建实例。 
根据 ISA-88 标准，可将该节点分类为设备模块。 
但是，如果使用 SIMATIC BATCH，则必须将该节点标记为设备模块！

说明

过程单元节点中的实例数

可在工厂层级的过程单元节点下创建任意数量的设备模块类型实例。但是，如果根据 
ISA-88 将该节点分类为设备模块，则多个实例毫无意义。不过，SIMATIC Manager 不会

对此进行检查，因此需要用户负责处理！

• 未复制可选控制模块。 
可在实例中选择并连接这些可选控制模块。

只有设备模块下第一个子级别的下级控制模块可定义为“可选”。 
• 此外，无论该类型中已分配的控制模块是类型的组件还是基本要求，都会同时复制其中

定义的控制模块分配。

• 创建实例时也将复制在类型中作为组件集成的控制模块。

• 复制时不包括“控制模块（基本要求）”，因为基本要求仅从理论上描述了要分配的控

制模块的最低要求。

必须在实例中为这些基本要求分配相应的控制模块。
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• 可在设备模块和控制模块的类型中定义命令和状态。这些内容不会复制。

• 要支持类型-实例同步，实例中的相应类型应为已知。 
类型与实例之间的比较

对类型或相关实例进行更改时，可能需要同步类型和实例。 
更多相关信息，请参见“比较并同步设备模块的类型和实例 (页 313)”部分。

11.2.4.6 比较并同步设备模块的类型和实例

简介

创建实例时，工厂设备模块的类型和实例均相同。 
类型或其相关实例发生更改时，可能需要同步类型和实例。 
因此，举例来说，创建实例时，SFC 类型中定义的工厂设备模块的顺控是相同的。但是，如

果更改主数据库中的 SFC 类型，则必须同时更新项目中的 SFC 类型来执行同步。

比较和同步

同步期间，会将项目中某一类型的所有实例与主数据库中的相应类型做比较。这样可显示出

工厂设备模块的类型与其实例（过程工程级）之间以及 CFC（程序级）等相关对象之间的差

别。 
通过更新项目中的 SFC 类型，可实现主数据库与项目之间的参数描述和顺控的同步。更多相

关信息，请参见“如何更新多项目中的块/SFC 类型 (页 117)”部分。

说明

自 CFC V9.0 起，工艺对象（例如控制模块 (CMT)）的类型实例同步需要 V9.0 及更高版本的 
VXM 许可证。 
有关同步的更多信息和说明，请参见“有关工艺对象类型实例同步的说明 (页 377)”部分。   

包括的对象

工厂级工厂设备模块的类型和实例的同步中包括以下下级对象：

• 控制模块

• 控制变量：

– 参数

– 信号

• 消息
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• 命令和状态

• 控制模块的分配

• 组态顺序控制

但是，控制模块的基本要求通常并不包括在内，因为根据定义，不允许在实例中使用这些对

象。

说明

主数据库中的同步

在库中，如果控制模块类型用作工厂设备模块类型中的下级控制模块，则该下级控制模块还

将与其控制模块类型同步。

操作步骤

1. 在工厂视图中选择项目。

2. 打开快捷菜单并选择菜单命令“设备类型 > 同步...”(Plant types > Synchronize...)。 
打开“同步设备类型”(Synchronize plant types) 对话框。 

3. 在表的左侧列中，选择想要比较和同步的工厂设备模块或控制模块的类型。

4. 单击“同步...”(Synchronize...) 按钮启动比较。 
比较中仅包括相关属性和关系。更多相关信息，请参见“设备模块类型/实例同步的相关属性 
(页 315)”部分。 
已添加到实例中的功能和功能块不包含在比较中，并且不会在比较结果中显示。

5. 显示比较结果。
比较结果中将突出显示以下对象： 
– 实例中添加的对象（例如子函数、消息、函数和函数块）将标记为附加对象。 
– 已删除对象。

– 属性已修改的对象。 
顺控拓扑与参数描述的差异不会直接显示在比较结果中。但会显示两个比较对象的更改时间
戳： 
– 主数据库中与“顺序控制”(Sequential control) 相关的 SFC 类型的更改时间戳。  
– 项目中相应 SFC 类型的更改时间戳。 
对于工厂设备模块类型中集成的控制模块，相应的“控制模块分配”也将显示在比较结果中。
如果“控制模块分配”丢失或已更改，则日志文件中会有一个条目提示用户检查此工厂设备
模块环境中的控制模块。

6. 在比较结果中，根据相应类型选择要同步的实例。 
选中或清除对话框左侧相应对象旁边的复选框。 

7. 通过“同步模板”(Synchronize templates) 图标启动同步。 
将同步所选实例。
如果实例特定的扩展没有应用到类型的对象，则会得以保留。 

工艺组态

11.2 组态和使用设备模块

SIMATIC S7 中的 CFC (V9.0 SP7)
314 功能手册, 05/2022, A5E41356112-AH



结果

已完成工厂设备模块或控制模块的类型与其实例之间的比较，并且已同步所选实例。 

参见

设备模块的基础知识 (页 290)
创建设备模块类型的实例 (页 312)

11.2.4.7 设备模块类型/实例同步的相关属性

简介

设备模块/控制模块的类型或相关实例发生更改后，可能需要在类型和相应实例之间进行比

较或同步。

比较中仅包括实例中无法更改的属性和关系。只会确定和显示这些属性和关系的比较结果。 

概述

下表概述了与比较相关的对象、属性和关系。 

对象/类型 相关属性  相关关系

设备模块  • 分配的名称

• 分配的注释

组态顺序控制 更改时间戳 
（已分配的 SFC 类型）

分配的块（块实例或 SFC 类型）

控制模块  • 分配的块（块实例或子 CFC）
• 分配的名称

• 分配的注释

• 分配的功能标识符

• 分配的块图标

• 分配的作者

• 分配的版本

控制模块分配（设备模块中的链

接对象）

 控制模块分配 
（与基本要求不相关）

• 角色

• 注释
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对象/类型 相关属性  相关关系

设备模块分配  • 角色

• 注释

控制变量 • 取反（仅限互连的输入）

• 名称

• 变量类型（参数/信号）

• 数据类型

• 注释

• 互连

• 分配的 I/O（块变量）

消息 • 名称

• 消息标识符

分配的消息

块实例 • 名称

• S7_mes
• S7_read_back
• 块类型（函数/函数块）

块类型（函数/函数块的实例）

块变量/块 I/O • 取反（仅限互连的输入）

• 名称

• 注释

• I/O 类型

• 数据类型

• 值 
（参见下面的注释）。

• S7_edit
• S7_visible
• S7_mes
• S7_archive
• S7_enum
• S7_string0
• S7_string1
• S7_shortcut
• S7_unit

互连源

子 CFC • 名称

• 版本

• 作者

 

CFC 接口  -  - 
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对象/类型 相关属性  相关关系

CFC 接口参数 • 名称

• 注释

• I/O 类型

• 数据类型

• 值 
（参见下面的注释）。

• S7_edit
• S7_visible
• S7_mes
• S7_archive
• S7_enum
• S7_string0
• S7_string1
• S7_shortcut
• S7_unit

 

块消息 • 消息标识符

• 消息类型

 

子消息 消息标识符

（子消息编号）

 

 

特别说明

“值”(Value) 属性

某些条件下，将忽略下列对象的“值”(Value) 属性：

• 块变量

• CFC 接口参数

如存在下列条件之一，则忽略该属性：

• 对设备模块的控制变量进行分配时。 
• 设置“S7_m_c”属性时。 
在这些条件下，通常会根据实例对“值”(Value) 属性进行调整。 
块实例中的互连
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如果在块类型中设置了“S7_contact”属性，则块实例中的互连也会被忽略。将控制模块分配

给设备模块时，将自动创建与处理块（例如电机块）的互连。

此时“值”属性也会始终被忽略，因为显式或隐式（在 SFC 类型实例中）定义为块触点的参

数会根据定义进行互连。

参见

比较并同步设备模块的类型和实例 (页 313)

11.2.4.8 设备模块对象的属性

简介

在工艺编辑器的左侧部分中，控制模块或工厂设备模块中的对象在树形结构中以层级方式显

示，例如“参数”(Parameter) 或“消息”(Message)。 
右侧部分列出了当前在树中所选对象的属性。 

概述

下面的表格显示了以下工厂设备模块对象的属性：

1. 工厂设备模块 
2. 组态顺序控制 
3. 控制模块

4. 控制模块分配

5. 控制模块（基本要求）

6. 参数

7. 信号

8. 消息

有关所有后续表格中“数据交换”列的说明

该列指示某个属性是否包含在与工厂自动化加速器 (PAA) 进行的数据交换中。
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1.“工厂设备模块”对象的属性

属性 属性值的说明 数据交换

分配的图表 不可编辑 -
名称 可编辑 

不转发。

获取默认值“EM(x)”。

✓

注释 可编辑

不转发。

✓

作者 可编辑

不转发给相关对象。

✓

版本 可编辑 ✓ 
采样时间 可编辑 

所分配图表的所有块均已安装在 OB 中并配有最适合的采样

时间。输入内容无效时，将输入稍大的最小有效值。

运行时编辑器会相应地调整。

✓

支持类型实例行为 可编辑

对于工艺类型的每个实例，此属性的默认设置为 TRUE。这

意味着实例与其类型链接，并且包含在类型实例同步中。

可通过禁用此属性来有选择地从类型实例同步中排除实例。

为某一实例禁用此属性不会消除对该类型的内部引用及与该

类型的关系。这样即可编辑实例，而无论其类型如何。

可以通过激活此属性将实例包含在类型实例同步中。激活此

属性可重新建立实例与其类型之间的链接，从而将实例包含

在类型实例同步中。

备注：

• 仅在例外情况下（例如，测试、调试、选择或逐步更新实

例时）禁用此属性。

• 长时间禁用此属性可能导致实例与其类型不一致。因此，

在同步工厂类型之前，请检查差异。

✓
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说明

“命令”和“状态”属性

在工厂设备模块中不能定义任何“命令”和“状态”对象。这些对象可以专门为控制设备类

型或基本要求定义，也可以定义为“全局”对象。有关“命令”和“状态”对象属性的说明，

请参见“控制模块的属性和属性值 (页 224)”部分。 

 
2.“顺序控制”(Sequential control) 对象的属性

属性 属性值的说明 数据交换

名称 可编辑

不转发。

获取默认值“工厂设备阶段”。

✓

注释 可编辑

不转发。

✓

作者 可编辑 
不转发给相关对象。

✓

分配的块 不可编辑 -

 
3.“控制模块”对象的属性

属性 属性值的说明 数据交换

分配的块 不可编辑 -
名称 可编辑 

转发给相关对象。

获取所分配图表的名称作为默认值。

也可以分配给 CFC 或一个块。 

✓

注释 可编辑 
转发给相关对象。

-

操作图标 可编辑 ✓
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属性 属性值的说明 数据交换

可选 可编辑

仅适用于类型。

此属性不适用于下级控制模块，即直接在控制模块/工厂设备

模块类型下面的控制模块。 

✓

作者 可编辑

不转发给相关对象。

-

功能标识符 可编辑

转发给相关对象。

不用于子控制模块。 

-

函数 可编辑 
用于将控制模块标识为函数。

-

函数名称 显示函数名称。

• 无法在控制模块的类型中编辑。 
当“函数”属性启用时，“名称”属性的值将自动应用。 

• 可在实例中编辑。 

-

基本要求 可编辑

仅适用于类型。

函数不能是基本要求。 

✓

控制模块类型 不可编辑

不转发。

-

 
控制模块没有工厂设备模块中的“采样时间”属性，因为控制模块分配到工厂设备模块的运

行组中。 
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4.“控制模块分配”对象的属性

属性 属性值的说明 数据交换

分配的控制模块 可编辑

不转发给相关对象。

✓

角色 可编辑

获取默认值“角色”。

✓

注释 可编辑

不转发。

✓

 
5.“控制模块（基本要求）”对象的属性

属性 属性值的说明 数据交换

分配的块 不可编辑 -
名称 可编辑

不转发。

获取默认值“Control module(x)”。

✓

注释 可编辑

不转发。

✓

操作图标 可编辑 ✓
可选 可编辑

不转发给相关对象。

✓

作者 可编辑

不转发给相关对象。

✓

功能标识符 可编辑

转发给相关对象

✓

函数 不可编辑

用于将控制模块标识为函数。

-

函数名称 不可编辑

显示函数名称。

-

基本要求 可编辑 ✓
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属性 属性值的说明 数据交换

类型 不可编辑

不转发。

-

工艺块 可编辑 
仅在控制模块类型无引用时显示。

-

 
6.“参数”对象的属性

属性 属性值的说明 数据交换

分配的 I/O 不可编辑 -
互连到 可编辑 

显示互连。

-

引用 CM 参数 可编辑

可以绝对或相对寻址。 
✓

引用块变量 可编辑

可以绝对或相对寻址。 
✓

引用全局变量 可编辑

可以绝对或相对寻址。 
✓

名称 可编辑

不转发

获取默认值“参数”。

✓

注释 可编辑

不转发。

✓

信号 可编辑

右键单击文本域并使用菜单命令“新信号互连”(New Signal 
Interconnection) 打开 CFC 的符号表。此值将转发到所分配 
I/O 的“互连”属性。

-

值 可编辑

转发给所分配 I/O 的“值”属性。

✓

取反 选中此复选框可对控制变量取反。仅当存在互连时才能选中

该框。

-
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属性 属性值的说明 数据交换

文本 0 可编辑

转发给所分配 I/O 的“文本 0”属性。

只有在编辑其系统属性设置为 S7_string_0 且数据类型为

“BOOL”的 I/O 时，此选项才可见。

✓

文本 1 可编辑

转发给所分配 I/O 的“文本 1”属性。

只有在编辑其系统属性设置为 S7_string_1 且数据类型为

“BOOL”的 I/O 时，此选项才可见。

✓

枚举 通过下拉菜单选择

转发给所分配 I/O 的“枚举”属性。 
仅当为 I/O 分配系统属性 S7_enum 时，此选项才可见。

✓

单元 通过下拉菜单选择

除单元文本外，还会在方括号中显示符合“过程控制设备规

约”标准的唯一标识号。

转发给所分配 I/O 的“单元”属性。为此必须组态 s7_unit 
属性。

✓
 

操作标识符 可编辑

转发给所分配 I/O 的“标识符”属性。为此必须组

态 s7_shortcut 属性。

✓

IO 类型 通过下拉菜单选择

必须与所分配 I/O 的 IO 类型相匹配。

-

数据类型 通过下拉菜单选择

必须与所分配 I/O 的数据类型相匹配。

✓

变量类型 “参数”（通过下拉菜单选择）。 
转发给所分配的 I/O。

✓

类型 不可编辑

不转发。

-
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7.“信号”对象的属性

属性 属性值的说明 数据交换

分配的 I/O 不可编辑 -
互连到 此处不相关。   -
引用 CM 参数 此处不相关。 -
引用块变量 此处不相关。 -
引用全局变量 此处不相关。 -
名称 可编辑

不转发。

获取默认值“信号”。

✓

注释 可编辑

不转发。

✓

信号 可编辑

右键单击文本域并使用菜单命令“新信号互连”(New Signal 
Interconnection) 打开 CFC 的符号表。此值将转发到所分配 
I/O 的“互连”属性。

-

值 此处不相关。

 
-

范围下限值 可编辑（在类型中） 
仅与“REAL”数据类型的模拟信号（输入和输出信号）相关。 
对于二进制信号，输入字段将被锁定。

✓

范围上限值 可编辑（在类型中） 
仅与“REAL”数据类型的模拟信号（输入和输出信号）相关。 
对于二进制信号，输入字段将被锁定。

✓

取反 选中此复选框可对控制变量取反。仅当存在互连时才能选中

该框。

-

枚举 此处不相关。 -
单元 此处不相关。 -
操作标识符 此处不相关。 -
IO 类型 通过下拉菜单选择

必须与所分配 I/O 的 IO 类型相匹配。

-
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属性 属性值的说明 数据交换

数据类型 通过下拉菜单选择

必须与所分配 I/O 的数据类型相匹配。

✓

变量类型 “信号”（通过下拉菜单选择）。 
转发给所分配的 I/O。

✓

类型 不可编辑

不转发。

-

 
8.“消息”对象的属性

属性 属性值的说明 数据交换

分配的消息 不可编辑 -
名称 可编辑

不转发给相关对象。

获取默认值“消息”。

✓

消息类别 不可编辑

此值继承自所分配单个消息的属性“消息类别”(Message 
class)。

-

优先级 可编辑

只能使用数字。输入内容无效时，将输入值“0”。会转发给所

分配单个消息的“优先级”属性。

✓

消息标识符 必须手动指定。

如果输入了有效的消息标识符（例如，SIG1），则只要所分

配的块有消息响应，就会自动应用消息类别、事件和来源属

性。

-

事件 不可编辑

继承自所分配单个消息的“事件”属性。

-

信息文本 会转发给所分配单个消息的“信息文本”属性。 -
来源 会转发给所分配单个消息的“来源”属性。 -
单个确认 可编辑

如果消息应作为单个消息确认，则选中该复选框。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓
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属性 属性值的说明 数据交换

需要确认 可编辑

如果生成的消息需要确认，则选中此复选框。如果选中此复

选框，“PCS 7 消息组态”(PCS 7 message configuration) 对话

框的“消息类别”(Message class) 列只显示可以确认的类别，

如果未选中此复选框，只显示无法确认的类别。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

触发操作 可编辑

选中该复选框后，此消息将触发标准的“GMsgFunction”，可

通过 PCS 7 的“全局脚本”编辑器来编辑该函数。该函数可

在“全局脚本”的函数浏览器中的“标准函数/报警”(Default 
functions/alarm) 下找到。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

OS 区域 不可编辑

从中可指定消息的区域分配。

如果未指定文本或区域或已定义为关键字 $$AREA$$，则在

通过 OS 编译传输数据时，将会对层级文件夹的相应属性进

行评估并将其存储在 OS 消息文本中。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

批生产 ID 不可编辑

从中可指定消息的批生产 ID 如果输入批生产 ID 的关键字 
@1%s@，在通过 AS-OS 连接组态传输数据时，将对相应属

性进行评估并将其作为“批生产名称”存储在 OS 消息文本

中。

也可在“PCS 7 消息组态”(PCS 7 message configuration) 对话

框中编辑该属性。

✓

 

“分配”列

根据工艺编辑器左侧的所选对象，可以在“分配”(Assignment) 列中将图表、块、块 I/O（参

数/信号）、消息、控制模块、工厂设备模块或 SFC 类型分配给所选对象的属性。
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可通过从 CFC 编辑器中进行拖放来分配块和参数。可通过在所选字段的快捷菜单中选择“添

加图表 EM”(Add Chart EM) 菜单命令来分配图表。
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11.3 组态和使用设备阶段

11.3.1 设备阶段的基础知识

概念

对于 PCS 7 V9.0 及以上版本，提供 Equipment Phase“EPH”用于对多个下级工厂设备模块进

行控制。 
• 连接 SIMATIC BATCH 时，该工厂设备阶段分配的伙伴位于过程控制端。 
• 各种工厂设备模块和控制模块的工厂设备阶段均可存储用于过程控制。

工厂设备阶段的优势是：

• SIMATIC BATCH 的工厂设备阶段不受资源影响。因此，SIMATIC BATCH 中的配方可以独立

于资源创建。 
发送命令、状态、控制策略和设定值，但不发送资源特定的数据。 

• 对于过程控制，将不对下级工厂设备模块 (EM) 进行永久性的分配，而是在运行时发出请

求，分配后再释放。

因为不存在严格的分配，下级工厂设备模块可在各种工厂设备阶段中连续使用。下级工

厂设备模块的请求、分配和释放策略在工厂设备阶段中组态。 
工厂设备阶段在 PCS 7 OS 的过程画面中通过面板进行展示，而且可以在手动模式下通过该

面板对其进行操作。 
概述 
下图显示了工艺对象、工厂设备阶段、工厂设备模块和控制模块的使用示例。 
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要点：

• 工厂设备阶段“EPH_100”使用下级工厂设备模块 "EM_10”、“EM_20”和“EM_30”。  
• 工厂设备阶段“EPH_200”使用下级工厂设备模块“EM_30”。 

此外，控制模块 (CM) 直接嵌套在其下方。

• 在“EPH_100”和“EPH_200”对象中，在相应下级工厂设备模块中组态“参考”
(References)。这些“参考”(references) 通过符号在画面中进行表示，包含下列组态： 
– 每个下级工厂设备模块的对象：

 -“工厂设备模块（基本要求）”(Equipment module (basic requirement))，描述了工厂

设备模块的最低工艺要求。 
 -“工厂设备模块分配”(Equipment module assignment)（角色），针对随后被分配到

工厂设备模块的实例。  
– 在工厂设备阶段的顺序控制中组态的分配策略和分配状态查询（如果需要） 

• “请求 + 运行时分配”对象显示在运行时请求工厂设备模块，随后分配并再次释放模块。

因为两个上级工厂设备阶段“EPH_100”和“EPH_200”均需要“EM_30”对象，分配状态查询

可与分配策略的组态一同使用。 
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基础知识

工厂设备阶段的元素

下面内容简要介绍了某个工厂设备阶段的数据对象。  
更多相关详细信息，请参见“设备阶段的数据对象概述 (页 335)”部分。

• “顺序控制”(Sequential control) 包括其顺控和参数说明，在工厂设备阶段中必须始终可

用，且仅可使用一次。

  可以选择性包含以下对象：

• 控制模块，设备模块类型的组成部分，可使用多个

• 控制模块分配；可使用多个

• “控制模块（基本要求）”(Control module (basic requirement))；作为基本要求，其中定

义了控制模块的最低要求。 
不可标记为可选；可使用多个

• “工厂设备模块分配”(Equipment module assignment)；可使用多个

• “工厂设备模块（基本要求）”(Equipment module (basic requirement))；作为基本要求，

其中定义了工厂设备模块的最低要求；可使用多个

• 下列对象可作为控制变量，可使用多个：

– 参数  
– 信号  

• 消息；可使用多个

控制模块的元素

控制模块包含以下可选对象：

• 子控制模块；可能有多个

• 命令；可使用多个

• 状态；可使用多个

• 下列对象可作为控制变量，可使用多个： 
– 参数  
– 信号  

• 消息；可使用多个

命令和状态
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以下内容适用于工厂设备阶段的“命令”(commands) 和“状态”(statuses)：
• 仅全局命令和状态可用于工厂设备阶段。这些命令和状态通过 SIMATIC Manager 在主数

据库中创建。

这些全局命令和状态通常基于工厂设备阶段和工厂设备模块，可在工厂的所有工厂设备

阶段中使用。

• 对象特定命令和状态不可用于工厂设备阶段。    
只能在控制模块类型（而不是实例）或在“控制模块（基本要求）”(Control module 
(basic requirement)) 中可用。

更多相关信息，请参见“全局“命令”(Command) 和“状态”(Status) 的数据对象概述 
(页 382)”部分。

工厂设备阶段中的控制模块

可将控制模块分配到工厂设备阶段。 
可使用以下组态选项： 
• 将要分配的控制模块集成为工厂设备阶段类型的组件，因此可将其用作下级对象。 

为此，将控制模块作为一个对象直接在工厂设备阶段中组态。还可以组态能够在其中定义

“角色”(Role) 的“控制模块分配”(Control module assignment)。  
• 该控制模块不是工厂设备阶段类型的组件。

随后为该控制模块组态“控制模块（基本要求）”(Control module (basic requirement)) 和
“控制模块分配”(Control module assignment) 对象。

更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。 

工厂设备阶段的类型和实例

类型/实例概念用于工厂设备阶段。类型/实例概念的优势在于，它可以在中央位置对类型进

行更改，然后通过同步实例传送这些更改。

• 当类型与实例之间存在差异时，可使用同步。同步类型和实例时，实例特定的扩展会加

以管理，而且不会丢失。因此，可以在自动化系统中无扰动地加载更改。 
• 工厂设备阶段的类型和实例包含在与工厂自动化加速器 (PAA) 之间的数据交换中。
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创建类型和实例：

• 使用下列选项，工厂设备阶段的类型仅可在 PCS 7 项目的主数据库中创建：  
– 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中  
– 在 PAA 中创建并在随后通过自动化接口 (AI) 导入 
在主数据库中，组态工厂设备阶段类型以便在 PCS 7 项目中使用。 
可以使用 SIMATIC Manager 在主数据库中复制和删除该类型。 

• 实例是指重复使用工厂层级的工厂描述中的类型。 
将类型从主数据库复制到工厂层级中某一节点下的项目中，便可轻松创建类型的实例。  

类型和实例的命名

• 此类型的名称在主数据库中是唯一的，这点与工厂设备模块类型和控制模块类型完全一样。

• 工厂设备阶段的类型与以下对象共享主数据库中的名称空间： 
– 工厂设备阶段的类型

– 控制模块类型 
– 全局命令和状态 
因此，工厂设备阶段类型和控制模块类型不能同名。

• 工厂设备模块类型的名称：  
– 该名称的最大长度是 22 个字符。建议只使用 18 个字符以便为自动重命名预留一些空

间，例如，复制期间通过自动添加字符串“(1)”以避免名称冲突。 
– 工厂设备阶段类型的实例通过工厂层级分层次进行寻址。因此，较高级别的单元都是

唯一的。

说明

如果复制期间名称已存在：

如果复制图表并粘贴，则带“(x)”（其中 x 为 1、2、3、4 等）后缀的图表名称将作为所复制

图表的名称。

例如：

如果存在名为“ChartName”的图表，并且若创建了此图表的副本，则复制的图表名称为

“ChartName(1)”，因为名称“ChartName”已存在。此外，如果再次粘贴（创建另一个副

本），则下一个复制的图表将命名为“ChartName(2)”。但是，如果从“ChartName(2)”图表创

建副本，则复制的图表将命名为“ChartName(2)(1)”。

工艺组态

11.3 组态和使用设备阶段

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 333



说明

如果复制期间超出了名称的最大长度：

如果复制名称具有 22 个字符（最大长度）的图表并粘贴，则所复制的图表名称将从该字符

串的末尾缩短，直到可以附加“~(x)”（其中 x 为 1、2、3、4 等）。

例如：

如果存在名为“ChartNameMotorControlA”（22 个字符）的图表，并且若创建了此图表的副

本，则复制的图表名称为“ChartNameMotorCont~(1)”。
在名称已存在的情况下，根据命名的一般规则，新图表名称应为

“ChartNameMotorControlA(1)”（25 个字符），但这超出了 22 个字符的最大允许长度。因

此，使用上述方法将名称缩短为 22 个字符。

类型和实例的比较和同步

类型或其相关实例发生更改时，可能需要同步类型和实例。

同步期间，会将项目中某一类型的所有实例与主数据库中的相应类型做比较。这样可显示出

工厂设备阶段的类型与其实例之间以及 CFC（程序级）等相关对象之间的差别。

更多相关信息，请参见“比较并同步设备阶段的类型和实例 (页 359)”部分。 
与 PAA 的数据交换

利用自动化接口 (AI) 的导入功能（基本功能），可将使用 PAA 定义的工程级工厂设备阶段

和工厂设备模块的类型传送到 PCS 7 过程控制系统。关联的顺控、转换条件和动作会随类型

一同导入。

这样，便可将在 PAA 中生成的工程级数据以工厂设备阶段和工厂设备模块的形式导入到 PCS 7 
中，进而输入到自动化层。此处，数据显示为顺控 (SFC) 和自动化程序 (CFC)。
更多相关信息，请参见“与 PAA 的数据交换概述 (页 362)”部分。 

参见

分配配方阶段 (RPH) 至工程系统的组态方法 (页 375)
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11.3.2 设备阶段的数据对象概述

简介

下面的表格将介绍： 
1.“工厂设备阶段”(Equipment phase) 的数据对象

在工艺编辑器中的图标：

2.“顺序控制”(Sequential control) 的数据对象
在工艺编辑器中的图标：

工厂设备阶段的数据对象

工厂设备阶段 (EPH) 由以下元素组成，这些元素可以为一个或多个。 

说明

在工厂设备阶段中不能定义任何“命令”(Command) 和“状态”(Status) 对象。这些对象可以

专门为控制设备类型或基本要求定义，也可以定义为“全局”对象。更多相关信息，请参见

下表。 
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对象/图标 描述

组态顺序控制

   
顺序控制定义了顺控及其参数描述（如设定值、控制策略、参数、消息）。

顺序控制可能仅在工厂设备阶段中存在一次。

每个工厂设备阶段必须且只能分配一个顺序控制。

下面的表格“顺序控制的数据对象”(Data objects of the sequential control) 介绍

了这些元素。

控制模块

   
控制模块可组态为工厂设备模块类型的组件。 
可以存在多个控制模块。

可选控制模块： 
• 在主数据库中的类型中，控制模块只能定义为“可选”。  
• 在工厂设备模块类型下的第一个子级别上，控制模块只能定义为“可选”。    
• 工厂设备模块下的控制模块嵌套深度限制为最多 3 层。 

这意味着工厂设备模块最多只能有两层子控制模块，例如，层级“工厂设备

模块 > 控制模块 > 子控制模块”(Equipment module > Control modules > Sub-
control modules)。

注：

属于工厂设备模块类型的组件的控制模块可定义为“基本要求”。为此，需对控

制策略的“基本要求”(Basic requirement) 属性进行设置。随后该控制模块便不

再是工厂设备模块类型的组件，并且该控制模块的块也将从模型中删除。 
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对象/图标 描述

控制模块分配

   
如果要在顺控中对控制模块进行控制，则必须将工厂设备模块分配给控制模块。

分配将组态以下内容： 
1.“角色”(role)。

所谓的控制模块“角色”在工厂设备模块类型中设置，而不是在控制模块中

设置。

“角色”指示了所分配的控制模块在此类型的上下文中的使用方式，例如，分

配的“阀”控制模块的“角色”为“出口”。  
“角色”用于在顺控的操作和转换条件中寻址目标控制模块。

2. 控制模块或基本要求的链接。

– 当控制模块集成在工厂设备模块的类型中时，此控制模块即已分配。  
– 如果控制模块未集成在类型中，则分配相应的基本要求。  

要分配的控制模块的具体要求在“控制模块（基本要求）”下自行指定，

如下所述。

可以为分配提供注释。

可以有多个分配。 
如果组态“控制模块分配”，还必须创建相应的基本要求或集成到类型中的控制

模块。

工厂设备模块分配

   
分配将组态以下内容： 
1.“角色”(role)。

工厂设备模块的类型定义了工厂设备模块的“角色”(role)，但特定的工厂设备

模块除外。

“角色”(role) 指示了所分配的工厂设备模块在此类型的上下文中的使用方式，

例如，分配的“阀”(valve) 工厂设备模块的“角色”(role) 为“出口”(outlet)。  
“角色”(role) 用于在顺控的操作和转换条件中寻址目标工厂设备模块。

2. 工厂设备模块或基本要求的链接。

– 如果已在工厂设备模块类型中组态了链接的工厂设备模块，则分配该工厂

设备模块。  
– 如果未在类型中组态链接的工厂设备模块，则分配相应的基本要求。  

要分配的工厂设备模块的具体要求在“工厂设备模块（基本要求）”
(Equipment module (basic requirement)) 下自行指定，如下所述。

可以为分配提供注释。

可以有多个分配。 
如果组态“工厂设备模块分配”(Equipment module assignment)，还必须创建相

应的基本要求或集成到类型中的下级工厂设备模块。

备注：

如果对 EM 和 EPH 的 SFC 类型执行“更新块类型”后，EM 和 EPH 实例之间的互

连未更新，则必须在 EPH 实例中重新分配 EM 角色。
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对象/图标 描述

控制模块（基本要求）

   
“控制模块（基本要求）”从理论上描述了要分配的控制模块的最低要求。 
尤其是，要求包括了必要的命令以及状态反馈。

• 可以有多个基本要求。 
• 工厂设备模块类型中需要基本要求，以便能使用命令和状态，例如在过程逻

辑中使用。

• “命令”(Command) 和“状态”(Status) 对象可在基本要求中定义。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部分。 

• 基本要求不能定义为可选。 
工厂设备模块（基本要求）

 

“工厂设备模块（基本要求）”(Equipment module (basic requirement)) 从理论上

描述了要分配的工厂设备模块的最低要求。 
尤其是，要求包括了必要的命令以及状态反馈。

• 可以有多个基本要求。 
• 工厂设备模块类型中需要基本要求，以便能使用命令和状态，例如在顺序逻

辑中使用。

• “命令”(Command) 和“状态”(Status) 对象可在基本要求中定义。 
更多相关信息，请参见“实现特定命令/状态的特别注意事项 (页 223)”部分。 

• 基本要求不能定义为可选。

参数

   

 

• 可以有多个参数。

• “参数”对象可以用作： 
– 工厂设备模块或控制模块的子对象。

– 命令和状态的形式参数。 
在“顺序控制”(Sequential control) 中，这些形式参数定义了特定参数或常

量的占位符，这些参数或常量位于顺控的操作和转换条件中的使用点。 
• “值”和“信号”属性以及“互连”关系只能作为替代内容输入。

• 只有输入参数允许“信号”属性，输出参数禁用该属性。

• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

对于输入参数，“取反”属性与参数互连或信号有关。
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对象/图标 描述

信号

   
• 可以有多个信号。

• 在工艺编辑器中，信号属性的表示方式与参数的表示方式相同。但是，

“值”、“枚举”、“操作标识符”、“单位”和“互连”值或关系的输入字

段被禁用。 
• 只有“BOOL”数据类型的输入参数允许“取反”属性，输出参数禁用该属性。

它适用于信号的“信号”属性。

消息

   
工厂设备模块默认可生成消息。

• 可以有多个消息。

• 可以直接在工厂设备模块下组态消息。然后这些消息将仅适用于相关 CFC 中 
SFC 类型的块实例。要分配相应的消息，必须将 SFC 类型的这一块实例的消

息输入设置为可见。 

顺序控制的数据对象

“顺序控制”(Sequential control) 由以下元素组成，这些元素可以为一个或多个： 

对象/图标 描述

参数

用于参数说明

   

• “顺序控制”(Sequential control) 的参数说明对应于“特性”(characteristics)，
这些特性在 SFC 类型中设置。 

• 在工程级 (PAA) 集成环境中，对数据交换模型中的过程工程所需的参数和属

性有一定限制。

• 参数可用作“顺序控制”(Sequence control) 的子对象，以定义为“顺序控制”
(Sequence control) 在外部和内部与顺控相连的各个变量。

更多相关信息，请参见此表格结尾处。 
• 控制策略

   
使用控制策略可以定义各种过程工程步骤。

顺控的控制基本上是控制策略的功能。控制策略对于高级配方控制级别（批生

产系统）非常重要。

属性：

• 名称  
• 编号  
• 注释  
• 分配的设定值   

在 PAA 数据交换模型中，通过关系（分配的控制策略）将设定值分配到控制

策略。
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对象/图标 描述

• 设定值

   
设定值可在过程工程中通过手动操作指定，也可以用高控制级别系统（批生产

系统）指定。

设定值会分配给单独的控制策略。除设定值外，实际（过程）值始终作为控制

变量提供。

属性：

• 名称  
• 数据类型  
• 注释  
• 下限  
• 上限  
• 单位  
通常在工厂设备模块的实例中确定或调整上限、下限和（测量）单位。 

• 过程值/实际值 
   

工厂设备模块中的过程值集成用于控制顺控，例如使用实际值来分步使能顺控。 
属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
单位通常在工厂设备模块的实例中设置。

• 控制值

   
连接外部控制模块时需要使用控制值，无法通过控制模块触点直接访问控制值。

属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
单位通常在工厂设备模块的实例中设置。

• 参数

   
参数用于对实例中“顺序控制”(Sequential control) 的行为施加影响，例如通过

选项施加影响。这些参数还可用于设置特定实例的限制。

属性：

• 名称  
• 数据类型  
• 注释  
• 单位  
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对象/图标 描述

• 位存储器

   
临时存储值时需要位存储器。其仅在顺序控制系统中本地使用。

属性：

• 名称  
• 数据类型  
• 注释  

• 定时器

   
定时器用于时间监视或计算运行时间等用途。

属性：

• 名称  
• 注释  

• 注释文本

   
注释文本用于用户界面等用途。

属性：

• 名称  
• 文本  
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对象/图标 描述

• 位置文本

   
位置文本用于显示操作员站的当前过程状态。 
属性：

• 名称  
• 文本  

顺控

   
过程工程任务“顺序控制”(Sequential control) 在顺序逻辑中定义。这通过顺控

来描述。必须为“顺序控制”(Sequential control) 每个状态的每个控制策略定义

行为。

顺控有一个起始步和一个结束步。

顺控可包括以下元素，这与 SFC 类型相似：

• 步

• 转换条件

• 选择分支

• 并行分支

• 循环

• 跳转

选择分支和并行分支都会以对称方式再次合并。

为 PAA 中的过程工程级的步骤定义的操作通过列表形式的命令来描述。用于此

用途的命令在控制模块（例如电机、阀）中集中提供。命令也可在工厂设备模

块中定义。

转换条件在 PAA 中的过程工程级设置为表达式，这些表达式使用状态和逻辑标

准函数，结果为布尔值。 
为此，由电机、阀等控制模块提供的状态以及在工厂设备模块中定义的状态都

可用于此用途。 

 
用作步和转换条件组态的各个变量的参数

在顺控中，步和转换条件组态可能需要各种单独的变量，例如实际值、限值。 
要创建这些单独的变量，应在工艺编辑器中选择相应 SFC 类型的块实例的所需块 I/O，并将

其拖动到“顺序控制”(Sequential control) 中。“参数”对象将自动创建。这些单独变量的

名称已预定义，不可更改。  
在工厂设备模块的实例中对这些单独变量进行互连和分配参数。

控制模块的数据对象

可为一个工厂设备阶段分配一个或多个控制模块。 
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与工厂设备阶段连接时，应该能通过工厂设备阶段顺控器的命令和状态访问控制模块，这一

点特别重要。

有关控制模块的数据元素的说明，请参见“设备模块和控制模块的数据对象概述 (页 294)”部
分。  
 

参见

设备阶段的基础知识 (页 329)
组态全局命令或状态 (页 378)

11.3.3 组态和管理设备阶段

11.3.3.1 组态和管理设备阶段概述

概述

• 组态 
使用下列选项，工厂设备阶段的类型仅可在 PCS 7 项目的主数据库中创建：

– 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中 
– 在工厂自动化加速器 (PAA) 中创建并随后通过自动化接口 (AI) 导入 
在主数据库中，组态工厂设备阶段类型以便在 PCS 7 项目中使用。 
更多相关信息，请参见“组态设备阶段（类型） (页 344)”部分。

• 管理

可在 SIMATIC Manager 中复制和删除工厂设备阶段类型。 
• 使用“派生接口”(derived interface) 创建工厂设备阶段

更多相关信息，请参见“使用“派生接口”(derived interface) 创建设备阶段 (页 346)”部分。

• 组态工厂设备阶段的顺序控制

更多相关信息，请参见“组态设备阶段的顺序控制 (页 350)”部分。

• 组态下级工厂设备模块

工厂设备模块可以在工厂设备阶段中分配为下级对象。 
更多相关信息，请参见“组态下级设备模块 (页 352)”部分。
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• 组态下级工厂设备模块的分配

对于工厂设备阶段，将不对下级工厂设备模块进行永久性的分配，而是在运行时发出请

求，分配后再释放。

更多相关信息，请参见“组态设备模块的分配 (页 354)”部分。 
• 位于工厂设备阶段类型上的控制模块

控制模块可在工厂设备阶段中分配为下级对象，或集成到工厂设备阶段中。 
更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。 

• 创建实例

将工厂设备阶段类型从主数据库复制到工厂层级的节点中，即可创建实例。 
更多相关信息，请参见“创建设备阶段类型的实例 (页 358)”部分。 

• 类型/实例同步

类型或其相关实例发生更改时，可能需要同步类型和实例。 
更多相关信息，请参见“比较并同步设备阶段的类型和实例 (页 359)”部分。 

• 工厂设备阶段实例中的控制模块

如果在类型中将控制模块组态为“控制模块（基本要求）”(Control module (basic 
requirement))，则必须在实例中分配项目的特定控制模块。

更多相关信息，请参见“将控制模块实例分配给设备模块/阶段 (页 288)”部分。

 

11.3.3.2 组态设备阶段（类型）

简介

使用下列选项，工厂设备阶段的类型仅在 PCS 7 项目的主数据库中创建： 
• 在 SIMATIC Manager 中的“工厂视图”(Plant view) 中 
• 在工厂自动化加速器 (PAA) 中创建并随后通过自动化接口 (AI) 导入 

更多相关信息，请参见“与 PAA 的数据交换概述 (页 362)”部分。 
可以使用 SIMATIC Manager 在主数据库中复制和删除该类型。

在主数据库中，组态工厂设备模块类型以便在 PCS 7 项目中使用。 
下面介绍该步骤。

要求

• 已在 SIMATIC Manager 中打开包含主数据库的多项目。
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操作步骤

1. 使用菜单命令“视图 > 工厂视图”(View > Plant View) 打开工厂视图。

2. 导入工厂设备阶段后，转到第 4 步。

3. 如果想要重新创建工厂设备阶段类型，在主数据库的工厂视图中导航到想要在其中创建对象
（例如“过程变量类型”(Process tag types)）的目录。
从快捷菜单中选择“插入新对象 > 工厂设备阶段（类型）”(Insert New Object > Equipment 
Phase (Type)) 命令。 
转到第 5 步。 

4. 在主数据库的工厂视图中，导航到在导入后创建或存储工厂设备阶段（例如“过程变量类型”
(Process tag types)）的目录。 
可以将类型移动或复制到用户在主数据库中创建的另一个目录，并在该目录下组态属性。

5. 右侧窗口中以相应的图标显示工厂设备阶段类型。

6. 双击图标。CFC 编辑器随即打开，可以在该编辑器中组态工厂设备阶段类型的属性。 
打开工艺编辑器。该类型具有多种属性，例如“名称”(Name)、“作者”(Author)、“注释”
(Comment)。 
输入所需的属性数据。 

7. 如果要组态该类型下的下级元素，请在工艺编辑器中选择工厂设备阶段类型的图标。

8. 从快捷菜单中选择“插入新对象”(Insert New Object) 命令。 
快捷菜单中将显示所有可用元素。 
– “控制模块”(Control module)；属于工厂设备模块组件的子控制模块。 
– “控制模块（基本要求）”(Control module (basic requirement))；作为基本要求，其中

定义了控制模块的最低要求

– “控制模块分配”(Control module assignment)
– “工厂设备模块分配”(Equipment module assignment)
– “工厂设备模块（基本要求）”(Equipment module (basic requirement))；作为基本要

求，其中定义了工厂设备模块的最低要求 
有关组态“工厂设备模块分配”(Equipment module assignment) 和“工厂设备模块

（基本信息）”(Equipment module (basic requirement)) 对象的信息，请参见“组态下

级设备模块 (页 352)”部分。

– “参数”(Parameter)
– “信号”(Signal)
–  “消息”(Message) 
– “顺序控制”(Sequential control) 

顺序控制可能仅在工厂设备阶段中存在一次。因此，只有当此工厂设备阶段中当前不

存在“顺序控制”(Sequential control) 对象时才能启用菜单命令。相关组态信息，请参

见“组态设备阶段的顺序控制 (页 350)”部分。

选择相应的菜单命令插入所需对象，如“参数”(Parameter)。 
9. 根据需要重复此步骤，添加更多下级元素。 
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结果

已组态工厂设备阶段类型。 
已插入下级元素，如参数和控制模块。 

说明

属性或分配的值等对象仍需在工艺编辑器中组态。

11.3.3.3 使用“派生接口”(derived interface) 创建设备阶段

简介

原理

下图显示了 BATCH 类别为“EPH 接口”(EPH interface) 和“EPH（派生）”(EPH (derived)) 的 SFC 
类型的使用原则。设备阶段 
在这一组态方法中，“EPH（派生）”(EPH (derived)) 类别的 SFC 类型将在 SIMATIC BATCH 中
作为配方阶段 (RPH) 的分配伙伴，而该类型则是由“EPH 接口”(EPH interface) 类别的 SFC 类
型中的抽象接口派生而来的。
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要点： 
• BATCH 类别“EPH 接口”(EPH interface) 在 SFC 类型“D-IF”中组态。 

此 SFC 类型无作为“EPH 接口”(EPH interface) 的顺控程序。 
• 为 EPH“定量给料 1”(Dosing 1) 和“定量给料 2”(Dosing 2) 组态关联的 SFC 类型“D1”和

“D2”。 
– 在 SFC 类型“D1”和“D2”中组态 BATCH 类别“EPH（派生）”(EPH (derived)) 和“D-IF”接口

名称（这两种 SFC 类型均从该接口派生而来）。

– 顺控程序可在这些 SFC 类型中组态为“EPH（派生）”(EPH (derived)) 类别的 SFC 类型。

– 作为“D-IF”的派生，其至少具有相同的参数、控制策略、设定值，例如“QUANTITY”、
“TEMP”，但也可能包含附加参数和不同参数，例如“RAMP”。 

• EM“加热器 1 + 2”(Heater 1 + 2) 和“秤 1 + 2”(Scale 1 + 2) 是位于 SFC 类型相互独立的“定

量给料 1”(Dosing 1) 和“定量给料 2”(Dosing 2) 下的下级 EM。  
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“EPH 接口”(EPH interface)
• BATCH 类别“EPH 接口”(EPH interface) 在“EPH 接口”(EPH interface) 的 SFC 类型属性中设

置。

• BATCH 类别为“EPH 接口”(EPH interface) 的 SFC 类型作为基本类别使用，因此可作为集成 
SIMATIC BATCH 配方阶段 (RPH) 的通用接口。

• BATCH 类别为“EPH 接口”(EPH interface) 的 SFC 类型仅包含设定值、控制策略等的接口描

述（但不含实施）。在这种情况下，将无法在 SFC 编辑器中对顺控程序的步和转移进行

编程。

“EPH（派生）”(EPH (derived))
• 在“EPH（派生）”(EPH (derived)) 的 SFC 类型属性中设置 BATCH 类别“EPH（派生）”(EPH 

(derived)) 并组态“EPH 接口”(EPH interface) 的 SFC 类型的名称。 
• BATCH 类别为“EPH 派生”(EPH (derived)) 的 SFC 类型包含设定值、控制策略以及实施等的

接口描述。可在 SFC 编辑器中对顺控程序进行编程。

• 可从相同“EPH 接口”(EPH interface) SFC 类型中派生出多个“EPH（派生）”(EPH (derived)) 
SFC 类型。这些派生出的“EPH（派生）”(EPH (derived)) SFC 类型的接口不需要完全相同，

但其必须满足“EPH 接口”(EPH interface) SFC 类型的要求。  

要求

• 已在 SIMATIC Manager 中打开包含主数据库的多项目。

• 主数据库包含要对其接口执行派生操作的设备阶段 (EPH)。   

步骤

1. 使用菜单命令“视图 > 组件视图”(View > Componen view) 切换到组件视图。 
在主数据库中导航至“图表”(Charts) 目录。 

2. 从快捷菜单中选择“插入新对象 > SFC 类型 (EPH)”(Insert New Object > SFC Type (EPH)) 命令。
“图表”(Charts) 目录中将显示新创建的 SFC 类型。 
如果需要，更改新创建的 SFC 类型的名称，例如，改为“D-IF”。   

3. 选择新创建的 SFC 类型并在快捷菜单中选择菜单命令“对象属性”(Object properties)。 
将打开“SFC 类型属性”(SFC Type Properties) 对话框。 
切换到“选项”(Options) 选项卡。

4. 在“SIMATIC BATCH”区的“类别”(Category) 选择框中，选择“EPH 接口”(EPH interface) 选项。  
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5. 在 SFC 类型的特性中组态所需的设定值、控制策略等。
关闭 SFC 编辑器。   
BATCH 类别为“EPH 接口”(EPH interface) 的 SFC 类型与对应图标一同显示在“图表”(Charts) 目
录中。  

6. 切换到工厂视图并打开将要从之前创建好的 SFC 类型中派生相应接口的设备阶段，例如“定
量给料 1”(Dosing 1)。 

7. 在设备阶段的 CFC 中，标记 SFC 块并在快捷菜单中选择“打开 SFC 类型”(Open SFC Type) 命令。
SFC 编辑器中将显示相关的 SFC 类型，例如“D1”。 

8. 选择菜单命令“SFC > 属性”(SFC > Properties)。 
将打开“SFC 类型属性”(SFC Type Properties) 对话框。 
切换到“选项”(Options) 选项卡。

9. 在“SIMATIC BATCH”区的“类别”(Category) 选择框中，选择选项“EPH（派生）”(EPH 
(derived))。

10.在“派生自接口：”(Derived from interface:) 字段中选择所需的接口，例如，“D-IF”。所有 
BATCH 类别为“EPH 接口”(EPH interface) 的可用 SFC 类型均显示在该字段中供选择。 
单击“确定”(OK)。 
随即在 SFC 编辑器中打开 BATCH 类别为“EPH（派生）”(EPH (derived)) 的 SFC 类型，例如
“D1”。 
“图表”(Charts) 目录中将显示 SFC 类型和对应图标。

11.同时，打开从中派生出相应接口的“EHP 接口”(EPH interface) 类别的 SFC 类型，例如“D-IF”。 
要执行此操作，请选择菜单命令“打开 SFC 类型”(Open SFC type)。  

12.同时打开两种 SFC 类型的特性编辑窗口。单击工具栏上的“特性”(Characteristics) 图标。 
13.检查两种 SFC 类型的特性。 

“EPH 接口”(EPH interface) 类别的 SFC 类型的所有特性均应可以用于“EPH（派生）”(EPH 
(derived)) 类别的 SFC 类型。 

结果

连同设定值和控制策略一起创建了 BATCH 类别为“EPH 接口”(EPH interface) 的 SFC 类型，并

将其作为基本类别使用。  
使用由“EPH 接口”(EPH interface) 类别的 SFC 类型派生而来的接口创建“EPH（派生）”(EPH 
(derived)) 类别的 SFC 类型。 
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这一“EPH（派生）”(EPH (derived)) 类别的 SFC 类型是设备阶段顺序控制的一部分。 

说明

上述说明中仅包含 BATCH 类别为“EPH 接口”(EPH interface) 和“EPH（派生）”(EPH (derived)) 
的 SFC 类型的组态。 
但要完成全部组态任务还需要执行额外的步骤；例如，还必须在 BATCH 类别为“EPH（派生）”
(EPH (derived)) 的 SFC 类型中执行额外参数和顺控程序。  

参见

分配配方阶段 (RPH) 至工程系统的组态方法 (页 375)

11.3.3.4 组态设备阶段的顺序控制

简介

顺序控制可能仅在设备阶段中存在一次。

• 当创建一个新的设备阶段时，会自动创建一个“顺序控制”(Sequential control) 对象和一

个相关的 SFC 类型。这个分配的 SFC 类型定义了顺控程序及其参数描述（例如设定值、控

制策略、参数、消息）。 
• 如果在设备阶段中删除并重新添加“顺序控制”(Sequential control) 对象，则必须再次为

该对象分配 SFC 类型。   
• 只要设备阶段中存在关联的“顺序控制”(Sequential control) 对象，就无法在主数据库的

“图表”(Charts) 目录中删除为“顺序控制”(Sequential control) 对象分配的 SFC 类型。   

要求

• 已在 SIMATIC Manager 中打开包含主数据库的多项目。

• 设备阶段类型在主数据库中可用，并按照“组态设备阶段（类型） (页 344)”部分所述进

行组态。 
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步骤

1. 在 CFC 编辑器中，打开主数据库中的设备阶段类型。 
2. 在工艺编辑器中选择设备阶段类型的图标。

全部已知对象都显示在此图标下。
在新创建的设备阶段中，“顺序控制”(Sequential control) 对象和相关的 SFC 类型自动可用。 
如果“顺序控制”(Sequential control) 对象已经存在，在工艺编辑器的“已分配块”(Assigned 
block) 属性的“已分配”(Assigned) 列下检查是否存在相应的条目。如果因此分配了相应的条
目和 SFC 类型，转至第 6 步。 

3. 如果“顺序控制”(Sequential control) 对象不可用，则从快捷菜单中选择“插入新对象”(Insert 
New Object) 命令。快捷菜单中将显示所有可用对象。 
选择菜单命令“顺序控制”(Sequential control)。 
顺序控制随即插入并显示为图标。 

由于每个设备阶段只能分配一个顺序控制，之后设备阶段快捷菜单中的相应菜单命令会处于
禁用状态。

4. 在工艺编辑器中选择“顺序控制”(Sequential control) 的图标。右侧窗口中将显示相关属性。 
选择“已分配块”(Assigned block) 属性。当手动创建顺序控制时，在“分配”(Assignment) 列
中无条目，因此也不存在已分配的 SFC 类型。 

5. 打开 CFC 编辑器中的块目录以分配 SFC 类型。 
将所需 SFC 类型从块目录中拖放到 CFC 编辑器的图表窗口中。新插入的 SFC 类型在 CFC 中显
示并在“已分配块”(Assigned block) 属性中进行引用。 
如果在块目录中无 SFC 类型，则在组件视图下主数据库的“图表”(Charts) 文件夹中创建需要
的类型。

6. 如果要组态该顺序控制的下级元素，请在工艺编辑器中选择顺序控制的图标。
从快捷菜单中选择“插入新对象”(Insert New Object) 命令。快捷菜单中将显示所有可用对象。
在当前版本中只能选择“参数”(Parameter)。 

7. 在快捷菜单中，选择“参数”(Parameters) 菜单命令。 
将打开“设备阶段的参数”(Parameters of the equipment phase) 对话框。所有可用的参数都
将在此对话框中显示。 
选择所需的参数，然后单击“插入”(Insert)。参数随即插入并显示为图标。组态该参数的属性。

8. 参数也可用作步和转移组态的单独变量，例如实际值、限值。 
要创建作为单独变量的参数，应在工艺编辑器中选择相应 SFC 类型的块实例的所需块 I/O，并
将其拖动到顺序控制中。
将自动创建“参数”(Parameter) 对象。这些单独变量的名称已预定义，不可更改。更多相关
信息，请参见顺序控制数据对象表中的“设备阶段的数据对象概述 (页 335)”部分。 

结果

“顺序控制”(Sequential control) 对象在分配设备阶段类型和 SFC 类型时组态。 
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如果需要，可创建作为该顺序控制子对象的参数。  

说明

对于分配的 SFC 类型，仍需在 SFC 编辑器中组态顺控程序和特性等内容。

 

11.3.3.5 组态下级设备模块

简介

在设备阶段的工艺编辑器中组态设备阶段的下级设备模块分配。 

组态下列对象以便将设备模块用作设备阶段的下级对象： 
• “设备模块（基本要求）”(Equipment module (basic requirement) 对象，由如下图标表

示：

基本要求描述了要分配的设备模块的最低工艺要求。 
• “设备模块分配”(Equipment module assignment) 对象，由如下图标表示：

在“设备模块分配”(Equipment module assignment) 中分配对应的基本要求，并为稍后

要分配的设备模块的实例组态“角色”(Role)。
以下部分描述了这一组态。 

要求

已在主数据库中创建设备阶段类型。 

步骤

1. 在 CFC 编辑器中打开所需设备阶段类型。

2. 在工艺编辑器中选择设备阶段类型的图标。

3. 从快捷菜单中选择“插入新对象 > 设备模块（基本要求）”(Insert New Object > Equipment 
Module (Basic Requirement)) 命令。 

“设备模块（基本要求）”(Equipment module (basic requirement) 随即插入并显示为图标。
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4. 在工艺编辑器中选择新创建的“设备模块（基本要求）”(Equipment module (basic 
requirement)) 的图标。 
将显示相关属性。 
组态属性，例如名称、作者。  

5. 在工艺编辑器中选择设备阶段类型的图标。

6. 从快捷菜单中选择“插入新对象 > 设备模块分配”(Insert New Object > Equipment Module 
Assignment)。 
“设备模块分配”(Equipment module assignment) 随即插入并显示为图标。

7. 在工艺编辑器中选择新创建的“设备模块分配”(Equipment module assignment) 的图标。将
显示相关属性，如“互连至”(Interconnection to) 和“角色”(Role)。  
由于相关设备模块不是此类型的一部分，因此需要为“设备模块分配”(Equipment module 
assignment) 属性组态基本要求。  
要组态“互连至”(Interconnection to) 属性，在工艺编辑器中将上面创建的基本要求拖放到“设
备模块分配”(Equipment module assignment) 对象中。 
将在“互连至”(Interconnection to) 属性中显示刚创建好的对基本要求的引用。

8. 使用相同的名称组态属性的“角色”。
“角色”(role) 表示将如何在此类型环境中使用相关的基本要求。 
必要时输入注释。 

9. 如果要在此“设备模块（基本要求）”(Equipment module (basic requirement)) 下组态“状态”
(Status) 等下级元素，请在工艺编辑器中选择“设备模块（基本要求）”(Equipment module 
(basic requirement)) 的图标。 

10.从快捷菜单中选择“插入新对象”(Insert new object) 命令。 
快捷菜单中将显示所有可用元素。 
– “控制模块”(Control module)
– “设备模块（基本要求）”(Equipment module (basic requirement))
– “参数”(Parameters)
– “信号”(Signal)
– “消息”(Message)
– “控制模块分配”(Control module assignment)
– “设备模块分配”(Equipment module assignment)
选择相应的菜单命令插入所需对象，如“参数”(Parameter)。
根据需要重复此步骤，添加更多下级元素。

11.组态下级元素的属性。 
步骤 2 到 4 的备选步骤 
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如果主数据库中已存在将要放置在设备阶段下的设备模块，则可使用此设备模块创建相应的

基本分配。

• 在 CFC 编辑器的模板目录中选择设备模块的图标。

• 将该图标拖放到工艺编辑器中的“设备阶段”(Equipment phase) 对象上。 
将自动创建“设备模块（基本要求）”(Equipment module (basic requirement)) 对象。其

名称与所使用设备模块的名称相同。  

结果

在设备阶段的类型上组态设备模块的“基本要求”(Basic requirement) 和“分配”
(Assignment)。
基本要求从理论上对设备模块进行了描述。 

11.3.3.6 组态设备模块的分配

简介

对于设备阶段，将不对下级设备模块进行永久性的分配，而是在运行时发出请求，分配后再

释放。 
不存在严格的分配且下级设备模块可在各种设备阶段中连续使用。

说明

一个设备模块仅由一个设备阶段控制时

如果一个设备模块仅由一个设备阶段控制，则无需获取该设备模块。此初始分配会自动进行。

但是，如果在单个设备阶段使用获取命令，则此特殊初始分配将丢失。这意味着，在获取和

释放只有一个设备阶段的设备模块时，即使只有一个设备阶段，也必须稍后再次获取设备模

块。

分配特征通过步中的“分配请求”(allocation request) 进行组态。

运行时分配的当前状态与“分配状态”(Allocation status) 一同显示，且可在转移中评估。  
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分配请求和分配状态

• 分配要求在主数据库下的“共享声明 > 枚举 > ES_AcquireTypes”(Shared Declarations > 
Enumerations > ES_AcquireTypes) 定义。 
下表按照优先级对可用分配请求进行了说明。 
最低优先级位于上方。 

分配请求

（符合 
ES_AcquireTypes 的
类型）

优先级 网络共享 说明

无请求

(NoRequest)
0  - 分配变量的默认值 

也用于撤销分配请求。

初步（等待） 
(PrelimWait) 

1 隐式 类似“等待”(Wait)，后续、上级分配请求

的隐式发布。

初步（现在） 
(PrelimNow)

2 隐式 分配必须立即成功否则分配失败。后续、

上级分配请求的隐式发布。

等待 
(Wait)

3 显式 如果无法进行立即分配，将等待发布。 
如果已经过去的等待时间为零，则等待可

能无限期持续下去。

当组态了一个大于零的等待时间且该时间

到期后，分配请求将失效。 
需要显式发布。

立即 
(Now) 

4 显式 分配必须立即成功否则分配失败。 
需要显式发布。

接管 
(Takeover)

5 隐式 具有相同的分配标识符（例如，单元名

称），将立即更改所有权。关于错误和等

待时间；或类似于“等待”(Wait) 类型。

强制（安全） 
(ForceSafe)

6 显式 一旦待分配的设备模块 (EM) 处于可由参数

确定的结束位置（IDLE、ABORTED 等 – 
ORing 同样可行），则会更改所有权。

强制（现在） 
(ForceNow) 

7 显式 通过请求对象立即、无条件地更改所有权。

 
• 分配状态在主数据库下的“共享声明 > 枚举 > ES_AcquireStates”(Shared Declarations > 

Enumerations > ES_AcquireStates) 定义。 
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下表对可用位置状态进行了说明。 

分配状态（根据 
ES_AcquireStates 标记）

注释

Idle 空闲

设备模块 (EM) 可用。

Owner 所有者

分配已成功。 
Waiting 正在等待

请求已被接受，但设备模块 (EM) 尚不可用。 
NotAvailable 不可用

设备模块 (EM) 在请求时不可用。

只有当分配请求为“立即 (Now)”和“初步（现在）

(PrelimNow)”时发生。

Deactivated 禁用

请求的设备模块 (EM) 通常无法根据其自身信息进行分配。 
Timeout 最大等待时间已过 
Snatched “已夺取”(Snatched)

设备模块 (EM) 已由另一个地址强制接管。

ConfigError 组态错误

仅适用于分配类型“强制（安全）(ForceSafe)”。 
当安全状态的描述掩码不匹配时发生，例如，每进行 OR 逻辑

运算时应包含相应位，同时，在每个 AND_NOT 逻辑运算时

则排除相应的位。

要求

设备阶段和设备模块组态为主数据库中的类型。 

步骤

1. 打开设备阶段的所需类型。导航到设备阶段 CFC 的“EPH”块并在快捷菜单中选择菜单命令“打
开 SFC 类型”(Open SFC Type)。在 SFC 编辑器中打开 SFC 类型。 

2. 双击所需步或为突出显示的步选择菜单命令“编辑 > 对象属性....”(Edit > Object 
Properties....)。打开步的“属性”(Properties) 对话框。
切换到“操作（工艺）”(Actions (technological)) 选项卡。 
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3. 在所需表格行单击“操作（工艺）”(Actions (technological)) 按钮。“操作（工艺）”(Action 
(technological)) 对话框随即打开。

4. 选择位于表格左侧列的顶部单元格，然后在快捷菜单中选择菜单命令“插入命令”(Insert 
Command)。

5. 从菜单中选择要为其组态分配要求的设备模块。 
在后续菜单中，选择子菜单中的菜单命令“EM_Allocate”和“EMAQAcquire”。 
在“操作（工艺）”(Actions (technological)) 对话框中选择的操作将插入名称“<对象名称
> .EMAQAcquire”下。  

6. 从新创建的操作“<对象名称 .EMAQAcquire>”中，选择子对象“策略”(Strategy)。 
7. 通过“互连”(Interconnection) 列的对应单元格中的选择菜单选择所需的请求行为，例如

“PrelimWait”。 
关于可用选项的更多相关信息，可参见以上说明。     

8. 单击“应用”(Apply) 按钮保存对突出显示步的指令的修改。 
9. 单击“关闭”(Close)。突出显示步的编辑对话框随即关闭。如果进行了更改而没有保存，则将

出现提示。

结果

在设备阶段中组态好了下级设备模块的分配请求。  

分配请求的状态评估

要评估分布请求是否成功，可在设备阶段顺控程序中的后续转移中组态工艺条件。 
在此条件中插入一个状态，并根据上表选择所需的设备模块和状态。   

11.3.3.7 设备阶段中的控制模块

概述

可将控制模块分配到设备阶段。 
可使用以下组态选项： 
• 将要分配的控制模块集成为设备阶段类型的组件，因此可将其用作下级对象。 

为此，将控制模块作为一个对象直接在设备阶段中组态。还可以组态能够在其中定义“角

色”(Role) 的“控制模块分配”(Control module assignment)。  
• 该控制模块不是设备阶段类型的组件。

随后为该控制模块组态“控制模块（基本要求）”(Control module (basic requirement)) 和
“控制模块分配”(Control module assignment) 对象。

更多相关信息，请参见“设备模块/设备阶段中控制模块的组态选项 (页 282)”部分。
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11.3.3.8 创建设备阶段类型的实例

概述

工厂设备阶段类型存储在主数据库中。

可在主数据库中复制类型，或复制到项目中以创建实例。 
在主数据库中复制工厂设备阶段类型时的属性

• 在主数据库内复制类型时，将创建一个新类型，同时复制包括基本要求在内的原始类型

的所有组件。

• 此外，无论该类型中已分配的控制模块是类型的组件还是基本要求，都会同时复制“控

制模块分配”(Control module assignment)。
• 还会复制类型中定义的“工厂设备模块分配”(Equipment module assignment)。 

工厂设备阶段中无法直接集成工厂设备模块；这意味着已分配的工厂设备模块仅有一个

基本要求。
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创建实例（从主数据库复制到项目）时的属性

• 将工厂设备阶段类型从主数据库复制到工厂层级的节点中，即可创建实例。 
根据 ISA-88 标准，可将该节点分类为工厂设备阶段。 
但是，如果使用 SIMATIC BATCH，则必须将该节点标记为工厂设备阶段。

说明

过程单元节点中的实例数

可在工厂层级的过程单元节点下创建任意数量的工厂设备阶段类型实例。但是，如果根据 
ISA-88 将该节点分类为工厂设备阶段，则多个实例毫无意义。不过，SIMATIC Manager 不
会对此进行检查，因此需要用户负责处理！

• 下级工厂设备模块对象的行为：

– 还会复制类型中定义的“工厂设备模块分配”(Equipment module assignment)。
– 复制时不包括“工厂设备模块（基本要求）”(Equipment module (basic 

requirement))，因为基本要求仅从理论上描述了要分配的工厂设备模块的最低要求。

必须在实例中为这些基本要求分配相应的工厂设备模块。

• 下级控制模块对象的行为：

– 未复制可选控制模块。 
可在实例中选择并连接这些可选控制模块。

只有工厂设备阶段下第一个子级别的下级控制模块可定义为“可选”(optional)。 
– 此外，无论该类型中已分配的控制模块是类型的组件还是基本要求，都会同时复制“控

制模块分配”(Control module assignment)。
– 创建实例时也将复制在类型中作为组件集成的控制模块。

– 复制时不包括“控制模块（基本要求）”，因为基本要求仅从理论上描述了要分配的

控制模块的最低要求。

必须在实例中为这些基本要求分配相应的控制模块。

– 可在控制模块的类型中定义命令和状态。这些内容不会复制。

要支持类型-实例同步，实例中的相应类型应为已知。 
类型和实例之间的比较和同步

对类型或相关实例进行更改时，可能需要同步类型和实例。 
更多相关信息，请参见“比较并同步设备阶段的类型和实例 (页 359)”部分。

11.3.3.9 比较并同步设备阶段的类型和实例

简介

创建实例时，设备阶段的类型和实例均相同。 
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类型或其相关实例发生更改时，可能需要同步类型和实例。 
因此，举例来说，创建实例时，SFC 类型中定义的设备阶段的顺控程序是相同的。但是，如

果更改主数据库中的 SFC 类型，则必须同时更新项目中的 SFC 类型来执行同步。

比较和同步

同步期间，会将项目中某一类型的所有实例与主数据库中的相应类型做比较。这样可显示出

设备模块的类型与其实例（过程工程级）之间以及 CFC（程序级）等相关对象之间的差别。 
通过更新项目中的 SFC 类型，可实现主数据库与项目之间的参数描述和顺控程序的同步。更

多相关信息，请参见“如何更新多项目中的块/SFC 类型 (页 117)”部分。

说明

自 CFC V9.0 起，工艺对象（例如控制模块 (CMT)）的类型实例同步需要 V9.0 及更高版本的 
VXM 许可证。 
有关同步的更多信息和说明，请参见“有关工艺对象类型实例同步的说明 (页 377)”部分。   

包括的对象

工厂级设备阶段的类型和实例的同步中包括以下下级对象：

• 控制模块

• 控制变量：

– 参数

– 信号

• 消息

• 命令和状态

• 控制模块的分配

• 设备模块的分配

• 顺序控制

但是，控制模块和设备模块的基本要求通常并不包括在内，因为根据定义，不允许在实例中

使用这些对象。

说明

主数据库中的同步 
在主数据库中，如果控制模块类型用作设备阶段类型中的子控制模块，则该子控制模块还将

与其控制模块类型同步。
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步骤

1. 在工厂视图中选择项目。

2. 打开快捷菜单并选择菜单命令“设备类型 > 同步...”(Plant types > Synchronize...)。 
打开“同步设备类型”(Synchronize plant types) 对话框。 

3. 在表的左侧列中，选择想要比较和同步的设备阶段、设备模块或控制模块的类型。

4. 单击“同步...”(Synchronize...) 按钮启动比较。 
比较中仅包括相关属性和关系。  
已添加到实例中的功能和功能块不包含在比较中，并且不会在比较结果中显示。

5. 显示比较结果。
比较结果中将突出显示以下对象： 
– 实例中添加的对象（例如子函数、消息、函数和函数块）将标记为附加对象。 
– 已删除对象。

– 属性已修改的对象。 
顺控程序拓扑与参数描述的差异不会直接显示在比较结果中。但会显示两个比较对象的更改
时间戳： 
– 主数据库中与“顺序控制”(Sequential control) 相关的 SFC 类型的更改时间戳。  
– 项目中相应 SFC 类型的更改时间戳。 
对于设备阶段类型中集成的控制模块，相应的“控制模块分配”(Control module assignment) 
也将显示在比较结果中。如果“控制模块分配”(Control module assignment) 丢失或已更改，
则日志文件中会有一个条目提示您检查此设备阶段环境中的控制模块。

6. 在比较结果中，根据相应类型选择要同步的实例。 
选中或清除对话框左侧相应对象旁边的复选框。 

7. 通过“同步模板”(Synchronize templates) 图标启动同步。 
将同步所选实例。
如果实例特定的扩展没有应用到类型的对象，则会得以保留。 

结果

已完成设备阶段的类型与其下级对象和实例之间的比较，并且已同步所选实例。 

参见

设备阶段的基础知识 (页 329)
创建设备阶段类型的实例 (页 358)
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11.4 与 COMOS 的数据通信中的设备模块/设备阶段

11.4.1 与 PAA 的数据交换概述

简介

可将在工厂自动化加速器 (PAA) 中生成的工程级数据以工厂设备模块及工厂设备阶段和控制

模块的形式导入到 PCS 7 的自动化层。这便为创建顺序控制 (SFC) 和自动化程序 (CFC) 奠定

了基础。 

PCS 7 与 PAA 之间的数据交换概述

下图显示了通过自动化接口 (AI) 在 PCS 7 与 PAA 之间进行数据交换的原理。

以下选项适用于数据交换：

• 当 PAA 和 PCS 7 安装在同一台计算机上时，采用直接数据交换。 
• 当 PAA 和 PCS 7 安装在不同计算机上时，通过 XML 文件进行间接数据交换。

更多相关信息，请参见“通过 XML 格式与 PAA 进行数据交换 (页 365)”部分。

利用通过自动化接口 (AI) 的导入服务实现的数据交换，不仅可以从 PAA 和 PCS 7 中读取工

厂设备模块的类型和实例，还可以对它们进行比较。此外，工厂层级、控制模块的类型和实

例、硬件配置等也可以进行比较。这样，便可删除或应用对目标所做的更改。

已重命名的对象

数据交换期间重新识别已重命名的对象，并在同步数据时显示和比较它们。 
检测以下对象的名称更改： 
• 工厂层级的节点 
• 工厂设备模块 (EM)
• 工厂设备阶段 (EPH)
• 控制模块 (CM)
• 参数，信号 (CV)
• 顺序控制的参数

• 顺序控制的顺控

• 命令  
• 状态  
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• 枚举

• 枚举值

• 硬件： 
– 站，从站（中央，从站）

– 子网，总线（全局子网）

• 符号（IO 变量）

数据交换的图形总览

在 PCS 7 的自动化接口 (AI) 中读取并比较要导入的数据。 
PAA 自动化树中显示了可用于与 PCS 7 进行数据交换的所有元素。 
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数据交换期间的扩展硬件参数

除硬件配置外，数据交换期间还会通过自动化接口 (AI) 传输扩展硬件参数。扩展硬件参数的

数据交换双向进行，并且可以启用/禁用，例如在出于性能方面的原因，并非所有扩展硬件

参数都参与到数据交换中时。

• 在 PAA 中，通过“硬件 > 扩展参数”(Hardware > Extended parameters) 选项在导入/导出

期间启用或禁用传输。  
• 在 PCS 7 中，通过 XML 控制文件“AIaS7ExtHWParameter.xml”中的条目启用或禁用相应硬

件参数的传输。 
此文件存储在“Program Files (x86)\SIEMENS\STEP7\S7DATA\AIS7AD”目录中。

XML 文件包含针对每个硬件参数的条目，条目以“<HWParameter name”表达式开头。此

条目包含用于控制此硬件参数的数据交换的表达式“uesd”。 
– 当表达式“used="1"”时，启用硬件参数的数据交换。    
– 当表达式“used="0"”时，禁用硬件参数的数据交换。

PCS 7 与 PAA 之间的数据交换原理

1. 对于已标识为要根据客户要求、相应的工厂设备模块类型或工厂设备阶段进行组态的工厂，根
据已规划的过程顺序加以指定。
为每种类型定义可能的控制策略、设定值和参数说明（例如，过程值、参数、定时器、位存
储器、控制值、操作员和注释文本、位置文本以及消息）。工厂设备模块或工厂设备阶段的
顺序控制以顺控形式说明。工厂设备模块类型描述的一个重要组成部分是顺序控制系统所需
的控制模块（执行器和传感器）的分配。

2. 使用 PAA 来创建工厂设备模块或工厂设备阶段的类型。之后，必须将这些类型传递到 PCS 7 的
主数据库（“项目数据库”），以对 SFC 和 CFC 编辑器的实施加以补充。 
数据交换期间，将在数据传输对话框中读取和比较来自 PAA 和 PCS 7 的工厂设备模块、工厂
设备阶段、控制模块的类型和实例、工厂层级、硬件配置等数据。这样，便可删除或应用对
目标所做的更改。
主数据库以实例化模板形式提供工厂设备模块、工厂设备阶段和控制模块的类型。导入实例
时，主数据库中的类型将用作模板。 

说明

必须考虑 PCS 7 中的某些限制才能实现从 PAA 到 PCS 7 的成功导入。

3. 定义并实施工厂设备模块或工厂设备阶段的类型后，即可组态实例。创建实例并与特定控制
模块建立连接后，即表示设备已处于单元的控制模块级中。
实例连同已分配的控制模块将一起用作 PAA 的过程工程级生成指令，以在相应的 PCS 7 项目
中创建、组态和互连特定的自动化图表 (CFC)。 

工艺组态

11.4 与 COMOS 的数据通信中的设备模块/设备阶段

SIMATIC S7 中的 CFC (V9.0 SP7)
364 功能手册, 05/2022, A5E41356112-AH



从 PAA 导入时 PCS 7 中的相关限制

• 顺序控制中的命令和状态： 
– 命令只能在顺序控制的步中使用。

– 状态只能在转换条件中使用。

• 指令和条件：

– 步：每步最多可有 50 个指令。

– 转换条件/启动条件：每个转换条件/启动条件最多可有 16 个条件，并以 2 x 5 和 2 x 3 
的形式分组。

更多信息，请参见“与 PAA 的数据交换中的顺序控制 (页 369)”部分的“步和转换条件的

指令和条件”段落。 
 

参见

设备模块的基础知识 (页 290)
设备阶段的基础知识 (页 329)

11.4.2 通过 XML 格式与 PAA 进行数据交换

简介

通过 PCS 7 和 工厂自动化加速器 (PAA) 之间的数据交换，可以双向传输数据并对数据进行比

较。 
以下选项用于数据传输和同步： 
• 当 PAA 和 PCS 7 安装在同一台计算机上时，采用直接数据交换。 

通过自动化接口 (AI) 的导入服务，可从 PAA 和 PCS 7 中读取工厂设备模块、工厂设备阶

段和控制模块的类型和实例并对其进行比较。

• 当 PAA 和 PCS 7 安装在不同计算机上时，通过 XML 文件进行间接数据交换。

使用间接数据交换时，首先会使用 SIMATIC Manager 或 PAA 中的导出功能将数据保存到 
XML 文件中。

随后，将 PAA 或 PCS 7 生成的 XML 文件导入到 SIMATIC Manager 或 PAA。同步过程也随

导入一起执行。这样，便可删除或应用对目标所做的更改。
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本部分介绍了 PCS 7 环境中的间接数据交换。 

说明

通过 XML 格式进行数据交换的安全性 
• 访问传送介质/传送目录：

在 PAA 和 SIMATIC PCS 7 之间通过 XML 格式进行间接数据交换时，请确保只有具备资质的人
员有权访问 XML 文件的传送介质或传送目录。

• XML 文件的数字签名：
通过 XML 格式交换数据时，可对 XML 文件进行数字签名以描述 XML 数据的来源和完整性。
这对应于 PCS 7 安全机制的要求（参见“http://cache.automation.siemens.com/dnl/zI/
zI1NDU1AAAA_22229786_HB/ps7sec_d.pdf”）。 
数字签名验证可确保传送介质中的 XML 文件不会更改。  
默认情况下，禁用 XML 文件的数字签名。建议启用数字签名。
有关更多信息，请参见“要求”部分。
应用的标准：
应用符合“PKCS#1”标准的不对称签名过程 RSA（参见“https://www.ietf.org/rfc/
rfc3447.txt”）。“http://www.ietf.org/rfc/rfc5280.txt”下介绍了证书的属性。  

 

要求

软件

要通过 XML 文件进行数据交换，需要在运行 PCS 7 系统的计算机中安装“SIMATIC 
XMLTRANSFER”软件。PAA 的产品 DVD 中包含该软件。 
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XML 文件数字签名的要求：

1. 启用数字签名： 
必须在 PCS 7 项目中启用 XML 文件的签名。使用菜单命令“编辑 > XML 数据传输 > XML 数
据传输的设置 > 需要签名”(Edit > XML data transfer > Settings for XML data transfer > 
Signature required) 在 SIMATIC Manager 中进行设置。

2. 计算机上必须提供以下对象，以便签名 XML 文件以用于导出： 
– 签名用户的证书。 

该证书可以由商业供应商或“Windows Server 证书颁发机构”创建，并必须保存在 
Windows“MMC”控制台中的“当前用户 > 证书”(Current User > Certificates) 之下。相

应的所谓“CA”证书必须位于“MMC”控制台中的“信任的根证书颁发机构”(Trusted Root 
Certificate Authorities) 之下。

在此证书中，必须在“密钥使用”(Key usage) 属性中至少设置值“digitalSignature”或
“nonRepudiation”之一。 

– “受信任根证书颁发机构”证书所需的“Private Key”。
3.  计算机上必须提供以下对象，以便导入签名的 XML 文件：

– 签名用户的证书。该证书包含所谓的 "Public Key"，识别 XML 文件的签名时需要该密

钥。 
签名用户的证书必须保存在 Windows“MMC”控制台中的“当前用户 > 证书”(Current 
User > Certificates) 之下。相应的所谓“CA”证书必须位于“MMC”控制台中的“信任的根

证书颁发机构”(Trusted Root Certificate Authorities) 之下。

扩展硬件参数的数据交换

扩展硬件参数的数据交换取决于控制文件“AIaS7ExtHWParameter.xml”中的设置。更多相关

信息，请参见“与 PAA 的数据交换概述 (页 362)”部分。

PCS 7 环境中的数据传送

双向数据交换

控制模块类型可以在 PCS 7 中指定和应用，也可能已处于数据库中。若要在 PAA 中使用这

些现有的控制模块类型，必须将它们从 PCS 7 传送到 PAA。
当进行工程级的更改时，或在 PAA 中工艺性指定了控制模块的类型时，则这两种类型可以从 
PAA 传送到 PCS 7。
完全传送工厂设备模块或工厂设备阶段的类型时，将包含所有控制模块和可选控制模块。 
通过 XML 文件进行数据交换的默认设置：

可在“XML 设置”(XML settings) 对话框中组态以下默认设置：  
• XML 文件数字签名的设置： 

更多相关信息，请参见上面的“要求”部分。

• 项目和库中对象的过滤器 
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使用菜单命令“编辑 > XML 数据传输 > XML 数据传输的设置”(Edit > XML data transfer > 
Settings for XML data transfer) 在 SIMATIC Manager 中打开“XML 设置”(XML settings) 对话

框。

SIMATIC Manager 的导出和导入功能

在 SIMATIC Manager 的 PCS 7 项目快捷菜单中，可使用菜单命令“导出 XML”(Export XML)、
“将所选对象导出到 XML”(Export selected objects to XML) 和“导入 XML”(Import XML) 实现

导出和导入功能。 
仅在安装“SIMATIC XMLTRANSFER”软件后，这些菜单命令才可使用，并且仅可用于与 PAA 之
间的间接数据交换。 
导入到 PCS 7
• 上述“导入 XML”导入功能用于通过 XML 文件进行的间接数据交换。为此，用户必须提

供并选择合适的 XML 文件。 
通过 PCS 7 项目快捷菜单中的“导入 XML”(Import XML) 命令启动导入功能。或者，可使

用 SIMATIC Manager 主菜单中的“编辑”(Edit) 菜单命令启动过程。 
• 如果已启用 XML 文件的签名，则在导入期间验证证书和签名。为此，必须满足“要求”

下列出的条件。 
– 成功验证后，会打开自动化接口的数据传送对话框以显示比较结果并开始导入。 
– 如果在无签名的情况下执行 XML 文件的导入（尽管要求签名），系统会中止该导入过

程并显示一条消息。 
– 如果在要导入 XML 文件的计算机上找到带有所谓“Common Name”和“校验信息”

(Fingerprint) 的证书，且已在 XML 文件的签名中使用该证书，会显示相应消息。

– 如果检测到 XML 文件的签名或内容更改，系统会显示消息，并且用户可以决定是否继

续导入。 
• 工厂设备模块类型或工厂设备阶段成功导入 PCS 7 项目中后，用户便可在导入对话框中

使用快捷菜单直接打开主数据库中的工厂设备模块或工厂设备阶段，此时该模块可用作

工艺外壳。 
• 初次导入后，相关 CFC 仅包含 SFC 类型的实例作为工厂设备阶段。 

用户现在可以利用 CFC 和 SFC 编辑器的资源实现工厂设备模块或工厂设备阶段。
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从 PCS 7 导出

• 上述导出功能用于通过 XML 文件进行的间接数据交换。 
– 使用菜单命令“导出 XML”(Export XML) 可导出全部对象 
– 使用菜单命令“将所选对象导出到 XML”(Export selected objects to XML) 可导出所选

的工艺对象 
该菜单命令会打开“选择工艺对象”(Select technological objects) 对话框，用于选择对

象 
通过 PCS 7 项目快捷菜单中的“编辑 > XML 数据传输”(Edit > XML data transfer) 菜单命

令启动所需的导出过程。 
或者，可使用 SIMATIC Manager 主菜单中的“编辑 > XML 数据传输”(Edit > XML data 
transfer) 菜单命令启动过程。 
用户可以选择 XML 文件的路径。 

• 如果已启用 XML 文件的签名，则会对证书（用于签名 XML 文件以便导出）进行检查。为

此，必须满足“要求”下列出的条件。

– XML 文件的导出和签名成功时，会显示一条消息。   
– 如果所选证书不适合签名，系统会取消导出过程并显示一条消息。

• 之后，使用 PAA 将 XML 文件传送并导入到计算机中。 

11.4.3 与 PAA 的数据交换中的顺序控制

简介

与工厂自动化加速器 (PAA) 进行数据交换期间，顺序控制同样将通过自动化接口 (AI) 的导入

服务作为工厂设备模块或工厂设备阶段的一部分进行交换。此外，还可以读取 PAA 和 PCS 7 
中的数据并进行比较。这样，便可删除或应用对目标所做的更改。 
顺序控制定义了顺控及其参数描述（如设定值、控制策略、参数、消息）。

顺控可包含与 SFC 类型相同的元素： 
• 步

• 转换条件

• 选择分支

• 并行分支
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• 循环

• 跳转

下面将介绍工厂设备模块或工厂设备阶段、顺控及其元素参与数据交换的方式。 

概述

下文将介绍工厂设备模块或工厂设备阶段的组件参与数据交换的方式： 
• 顺控 
• 步和转换条件

• 步和转换条件的指令和条件

• 工厂设备模块或工厂设备阶段的 SFC 类型的特征 
数据传输对话框中的顺控

在自动化接口 (AI) 的数据传送对话框中，顺序控制及其元素以树形结构显示。 
顺控的元素以顺序控制的子元素表示。 
• 顺控

顺控始终以 START 步开始，以 END 步结束。必须始终在启动顺控时组态启动条件。 
– 启动条件 

• 顺控包含交替的步和转换条件元素。

– 步

– 转换条件
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• 除简单的步和转换条件外，顺控还可以包含选择分支和并行分支。 
–  选择分支

选择分支至少包含 2 个转换条件顺序。 

转换条件顺序始终以转换条件元素开始和结束。转换条件顺序本身就是一个转换条件

元素。 
– 并行分支

并行分支至少包含 2 个转换条件顺序。 

步顺序始终以步元素开始和结束。 
步元素和转换条件元素按照自动化接口中比较树的图形和拓扑结构显示。

• 顺控还可以包含循环和跳转。循环和跳转按照转换条件执行。 
– 循环 

通常，循环只能由步顺序确定。在步和转换条件顺序末尾的最后一步后，检查转换条

件。如有必要，顺控会从顺序的第一步重新开始。 
– 跳转

利用跳转指令，顺控可根据是否已满足转换条件判定是否从指定步继续执行。

数据交换和导入期间顺控的属性

• 初次导入操作将完全传送先前不可用的顺序控制。

• 在自动化接口的比较树中，只能将顺序控制中的顺控作为整体进行选择或取消选择。 
这意味着，只能将完整的顺控包括在导入中或将其忽略。这样可避免发生不一致问题。 

说明

导入到 PCS 7 期间的现有步和转换条件 
如果标记顺控并将其包含在导入中，则在 PCS 7 中将覆盖顺控的现有步和转换条件的所有内

容。在导入期间，创建、修改或删除对象时会生成相应的消息。   
完成导入之后，如果在 PCS 7 端对顺控中的步和转换条件进行了更改，则必须检查这些手动

更改，并可在导入之前进行备份。   

 
顺序控制中顺控的顺序

从 PAA 的首次导入过程期间，顺序控制的顺控按照字母顺序排序。 
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从过程工程的角度来说，该顺序没有意义。因此，用户可以在 SFC 编辑器中按所需顺序手动

设置顺控。 
如果已对顺序进行手动排序，并且为后续导入增加了一个或多个新顺控，则这些顺控将置于

现有顺控顺序的前面。因此，这些新的顺控将显示在 SFC 编辑器的图形布局中的最左侧。  

说明

如果手动更改了顺序控制中多个顺控的顺序，则必须检查导入新顺控之后生成的新顺序，并

根据需要进行修改。 

 
数据传输对话框中的步和转换条件

1. 同步工厂设备阶段时，将首先对步顺序和转换条件顺序的步、分支、转换条件等进行比较。利
用这种方式，可以正确识别并行和选择分支、循环、步和转换条件顺序等新插入的未命名拓
扑元素。

2. 根据定义，转换条件和步的名称中不能仅包含数字。 
在 PCS 7 中创建步和转换条件时，既不会自动生成名称，也不会自动分配编号来标识这些对
象。因此，如果 PCS 7 端没有名称，则需要在与 PAA 进行数据交换时手动创建名称。名称由
编号构成。步的前缀为“S”，转换条件的前缀为“T”。
用户应在 PCS 7 的 SFC 编辑器中为步和转换条件分配适当的名称，用于与 PAA 进行数据交换。

3. 步和转换条件元素只能按照顺控的拓扑规则出现；否则，顺控将处于不一致的状态。 
如果检测到步和转换条件的顺序不合理，则会在日志文件中建立一个条目记录此影响。 
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4. 步和转换条件元素在比较树中的比较方式与所有其它对象的比较方式相同。因此，只能更改、
添加或删除相关对象。 
步和转换条件程序： 
可以通过 PAA 在带或不带步和转换条件程序描述的情况下传送工厂设备模块或工厂设备阶段
的类型。 
– 不带步和转换条件程序的传送：

步和转换条件程序在 PCS 7 中不会发生变化，即使按上文所述为导入选择整个顺控也

是如此。 
– 带步和转换条件程序的传送：

在数据传送对话框中，将显示步和转换条件程序，差异的形式为 PAA 端的多余对象。

现在可以为导入选择或删除步和转换条件程序的对象。 
如果选择一个对象，该对象也会导入到 PCS 7 并覆盖现有内容。 
如果删除对象，则不会执行任何导入，PCS 7 中的现有内容将保留。  

5. 步和转换条件元素不能单独选择或删除，只能通过选择或删除顺控来进行间接选择或删除。 
只能选择完整的顺控并包含在导入中。

说明

“在目标处删除”(Delete at target) 选项的含义

如果选择顺控并将其包含在导入中，则在导入期间在目标处插入或删除步和转换条件。无

论是否激活“在目标处删除”(Delete at target) 选项，此规则都适用。当禁用“在目标处

删除”(Delete at target) 选项时，也会删除目标中的步和转换条件。决定性因素是顺控是

否包含在导入过程中！

导入到 PCS 7 期间的现有步和转换条件

如果标记顺控并将其包含在导入中，则在 PCS 7 中将覆盖顺控的现有步和转换条件。更

多信息，请参见上述“数据交换和导入期间顺控的属性”部分。

步和转换条件程序：如果在具有步和转换条件程序描述的情况下从 PAA 传送工厂设备模

块或工厂设备阶段的类型，则用户可指定是否将这些步和转换条件程序描述导入 PCS 7。
更多相关信息，请参见第 4 点。

 
步和转换条件的指令和条件

• 步的指令和转换条件的条件在工艺编辑器中没有各自的对象，因此不会在数据传送对话

框中显示以进行比较。 

工艺组态

11.4 与 COMOS 的数据通信中的设备模块/设备阶段

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 373



说明

指令和条件的限制

从 PAA 传送步和转换条件时，必须遵循 PCS 7 中的以下限制： 
• 步：每步最多可有 50 个指令。

• 转换条件/启动条件：每个转换条件/启动条件最多可有 16 个条件，并以 2 x 5 和 2 x 3 的形式
分组。

如果从 PAA 的传送期间超出这些限制，则 PCS 7 中不会导入/生成相应的顺控，并且自动化

接口 (AI) 的日志文件中会生成相应的条目。  

 
工厂设备模块或工厂设备阶段的 SFC 类型的特征

在 PAA 的首次导入过程期间，工厂设备模块或工厂设备阶段的 SFC 类型特征（如控制策略）

也在 PCS 7 中按字母顺序传送。 
从过程工程的角度来说，该特征（尤其是控制策略）顺序没有意义。因此，用户可以在 SFC 
编辑器中按所需顺序手动排列特征。 

说明

如果手动更改了工厂设备模块或工厂设备阶段的 SFC 类型的特征顺序，则必须检查导入新顺

控之后生成的新顺序，并根据需要进行修改。 

11.4.4 与 PAA 进行数据交换时的信号处理

概述

与 PAA 进行数据交换时，请注意以下关于信号处理概念的事项：

“信号”(Signal) 变量类型的控制变量（例如，各控制模块的控制变量）表示通道请求，最好在 
CFC 工艺编辑器中将其分配给工艺处理块的相应块 I/O，而不是分配给通道驱动程序块的 I/
O。 
仅当使用 V8.0 或更高版本的 PCS 7 APL 库时才支持此概念。
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11.5 分配配方阶段 (RPH) 至工程系统的组态方法

概述

下图显示了将配方阶段 (RPH) 分配至工程系统的可行的组态方法。 
• 变体“A”

在过去，通过为工程系统中的 SFC 块分配配方阶段 (RPH) 连接 SIMATIC BATCH，从而在 
PCS 7 中实现过程控制。您可继续使用此组态方法。

• 变体“B”
在这种组态方法中，设备阶段作为配方阶段 (RPH) 的分配伙伴。 
设备阶段 (EPH) 可控制多个下级设备模块 (EM)。 
使用： 
如果在过程控制端存在过程相关的描述（即资源保持不变），则推荐使用此组态方法。

SIMATIC BATCH 中的配方独立于资源进行创建。 
• 变体“C”

在这种组态方法中，BATCH 类别为“EPH（派生）”(EPH (derived)) 的 SFC 块可作为配方阶

段 (RPH) 的分配伙伴。其通过 BATCH 类别为“EPH 接口”(EPH interface) 的 SFC 类型形式

的抽象接口派生而来。

设备阶段 (EPH) 可控制多个下级设备模块 (EM)。
使用： 
如果在过程控制端存在不同的过程相关描述（即使用不同资源），则推荐使用此组态方

法。因此，可以在抽象接口中定义所需的设定值、控制策略等，然后在各种“派生”
(derivatives) 中使用。    
SIMATIC BATCH 中的配方独立于资源进行创建。 
有关组态这些变体的更多信息，请参见“使用“派生接口”(derived interface) 创建设备阶

段 (页 346)”部分。

只有在 PCS 7 V9.0 及以上版本中，才能够使用设备阶段 (EPH) 以及组态 BATCH 类别“EPH 接
口”(EPH interface) 和“EPH （派生）”(EPH (derived))。
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11.6 有关工艺对象类型实例同步的说明

工艺对象的类型实例同步期间，需要 VXM 许可证

自 CFC V9.0 起，工艺对象（例如控制模块 (CMT)、设备模块 (EMT)、设备阶段 (EPH)）的类

型实例同步需要 V9.0 及更高版本的 VXM 许可证。 
由于这种同步基于 VXM 功能，因此需要 VXM 许可证。 
如果没有可用的 VXM 许可证，则会显示一条必须安装 VXM 的消息。不过，仅安装 VXM 许
可证便足以为类型实例同步启用 VXM 功能。

 
下级类型/对象的类型-实例同步    
如果在类型-实例同步期间选择了多种类型的工艺对象进行同步，并且其中一种所选类型以

实例的形式存储在另一所选类型下方，则将仅同步上级类型，而不同步下级类型或对象。

如果以下对象/类型嵌套在其他类型中，则不会进行同步：

• 控制模块类型 (CMT)
• 命令

• 状态

在同步日志中记录非同步类型条目，例如：

“未同步对象 <Path to Object1>，因为类型 <Name of Type2> 本身选择为同步。”

日志条目示例： 
• 组态： 

“Object1”是控制模块类型 (CMT)，在 EM 类型 <Name of Type2> 中存储为实例。

• 结果： 
– EM 类型 <Name of Type2> 与其实例同步。 
– 未同步 EM 类型中的 CM 类型“Object1”的实例。 

补救日志条目的原因：

1. 完成同步后，在日志中查找如下格式的条目： 
“未同步对象 <Path to Object1>，因为类型 <Name of Type2> 本身选择为同步。”

2. 重复执行同步过程，并在日志条目中仅选择名为“Object1”的类型/对象。

3. 重复执行同步过程，并在日志条目中仅选择名为“Name of Type2”的类型。
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11.7 组态全局命令或状态

简介

“命令”(Command) 和“状态”(Status) 对象可按如下方式定义： 
• 在控制模块的类型（而不是实例）中定义，或在“控制模块（基本要求）”中定义。

这些命令和状态特定于这些对象。 
• 全局定义，即，使用 SIMATIC Manager 在主数据库中定义。

这些命令和状态通常基于工厂设备阶段 (EPH) 或工厂设备模块 (EM)。它们可在工厂设备

阶段或工厂设备模块的“顺序控制”(Sequential controls)（SFC 类型）中使用。 
以下部分介绍了如何创建全局命令或状态。还介绍了这些对象的形式参数的可选创建。

说明

库中的全局命令和状态 
对于 PCS 7 V9.0 及以上版本，“SFC 库”(SFC Library) 中的预定义全局命令和状态可用。它们

可在工厂设备阶段或工厂设备模块的“顺序控制”(Sequentical control) 中复制和使用。 

操作模式的区别

全局命令和状态根据其操作模式进行区分： 
• 作用于 SFC 实例本地状态的命令/状态。 

这意味着实施仅使用顺控的操作状态、顺控信息等。

• 作用于下级顺序控制的命令/状态。 
这些命令/状态与下级工厂设备模块 SFC 实例的设定值、状态等间接相关。“工厂设备模

块分配”(Equipment module assignment) 在上级工厂设备阶段或工厂设备模块中可用于

此。  
为这些状态／命令启用“访问下级工厂设备模块”(Access to lower-level equipment 
module) 属性。     

常规信息

命令和状态通过名称标识，可以有多个名称。这些对象可在 SIMATIC Manager 中单独或统

一选择、复制和删除。

命名全局命令和状态
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全局命令和状态名称的最大长度为 22 个字符，因为工艺编辑器中分配的后续组态期间只接

受这 22 个字符。 

说明

全局命令/状态条件下特性的使用

在以下特性的条件下不能直接使用变量： 
• 控制策略   
• 注释文本  
• 位置文本  
在全局命令/状态条件下使用标准参数“QCS”、“QCSP”、“OPTINO”和“POSINO”时，只能通过编

号寻址上述特性，例如控制策略。

为此，需要在全局命令/状态下进行以下组态：  
• 要在某个条件下使用上述特性之一，必须以此特性全局命令/状态的下级对象的形式创建相应

的形式参数。此形式参数必须具有相关数据类型。 
示例：某个位置文本的名称为“Positiontext_A”，数据类型为“POSITION TEXT”。 

• 在条件分配中，输入此形式参数的名称，例如“Positiontext_A”，并补充字符串“_NUMBER”。该
字段将自动变为黄色背景。 
在此示例中，将调用以下条件："POSINO" = "Positiontext_A_NUMBER"。 

从工厂自动化加速器 (PAA) 获取数据或在 PCS 7 中生成运行时程序时，特性（如位置文本）

的相应编号将自动插入工厂设备阶段 (EPH) 或工厂设备模块 (EM) 顺控的条件中。 
在此示例中，将调用以下条件："POSINO" = "1"。

 

要求

已在 SIMATIC Manager 中打开包含主数据库的多项目。

操作步骤

1. 使用菜单命令“视图 > 工厂视图”(View > Plant View) 打开工厂视图。

2. 在工厂视图的主数据库中，导航到想要在其中创建全局命令或状态（例如“过程标签类型”）
的目录。可以使用其它目录，例如用户在主数据库中创建的目录。 
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3. 在快捷菜单中选择命令“插入新对象”(Insert New Object)，然后选择“命令”(Command) 或
“状态”(Status)。 
右侧窗口中将显示新创建的命令或状态及相应图标。

– 状态

自动为新状态创建名称为“OUT”的下级“参数”对象。该参数的数据类型为 BOOL，用

作形式输出参数。

– 命令

4. 在 CFC 编辑器中打开命令或状态以组态其属性。 

说明

自 CFC V9.0 SP4 起，不能通过目录、也不能通过从其它图表复制到全局命令或状态的 CFC 
图表（即，命令或状态是根级别的控制模块时）插入对象（例如块、子图表等）。此类

命令和状态只能在工艺编辑器中编辑。但是，可在工艺编辑器和 CFC 图表中编辑较低级

别的命令或状态。

在工艺编辑器中选择“命令”(Command) 或“状态”(Status) 的图标。
命令或状态具有默认属性“名称”(Name)、“作者”(Author) 和“注释”(Comment)。 
组态所需的属性。

5. 还可以为此命令或状态创建下级形式参数。 
为此，在工艺编辑器中选择要为其创建参数的图标。

6. 从快捷菜单中选择“插入新对象 > 参数”(Insert New Object > Parameter)。
所选对象随即插入并显示为图标。 

7. 如果要组态参数的属性，在工艺编辑器中选择“参数”(Parameter) 图标。
将显示相关属性。 
组态所需的属性。

8. 要组态新命令或状态的属性，请在工艺编辑器中选择相应的图标。 
在快捷菜单中，选择菜单命令“属性”(Properties)。 
将打开“属性”(Properties) 对话框。 
对于“命令”(Command)，对话框的结构与步组态对话框的结构相似；对于“状态”(Status)，
对话框的结构与转换条件组态对话框的结构相似。

9. 为命令或状态组态所需的条件。 
还可以使用“浏览”(Browse) 按钮打开选择对话框。所有可使用的参数（即，只要标识符为
“S7_contact = true”的块 I/O）都会显示在此对话框中。 

10.选择需要的参数。单击“应用”(Apply) 按钮以应用之前在“属性”(Properties) 对话框选择的行
中的所选参数。 
在“属性”(Properties) 对话框中，将自动选择下一行条件，且选择对话框保持打开状态。根
据需要，重复此步骤来组态其它条件。 
单击“关闭”(Close) 关闭选择对话框。 

11.单击“关闭”(Close) 关闭“属性”(Properties) 对话框。 
如果需要，将显示应用组态的提示。确认此提示。 
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结果

全局命令和/或状态已在主数据库中创建。 
这些对象的形式参数也已选择性地插入。 
自动为状态创建名称为“OUT”的参数。 

参见

设备模块和控制模块的数据对象概述 (页 294)
设备阶段的数据对象概述 (页 335)
全局“命令”(Command) 和“状态”(Status) 的数据对象概述 (页 382)
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11.8 全局“命令”(Command) 和“状态”(Status) 的数据对象概述

概述

“命令”(Command) 和“状态”(Status) 对象可按如下方式定义：

• 在控制模块的类型（而不是实例）中定义，或在“控制模块（基本要求）”中定义。这

些命令和状态特定于这些对象。

相关说明请参见“设备模块和控制模块的数据对象概述 (页 294)”部分的表格。

• “全局”定义，即使用 SIMATIC Manager 在主数据库中定义。

这些命令和状态通常基于工厂设备阶段 (EPH) 或工厂设备模块 (EM) 的“顺序控制”
(Sequential controls)，可在工厂的所有工厂设备阶段或“顺序控制”(sequential controls) 
中使用。

下面的表格中介绍了这些全局命令和状态。

工艺组态

11.8 全局“命令”(Command) 和“状态”(Status) 的数据对象概述

SIMATIC S7 中的 CFC (V9.0 SP7)
382 功能手册, 05/2022, A5E41356112-AH



有关各种条件下的组态和特性的更多信息，请参见“组态全局命令或状态 (页 378)”部分。

对象/图标 描述

命令 
   

• “全局”(Global) 命令通常基于工厂设备阶段 (EPH) 或工厂设备模块 (EM) 的“顺

序控制”(Sequential control)，可在工厂的所有工厂设备阶段或“顺序控制”
(sequential controls) 中使用。  
这意味着实施仅使用顺序控制的操作状态、顺控信息以及特性等。 

• 命令通过其名称确定。有关命名的更多信息，请参见“组态全局命令或状态 
(页 378)”部分。 

• 全局命令与以下对象共享主数据库中的名称空间： 
– 工厂设备模块和控制模块的类型

– SFC 和 CFC 
– 全局状态 

• 每个命令都有属性“注释”(Comment) 和“作者”(Author)。
• 一个命令可以带一个或多个形式参数。

• 可以有多个命令。 
可以在 SIMATIC Manager 中单独或统一选择和复制。

状态

   
• “全局”(Global) 状态通常基于工厂设备阶段 (EPH) 或工厂设备模块 (EM) 的“顺

序控制”(Sequential control)，可在工厂的所有工厂设备阶段或“顺序控制”
(sequential controls) 中使用。 
这意味着实施仅使用顺序控制的操作状态、顺控信息以及特性等。

• 状态通过指定其名称来确定。有关命名的更多信息，请参见“组态全局命令

或状态 (页 378)”部分。 
全局状态与以下对象共享主数据库中的名称空间： 
– 工厂设备模块和控制模块的类型

– SFC 和 CFC 
– 全局命令 

• 每个状态都有属性“注释”(Comment) 和“作者”(Author)。
• 一个状态可以带一个或多个形式参数。

• 可以有多个状态。 
可以在 SIMATIC Manager 中单独或统一选择和复制。
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11.9 使用 CM 生成器列表创建、更新或删除实例

概述

CM 生成器基于大批量工程组态机制，使用一个单独的 CSV 文件（又称为“生成器列表”）

在项目中创建、更新和删除 CMT、EMT 和 EPHT 实例。可以在电子表格编辑器（例如 
Microsoft Excel）中轻松编辑此生成器列表。此外，CM 生成器还支持 XML 格式 
(SimaticML)。
为此，首先使用“导出生成器列表”(Export generator list) 菜单命令（即生成器列表）将项

目的所有或选择的 CM、EM 和 EPH（实例）导出到 CSV。然后，在电子表格中编辑此生成

器列表，可以在此电子表格中通过编辑生成器列表的条目来创建、更新或删除实例。最后，

使用“导入生成器列表”(Import generator list) 菜单命令将更新的生成器列表导入到项目中。

系统根据该生成器列表中的内容，创建、更新和/或删除实例。

可将 CM 生成器功能（导出/导入生成器列表）用于以下目的： 
• 在传感器和执行器级别，全新生成过程工厂的各种控制模块（取决于所指定的 CMT）。

• 在组控制级别，全新生成相应工厂设备阶段的各种工厂设备模块（取决于所指定的 EMT/
EPHT）。

• 修改控制模块的型号。

• 交换相应 CM EM/EPH 实例的相应 CMT EMT/EPHT 类型关系（参考）。

• 更改对工艺层级节点的分配。

• 更改或确定 CPU 模块目标（AS 站）。

• 更改相应 CM EM/EPH 实例的版本或作者。

• 更改相应 CM EM/EPH 实例的注释。

• 重命名相应 CM EM/EPH 实例。
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导出生成器列表

1. 根据具体要求，可通过以下方法之一导出生成器列表：

– 导出项目的所有 CM、EM 和 EPH（实例）：

在 SIMATIC Manager 的“组件视图”(Component View)、“工厂视图”(Plant view)、
“过程对象视图”(Process Object View) 或“工艺列表编辑器”(Technological list editor) 
中，选择项目，然后单击“选项 > 工厂类型 > 导出生成器列表”(Options > Plant types 
> Export generator list) 菜单命令。

– 导出项目的选择性 CM、EM 或 EPH（实例）：

在“工艺列表编辑器”(Technoligical list editor) 的“CM”、“EM”或“EPH”选项卡中，选择

行，然后在快捷菜单中单击“工艺类型 > 导出生成器列表”(Technological types > 
Export generator list)。

将打开“另存为”(Save As) 对话框。

2. 指定生成器列表的文件夹位置、文件名和文件类型，然后单击“保存”(Save)。
将在指定路径中以指定格式创建生成器列表。

说明

导出的生成器列表的内容

• 仅当项目具有工艺对象（CM、EM 和 EPH）时，才会导出生成器列表。

• 仅导出根级 CM、EM 和 EPH。所有子控制模块均不会导出。

编辑生成器列表

在电子表格编辑器（例如 Microsoft Excel）中打开生成器列表。

生成器列表的结构：

生成器列表具有以下结构：

Name Type Version Hierarc
hy

AS 
Station

Author Sampli
ng Time

Variant
s

Comme
nt

ID Class

V0001 ValveL 1.0 TH01\T
H05

SIMATIC
 H-
Station(
1)

西门子 100 A | B Valve 0:12:9
8

CM

• “Name”：实例名称。

• “Type”：类型名称（CMT、EMT 或 EPHT）。

• “Version”：工艺对象的版本（CM、EM 或 EPH）。

• “Hierarchy”：层级文件夹中实例的路径。
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• “AS Station”：项目的目标 AS 站。

• “Author”：作者姓名。

• “Sampling Time”：采样时间 (s)。
• “Variants”：控制模块的型号（子控制模块名称，用竖线符 (Ι) 分隔，例如 FbkClose | 

FbkOpen | Vlv_Fbk）。

• “Comment”：实例的注释。

• “ID”：导出时自动为实例生成的 ID。
• “Class”：工艺对象的类型（CM、EM 或 EPH）。

说明

列标题

列标题不得更改，否则导入生成器列表时将发生错误。

更新项目的实例：

要更新项目的实例，可编辑现有行的列条目。例如，要重命名控制模块，必须在“名称”
(Name) 列中更改条目。

不得更改“ID”列中的现有条目，因为在导出过程中会自动设置这些 ID。
如果目标工厂层级节点尚不可用且必须自动生成，则需要“AS 站”(AS Station) 列中的条目。在

这种情况下，目标 AS 必须由用户确定。

在项目中创建新实例：

要在项目中创建新实例，可复制现有行并更改列条目，也可以创建一个空行并输入有效条目。

新建实例时，至少“Name”、“Type”、“Hierarchy”、“AS Station”和“Class”列中需提供有效条目。

从项目中删除实例：

要从项目中删除实例，请删除所选实例的整个行条目。在导入生成器列表的过程中，此类实

例将从项目中删除。

编辑后保存 CM 生成器列表文件：
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如果在 Microsoft Excel 中对 CM 生成器列表进行编辑，则在保存该生成器列表前需在“公式”
(Formulas) 功能区中启用选项“显示公式”(Show Formulas)。否则，导入生成器列表时，将

发生导入文件的标题无效错误。

导入生成器列表

1. 在 SIMATIC Manager 的“组件视图”(Component View)、“工厂视图”(Plant view)、“过程对
象视图”(Process Object View) 或“工艺列表编辑器”(Technological list editor) 中，选择要导入
生成器列表的项目。

2. 在快捷菜单或“选项”(Options) 菜单中（在 SIMATIC Manager 菜单栏中），单击“工厂类型 > 
导入生成器列表”(Plant types > Import generator list)。
将打开一个对话框，提示用户选择导入文件。

3. 导航到生成器列表的存储位置。选择生成器列表文件，然后单击“打开”(Open)。
“数据传输 - 生成/导入”(Data transfer - Generate/import) 对话框将打开。在此对话框中，将显
示所选项目和所选生成器列表之间的所有差异。

4. 查看差异，然后单击“导入”(Import) 按钮确认导入以更新和创建实例。
或者，如果要删除实例，可选中“在目标位置删除”(Delete at target) 复选框，然后单击“导
入”(Import)。 
实例随即根据生成器列表文件的内容创建、更新和/或删除。

说明

仅导入在主数据库中包含相关类型的工艺对象（CM、EM 和 EPH）。
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11.10 更新主数据库中的工艺类型（CMT、EMT 和 EPHT）
如果修改后的工艺类型位于用户库中，本部分将提供有关更新主数据库中的工艺类型（CMT、
EMT 和 EPHT）的信息。

步骤

1. 建议先同步设备类型（类型-实例同步），确保项目与主数据库中的当前工艺类型保持同步。

2. 创建当前工艺类型的备份副本。为此，通过将当前工艺类型以不同名称复制到同一主数据库
中或以相同名称复制到另一个库中来保存当前工艺类型。

说明

创建当前 EMT 或 EPHT 的备份副本

不要通过在同一主数据库中进行复制来保存当前 EMT 或 EPHT，这将导致 FB 编号发生冲

突，而是应当通过将当前 EMT 或 EPHT 复制到另一个库中来进行保存。

3. 从主数据库中删除当前工艺类型。

说明

删除当前 EMT 和 EPHT
从主数据库中删除当前 EMT 或 EPHT 时，还必须从项目的图表文件夹中删除关联的 SFC 类
型。

4. 将修改后的工艺类型从用户库复制到主数据库中。

说明

工艺类型的名称

必须确保修改后的工艺类型的名称与旧工艺类型的名称相同。

5. 建议同步设备类型以检查是否存在差异，并使用主数据库中的最新工艺类型更新项目。
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11.11 工艺组态中的安全功能（故障安全控制模块）

11.11.1 F-CMT 编程

概述

如果关联的 CFC 至少包含一个具有属性 F_NAME 和 F_ID 的故障安全块（F 块），则会将控

制模块 (CM) 视为故障安全 CM (F-CM)。
在工艺级编写 F-CM 和相关故障安全 CFC (F-CFC) 程序的方法与使用工艺编辑器及工艺列表

编辑器编写标准 CM 程序的方法相同。详细信息，请参见“组态和管理控制模块 (页 213)”。
表示 F 程序的 CFC 永久分配给 F-CMT。因此，更改 F-CMT 会同步修改 F 程序。从而会使用

工艺应用间接修改 F 程序。

在 F-CM 中，特殊图标和黄色代码指示安全相关对象。详细信息，请参见“F-CMT 图标 
(页 390)”。
在 F-CM 中，会将特殊结构的数据类型分配给已分配到 F 块参数的工艺参数。不能在 F-CM 的
工艺 I/O 接口中使用 F 系统相关的块 I/O 参数。有关详细信息，请参见“F-CMT 数据类型 
(页 391)”。
用户打开 F-CFC 进行编辑时，系统会通知用户仅可在安全模式已取消激活或处于 STOP 模式

时下载修改。

故障安全程序（管理型）

将第一个故障安全块（F 块）插入管理型 CFC（即基于图表插入）时，会自动创建故障安全

运行系统组（F 组）。F 块会自动移至相应的 F 组。对于管理型 F 组，会在名称后面添加后缀

“_F”。有关详细信息，请参见“如何创建、编辑和删除运行组 (页 196)”和“针对 CFC 块的基

于图表的运行组管理 (页 203)”。
但是，如果运行系统组不是由系统隐式管理的，也可使用 F-CMT。在这种情况下，不支持故

障安全系统采样时间（“F 程序采样时间 (ms)”属性）。因此，建议使用管理型 CFC 的默认设

置。详细信息，请参见“F 程序采样时间 (页 392)”。

故障安全程序密码保护

为了防止意外修改 F 程序，必须设置密码。首次将 F 块插入 CFC 时，系统会提示用户为相

应安全程序设置密码。这一点适用于分配给项目中 CPU 的 CM 以及主数据库中的 CMT。因

此会为每个单独的 CPU 设置密码。

如果要进行修改或密码到期，首次打开 CPU 中的 F-CFC 时，会显示密码提示。
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对于未分配给 CPU 的 CM，也会管理其密码。在这种情况下，仅可通过密码实现访问授权。

将 F-CM 从 PAA 导出到 PCS 7 时，首次检测到 F 程序中的修改时，会显示密码提示。如果未

对 F 程序进行修改，则不会显示密码提示。

详细信息，请参见“CFC 中 F 块的特性 (页 109)”。

11.11.2 F-CMT 图标

黄色图标指示至少有一个 F 块与对象或对象的某一部分相关。

在工艺编辑器中，会为 CM 显示以下图标：

图标 描述

故障安全控制模块 (F-CM) 或故障安全从属控制模块 (F-sub-CM)
故障安全参数（F 参数）

故障安全信号（F 信号）

故障安全功能（F 功能）

安全功能通常组态为单独的程序，并作为 F-CM 独立于顺序任务进行管理。但在例外情况下

（罕见用例和理论上存在的用例），也可为作为直接聚合控制模块（子 CM）的 EM 和 EPH 编
写安全功能程序。

在工艺编辑器中，会为 EM 和 EPH 显示以下图标：

图标 描述

故障安全工厂设备模块 (F-EM)

故障安全工厂设备阶段 (F-EPH)

对于 F 信号和 F 参数，如果数据类型为故障安全数据类型（F 数据类型），会显示相应的 F 图
标。详细信息，请参见“F-CMT 数据类型 (页 391)”。
在工艺编辑器以及工艺列表编辑器中，F 信号和 F 参数父对象的所有图标显示为黄色。 
但分配给工艺接口的块参数显示为绿色，指示这些参数与工艺组态相关。

在工艺列表编辑器中，如果“CM”、“EM”、“参数”(Parameters) 或“信号”(Signals) 选项卡与 F 
块直接或间接相关，第一个编号列中的单元格显示为黄色。
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11.11.3 F-CMT 数据类型

在工艺语言级别，F 数据类型与标准数据类型不同。在工艺组态中，用于 F 参数和 F 信号的

特殊故障安全数据类型（F 数据类型）的结构如下：

结构元素 DATA 指定基本数据类型。结构元素 PAR_ID 和 COMPLEM 在工艺语言级别是隐藏的，

因此无法修改这些元素。

每个 F 数据类型都包含前缀“F_”。下表定义了 F 系统支持的安全数据格式 (SDF) 的结构：

STRUCT F_BOOL F_REAL F_INT F_DINT F_TIME F_BYTE F_WORD F_DWOR
D

DATA BOOL REAL INT DINT TIME BYTE WORD DWORD
PAR_ID WORD WORD WORD WORD WORD WORD WORD WORD
COMPLEM WORD DWORD WORD DWORD DWORD WORD WORD DWORD

F 参数的数据类型

通过将 SDF 映射到相应的特殊 F 数据类型，支持在工艺 I/O 接口（工艺编辑器）中显式使用 F 
参数。

如果通过将 F 块的参数从 CFC 拖放到工艺 I/O 接口（工艺编辑器）的方式定义 F-CMT 中的 F 
参数，在工艺语言级别，数据类型会自动从结构化 F 数据类型映射为相应的 F 数据类型。

对于分配给工艺接口的 F 参数，支持以下 F 数据类型：

• F_BOOL
• F_REAL
• F_INT
• F_DINT
• F_TIME
• F_BYTE
• F_WORD
• F_DWORD
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一般来讲，F 参数不允许直接用于 EM 和 EPH 根对象下方。安全功能通常定义为控制模块

(CM)。 通过这种方式，可确保满足 CM 参数互连规则的要求，因为用户仅可互连数据类型

相同的参数。

如果在工艺级别在两个 F 参数之间绘制互连，则会在 F 程序中同时执行互连。

即使 F 参数在程序级别与结构化变量相关联，也可以对 F 参数进行参数化设置。F 参数的值

会按照相应 IEC 数据类型 BOOL、REAL、INT 等的规则进行标准化处理。

由于工艺编辑器中禁用 F 系统相关的块 I/O 参数，因此不能对此类参数进行调节。将 F 系统

相关的块 I/O 参数拖放到工艺编辑器时，会拒绝插入操作，并提示相应的消息。有关 F 系统

相关的块 I/O 参数列表，请参见“F 系统相关的块 I/O 参数 (页 393)”。

F 信号的数据类型

F 信号定义为必须连接到硬件 I/O 模块的 I/O 通道的安全功能变量。F 信号分为数字量信号、

模拟量信号和计数器。F 信号通常与 F 通道驱动器块的过程值输入和输出相关。

对于分配给工艺接口的 F 参数，支持以下 F 数据类型：

• F_BOOL
• F_REAL（不支持用于输入信号）

• F_INT
• F_DINT
对于模拟量 F 信号，不支持属性 Unit 和 Scale（高位和低位）。

11.11.4 F 程序采样时间

对于管理型 CFC，会自动将每个 F 程序分配给单独的 F 组。对于在主运行系统组中运行的标

准块，可单独确定采样时间。

如果 CM 中至少有一个 F 块可用，则会在工艺编辑器以及工艺列表编辑器中启用“F 程序采样

时间 (ms)”(F-program sampling time (ms)) 属性。

原则上，采样时间以及 F 程序采样时间是通过块插入的组和任务 (OB) 计算的，单位为毫秒。

在工艺编辑器中，可使用“F 程序采样时间 (ms)”(F-program sampling time (ms)) 属性指定循

环时间，单位为毫秒。F 组自动移动到相应任务 (OB)。与 CFC 关联的表示所插入 F 块的主 F 
组的 F 组是唯一的。因此，仅会为工艺编辑器中的根对象，即 CM（特殊情况下为 EM 或 EPH）
定义“F 程序采样时间 (ms)”(F-program sampling time (ms)) 属性。
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11.11.5 F-CMT 同步

要将 F-CM 实例同步到其类型，应使用“同步工厂类型”(Synchronize plant types) 对话框中的

“F CM 选项卡”。

由 F 编译器调节的值或属性不会进行同步。详细信息，请参见“F 系统相关的块 I/O 参数 
(页 393)”。
同步 F-CM 时，通常不会考虑 F 系统组中的块 (@F_...) 的运行系统序列信息。详细信息，请

参见“由 F 编译器隐式移动到 @F 组的 F 块 (页 394)”。
除了标准 F 库中的 F 块之外，还可以定义用户特定的 F 块类型。但必须添加属性 F_NAME 和 
F_ID 对这些可随意编程的 F 块类型进行标记。如果同时在块类型中设置 F_NAME 和 F_ID 属
性，且参数名为 PAR_ID 或 COMPLEM，则同步时不会考虑用户特定 F 块的参数值、互连和

备注。

11.11.6 F 系统相关的块 I/O 参数

F 系统相关的块 I/O 参数由 F 编译器隐式调节，因此不会进行同步。

一般禁止在工艺 I/O 接口（工艺编辑器）中使用 F 系统相关的块 I/O 参数。

以下参数与 F 系统相关：

• 以下 SDF 结构的元素：

– PAR_ID
– COMPLEM

• 常用的系统相关参数：

– DB_ID
– DB_INIT
– PLK_DB
– TestM_DB

• 包含以下 UDA 的参数：

– F_INSERT
– F_CHECK
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11.11.7 由 F 编译器隐式移动到 @F 组的 F 块
在主数据库中，通常不会调用 F 编译器。由于没有硬件可用，也不会调用驱动器生成器。因

此，不能像在项目中那样通过 F 编译器自动确定库的运行顺序。但在某些情况下，F 编译器

会在项目中隐式调节 F 程序的运行顺序。原则上，这一点适用于所有具有 F_CLASS 属性、且

值不是“0”的 F 块。

将 F 块移动到特殊 F 系统组 (@F_...) 时，运行顺序会隐式更改。确定 F 程序的运行顺序时，

CMT 同步程序会忽略以下块：

• 数据转换 F 块：

– F_BO_FBO
– F_I_FI
– F_R_FR
– F_TI_FTI

• 跨 CPU 发送方和接收方 F 块：

– F_SENDBO
– F_RCVBO
– F_SENDR
– F_RCVR
– F_SDS_BO
– F_RDS_BO

• 部分关闭组标记 F 块：

– F_PSG_M
• 跨关闭组发送方和接收方 F 块：

– F_S_BO
– F_R_BO
– F_S_R
– F_R_R
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• 冷启动标识符 F 块：

– F_START
• 安全写入命令

– SWC_MOS
– SWC_QOS
– SWC_CHG
– F_SWC_P
– F_SWC_BO
– F_SWC_R
– F_SWC_CB
– F_SWC_CR

确定运行顺序中的差异时，会考虑不具有 F_CLASS 属性的块，但以下块除外：

• F_START
• SWC_MOS
• SWC_QOS
• SWC_CHG
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编译 12
12.1 CFC 图表编译要点

概要    
如果要通过“编译设置”(Settings for compilation) 对话框控制目标系统上的资源分配，则了

解以下所述的关系很重要。 
更多相关信息，请参见以下部分：编译/下载设置 (页 398) 
在 CFC 中组态的结构会映射到 S7 对象 FC 和 DB。
根据所组态的运行顺序，FC 对于调用在 CFC 中处理的块而言是必需的，如下所示：

• 每个使用的 OB 需要一个 FC
• 每个运行组需要一个 FC
DB 以如下方式使用：

• 对于 FB 的每个实例都创建一个背景数据块。

• 在 CFC 中创建内部 DB，用于存储中间结果，例如，来自于 FC 的结果。对于每个数据类

型，需要这些 DB 中的某一个。达到 4 KB 的最大长度时，将再创建一个 DB。

SCL 编译器

使用 SCL 编译器编译时，请注意以下几点：

• SFC 编译器所需时间因大型 CFC 结构而适当延长。在某些情况下，可能在几分钟之内看

不到进度变化。

SIMATIC S7 中的 CFC (V9.0 SP7)
功能手册, 05/2022, A5E41356112-AH 397



12.2 编译/下载设置

进行设置 
编译前可为当前 CPU 自定义设置。

选择菜单命令“选项”(Options) >“自定义”(Customize) >“编译/下载…”(Compile/
Download…)。
对话框打开，在其中可以：

• 设置警告限制值以便在启动下载前及时检测可能的危险。警告限制值可用于：

– 本地数据

– S7 通信的背景数据块（编号）

– 装载存储器/工作存储器

仅当执行下载时检查。   
– 每个运行组或 OB 的块

有关这些术语的更多信息，请参见“编译和下载 S7 程序的帮助”。 
• 编译当前图表文件夹的图表时，指定哪些资源应该被保留为不使用（为其它应用程序保

留的区域）。这会十分有用，例如，如果要结合图表的使用和通过诸如 STL、LAD 或 SCL 
程序编程来解决自动化任务，以及在用户程序中使用来自于其它源的功能 (FC) 或数据块 
(DB) 时。

• 查看 CPU 上有多少资源（DB、FC）可用于编译图表以及有多少资源已被占用的统计信息。

提供以下信息：

– CPU 上的最大可用 DB 和 FC 数量

– 对 CFC 可用的 DB 和 FC 数量（CPU 上的最大值减去保留区域）

– 由 CFC 使用的 DB 和 FC 编号的数量

如果未将 CPU 分配给当前图表，则“最大”和“可用”列将显示“- -”。
• 激活“为下载程序生成映象以用于比较”选项：

使用此选项可在成功完成下载操作后生成一个当前程序的映像。将此映像创建为 XML 文
档，并分配给此程序。 
然后，当想再次下载时，可在实际下载前单击“S7 下载”(S7 Download) 对话框中的“显示

更改”(Show Changes) 来比较 XML 文件与您要下载的数据。仅当安装了 Version Cross 
Manager (VXM)  附加软件包且先前下载程序时生成了映像，才能进行此比较。

请注意，XML 文件的生成会减慢完全下载完成的速度。 
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压缩

单击“压缩”将对 DB 和 FC 中的间隙进行压缩。这些间隙，例如，有可能是删除对象时产

生的。重新压缩后将消除这些间隙，释放 DB 号范围。

说明

如果更改并压缩编号范围，则必须编译整个程序，并在停止模式将其下载到 CPU。
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12.3 将图表编译为程序

概述 
如果在图表文件夹中已添加或修改对象但尚未编译，则在 SIMATIC Manager 中通过以下图

标指示这种情况： 
• 已关闭的图表文件夹左下角的附加符号“C->”。这表示该程序仍需编译。 

• 图表文件夹中对象图标左下角的附加符号“C->”。这表示此对象已更改，但尚未编译和下载。

CFC 图标示例：

现可编译整个程序或者所有更改，如下所述。 
如果您不想编译整个用户程序或所有更改，可使用“选择性下载”功能编译各个图表并将其

下载至 CPU。更多信息，请参见“各个图表的选择性下载 (页 421)”部分。 
编译

编译期间会自动执行一致性检查。也可以在不进行编译的情况下启动一致性检查，例如，在

通过编译覆盖旧的和仍在运行的 CFC 程序前。为此，请选择菜单命令“图表 > 检查一致性 > 
图表作为程序.../图表作为块类型...”(Chart > Check Consistency > Charts as Program.../
Chart as Block Type...)。
要进行编译，请选择菜单命令“图表 > 编译 > 图表作为程序...”(Chart > Compile > Charts 
as Program...) 或单击工具栏中的图标：

对话框打开。可在其中选择其它选项。 
一致性检查和编译期间会生成日志。可通过菜单命令“选项”(Options) >“日志...”(Logs...) 查
看 CFC 中的条目。

一致性检查会根据特定目标系统而有所不同。例如，执行以下检查以查看：

• 是否输入/输出参数或类型为“ANY”、“STRING”、“DATE_AND_TIME”或“POINTER”的块输出

已互连

• 是否按照其任务列表安装了块

• 是否 FC 和 DB 的编号在 CFC 非法范围内（为其它应用程序保留的区域）

编译
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编译范围

可选择两个编译选项之一：

• 范围：整个程序 (Scope: Entire program)
设置此选项时，将编译所有 AS 资源，即无论是否有更改都编译整个图表文件夹的内容。

• 范围：仅更改 (Scope: Changes only)
设置此选项时，仅编译在上次编译后对 AS 资源所做的更改。这仅包括内容的更改，例如，

互连、块属性或输入数量，但是不包括对象在图表内的移动。尽可能选择“编译更改”，

因为这可显著缩短编译时间。

说明

编译更改时，将仅检查更改内容。您还需要执行一致性检查来验证整个程序。

编译前执行的可选功能

编译数据前，可以设置要在编译前执行的特定可选功能：

• “生成 SCL 源”(Generate SCL source) 选项

在默认情况下，该复选框被禁用。如果选中此复选框，则会生成 SCL 源文件且存储在源

文件文件夹中。程序编译时不需要此源。

仅当要查看 SCL 代码的某个程序部分时，才需要生成源文件，例如，为了使事情更清晰

或用于故障排除。 
启用此复选框仅对一次编译过程有效；下次编译时会重新禁用此复选框。

• “生成模块驱动程序”(Generate module drivers) 选项

默认情况下会选中该复选框，即在每次编译之前还将启动驱动程序生成器。在特殊情况下

（例如，硬件不完整），您可以清除此复选框，以便不执行“生成模块驱动程序”(Generate 
module drivers) 功能。

此禁用操作仅在此次编译过程中有效，下次编译时会重新激活该复选框。

• “模块驱动程序设置”(Module drivers settings) 按钮

如果自上次编译后硬件配置发生了更改，驱动程序生成器将为现有信号处理块创建并互

连模块驱动程序。如果不想使用当前 PCS 7 Library 的驱动程序块，则可以使用“模块驱

动程序设置”(Module driver settings) 按钮打开一个对话框，您可以在其中选择所需的驱

动程序库。

说明

HW Config 中更改的采样时间将在下次编译 ES 时生效。
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编译程序时创建 OB
编译程序时，仅在以下情况下创建 OB：
• OB 包括用户程序。

• OB 不包括用户程序，但可以访问过程映像分区 (PiP)，并且存在分配给该 PiP 的硬件模块。

在这种情况下，会为不包括程序但支持 PiP 访问的每个较慢的任务生成一个独立于分配的

硬件的 OB。
任何创建的 OB 也会获得一个实例化的 CPU_RT 块。

编译后

编译完成或取消后，将打开 S7 日志对话框。此日志中包括所有编译事件、警告和错误。基

于此日志，您可以验证编译，并通过单击“打印”(Print) 打印日志文件。单击“关闭”(Close) 
可关闭此对话框。

以后可通过菜单命令“选项”(Options) >“日志...”(Logs...) 打开并打印日志。 

说明

请注意以下信息：

• 写入到日志中的警告并不会中止编译，但进行后续下载时可能会引起错误，即阻止或取消下载。
与未关闭的文本互连相关或与到符号表中（尚）不可用的地址的互连相关的警告不影响下载。
在这两种情况下，将根据块类型的默认参数值生成一个替代值。

• 如果项目包含递归调用的块，将会在日志中写入警告。递归调用的块显示在图表引用数据的
“块调用层级”视图中。可使用菜单命令“选项”(Options) >“图表引用数据”(Chart 
Reference Data) 调用此视图。

• 由于 PCS 7 块不包含递归调用，所以这些块一定是用户块。请确保程序中的终止条件总能被
满足，否则将会出现死循环或递归移除。

• 如果许可证数量不足，则只能编译整个程序。这种情况下将取消编译更改。

• 编译整个程序并不一定意味着必须下载整个程序。如果编译前程序已加载到 CPU，那么可执
行下载更改。

更多信息

更多相关信息，请参见以下部分：

CFC 图表编译要点 (页 397)
编译/下载设置 (页 398)
编译和下载对象 (页 420)
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12.4 将图表编译为块类型

启动

可将当前具有图表 I/O 的 CFC 图表编译成可多次使用的功能块。可将系统属性分配给这些块

类型。

要执行编译，选择菜单命令“图表”(Chart) >“编译”(Compile) >“图表作为块类型...”(Chart 
as Block Type...)。将打开显示“常规”(General) 和“属性”(Attributes) 选项卡的对话框。

编译

可具有以下编译设置选项：

• 在“常规”(General) 选项卡中，启动编译前指定块类型属性（FB 编号、符号名称、名称

（标题）、系列、作者和版本），并指定将在其中使用该块的目标系统。由于 SCL 编译器

需要为每个目标系统生成不同的编码，所以此信息 (S7-300/S7-400) 与启动块相关。

FB 编号的注意事项：此编号不得超过目标 CPU 所支持的范围。

示例：对于 414-2DP CPU 而言，最大编号范围设置为 512（地址范围：FB 数目）。因此，

分配给块的编号不得大于 511。
使用特定的代码序列确保要编译的所有图表块都依其在 S7_tasklist 属性中的条目进行调

用。

说明

S7 -300 仅支持 OB100，不允许任务列表中有任何其它 OB 条目。否则，会引发出错消息。

• 可启动影响本地数据要求或更改的在线下载的编码优化。

– 本地数据要求：

使用这种优化类型，图表中的更改不会增加本地数据要求，因为所有临时变量均存储

在背景数据块（VAR 区域）中。但是这可导致背景数据块的结构更改及其接口时间戳

的更改。在这种情况下，不能在线下载更改。

– RUN 模式下下载更改：

使用这种优化类型，如果图表中有了一个更改，那么如有可能，临时变量将存储在 
VAR_TEMP 区域。在此上下文中可能意味着数据流中的所有中间结果在此位置存储。

只有中间结果不在数据流中，例如，在反馈回路中，才继续保存在 VAR 区域（背景数

据块）。此优化方法的优点是并非所有的修改都会影响背景数据块的接口时间戳，即，

在多数情况下，仍可在线下载更改。但是，将增加本地数据要求。

• 或者，也可启用专有知识保护。可查看块算法，但仅在合适的 SCL 源文件存在时，才可

修改块算法。

• 可在“属性”(Attributes) 选项卡上设置此块类型的系统属性。
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一致性检查

编译期间，一致性检查遵循以下标准：

• 图表是否包含嵌套图表

• 块在 OB 中是否仅手动安装一次，也就是说，仅安装在由“S7_tasklist”系统属性指定的 OB 
之外的 OB 中一次

• 所有块是否连续安装在同一 OB 中，以确保没有其它图表块安置在其中

• 块是否插入到运行组中

• 所有图表 I/O 是否与内部块 I/O 互连 
• 图表 I/O 是否具有一个 EN 输入，由于这些图表 I/O 可自动生成

• 是否为现有 ENO I/O 分配 BOOL 数据类型 
• 是否将无法互连的块输入分配图表 I/O 的属性 S7_link:="false"
• 是否存在非法块

• I/O 中是否存在非法数据类型

更多信息

• 在 SIMATIC Manager 的“系统属性的帮助”在线帮助的“块的系统属性”、“块 I/O 的
系统属性”和“分配系统属性”部分中。 

• 在 CFC 中创建块类型 (页 111)
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12.5 有关 CPU 410-5H PA 编译期间的特别注意事项

概述

为 CPU 410-5H Process Automation (CPU 410-5H PA) 编译程序时，需遵循以下特别注意事

项： 
• 许可证信息的监视块 

编译期间将自动创建包含“PA_CPU”块实例的“@PA-CPU”CFC。此 CFC 也安装在 OB1 中。 
CPU 410-5H PA 中需要“PA_CPU”块，该块用于许可证监视。该块在 CFC 库中的目录

“ELEM_400”下以 FB16 的形式提供。 
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下载 13
13.1 如何将用户程序下载到目标系统

概述 
完成编译后，可下载用户程序，然后在目标系统上测试并运行。     
当程序或图表已编译但尚未下载到 CPU 时，在 SIMATIC Manager 中通过以下图标指示这种

情况： 
• 已关闭的图表文件夹左下角的附加箭头符号。这表示该程序在编译后仍需下载。  

• 图表文件夹中对象图标左下角的附加箭头符号。这表示该对象已编译，但尚未下载。

CFC 图标示例：

现可下载整个程序或者任意更改，如下所述。

如果您不想下载整个用户程序或所有更改，可使用“选择性下载”功能下载一个或多个图表。

更多信息，请参见“各个图表的选择性下载 (页 421)”部分。   
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常规信息

请注意以下信息：

• 由于只有 CFC 的下载功能才能保证离线和在线目标系统数据的一致性，所以始终要将在 
CFC 中创建的程序从 CFC 下载到目标系统。

例外：

SIMATIC Manager 在以下情况中也提供 CFC 下载功能：

– 对于所选的图表文件夹，通过菜单命令“CPU > 下载”(CPU > Download)。
– 对于所选的（多）项目或工作站，通过菜单命令“CPU > 编译对象并下载”(CPU > 

Compile and Download Objects)。
相关信息，请参见以下部分：编译和下载对象 (页 420)

不允许标记块文件夹或单独块，以及调用菜单命令 CPU >“下载”(Download)，或从“离

线块文件夹”中复制块然后将块插入到“在线块文件夹”。

• 如同在测试模式下工作一样，向 CPU 下载数据是 S7 中一种受保护的功能，所以如果安

装了 SIMATIC Logon Service，则该过程一定会记录到日志中。如果已经通过菜单命令“图

表文件夹”(Chart Folder) >“对象属性...”(Object Properties...) >“ES 日志”(ES Log) 选项

卡启用 ES 日志的当前图表文件夹，则下载期间的操作和时间戳将在 ES 日志中列出。

更多相关信息，请参见以下部分：更改日志和 ES 日志 (页 447)
• 如果在程序编译期间日志中输入警告，这可能意味着下载将被阻止或中止。在这种情况

下，下载前请检查编译日志中的警告是否与下载相关。

下载
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步骤

要下载用户程序到目标系统，请执行以下步骤：

1. 选择 CFC 菜单命令 “CPU >下载...”(CPU > Download...)
或
单击工具栏中的以下按钮：

将打开对话框，可在其中选择下载类型。
如果下载前，在用户程序中已更改了与下载相关的数据，将显示一条消息，此消息告知程序
首先需要编译。然后询问是否在下载前执行编译。 

2. 选择下载类型：

– 整个程序 (Entire program)：将下载所有应用程序对象。

– 仅更改 (Changes only)：将下载上次下载后所做的更改。

– 下载到测试 CPU（整个程序）(Download to test CPU (entire program))：将下载所有

应用程序对象。

– 在 RUN 模式下下载更改至 CPU： 
更多相关信息，可参见以下说明。 

3. 单击“确定”(OK)。
即开始下载。  

单击“应用”(Apply) 在不启动下载的情况下，保存更改。

如果不下载而仅保存设置，单击“应用”(Apply) 然后单击“取消”(Cancel)。

下载：整个程序 
可在 STOP 或 RUN-P 模式下下载“整个程序”。在 RUN-P 模式下，将 CPU 设置为 STOP 状态，

出现提示后将删除其包含的所有块。下载完成后，系统提示“要重新启动 CPU 吗？”(Do you 
want to restart the CPU?)。单击“是”(Yes) 触发 CPU 的重新启动。 
在执行完整下载之前，将打开一个对话框，您可以选择回读参数。只有未更改块类型的接口

时，才可进行回读，这意味着仍可下载更改。

执行完整下载时，使用以下步骤：

• 编译整个程序并不一定意味着必须下载整个程序。如果编译前程序已加载到 CPU，那么

可执行下载更改。

• 如果已取消完整下载，则只有完全执行完整下载后，才能下载更改。

原因：在下载之前，系统已经删除了 CPU 中的块。

下载
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下载：更改

CPU 在 RUN-P 模式下，可下载更改。将保留数据下载所需的正确下载顺序和分段。请注意，

由于不可能检查所有的情况，所以无法完全保证在临时不一致的情况下 CPU 不会更改到 
STOP。 

“修改与下载相关的用户 DB”(Modified user DBs relevant to loading) 选项为默认设置，并且

仅当下载更改时发挥作用。下载整个程序时，始终会下载所有块，包括用户数据块。

此复选框的效果取决于离线程序中用户 DB 中的更改是否与下载相关： 
• 与下载相关的用户 DB 更改：

当用户 DB 的接口发生变化时，会发生与下载相关的变化，即：

– 添加或删除 DB 变量。

– 更改 DB 变量的数据类型。

– 更改 DB 变量的值。

• 与下载无关的用户 DB 更改：

当用户 DB 发生变化但用户 DB 的接口保留时，会发生与下载无关的更改。例如：

– 更改 DB 的作者。

– 更改 DB 的备注。

– 更改 DB 变量的备注。

– 更改 DB 变量的名称。

如果激活此选项，则仅将具有下载相关更改的用户数据块下载到 CPU：
• 如果用户 DB 存在于离线程序中而不存在于 CPU 中，则将离线程序中的用户 DB 下载到 

CPU。
• 如果用户 DB 同时存在于离线程序和 CPU 中，则离线程序中的 DB 内容会覆盖 CPU 中相应 

DB 的内容。

• 如果用户 DB 不存在于离线程序中（已删除），但存在于 CPU 中，则下载后从 CPU 中删

除相应的用户 DB。
如果禁用此选项，则在下载更改时将忽略已修改的用户数据块。但是，如果离线程序中用户 
DB 中的更改与下载相关，则会显示关于未下载的已修改数据块的警告。

• 如果用户 DB 存在于离线程序中但不存在于 CPU 中，则下载将中止并显示错误消息。

• 如果用户 DB 不再存在于离线程序中（已删除）但存在于 CPU 中，则会显示警告。

下载
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说明

程序更改

程序更改后请注意下列情况：

• 下载更改后，AS-OS 通信的自动化系统和操作系统数据可能不一致。在这种情况下，需使用
菜单命令“选项 > 向导：编译多个 OS > 启动...”(Options > Wizard: Compile Multiple OSs 
> Start...) 来重新传送数据。

• 下载更改内容后，跨 CPU 通信 (AS-AS) 可能出现不一致。

说明

注意，在下载更改内容时，无法百分之百保证 CPU 不会切换到 STOP 模式。

更多相关信息，请参见《SIMATIC S7 的 CFC》手册或在线帮助的“避免导致 CPU 转入 STOP 
模式的系统支持”部分。

关于下载更改内容的注意事项

请注意以下信息：

• 如果以下条件满足，则始终可下载更改：

– 至少成功执行一次完全下载时

– 使用以前使用的程序结构执行下载。

相关信息，请参见以下部分：关于下载更改所应该了解的信息 (页 415)。
• 每次下载更改时，将隐式地执行“CPU 存储器的异步压缩”功能。这可帮助避免随后下载

更改期间，由于存储器不足而产生的警告和错误消息。

压缩 CPU 存储器空间与压缩 DB/FC 编号区域相比，对下载有其它影响。压缩 DB/FC 则不

能下载更改内容。

• 编译整个程序并不一定意味着必须下载整个程序。如果编译前程序已加载到 CPU 上，则

下载更改是可行的。

• 可多次编译程序（仅更改部分或整个程序）而不会失去下载更改的能力。

• 可重复已取消的下载更改，以下载首次未包含的对象。

下载
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• 在将修改的程序下载到运行系统之前，已经在另一个系统上或通过 PLCSIM 测试了该程序，

则不能下载更改。

补救措施：使用选项“范围：下载到测试 CPU（整个程序）”(Scope: Download to test 
CPU (entire program))，仍可将更改下载到原始 CPU。另请参考：

将修改过的程序下载到测试 CPU (页 414)
• 问题答案：

– “什么情况将阻止在线下载更改？”

以及 
– “如何保持程序执行在线下载更改的功能？”

请参见：关于下载更改所应该了解的信息 (页 415)

说明

某些方案可能意味着将不再执行更改内容下载。唯一的选择是在 CPU 转入 STOP 模式

时下载整个程序。执行此操作前会出现一条警告，提防无意中丢失下载更改的功能。

下载：在 RUN 模式下下载更改至 CPU
该选项只有在使用 CPU 410-5H PA 时可用，因为此 CPU 支持 RUN 模式下的类型更新。CPU 
410-5H PA  的各个下载功能的操作模式与其它 CPU 不同。 
更多信息，请参见“有关向 CPU 410-5H PA 下载程序期间的特别注意事项 (页 429)”部分。 

系统支持

将针对在 STEP 7 V5.0 + SP3 及更高版本或 SCL V5.0 + SP3 及更高版本下编译的块创建引用

列表。基于这些引用列表，系统执行检查，以检测导致 CPU STOP 的原因，并在发生任何错误

（消息）时阻止下载。

更多相关信息，请参见以下部分：避免导致 CPU STOP 的系统支持 (页 417)

下载前显示更改

仅当安装了 Version Cross Manager(VXM)  附加软件包且生成已下载程序的映像时，“显示

更改”(Show Changes) 功能才可用。 
生成已下载程序的映像

假定已选择了“编译/下载的设置”(Settings for Compilation/Download) 对话框中的“生成已

下载程序的映像用于比较”(Generate image of downloaded program for comparison)，则在

成功完成下载操作之后，系统将生成 XML 文档格式的映像，并将其分配给该程序。

比较程序
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如果生成了已下载程序的映像，则在实际下载之前可单击“S7 下载”(S7 Download) 对话框中的

“显示更改”(Show Changes)，以对 XML 文件与目前要下载的程序进行比较。

比较时会调用 VXM。通过比较，您可以了解相对于先前下载的程序，哪些数据发生了变化。

然后便可决定是否下载最新版本。

H CPU 的注意事项

• 如果 H CPU 处于单机模式（例如，由于 CPU 故障）并且已发生 CPU 失效转移，那么在线

访问请求之后将出现一个对话框。可在其中选择应链接的 CPU。冗余模式下则不显示此

对话框。

• 如果将程序更改下载到单机模式运行的 CPU 中，然后通过菜单命令 CPU >“工作模式...”
(Operating Mode...) 执行“使用修改后的组态进行切换”(Switchover with modified 
configuration) 操作，则所有的更改都将丢失。此时需要下载整个程序。

补救措施：在冗余工作模式中下载。在这种情况下，必须确保下载完成之前工作模式保

持不变。

F 系统注意事项

必须输入 F 密码，才能使用已修改的 F 组件从程序中下载更改。否则，F 系统将拒绝下载。

下载
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13.2 将修改过的程序下载到测试 CPU

下载到测试 CPU    
使用 S7 下载对话框中的“载到测试 CPU”(Download to test CPU) 选项，可将更改的程序下

载到不同的 CPU 或 PLCSIM 进行测试，同时不会丢失程序的下载更改功能。

当将测试程序下载到测试 CPU 或 PLCSIM 时，系统将不会丢失下载标识符也不会将用于比较

的时间标签写入 ES 数据管理中。

为避免测试下载意外覆盖程序，加载程序检查已更改程序是否能够仅更改下载。在该情况下，

必须使用原始 CPU 而不是测试 CPU 进行下载，此时将显示注释文本，且无法执行下载。“确

定”(OK) 按钮将禁用。

更多信息

更多相关信息，请参见以下部分：关于下载更改所应该了解的信息 (页 415)
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13.3 关于下载更改所应该了解的信息

如何保持程序的在线下载更改的功能？       
当操作期间流程发生改变，但又绝不可能切换到 STOP 模式进行下载，则必须确保下载更改

的可能性。 

说明

如果要确保程序保持其下载更改的功能，每次下载完成后应该生成备份副本。

这项措施对于测试或调试阶段来说不是必需的。可自行决定此事，并且这取决于特定环境中

是否容许在 STOP 模式下的完整下载。

下图显示在线下载更改的功能是如何在无意间丢失的。

图例：

蓝色三角形 = 下载更改

第 1 步：

程序被下载到 CPU，且生成备份副本。下载时，在编译期间生成的时间戳被存储到离线和在

下载
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线程序（17.04.02 12:04:38）。

因此，在离线程序中存在两个时间戳：

• 一个每次执行编译时更新

• 一个用于比较且仅当成功完成下载时才被覆盖

第 2 步：

完成对离线程序的更改和后续编译后，会为其分配当前时间戳“18.04.02 10:14:22”。上次下

载期间生成的离线比较时戳指向“17.04.02 12:04:38”；在线程序也包含此时间戳。执行下载

更改。离线程序会被分配新比较时戳“18.04.02 10:14:22”，此时戳也将传输给在线程序。

第 3 步：

程序被更改并且变得不一致，例如电源故障引起的数据丢失后。

第 4 步：

系统将访问最近已知版本（第 1 步）并再次执行在第 2 步和第 3 步中所做的更改。程序编

译后，被分配了当前时间戳“20.04.02 09:05:35”，上次下载的离线比较时戳指向“17.04.02 
12:04:38”（第 1 步）。在线程序的时间戳指向“18.04.02 10:14:22”（第 2 步）。由于两次

时间戳不相同，所以不再可能下载更改，

此情形清楚地显示了在第 2 步生成的备份副本将有能力在第 4 步生成同一时间戳，这样可

启用下载更改。

什么情况将阻止在线下载更改？

如果出现下列情况，将不再可能下载更改：

• 使用的块类型被包含结构更改的新版本替代，例如，由于加入了 I/O 和/或消息。

• 编译期间通过菜单命令“选项”(Options) >“设置”(Settings) >“编译/下载...”(Compile/
Download...) >“压缩”(Compress) 选项已经压缩了 DB 和 FC 的编号区域。在这种情况下，

DB 和 FC 将被分配给一个新的编号序列。

• 下载更改前，已修改的程序下载到另一个 CPU 中，例如，用于测试目的。在这种情况下，

时间戳不再与原始 CPU 的时间戳匹配。

例外：如果使用“S7 下载”(S7 Download) 对话框的“下载到测试 CPU”(Download to test 
CPU) 选项，将保留下载标识符和比较时戳。因此仍可通过下载更改将程序传输到原始 
CPU。

• 已从归档中恢复程序。这不是上次下载使用的原始程序（时间戳比较）。

下载

13.3 关于下载更改所应该了解的信息

SIMATIC S7 中的 CFC (V9.0 SP7)
416 功能手册, 05/2022, A5E41356112-AH



13.4 避免导致 CPU STOP 的系统支持

简介 
编译和下载期间，系统执行检查和评估以避免在线程序下载过程中导致 CPU STOP 的因素。

块引用列表也用于这些检查。这些引用列表仅适用于使用 STEP 7 V5.0 + SP3 及更高版本或 
SCL V5.0 + SP3 及更高版本编译的块。这将影响 PCS 7 V5.1 库中的块。如果程序使用不带有

引用列表的块（PCS 7 V4.x 和 V5.0 库以及 STEP 7 标准库中的块），则不可能执行完整验证。

在这种情况下，将显示一条警告。

编译期间的系统支持

系统支持编译，如下所示：

• 一致性检查包括整个块调用层级以及其时间戳。系统可检测到：两个块将调用同一块（递

归调用），但是这些被调用的块具有不同版本。

• 计算出最大本地数据要求，并将其与已组态的 CPU 资源相比较。如果超出绝对值 (100%) 
或通过菜单命令“选项”(Options) >“自定义”(Customize) >“编译/下载…”(Compile/
Download…) 设置的警告限制值，则将生成一个警告；仍然生成代码。这允许您调整本

地数据堆栈，而无需重新编译数据。

• 按照其块的嵌套深度来扫描程序结构，并将结果与已组态的 CPU 的最大可能嵌套深度相

比较。如果超出了最大嵌套深度，则取消编译。包含相关 OB 完整调用层级的出错消息会

被写入日志文件。

一个 OB 的最大嵌套深度 <= 24。
计算如下（嵌套深度 = ND）：

 STmax = OB 的 STmax + OB 121 的 STmax + OB 122 的 STmax
• 检查 OB 以确保其调用正确的块，这些块由 ES（任务 FC）生成。如果调用了错误的 FC，

则将向日志文件中写入一条出错消息。

• 编译完成后，将计算 S7 通信的背景数据块编号，并将其与通信作业的最大组态编号相比

较。通信作业的编号与 S7 通信的背景数据块编号相匹配。此检查可确定是否超出设置警

告限制值或绝对限制值 (100%)。
如果超出这些限制值中的任意一个，则将向日志文件中写入一条警告消息。

所有出错消息均会阻止后续下载。
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下载期间的系统支持

系统支持如下下载：

• 系统进行检查以确定连接的 CPU 是否支持程序所需的系统功能（SFB、SFC）。如果缺少

支持，则取消下载。

• 编译期间计算的最大本地数据要求与用于下载的在线 CPU 资源相比较。系统将读取系统

状态列表来获取相应的信息。如果超出警告限制值，则系统在日志中输出一条警告，但

不会阻止下载。如果超出绝对限制，则系统取消该下载并输入一个出错消息到日志中。

• 计算出要下载的块所需要的存储器空间，并将结果与 CPU 的存储器资源相比较。系统进

行检查以确定设置的警告限制值和/或绝对限制值 (100%) 是否超出。如果超出这些限制

值中的任意一个，则会将相应的消息输出到对话框中。在此对话框中以下选项可用：

– 压缩 CPU 存储器空间 (Compressing CPU memory)
– 放弃压缩并继续下载（用户承担责任）(Discarding compression and continuing the 

download (responsibility of the user))
– 取消下载 (Cancellation of the download)
CPU RUN 模式下完成数据压缩后便确定了存储器资源。如果现在需要的存储器空间低于

设置的警告限制值，则执行下载。如果压缩结果不理想，对话框中会再次出现相应的消

息。现在可决定是继续下载还是取消下载。

如果您忽略警告继续下载，则达到绝对限制值时将自动取消下载。但是，CPU 不会转到 
STOP 状态。而出错消息将写入日志文件。

说明

请注意，存储器空间的需求计算不能确定是否删除或改写工作存储器中的现有块，或如

已删除或改写，则不能确定其数量。即，实际需要的工作存储器空间可能少于将重新加

载的块的数据量。 
如果取消下载，则已下载的块将保留在 CPU 中。启动新下载后，计算存储器空间需求时

只包含尚未下载的块。可根据需要重复此下载过程，直到成功地将整个程序传送到 CPU 存
储器中。 

• 将在编译期间计算的 S7 通信的背景数据块编号与为在线 CPU 组态的编号相比较。如果

超出警告限制值，则系统在日志中输出一条警告，但不会阻止下载。如果超出绝对限制，

则系统取消该下载并输入一个出错消息到日志中。
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其它系统支持功能

• 类型导入

在多实例块的类型导入期间也使用要导入的块的引用列表来标识调用块。此功能允许您

在导入期间将 FC 复制到目标程序中。 
如果时间戳评估标识出由不同版本的块调用的块，则将在一个对话框中显示该块的调用

层级。导入期间更新的块将在此对话框中进行标识。 
如果导入功能隐式也更新被调用的块，则可能无法再执行调用同一块的另一个块。

示例：下图显示了同时包含 FB 46 调用的 FB 61。两个 FB 在导入期间均更新。但是，FB 
202 也调用 FB 46，由于 FB 202 未更新，因此不能访问已修改的参数。 

从此处往后，用户必须进行干预：

通过选择菜单命令“选项”(Options) >“图表引用数据...”(Chart Reference Data...) 读取

图表引用数据。

通过在“块调用层级”(Block Call Hierarchy)视图中选择菜单命令“编辑”(Edit) >“查找”
(Find) 搜索被调用的块，直到找到所有调用块。完成搜索后还可以导入这些块。

• 复制/移动

如果您将多个实例块复制或移动到另一个程序（类似于类型导入），则通过评估块引用

列表，会包括被调用的块。 
• 生成模块驱动程序

因为在检测到错误的情况下 PCS 7 过程控制系统就可能会进入停止状态，所以能够对各

种错误原因（如机架/模块故障或 I/O 访问错误）作出响应是必需的功能。为此，驱动程

序生成器插入块 OB_BEGIN 和 OB_END（使用块 MSG_CSF，版本最高到 V5.2）。 
将在 CFC 中生成用于检测错误原因、防止 CPU 停机的错误 OB，然后下载到 AS。
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13.5 编译和下载对象

概述

SIMATIC Manager“编译和下载对象”(Compile and Download Objects) 功能用于帮助用户在单

一传递中生成不同对象（例如，网络、硬件、块、图表、OS 服务器、OS 客户端、BATCH 服
务器和 BATCH 客户端）的一致性修改数据。所有先前分布于多个应用程序的操作步骤现在

被统一在一起，并按照正确的顺序执行。 
要启动该功能，可选择某一（多个）项目或某个站，然后选择 SIMATIC Manager 中的菜单

命令“PLC > 编译和下载对象”(PLC > Compile and Download Objects)。
请注意，基于安全的考虑，当使用该功能对程序进行完全下载时，必须在执行操作之前先将

相应 CPU 设置到停止模式。

有关此功能的更多信息，请参见 STEP 7 基本帮助。

说明

自动归档 
对于使用“下载和编译对象”(Download and compile objects) 对话框执行的下载，不会执行

“下载”(Download) 对话框中已启用的自动归档。 
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13.6 各个图表的选择性下载

概述

“选择性下载”功能可用来将一个或多个修改的 CFC 或 SFC 下载到 CPU。 
作为用户，您可以使用选择性下载功能来明确选择应将哪些已组态更改传送到 CPU，并加以

启用。例如，可以在 CPU 上一次组态多个单元，因为仅针对特定单元的更改进行编译、下

载和测试。 
选择图表

• 选择对话框会显示所有可选择性下载的图表。在该对话框中选择要下载的图表。相关图

表也会自动选择。相关性通过以下方式创建：

– 在顺序中插入块

– 相同 SFC 类型的实例

– 将块从一个图表移动到另一个图表

– 将块从一个运行组移动到另一个运行组

• 未选中但受到更改影响的图表会自动传送。    
• 前缀为“@”的系统图表不会显示，但如果它们受到更改的影响，也会被自动传送。 
有关选择单个或所有已更改图表的注意事项

选择具有以下影响。 
• 选择并选择性下载单个已更改的图表： 

– 不会在 AS 中删除不再使用的数据块和用户 FB/FC。 
– 同样，不会更新 VXM 映像。 
– 当带有互连源（输出）的图表也无法下载时，如果必要，会将跨图表互连替换为默认

值 (DB) 来进行选择性下载。

– 更多相关信息，请参见下面的“有关选择性下载的过程符合性的注意事项”段落。

• 在对话框中选择所有已更改的图表并进行下载：

– 会删除 AS 中不再使用的数据块和用户 FB/FC。 
– 更新 VXM 映像。 

说明

选择性下载时预定 PO 许可证

选择性下载图表时，PO 许可证始终可用于所有已组态的 PO，即使这些 PO 中只有一部分是

在标记为选择性下载的图表中组态的。 
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FB/FC 块中的代码更改

如果选择性下载某个图表，并且该图表包含带有已更改代码的 FB/FC 块，则还将下载此 FB/FC 
块。带有已更改代码的 FB/FC 块随后会影响 CPU 中的所有其它实例。 
执行选项

可使用以下选项执行“选择性下载”功能：  
• 组件视图：导航窗口的“图表”(Charts) 文件夹中的所需 CPU 下。 

此选项在下面的说明中使用。 
• 工厂视图：导航窗口的“功能”(Function) 文件夹中的单元下 

具有不同 AS 分配的 CFC 不能选择性下载。 
• SIMATIC Manager：通过菜单命令“选项 > 图表 > 选择性下载...”(Options > Charts > 

Selective Download...)。  
• 在 CFC 编辑器中：通过菜单命令“CPU > 选择性下载...”(CPU > Selective Download...)。  

嵌套的图表

此功能只能用于顶层图表（最高层级）。下载各个图表时，始终包含顶层图表的从属图表。

不能下载单个子图表。 

F 系统

如果 F 系统的块受到更改的影响，“选择性下载”中会自动包含这些块。

受到更改影响的所有 F 图表均显示在对话框中，并且只能完整传送。不能选择和下载单个 F 
图表。

维护下载更改功能 
为维护下载更改功能，应在每次成功进行选择性下载后都创建一个备份副本。更多相关信息，

请参见“关于下载更改所应该了解的信息 (页 415)”部分。

如果还使用了 PCS 7 Version Trail，则备份副本可自动创建。为此，请在“编译程序/下载到

目标系统”(Compile Program/Download to Target System) 对话框中选择“成功下载后归档项

目”(Archive project after successful download) 选项。 
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在运行组中基于图表插入块

从 CFC V8.2 开始，只有集成到面向图表的运行组管理中的图表才可以选择下载。为此，对

图表文件夹使用“选择性下载”(Selective Download) 功能时，需要选择“图表文件夹属性”
(Properties Chart Folder) 对话框中的“基于图表插入”(Chart-based insertion) 选项。更多相

关信息，请参见“针对 CFC 块的基于图表的运行组管理 (页 203)”部分。 
如果启用“基于图表插入”(Chart-based insertion) 选项，在实例化图表中的块时，会自动在

已分配的运行组中插入块。创建新图表时会自动创建相关的运行组。

在此图表的运行组中插入图表的新块，可减少相关图表的数量，这些图表也需要包括在选择

性下载中。  
对于使用 PCS 7 V8.1 及更高版本创建的 PCS 7 项目，自动启用该选项。对于使用 V8.1 之前

的版本创建的现有 PCS 7 项目，该选项仅适用于启用选项后新创建的图表。启用该选项后，

现有图表及其组态不会受到影响。

“基于图表插入”(Chart-based insertion) 选项的注意事项

• 重命名图表时对运行组的影响：

启用“基于图表插入”(Chart-based insertion) 选项后，对于每个 OB，各图表都有一个单

独的运行组。运行组的名称包含图表名称。

如果更改图表名称，则只有循环中断中相应的运行组会重命名；所有其它运行组名称保

持不变。但是，这违背了运行组名称必须包含图表名称的规则，而且缺少明确性。

如果之前未在运行编辑器中对运行组名称进行过修改，则在重命名图表后，必须手动更

改所有运行组名称以匹配循环中断。

注：如果运行组名称与图表名称相同，则更改图表名称时，运行组的名称也会更改。不

过，该图表的另一个相关运行组不会被重命名。

• 移动块时对运行组的影响： 
如果针对图表文件夹启用“基于图表插入”(Chart-based insertion) 选项，则每个图表的每

个受影响的 OB 中的运行顺序都会插入一个运行组。之前，仅在循环 OB 中插入运行组。

图表中随后要实例化的块会自动并入属于该图表的运行组。

但是，将块移动到其它图表时，这些块不会自动传送到目标图表的相应运行组。 
为了保持基于图表插入的原则以及更改源与目标图表的选择性下载功能，需要手动将块

移动到属于新图表的运行组。  
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有关选择性下载的过程符合性的注意事项

使用选择性下载时，必须考虑到外部互连的反应是否符合过程： 
• 在完成最新组态后下载 CFC 期间，输入互连 (IN/IN_OUT) 处于活动状态。如果下载中未

包含带有互连源（输出）的源图表，则所需资源将下载到带有预分配默认值的 CPU 中，即

使源图表不在 CPU 中处理这些资源。 
• 与地址的互连会立即按组态 (IN/IN_OUT/OUT) 激活。

• 如果下载的图表带有与运行组的输出互连，则与运行组的互连将激活。

• 即使相关 CFC 已更改，SFC 访问也将立即激活。如果尚未下载更改的 CFC，这种情况下

也会激活预分配的默认值。 
• AS 范围的互连在整个程序内激活。

请阅读以下安全信息“确保程序符合过程的责任”。

要求

• 只能在 PCS 7 中使用“选择性下载”功能。  
• 要使用“选择性下载”(Selective Download) 功能，需要针对图表文件夹选择“图表文件

夹属性”(Properties Chart Folder) 对话框中的“基于图表插入”(Chart-based insertion) 选
项，以便它们集成到面向图表的运行组管理中。 

• CPU 的所有图表事先已编译并下载。首次下载不能使用“选择性下载”功能。  
• 如果满足以下一个或多个条件，则不能使用“选择性下载”功能： 

– 需要完整下载。 
– 需要完整编译。 
– 使用 CPU 410-5H PA： 

当 CFC 编辑器的状态栏中显示状态消息“TCiR：需要下载”(TCiR: Download required) 
时。此状态消息表示在更改块类型的接口期间更新了项目中的实例，但尚未将这些实

例下载到带有“RUN 模式下的类型更新”功能的 CPU 410-5H PA。
• 所选图表中的图标可显示以下状态：这些图表可选择性下载。有关此状态的更多信息，请

参见上文。    
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小心

确保程序符合过程的责任 
“选择性下载”功能可用来将一个或多个修改的 CFC 或 SFC 下载到 CPU 并对它们进行测试。

选择性下载会产生不一致的数据，导致 CPU 中的程序不符合过程。

用户负责确保程序符合过程。    
所有已修改的图表及其相关图表均显示在“选择性下载”(Selective Download) 对话框中，有

助于确保程序符合过程。选择要下载的图表时应考虑到这一点，因为如果没有选择所有所需/
已更改的图表，下载单个图表将导致处理流程中出现不一致。  
在工厂正常运行期间实施

在工厂正常运行期间，如果功能或程序出错，则实施执行建议的操作可能导致严重的财产

损失或者人员伤害。

在执行操作前，确保不会出现任何危险情况。

请遵照以下原则：

• 如果更改了多个图表（例如跨图表互连），但未将所有受影响的图表均传送到带有“选择性
下载”功能的 CPU，则可能会由于数据不一致而产生损坏。

 

步骤

1. 在组件视图导航窗口中的所需 CPU 下，选择“图表”(Charts) 文件夹或该文件夹中的任一 
CFC。 
还可以从工厂视图中启动此功能，如上文所述。 

2. 选择菜单命令“选项 > 图表 > 选择性下载...”(Options > Charts > Selective Download...)。
将打开“选择性下载”(Selective Download) 对话框。
此对话框会显示该 CPU 的所有图表，并通过图标表示其当前状态。
前缀为“@”的系统图表不会显示，但如果它们受到更改的影响，也会被自动传送。 

3. 选择要下载到 CPU 的所需图表。 
在“图表”(Chart) 列中选中与此对应的复选框。“相关性”(Dependencies) 列指示是否还需要
下载其它图表。   
未选中但受到更改影响的图表会自动传送。
对于 F 系统的图表，请阅读上文“F 系统”段落中的信息。

4. 检查对话框下部用于生成模块驱动程序和 SCL 源的设置，并在必要时进行更改。   
5. 单击“下载”(Download)。

将下载所选图表。 
如果在下载所选图表前需要编译，此操作会自动进行。

6. 操作结果显示在“日志”(Logs) 对话框中。
检查显示的消息，然后单击“关闭”(Close) 按钮关闭对话框。  
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结果

所选图表下载到 CPU。受到更改影响的图表已自动传送。

下载

13.6 各个图表的选择性下载

SIMATIC S7 中的 CFC (V9.0 SP7)
426 功能手册, 05/2022, A5E41356112-AH



13.7 比较 CPU 程序的时间戳

时间戳         
以时间戳为基础，可以确定用户程序的哪些区域已被更改以及这些区域是否需要重新编译或

下载。系统将根据下列事件分配时间戳：

• 上一次与下载相关的更改

• 上次编译过程

• 已下载程序完成编译的时间

步骤

在 CFC 中选择菜单命令 CPU >“比较”(Compare)。
或者，也可以选择 SIMATIC Manager  菜单命令：

选择工作站、CPU、S7 程序或图表文件夹，随后选择快捷菜单命令 CPU >“比较”(Compare)。
出现一个显示下载程序的当前时间戳的对话框。

评估

• “上次与下载相关的更改”时间戳指示离线程序更改的时间，该更改需要下载到在线程序，

例如互连更改或块更改。如果在测试模式下编辑块 I/O，则时间戳也会改变。

在编译为机器代码时，如果不考虑这些更改，则不将其分类为与下载相关的。示例包括

在图表中块位置的更改或对文本字段的插入或删除。

• “上次编译”时间戳是上次程序更改后编译程序的时间。

• “编译下载程序”时间戳是在上次编译过程中生成的和下载时输入的时间戳。如果还没有

建立与 CPU 的连接，将无法读取此时间戳，并且会显示“---”。
仅在“上次编译”时间戳与“编译下载程序”时间戳完全匹配，并且比“上次与下载相关的

更改”时间戳更新时，上次下载到 CPU 的用户程序和当前用户程序在 CFC 数据管理及机器

代码上一致。 
提示：通过图表文件夹符号的更改，可以确认用户程序需要编译和/或下载。在 SIMATIC 
Manager  中，相应的图标在图表文件夹附近显示。

编译要求：

下载要求：
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H CPU 注意事项

• 如果 H CPU 在单机模式下运行（例如，由于 CPU 故障）并且已发生 CPU 失效转移，那么

在线访问请求之后将出现一个对话框。可在其中选择应链接的 CPU。冗余模式下则不显

示此对话框。

• 如果将程序更改下载到单机模式运行的 CPU 中，然后通过菜单命令 CPU >“工作模式...”
(Operating Mode...) 执行“使用修改后的组态进行切换”(Switchover with modified 
configuration) 操作，则所有的更改都将丢失。此时需要下载整个程序。

补救措施：在冗余工作模式中下载。然而，在这种情况下，必须确保在下载完成以前工

作模式保持不变。

下载

13.7 比较 CPU 程序的时间戳

SIMATIC S7 中的 CFC (V9.0 SP7)
428 功能手册, 05/2022, A5E41356112-AH



13.8 有关向 CPU 410-5H PA 下载程序期间的特别注意事项

概述

向 CPU 410-5H Process Automation (CPU 410-5H PA) 下载程序时，需遵循以下特别注意事

项： 
• PO 数通过硬件授权。

对于 CPU 410-5H PA，最大 PO 数由硬件授权。下载到 AS 中的 PO 数不能大于硬件授权的 
PO 数。 
否则，下载操作将取消。 

• 需要“PCS 7 项目”项目类型。

向 CPU 410-5H PA 下载程序期间，将检查项目的项目类型是否为“PCS 7 项目”。 
只有此项目类型的项目可下载。 

• 只能通过 CFC 下载。 
CPU 410-5H PA 只能通过 CFC V8.0 SP3（或更高版本）进行下载。而无法通过其它 STEP 7 
编辑器进行下载。 

• 许可证信息的监视块

向 CPU 410-5H PA 下载程序期间，“@PA-CPU”CFC 将自动随“PA_CPU”块下载。CPU 
410-5H PA 中需要“PA_CPU”块，该块用于许可证监视。

• CPU 410-5H PA 支持 RUN 模式下的类型更新。 
在更改块类型的接口后，可以在 RUN 模式下更新实例并将其下载到 CPU。在其它自动化

系统中，只能在 STOP 模式下执行此操作。 
更多相关信息，请参见“如何更新多项目中的块/SFC 类型 (页 117)”和“使用 CPU 410-5H 
PA 时的类型更新 (页 120)”部分。

参见

如何将用户程序下载到目标系统 (页 407)
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测试用户程序 14
14.1 如何在测试模式下工作

要求 
测试和调试之前，必须先成功编译 CFC 编辑器中创建的用户程序，然后再下载到 CPU 中。

测试设置

在测试设置下可以设置监视周期。监视周期是用于更新为测试而注册的 I/O 的周期时间。

默认值：2 s。
监视周期是 CPU 特定的；也就是说，此设置适用于当前图表文件夹的所有图表。如果将当

前图表移动到另一个 CPU 的图表文件夹中，则为此 CPU 设置的值适用于该图表。 

设置监视周期

1. 选择“测试 > 测试设置...”(Test > Test Settings...) 菜单命令。
将打开一个对话框。

2. 调整监视周期。

在编辑或测试模式下，可以更改观察周期的设置：

• 在活动图表窗口中

• 在动态显示窗口中（在此窗口中选择了一行条目）

说明

如果在 CFC 外（例如，在 SFC 中）修改了周期时间，只有在关闭并重新打开 CFC 后才能

激活此更改。
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编辑模式

CFC 编辑器提供两种编辑模式： 
• 编辑模式

在此离线模式下，可以组态 CPU 的整个软件结构。

• 测试模式

允许以在线模式监视和编辑值。

说明

在编辑模式下也可以着手进行某些离线调试功能，例如，可以将块 I/O 添加到监视列表并

对其进行编辑。 

测试模式

测试模式涉及到当前激活的图表所属的 CPU。
CFC 编辑器通过提供测试功能支持调试，此测试功能允许监视和影响 CPU 上块的执行且可

根据需要更改设定值。测试有两种执行模式：

• 过程模式

• 实验室模式

在编辑模式下，可以使用“测试”(Test) 菜单中的菜单命令选择测试模式。一旦处于测试模式，

就不能在过程模式和实验室模式之间进行切换。

在过程模式下，块的在线动态显示的通信受限，因此仅在 CP 和总线上产生轻微的额外负载。

当激活测试模式时，所有块都以“关闭监视”(Watch Off) 属性初始化。

在实验室模式下，调试和试运行更为方便和高效。相对于过程模式，实验室模式不限制图表

在线动态更新的通信。

激活测试模式时，所有块都以“打开监视”(Watch On) 属性初始化。

更改日志和 ES 日志

如同向 CPU 下载数据一样，在测试模式下工作是 S7 中一种受保护的功能，所以如果安装了 
SIMATIC Logon Service，则该过程一定会记录到日志中。 
如果在 SIMATIC Manager  中启用了访问保护和更改日志，则当您启动和结束测试模式及更改 
CPU 上的值时将打开一个对话框。在此对话框中可输入您执行操作的原因，这随后将输入到

更改日志中。

如果已经通过菜单命令图表文件夹 > 对象属性... >“ES 日志”选项卡 (Chart Folder > Object 
Properties... > "ES Log") 启用 ES 日志的当前图表文件夹，则可跟踪的操作将在 ES 日志中列出。
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更多相关信息，请参见以下部分：更改日志和 ES 日志 (页 447)

激活/禁用测试模式

按如下方式激活测试模式：

选择 CFC 菜单命令“测试 > 测试模式...”(Test > Test Mode...) 或单击工具栏中的以下按钮：

现在可以启用测试菜单功能了；编辑模式的多数功能将被禁用。

说明

激活测试模式时系统的可能响应

• 如果编译代码后修改了用户程序，则切换到测试模式时，会输出一条相关消息。

• 如果在 CPU 中启用了所谓的保护等级，则根据 CPU 和组态的保护等级，在激活测试模式时可
能需要输入密码。     

当关闭测试模式时，将禁用测试功能，并且重新启用编辑模式。

通过选择“测试 > 测试模式”(Test > Test Mode) 菜单命令或再次单击工具栏中的以下按钮

退出测试模式：

组态 I/O
激活测试模式时，可以修改所有没有互连的输入值。有关例外的信息，请参考块 I/O 监视要点 
(页 435)部分。

CPU 采用修改值之前，会对该值进行有效性检查。

说明

请注意，测试模式下修改的参数始终写入 CFC 数据库。
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H CPU 的注意事项

• 如果 CFC 在容错系统 (H-CPU) 中使用，则测试模式下的 CFC 始终在主 CPU 中使用。

• 如果冗余模式下的主站发生更改，则与 CPU 的连接终止。为了重新建立连接，必须退出

测试模式然后重新打开设备。

• 如果 H-CPU 在单机模式下运行（例如，因 CPU 故障导致 CPU 切换之后），则进行任何在

线访问时（在此：激活测试模式），都将打开一个选择对话框。可在其中选择应链接的 
CPU。冗余模式下则不显示此对话框。
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14.2 监视块/图表 I/O 并为其分配参数

14.2.1 块 I/O 监视要点

监视块 I/O
如果为已注册为调试的 I/O 启用“监视”(Watch)，则调试模式下 CPU 将提供这些 I/O 的当前

值。    
启动测试模式时，还通过以下图标为“实验室模式”下的 CFC 图表启用“打开监视”功能： 

这意味着，在测试模式下可以监视为用于测试而注册的块/图表 I/O 的动态数据，即这些值将

周期性地从 CPU 中获取并显示，并且可以修改用于此动态数据显示的选项和具有 OCM 功能

的 I/O 参数。

在“过程模式”下，通过以下图标启用“关闭监视”功能： 

这意味着首先必须在要监视的图表中为动态数据选择块/图表。然后，选择“打开监视”(Watch 
On)。
另一方面，如果发生过载，则可以从监视列表中删除特定的块/图表。要执行上述操作，可

以通过菜单命令“停用监视”(Watch Off)。

说明

如果禁用了监视，且选择了一个 I/O 注册以进行测试，那么将对此 I/O 以及该块的所有以前

注册的 I/O 启用监视。 

通过以下图标启用 I/O 的监视：
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当为活动的动态显示窗口启用测试模式时，所有列出的 I/O 将连接到 CPU 上。对于特定的 I/O，

在“监视”(Watch) 列上用复选标记启用“监视”(Watch) 功能。

说明

请注意以下信息：

• 如果块 I/O 未存储在 DB 上，则不能监视块 I/O。这也适用于诸如打开 FC 和 BOP 输入和 
STRING、DATE_AND_TIME 和 ANY 数据类型输出之类的情况。

• 测试模式下如果设置 EN=0，则功能块 (FB) 不指示互连输入上的已连接源的值。那些互连输
入将只显示块上次执行时所用的值。请注意，当 EN=0 设置为 EN=1 时，互连输入的值可以
更改。该语句也适用于强制值。另外，FC 和 BOP 总是显示互连源的值。

• 当 I/O 被注册为测试但不可操作时，例如，如果这些 I/O 是互连的，则值将在灰黄色背景中显
示。

• 即使并未将块 I/O 注册为用于测试，也可以将该块 I/O 的值显示为工具提示信息。另请参
见：通过光标显示工具提示 (页 494)

• 在测试模式下，只将结构中第一个元素的状态显示为彩色，而不显示其它元素的状态。

更多信息

更多此内容的相关信息，请参见以下部分：

• 如何添加和移除监视列表中的 I/O (页 436)
• 如何启用/禁用监视动态 I/O 数据 (页 438)
• 组态 I/O (页 439)
• “动态显示”窗口 (页 443)
• 趋势显示窗口 (页 445)
 

14.2.2 如何添加和移除监视列表中的 I/O

添加到监视列表            
在编辑或测试模式下（过程或实验室模式），可以添加单个块或图表 I/O 供调试使用。选择 
I/O，然后选择菜单命令“调试”(Debug) >“添加 I/O”(Add I/O) 或单击工具栏中的以下按钮：
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当切换为测试模式时，也会启动监视功能，即 I/O 和它的当前值在黄色背景中显示。对于不

具有 OCM 功能的 I/O，值在灰黄色背景中显示。如果先前对此块/图表禁用了监视功能，则

将对以前添加到监视列表的所有其它 I/O 启用监视。

从监视列表中移除

通过选择 I/O，然后选择菜单命令

“测试 > 从监视列表中移除”(Test > Remove from Watch List)，或者单击工具栏中的以下按

钮可从监视列表中移除 I/O：

此操作只有在测试模式下且选择了“受监视”(watched) 时才可行。 

或者：

在编辑模式下，对于特定的块/图表也可以添加和移除 I/O。针对所选的块调用“对象属性”
(Object Properties) 对话框，然后选择或取消选择“I/O”选项卡上“受监视”(Watched) 列中的

各个 I/O。

说明

不要同时监视太多 I/O，因为这样做会引起总线和 CPU 高通信负载。如果这个负载超过了某

个容量，例如，在 1 秒的监视周期内多于 500 个 I/O，则时间监视可作出响应。I/O 值将被

临时标记为“已损坏”(corrupted)。
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14.2.3 如何启用/禁用监视动态 I/O 数据

启用和禁用      
可按以下方式启用监视列表中的块/图表 I/O 的监视：

• 自动监视，通过对所有块在“实验室模式”下启用调试模式

• 使用菜单命令“调试”(Debug) >“打开监视”(Watch On) 或通过单击工具栏中的以下按钮：

在实验室模式下，该功能适用于所有的块，而在过程模式下，该功能只适用于以前在图

表中选中的块。

• 通过菜单命令“调试”(Debug) >“关闭监视”(Watch Off) 或单击工具栏中的以下按钮可停

止监视功能：

在实验室模式中，I/O 值不再更新，这适用于所有块，而在过程模式中只适用于在图表中

所选的块。

监视列表中所有激活的 I/O 值将根据通过菜单命令“调试”(Debug) >“测试设置...”(Test 
Settings...) 设置的监视周期来更新。

这些值将根据其数据类型在 I/O 旁显示。它们在屏幕上以彩色背景显示。 

白底蓝字 显示在编辑模式的值（离线）

黄底黑字，星号 显示在转换为动态显示期间

的值

黄底黑字，值 显示测试模式期间从 CPU 获取的值 
灰黄底黑字，值 显示在测试模式下从 CPU 读取的无 OCM 功能的 I/O 处的值

红色背景上的 #### 显示不能提供 CPU 所请求的动态

更新值（干扰，过载）时的值
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14.2.4 组态 I/O

        
激活测试模式时，可以修改所有没有互连的输入值。有关例外的信息，请参考块 I/O 监视要点 
(页 435)部分。

CPU 采用修改值之前，会对该值进行有效性检查。

说明

请注意，测试模式下修改的参数始终写入 CFC 数据库。
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14.3 强制块 I/O

简要描述 
该功能有助于在调试期间模拟互连的各种值，也就是说，始终用强制值覆盖互连的值。虽然

通常可以在测试模式下组态输入，但由于该值将立即被互连的输出值所覆盖，因此这不会达

到所期望的结果。仿真时，必须临时移除块之间的互连，且必须将指定值分配到这些互连的

相应输入（IN 或 IN_OUT）。在后文用“强制”指代用此类组态来替代互连。强制功能用“强

制值”替换通常由互连提供的块输入处的值。可以随时在块实例的输入处激活和禁用这种强

制功能。

出于性能考虑，并非所有块输入都被设计为从一开始就具有强制功能。这样可以避免代码生

成器生成过多的 SCL 代码。可在 CFC 的组态中或在过程对象视图中设置可进行强制的输入。

程序编译后，如果输入处的“添加强制”(Add forcing) 和“强制激活”(Forcing active) 属性被

更改，则需要重新编译并加载该程序。

最多可以强制 8192 个标准 I/O 和 8192 个 F I/O。 

说明

如果注册和下载的强制参数达到最大数目，则必须在强制禁用一个或多个参数后执行下载更

改，这也是为了重新启用 CPU 中的参数。只有在下载更改后才能强制启用新的或不同的强

制参数。 

强制功能设置

强制功能由 4 个属性进行控制： 
• “支持强制”(Support forcing)
• “添加强制”(Add forcing)
• “强制激活”(Forcing active)
• “强制值”(Force value)
可通过 SIMATIC Manager  和 CFC 中的相应复选框来启用这些属性。

在 SIMATIC Manager  中，在图表文件夹对象属性的“高级”(Advanced) 选项卡中： 
• “支持强制”(Support forcing) 复选框：此选项可启用强制功能以及 CFC 和过程对象视图

中的相应选项。
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在 CFC 中，在块输入的对象属性中：

• “添加强制”(Add forcing) 复选框：此选项用于启用或禁用该输入的“强制功能”。每次

更改该选项都需要重新编译和加载程序。不能在测试模式下更改此选项。

• “强制激活”(Forcing active) 复选框：激活此复选框时，互连的值将始终由强制值代替。禁

用强制功能后，将重新激活互连的值。无需对测试模式下的更改进行重新编译。

• “强制值”(Force value) 文本字段：如启用了“添加强制”(Add forcing) 和“强制激活”
(Forcing active) 选项，则在此文本字段中输入要应用到块输入的值。无需对测试模式下

的更改进行重新编译。在 INOUT 上，也会将强制值写入到互连块的输出中。

替代步骤

如果激活了图表文件夹的“支持强制”(Support forcing) 选项，则可以按以下说明操作：

1. 可以在 CFC 中对多个块输入进行设置。块对象属性的“I/O”选项卡中提供了设置强制功能的相
应列。

2. 在过程对象视图中，可以对项目中所有块的所需输入进行设置。“参数”(Parameters) 和“信
号”(Signals) 选项卡中提供了设置强制功能的相应列。

显示 
在 CFC 中，强制输入的互连可通过块输入处的彩色矩形来标识。 
• 绿色矩形表示：“添加强制”(Add forcing) 已激活

• 红色矩形表示：“添加强制”(Add forcing) 和“强制激活”(Forcing active) 已激活。

说明

由于只对于互连的参数存在强制，因此仅对于互连会显示彩色矩形。

在测试模式下，强制值通过不同的背景色区别于其它动态值。默认设置是“浅蓝”，可在“颜

色设置”(Color Settings) 中进行更改。只有结构中第一个元素将显示为彩色。其它元素不显

示可见。

强制值的背景色与图表的动态显示颜色相同。

说明

在激活强制期间执行 CPU 的冷启动后，所有强制设置都将丢失。这些设置都保留在离线程

序中。要使离线程序和在线程序之间恢复一致，请在图表文件夹中禁用“支持强制”(Support 
forcing)，编译并下载数据，在图表文件夹中重新启用“支持强制”(Support forcing)，然后

再次编译并下载数据。

虽然可将带文本互连的连接设置为强制，但在测试模式下这种设置无效。
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强制启用时发消息到 WinCC（仅限使用 S7-400 CPU 时)
强制情况下，在编译期间会自动在 OB1 中同名的运行组中安装新图表 @FRC_CFC。消息块 
FRC_CFC 将被添加到该图表中，同时也会添加到 OB100 中。如果以参数方式设置了“强制

激活”(Forcing active)，则该块会触发一条激活的消息，发送到 WinCC。再次禁用“强制激活”
(Forcing active) 后，该块将触发相应的离开消息。@FRC_CFC 运行组的“激活”(Active) 控制

选项定义仅在更改了“强制激活”(Forcing active) 功能后才能执行该块。

禁用强制后，块、系统图表和运行组将在下一次编译和下载时被再次从程序中删除。

数据类型

可强制以下数据类型：

BOOL、BYTE、INT、DINT、REAL、STRUCT、WORD、DWORD、DATE_AND_TIME
对于 STRUCT 数据类型，只能强制该类型的第一层。而不能强制图表的输入/输出。

说明

如果将 EN 输入或者将 FC 或 BOP 的输入注册为强制，则可以在测试模式下设置起输入参数，

使其具有操作员监视和控制功能。
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14.4 “动态显示”窗口

动态显示窗口

调试模式下，块和图表 I/O 的值可以在单独窗口中动态显示。这对于基本数据类型（BO、W、

R 等等）和结构元素是可能的。 
动态显示窗口可以被打开，并可以和任何图表窗口和/或趋势显示在 CFC 编辑器窗口中一起

排列。窗口大小是可调整的。当关闭该窗口或退出 CFC 编辑器时，将保存该窗口的内容（只

是静态内容，而不是值），而当下次打开该窗口时将恢复。

可以对每一个 CPU 创建并管理任意数量的动态显示。每个显示都有自己的名称，该名称是

您在创建时输入的，而且可以随时修改该名称。在动态显示窗口，在同一时间只有一个动态

显示是激活的。您可在标题的组合框中进行选择。此栏也包含用于创建、删除和重命名动态

显示的按钮。

在该窗口中，可以显示、监视和更改来自 CPU 不同图表中的 I/O 值。相关图表不必处于打开

状态。必须建立与 CPU 的连接。

使用菜单命令“视图”(View) >“动态显示”(Dynamic Display) 可打开和关闭动态显示窗口。

插入 I/O
在编辑或测试模式下，可以添加 I/O 到动态显示窗口。此功能和添加或移除监视列表中的块 
I/O 的处理方式一样。

如何将一个打开图表的 I/O 添加到动态显示窗口：

1. 在动态显示窗口中打开需要的动态显示（只有创建了多个动态显示时才相关）。

2. 选择所需 I/O，然后选择“调试 > 输入/输出 > 插入到动态显示”(Debug > Inputs/Outputs > 
Insert in Dynamic Display) 菜单命令。

3. 将此 I/O 拖放到动态显示窗口。

对于带结构的块 I/O：在将 I/O 插入到动态显示窗口之前，会出现一个对话框，在此可以选

择要显示的值的结构元素。

如果想将一个块或嵌套图表的所有 I/O 添加到动态显示窗口中，可以选择该块或图表，并将

它拖放到动态显示窗口中。 
数据类型 STRUCT 的 I/O 和隐藏的 I/O 除外。
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删除 I/O
要删除 I/O，在动态显示窗口中选择相关的行并使用快捷菜单命令“删除”(Delete) 进行删除

或通过选择菜单命令“编辑”(Edit) >“删除”(Delete) 进行删除。

说明

如果删除了其 I/O 包含在动态显示中的块或将其从 S7 程序中移出，则相关的条目也将从动

态显示中移除。

监视值

可以监视块/图表 I/O 值，而不必打开相关的图表。 
如果满足下列要求，则该值将根据设置的监视周期以黄色背景动态显示：

• 启用测试模式。

• I/O 或结构元素通过在“监视”(Watch) 列中的选择注册为监控。

• 您的站连接到了 CPU 上。

损坏的值用“####”指示，无法监视的 I/O 值显示为“- - - -”。
强制值不会以黄色（在“颜色设置”(Color Settings) 中指定）以外的背景色来显示。默认设

置为“浅蓝”。

打印

也可以打印动态显示的内容。使用菜单命令“图表”(Chart) >“打印...”(Print ...) 或单击功能

栏中的打印机符号，可打印开始打印时的当前值。 

打开图表

如果选择了动态显示中的一行，则可以跳到包含 I/O 被监视的块的图表中。调用菜单命令“编

辑”(Edit) >“转到”(Go To) >“图表”(Chart) 来打开相关的图表并突出显示 I/O。

测试用户程序

14.4 “动态显示”窗口

SIMATIC S7 中的 CFC (V9.0 SP7)
444 功能手册, 05/2022, A5E41356112-AH



14.5 趋势显示窗口

趋势显示

通过 CFC 中的趋势显示，可以不间断地追踪一个或多个 CPU 信号随时间推移而发生的变化。

趋势显示可由所有支持正常在线操作的目标系统使用。一次最多可以记录 12 个变量。

说明

如果删除了 I/O 包含在趋势显示中的块或将它们从 S7 程序中移出，相关条目将从趋势显示

中移除。

可以为每一个 CPU 创建和管理任意数量的趋势显示。每个显示都有自己的名称，该名称是

您在创建时输入的，而且可以随时修改该名称。在趋势显示窗口，任一时刻只能有一个趋势

显示处于活动状态。可在标题的“趋势显示”(Trend Display) 框的下拉列表中选择趋势显示。

该栏也包含用于创建、删除、重命名和导出趋势显示的按钮。

使用菜单命令“视图”(View) >“趋势显示”(Trend Display) 打开和关闭趋势显示窗口。

• 第一次打开趋势显示窗口时，将显示一个名为“无标题”的空窗口。可以重命名这个趋

势显示。

• 如果有多个趋势显示，则在 CFC 重新启动之后打开趋势显示时，将显示在下拉列表最上

面的趋势显示。

操作员输入和设置

必须将想要记录值的每个 I/O 分配到八条趋势显示通道中的一个。只能分配数值数据类型

（BYTE、INT、DINT、WORD、DWORD 和 REAL）及布尔数据类型 (BOOL) 的 I/O。 
对于每个选定的数值数据类型的通道，可设置显示参数（y 轴）的上限和下限。可删除特定

通道不再需要的分配。

可以从一个占用通道跳转到包含所使用的 I/O 的图表。图表将会打开并选择相关 I/O，或如果 
I/O 已互连，则会闪烁。 
在输入字段中为每个通道输入要显示的测量点数（x 轴）。该数字可以在 10 和 500 之间，将

在单击“应用”(Apply) 之后生效。此处指定的数字不能超过缓冲长度（更多信息，请参见“记

录”）。

在记录期间，不显示记录时间（启动和结束），仅显示文本“记录中...”(Recording...)。

测试用户程序
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单击“更改...”(Change...) 以打开“记录参数”(Recording Parameters) 对话框，指定以下参

数：

• 要记录的值数量（缓冲长度）

• 采集周期（秒）

• 记录模式（“连续”(Continuous)、“有中止条件的连续”(Continuous with abort 
conditions)、“一次”(One-time)）

• 中止条件 (Abort conditions)
只有在测试模式下，“启动”(Start) 按钮才是激活的。启动之后，启动按钮改为“暂停”按钮。

之后可随时使用它来停止记录。

“记录”(Recording) 窗口

启动后将删除最后记录的趋势，并显示当前采集的值。如果显示区域比总数（缓冲区大小）

小，则当达到窗口右边缘时，窗口将自动滚动，以便始终显示最新值。

如果连续地记录，则达到缓冲区最大大小时，会将显示左移。

记录窗口下整个时间轴的显示取决于在“记录”(Recording) 中输入的值数目（缓冲区大小）

及采集周期。 
因此，可见的时间轴和刻度由在“显示”(Display) 中输入的采样值及采集周期决定。

如果缓冲区长度大于“显示”(Display) 的采样值数，将在时间轴下显示一个滑块。使用此滑

块可移动窗口中的可见区域。

打印

无法直接打印趋势显示。但可以导出当前趋势显示，例如，以可在 Excel 中读取的格式，随

后在此程序中编辑显示并将其作为表格打印。要导出该显示，请单击“导出...”(Export...)。
应该通过菜单命令“选项”(Options) >“自定义”(Customize) >“导出趋势数据”(Export Trend 
Data) 检查导出设置。

测试用户程序
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更改日志和 ES 日志 15
简介

工程组态系统中提供了多种用于跟踪更改的日志。 
• 更改日志

• ES 日志

• “下载”(Download) 选项卡中的日志

• WinCC Audit 中的更改日志

更改日志 
如果满足以下条件，则在执行某个需要记录的操作时将会打开更改日志： 
• 安装了 SIMATIC Logon Service。
• 在 SIMATIC 管理器中激活了访问保护和更改日志。

将记录下列受保护的操作：

• 下载到 PLC（整个程序）

• 下载到 PLC（仅下载更改）

• 激活和禁用测试模式

• 在测试模式下更改值

更改日志记录用户、时间、CPU、所做的更改及更改原因。 
如果尚未在 SIMATIC 管理器中启用更改日志，则无法编辑更改原因。 
在 SIMATIC 管理器（选定了某个 SIMATIC 站）中使用菜单命令“选项 > 更改日志 > 显示”

(Options > Change Log > Display) 打开更改日志。

在日志条目列表中，您可以在“工作对象”(Work object) 列中找到 CFC/SFC 的更改日志，其

中包含“YYYYMMDD_hhmmss”格式的条目。 

ES 日志

除了更改日志的信息外，还可在 CFC/SFC 的 ES 日志中记录与下载相关的操作及时间戳。 
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要求： 
• 必须为对应图表文件夹激活 ES 日志。 

激活和显示的描述如下。 

激活 ES 日志

要为当前图表文件夹启用 ES 日志，请按以下步骤操作：

1. 选择菜单命令“对象属性”(Object Properties)。
2. 在“图表文件夹属性”(Properties Chart Folder) 对话框的“高级”(Advanced) 选项卡中，选中

“ES 日志激活”(ES log active) 复选框。
随即会激活 ES 日志。

如果受保护的功能不需要进行记录（例如，在初始组态的上下文中），可以禁用 ES 日志。为

此，清空“ES 日志激活”(ES log active) 复选框。

说明

请注意以下信息：

• 如果没有使用 S7 目标系统，请查看目标系统在线帮助，以了解目标系统是否支持 ES 日志。

• 请注意，只能在安装了 SIMATIC Logon Service 的计算机上禁用激活的 ES 日志。原因：禁用
和激活都必须被记录下来。

• 如果将 ES 日志已激活的程序或图表文件夹复制到一个未安装 SIMATIC Logon Service 的计算
机，则在下载或切换到测试模式时会收到一条出错消息，并且不会执行操作。 
在这种情况下无法禁用 ES 日志，因为图表文件夹的对象属性对话框中未提供“ES 日志”(ES Log) 
选项卡。激活和禁用只能在此对话框中进行设置。

• 如果激活了访问保护和 ES 日志，则在下载到各个 CPU 之前，打开 ES 日志会使 SIMATIC 管理
器的“编译和下载对象”(Compile and Download Objects) 功能中断。 

在 ES 中记录

ES 日志

使用菜单命令“选项 > 日志... > 选项卡：ES 日志”(Options > Logs... > Tab: ES Log) 打开 CFC 
中的 ES 日志。

每个操作都记录在日志的主行中，其后显示与该操作相关的其他详细信息（例如，下载日

志）。按时间顺序对操作进行记录。 
执行“下载整个程序”(Download entire program) 操作时，将会清除 ES 日志，但同时会将其

保存为具有日期 ID 的文件。归档操作和所用的文件名（包括路径）将记录在日志中。

更改日志和 ES 日志
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下载期间，目标系统的比较戳记也会写入到日志：

• 上次与下载相关的更改

• 上次编译

• 已装载程序的编译

当执行“启用测试模式”(Test mode on) 操作时，引起 CPU 中值改变的后续操作都将被记录

下来： 
• 在 CFC 中：

– 各连接的组态

– 运行组的激活/禁用

• 在 SFC (PCS 7) 中：

– 各步中的常量组态

– 转移中的常量组态

– 顺控程序属性中的常量组态

记录包括值及其更改方式（地址、旧值和新值）。
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“下载”(Download) 选项卡中的日志

• 文本格式的下载日志

禁用更改日志时，会记录与下载相关的信息并将其存储在以“YYYYMMDD_hhmmss.log”格
式命名的文本文件中。 
在“日志”(Logs) 对话框的“下载”(Download) 选项卡中，可通过“归档”(Archive) 按钮打

开相应的对话框以选择和显示这些日志文件。 
禁用更改日志，“归档”(Archive) 按钮也处于禁用状态。

SIMATIC Logon 中的引用：

在 SIMATIC Logon 日志中引用了相关下载日志文件。在日志条目列表中，您可以在“工

作对象”(Work object) 列中找到对 CFC/SFC 的下载日志（其中包含“YYYYMMDD_hhmmss”
格式的条目）的引用。可通过“下载”(Download) 选项卡中的“归档”(Archive) 按钮找到

并显示指定的日志文件。 
• XML 格式的下载日志： 

下载日志也可以保存为 XML 格式。下载日志以 XML 格式包含所有待下载对象的相关信息。

要生成 XML 格式的下载日志，必须在 CFC 编辑器的“编译/下载设置”(Settings for 
Compilation/Download) 对话框中激活“生成已下载程序映像进行比较”(Generate image 
of downloaded program for comparison) 选项。“编译/下载设置”(Settings for 
Compilation/Download) 对话框用于打开菜单命令“选项 > 自定义> 编译/下载”(Options 
> Customize > Compile/DownloadOptions > Customize > Compile/Download)。
激活更改日志时自动激活“生成已下载程序映像进行比较”(Generate image of 
downloaded program for comparison) 选项。

具体取决于更改日志：

– 更改日志未激活：

默认会临时以“LOADOBJECTS.xml”名称创建一个 XML 格式的下载日志，然后在每次运

行编译时将其覆盖。 
下载到 AS 之前，可通过“下载目标系统”(Download target system) 对话框中的“显

示更改”(Display changes) 按钮显示此日志。 
– 更改日志激活：

每次下载后，以 XML 格式存储下载日志并以“YYYYMMDD_hhmmss.xml”格式命名。可

通过“下载”(Download) 选项卡中的“归档”(Archive) 按钮找到该日志文件。

在“下载”(Download) 选项卡中输入引用此 XML 文件的相应行。 
– 这些 XML 文件包含已下载更改的相关信息，如有需要，可以在 VXM 中进行比较。 

   

WinCC Audit 中的更改日志

如果安装了 WinCC Audit 并且为每个 ES 项目组态了 Audit Trail 连接，则可以通过 WinCC 
Audit 记录更改。所有更改都存储在系统级中央 WinCC Audit 服务器上。

更改日志和 ES 日志
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记录以下更改：

• 程序下载（完整、增量或选择性）

• 测试模式（CFC 或 SFC）中的值变化

• 手动模式下在 SFC 中执行的用户操作

组态 Audit Trail 服务器和数据库的连接

必须使用 WinCC Audit 编辑器为每个 ES 项目组态审计跟踪。 
如果没有为 ES 项目组态 WinCC 对象，则创建一个虚拟 WinCC 项目以执行 WinCC Audit 组态。

先决条件：

• 需要 SIMATIC Logon 才能登录 WinCC Audit。
操作步骤：

1. 在 ES 项目中打开 WinCC 对象或打开 WinCC 项目。将打开 WinCC 项目管理器。

2. 通过 SIMATIC Logon Service 打开 WinCC Audit 编辑器。审计跟踪编辑器打开。显示工厂中所
有可用的审计跟踪服务器和数据库。

3. 通过快捷菜单命令“选择服务器”(Select Server) 选择审计跟踪服务器，并通过“选择”(Select) 
复选框选择数据库。至此就完成了所选 ES 项目的 Audit Trail 服务器和数据库组态。
可以在属性区域组态其它数据库设置。

4. 对每个 ES 项目重复步骤 1 到 3。

说明

审计跟踪数据库

打开 ES 项目中的另一个 WinCC 对象或另一个具有不同 WinCC Audit 组态的 WinCC 项目可

能会导致更改日志条目写入错误的数据库。

更改日志和 ES 日志
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回读图表 16
16.1 如何保存参数（回读）

可以保存（回读）激活图表的图表文件夹中包含的所有 CFC 的参数，该激活图表的 AS 数据

通过某种方式（例如，通过 OS 操作）进行了更改。这适用于限制值或控制参数等。  

说明

执行程序的完整下载之前，会自动出现回读选项。用于防止删除所有块时，之前在调试模式

下或 OS 上修改的值意外丢失。可自行决定接受还是拒绝回读选项，该选项是在对话框中提

供的。

只有在未对块类型进行任何接口更改时，才能进行回读，也就是说，前提是仍然可以下载更

改。

步骤

1. 在 CFC 编辑器中选择“图表 > 回读...”(Chart > Read-back...) 菜单命令，或在 SIMATIC 
Manager 中选择“选项 > 图表 > 回读程序...”(Options > Charts > Read Back Program...) 菜
单命令。

2. 在“回读”(Read Back) 对话框中选择源：

– 选择“CPU 上的程序”(Program on the CPU)，
以将使用当前参数的程序从 CPU（在线块文件夹）回读到图表文件夹中。

– 如果无法直接访问 CPU 并且已将在线块文件夹复制到工厂中 S7 程序的离线块文件夹，

请选择“离线程序”(Program offline)。随即将打开一个浏览器，之后回读将允许选择

包含工厂数据的相应 S7 程序。然后将从此源读取值，并写入 ES 数据库中。

这两种情况下可以在对话框中选择以下项：

• 块输入的所有参数

• 具有 OCM 功能的参数（系统属性 S7_m_c: = 'true'）
• 指定的参数（系统属性 S7_read_back := 'true'）
作用域的默认设置是“具有 OCM 功能的参数”(OCM-capable parameters)。
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一般规则

无论选择的作用域为何，以下规则都适用：

• 只有输入/输出及输入参数可以回读。输出参数无法回读。

• 回读中不包括以下数据类型：

ANY、ARRAY、POINTER、UDT
• 不会回读那些写入到 SFC 中的输入。

• 如果绝对不会回读某参数，则必须设置属性 S7_read_back = never。
如果始终要回读某参数，则必须设置属性 S7_read_back = always。

• 可从回读中排除整个块，例如，BATCH 块。在这种情况下，该块类型包含属性 
S7_read_back := 'false'。该属性可在块实例中通过菜单命令“块属性”(Block Properties) 
>“回读已启用”(Read-back enabled) 选项进行更改。

• 如果未组态的输入（S7_param =“false”）使用简单数据类型，则不会被回读。S7_param 
=“false”不会阻止对复杂数据类型的回读。

• H-CPU 注意事项

H-CPU 处于单机模式（例如，由于 CPU 故障而致）并且 CPU 已切换时，将打开用于在线

访问的对话框（在此情况下为：回读）。可在其中选择应链接的 CPU。冗余模式下则不

显示此对话框。

• 下载 HW Config 数据注意事项

HW Config 数据下载后，请注意该数据是从装载存储器中获取的。由操作员监控或在测

试模式下执行的更改只保留在主存储器中。从装载存储器获取数据时主存储器中的更改

将会丢失，因为其会被装载存储器的初始值覆盖。如果在下载 HW Config 数据前执行了

回读以获取操作员值，则可在 STOP 状态下通过完整下载将其传送到 CPU。

作用域规则 
将作用域指定为“具有 OCM 功能的参数”(OCM-capable parameters) 和“指定的参数”
(Designated parameters) 时，将执行以下规则：

• 忽略 FC 输入中的值。

将作用域指定为“所有参数”(All parameters) 时，将执行以下规则：

• 与图表 I/O 互连的 FC 输入将被回读。此规则也适用于与块输入（FB 和 FC）多次互连的

图表 I/O。
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回读后

• 回读后不必执行完整编译。CPU 处于 RUN 状态时也可继续下载程序（下载更改部分）。

• 回读完成时将生成并显示日志。可在以后通过菜单命令“选项”(Options) >“日志”(Log) 
>“回读”(Read Back) 选项卡打开该日志。例如，日志中显示下列内容：

– 回读和更改的 I/O
– 出现问题的位置
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信号处理 17
17.1 如何生成模块驱动程序

自动生成模块驱动程序

PCS 7 提供了一种信号处理功能，当使用 HW config 和 CFC 中的工艺函数组态硬件后，系统

将会自动生成所需的模块驱动程序、将它们互连并相应设置它们的参数。在信号处理期间，

需要使用这些模块驱动程序诊断和报告错误。      
如果启用了“生成模块驱动程序”(Generate module drivers) 复选框（默认设置），则在编译

程序时将调用此功能。如果已为项目生成了模块驱动程序，系统会检查在处理期间是否需要

更新这些驱动程序。如果在此期间硬件配置发生了变化，则必须进行更新。 

手动生成模块驱动程序

也可从 SIMATIC Manager  中调用此功能。操作过程如下：

1. 选择图表文件夹。

2. 选择菜单命令“选项”(Options) >“图表”(Charts) >“生成模块驱动程序...”(Generate Module 
Drivers...)。

在下文中，我们将把“生成模块驱动程序”功能称为“驱动程序生成器”。

此处介绍的驱动程序和消息方式仅适用于 S7-400 系列 CPU。

说明

如果数字 I/O 模块的地址空间在 HW Config 中进行了压缩（使用“压缩地址”(Pack addresses) 
功能），则驱动程序生成器不能为相应的块提供唯一的地址。要确保每个模块都定义了槽分

配，一定不能将地址压缩。

驱动程序和消息概念

CFC V5.2 SP1 中引入了扩展驱动程序的方式。可依照扩展的方式或之前的方式执行驱动程序

生成器。实际用于现有项目的方式取决于所使用的信号处理块（CH 块）。将会搜索导入的

块类型，并检查 CH 块的版本。之前的方式将应用于版本低于 2.0 的 CH 块。 
更多相关信息，请参见以下部分：V5.2 及更低版本的驱动程序概念的信号处理 (页 496)。
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扩展驱动程序方式

扩展驱动程序概念支持针对 PCS 7 发布的其它 ET 200M、ET 200S、ET 200X、PA 设备、DP/
PA 耦合器、DP/PA 链路、Y 链路、DPV0/DPV1 从站、诊断中继器、HART 现场设备（诊断）

和冗余 I/O 模块。从而能够精确识别通道错误消息。也可应用来自 SIMATIC PDM 的组态数

据。 
新的嵌套互联模式 (页 462)及驱动功能块结合使用了用于 CPU 和连接诊断的 OB_BEGIN 和 
OB_END 功能块(替代 V5.2 版本的 MSG_CSF)提供了运行优化的方法。

这也为将来的扩展留出了机会。应用用户特定和第三方模块类型时，驱动程序生成器的 Meta 
信息可通过附加的 XML 文件（对象和操作列表）进行扩展。《为 PCS 7 创建驱动程序块编

程指南》(Programming Guide for Creating Driver Blocks for PCS 7) 手册中介绍了如何创建

这些文件。

说明

请注意以下信息：

• 必须通过安装程序在 PC 上安装驱动程序块库。只有这种安装类型才能确保有足够的 Meta 信
息可供驱动程序生成器使用。不允许将库从一台计算机复制到另一台计算机。

• 也可使用其它库中的驱动程序块（例如，自定义库中的用户块）。在“生成模块驱动程序”
(Generate Module Drivers) 对话框中，可以指定附加库。驱动程序生成器随后会先在此附加
库中寻找每一个要导入的块。如果它无法在指定库中找到块，将只在控制文件（XML 文件）
中寻找。

• 如果 S7 程序包含用于处理信号的块（CH_xx、CH_U_xx、PA_xx），但没有一个块来自其中
一个 PCS 7 库，则必须在“生成模块驱动程序”(Generate Module Drivers) 对话框中指定应从
中导入驱动程序块的驱动程序库版本。

• 信号处理块（CH_xx、CH_U_xx、PA_xx）必须与符号表中相应的信号名称互连。在为信号处
理生成系统图表和块参数分配期间，这是唯一可确保驱动程序生成器考虑此块的方式。否则，
可能会影响其它具有相同参数分配的信号处理块的功能。

更多信息

更多相关信息，请参见以下部分：

• 所用块的简短说明 (页 460) 
• “生成模块驱动程序”功能如何工作 (页 463) 
• “生成模块驱动程序”的会话模型 (页 465) 
• 驱动程序生成器所支持的设备 (页 459) 
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17.2 驱动程序生成器所支持的设备

表格 17-1

目录文件夹 支持的设备

SIMATIC 400 HW Config 目录（配置文件 PCS 7_V52/PCS 7_V60/PCS 7_V61/PCS 
7_V70/PCS 7_V71）中的所有机架和 SM 模块

SIMATIC PC 站 HW Config 目录（配置文件 PCS 7_V52/PCS 7_V60/PCS 7_V61/PCS 
7_V70/PCS 7_V71）中的所有机架和 SM 模块

PROFIBUS DP ET 200iS、ET 200M 和 ET 200X 从站（V6.0 及更高版本，包括 ET 
200S） 
• HW Config 目录（配置文件 PCS 7_V52/PCS 7_V60/PCS 7_V61/

PCS 7_V70/PCS 7_V71）中的所有机架和 SM 模块

• 在从站上插入的 SM 模块

• CP 和 FM 模块，有某些限制，

请参见列表“PCS 7 - 已发布模块”。

• 对于 ET 200S 以及 PM 和电机启动器，有某些限制，

从 V6.1 版本开始还包括 Y link 的下游设备，

请参见列表“PCS 7 - 已发布模块”。

非冗余标准从站：对于 DPV0 从站，将放置诊断块 OB_DIAG1。
从 V6.0 开始，也为 DPV1 从站放置诊断块。

从 V6.0 开始，将为诊断中继器放置诊断块。

PROFIBUS PA 对于所有遵循从 PA 连接器向下游组态的 DPV0 的 PA 从站（需要从

站系列 12 和 PA 配置文件 3.0），将放置相应的 PA 诊断块（通过信

号处理块 PA_xx 或 CH_U_xx 访问）。

从 V6.0 开始，对于遵循在 DP 主站系统上通过 DP/PA 耦合器直接组

态的 DPV0 和 DPV1 的 PA 从站，也将放置 PA 从站。

遵循 PA 链接器 (DPV1) 下游 DPV1 的 PA 从站也不会得到处理。

支持最多有 16 个已分配插槽的 PA 设备。

说明

此外，设备制造商可以提供自己的具有相应 XML 文件的诊断块，这些诊断块随后将由驱动

程序生成器进行处理。
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17.3 所用块的简短说明

块类型

使用以下块类型，这些块类型将硬件和软件组态分开：

• 用户将通道相关块（CH/PA 块）插入到 CFC 图表中，并将这些条目连接到符号表的相应

信号名上。由于块是系统功能的一部分，因此在同一过程中始终包括这些块和系统功能。

驱动程序块库提供以下几种信号处理通道块类型：

– 标准通道块：

CH_AI、CH_AO、CH_DI、CH_DO。

这些块只用于处理 S7-300/400 SM 模块的信号。如果希望优化内存、缩短运行时间同

时无需处理 PA 设备，则可以使用这些标准块。

– 通用通道块：

CH_U_AI、CH_U_AO、CH_U_DI、CH_U_DO。

这些块用于处理 S7-300/400 SM 模块或 PA 现场设备的信号。这些块的优点在于创建 
CFC 图表时可以不考虑以后要使用的硬件 I/O。缺点是会增加内存负载与周期时间。

– PA 通道块：

PA_AI、PA_AO、PA_DI、PA_DO、PA_TOT，
这些块是为配合 PA 现场设备使用而专门设计的。它们主要用于需要这些设备的特殊

功能的地方。与 CH 块不同，根据在硬件配置中选择的期望的设备配置，PA 通道块不

仅处理实际信号，还会处理该设备的所有变量。

– 特殊通道块

CH_CNT、CH_CNT1、CH_MS。
有些特殊应用（如控制和读取 ET 200iSP 上 FM 350-1/-2 模块和 8-DI NAMUR 模块的

计数器或频率值，以及 ET 200S 电机启动器模块的信号处理）需要用到这些块。

– 高级过程库中的标准通道块：

Pcs7AnIn、Pcs7AnOu、Pcs7Diln、Pcs7DiOu、Pcs7DilT
这些块只用于处理 S7-300/400 SM 模块的信号。如果希望优化内存、缩短运行时间，

同时无需处理任何 PA 设备，则可使用这些标准块。

– 高级过程库中的 FF/PA 通道块：

FbAnIn、FbAnOu、FbDiIn、FbDiOu
这些块专用于 PA 现场设备以及 PROFIBUS 3.0 A 类和 B 类网络中的 FF 现场设备。如

果要使用这些设备的特殊功能，则应使用这些块。与标准通道块相比，PA 通道块可根

据硬件配置中选择的所需设备组件，对信号本身进行处理，也可以处理所有变量。

有关 CH 和 PA 块功能及功能性的更多信息，请参考每个块的上下文相关帮助（按 <F1> 
键）。

• 在扩展驱动程序设计中，MSG_CSF 被 OB_BEGIN 块替代，以用于标准 CPU 和 H CPU。此

功能监视（冗余）CPU 和 DP 主站系统的状态。它会获取 OB 启动信息（更多相关信息，

请参见下图：互连模型、模块驱动程序 (页 462)），根据逻辑地址确定地理地址，并将

此信息传递到输出（CPU_DIAG 结构）。所有驱动程序块均使用此结构互连。OB_END 安
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装在所有 OB 顺控程序的末端，它会复位启动信息。

例如，OB_BEGIN 还执行连接诊断。将不再监视通过 MSG_CSF 监视的过程控制外壳。此

功能必须根据需要在单独的块中实现。

• SUBNET 块使用 OB 70 和 OB 86 分析 DP 主站系统状态并返回此信息（链接到 CPU 监视），

作为到 RACK 块的更高等级错误。

• RACK 块监视机架、DP/PA 或 Y 链接器 DP V1 的状态并报告错误事件。

为防止在机架出现故障时所有 MOD 块都报告模块故障，每个机架中的有一个 RACK 块承

担报告功能。MOD 块在 OB 86 中识别到该事件已处理，从而不进行报告。

• 使用诊断块

– MOD 块用于监视 SM 模块、电机启动模块和 HART/PA 现场设备。它们为信号处理块

提供通道特定值状态（1 = 好、0 = 坏）。ALARM_8P 用于报告这些事件。RACK 块中

将处理较高一级（例如，DP 主站系统诊断）引发的错误。

– DP/PA 从站与 PADP_L0x (V0) 或 PADP_L10 (V1) 块一起接受监视，PA 从站则与 
DPAY_V0 或 DPAY_V1 块一起接受监视。

• PO_UPDAT 块确保由 CH_AO 和 CH_DO 块写入到过程映像中的启动值在 CPU 重新启动时

发送到输出模块 (OB 100)。这意味着 CPU 转入 RUN 模式时这些值将立即生效。

有关这些块功能、功能性及消息功能的更多信息，请参考块的上下文相关帮助（按 <F1> 
键）。

更多信息

更多相关信息，请参见以下部分：

“生成模块驱动程序”功能如何工作 (页 463)
“生成模块驱动程序”的会话模型 (页 465)
驱动程序生成器所支持的设备 (页 459)
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17.4 互连模型、模块驱动程序
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17.5 “生成模块驱动程序”功能如何工作

工作原理

此功能自动生成系统图表，并插入诊断块（MOD 或 PADP/DPAY 块）、RACK 及 SUBNET 块、

OB_BEGIN 和 OB_END 以及用于输出过程映像 PO_UPDATE 的块。将为系统图表分配名称

“@.....”。   
将为由驱动程序生成器插入的块将分配对应的模块名称。将为 WinCC 消息系统的过程控制

消息分配其来源的名称。在这种情况下，先是块名称，然后是监控功能块的名称。 
提示：可通过在 HW Config 中设置相应模块名称，将特定文本分配给过程控制消息。这样此

文本可成为过程控制消息的一部分。

最初生成模块驱动程序并且 CFC 数据管理尚不包含任何驱动程序块（包括 OB_BEGIN 和 
OB_END）时，将从库中导入块。自“设置 – 生成块驱动程序”(Settings – Generate Block 
Drivers) 对话框中定义的路径起执行块搜索。如果在此路径下未找到块，搜索会扩展到 PCS 7 
库安装期间定义的默认路径。

说明

请注意以下信息：

• 用户不应修改由“@”字符标识的对象，而只应使用“生成模块驱动程序”功能对其进行处理。
相应地，MOD/PADP/DPAY、RACK 和 SUBNET 块不应手动插入。

• 必须从块目录中插入用户创建的驱动程序块。复制的“@”块将在下次调用“生成模块驱动程序”
功能时删除，这是因为驱动程序生成器未分配其 ID。

非周期性错误 OB 以及 OB 1 中都安装了 MOD/PADP/DPAY 块。这确保对更改内容进行在线下

载之后，也执行这些块（因为在这种情况下将不再执行 OB 100）。将为运行组分配 16 这
一减速比。每执行 16 次 OB 1 才会调用一次块，以避免不必要的 CPU 负载。

驱动程序生成器启动后，将为 OB 1 中的运行组分配 16 这一减速比。为防止程序循环过程

中出现不一致，用户随后做出的更改将被覆盖。

系统会在 CFC 中验证 PO_UPDAT 块是否存在。如果不存在，则从库中将其导入，并插入到

系统图表中。此块在 OB 100 中安装在运行顺序的最后位置。如果该块已存在，系统会验证

其是否在驱动程序块后安装到 OB 100 中，以及是否已从所有其它 OB 中删除。

系统会在 CFC 中验证是否存在 OB_BEGIN/OB_END 块。如果未找到，系统将从库中导入块，

并将其插入到图表和运行顺序中。

过程映像分区

CH/PA 块通过过程映像 (PI, process image） 接收并输出其信号。
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PO_UPDAT 块确保 CPU 重新启动期间由 CH_AO 和 CH_DO 块写入到过程映像中的启动值传

送到输出模块，并确保这些值立即生效。 
在周期控制点（无持续扫描周期时间）更新 OB 1 PI。可使用过程映像分区 (PIP, process image 
partition) 获得持续扫描时间。在 HW Config 中通过将 PIP 分配给 OB 来组态 PIP 更新时间。PIP 
更新涵盖 OB 执行开始的输入和 OB 执行结束的输出。过程映像分区是模块相关的，即速度

最快的信号决定所有模块信号的更新。

实现新版本块

安装包含已修改块类型的新 PCS 7 Library 最初不会影响已使用的块。也许无法再在线下载

更改。

如果要更新块，请按以下步骤操作： 
• 从图表文件夹中删除所有 @ 系统图表。

注意

删除的影响 
删除 @ 系统图表后，随后生成模块驱动程序时会生成新 DB。由于在此过程中初始值写

入 CPU 的一个周期，因此无法始终保证平稳的连续操作。

• 选择菜单命令“选项”(Options) >“块类型...”(Block Types...)。
• 在“图表文件夹”(Chart folder) 窗口中选择相关块。

• 单击“清除”(Clean Up)。
这些块会被删除。

• 调用 SIMATIC Manager 组件视图中的“生成模块驱动程序”功能。

将会创建新系统图表。由于驱动程序块在 CFC 中不再可用，因此将安装新库的驱动程序

块。必须在“定制”(Customize) 对话框中选择相应库。

更多信息

更多相关信息，请参见以下部分：

• 如何生成模块驱动程序 (页 457)
• “生成模块驱动程序”的会话模型 (页 465)
• 互连模型、模块驱动程序 (页 462)
• 驱动程序生成器所支持的设备 (页 459)
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17.6 “生成模块驱动程序”的会话模型

为“生成模块驱动程序”组态会话模型：

• 配置硬件并将符号名称分配给 I/O 信号。HW Config 将直接把信号名称写入到符号表中：

– 选择模块。

– 在 HW Config 中选择菜单命令“编辑”(Edit) >“符号...”(Symbols...)。
说明

如果显示的消息告知尝试输入非法符号地址，则说明可能是 HW Config 中组态的过程

映像的大小过小。例如，某些 CPU 的默认大小是 512。可在 CPU 属性的“周期/时钟

存储器”(Cycle/Clock Memory) 选项卡中找到过程映像的设置。如果插入模拟输入和输

出，其地址将始终从 512 开始，因此将不再位于过程映像中。如果现在分配符号名称，

将在符号表中输入“PIW”或“PQW”作为地址。结果是，输入/输出将无法再与 CH_AI/
CH_AO 块链接。

补救措施 1：
更改模块对象属性的“地址”(Addresses) 选项卡中各个模拟模块的初始地址，使其地

址范围不超过过程映像的大小。

补救措施 2：
如果有足够的工作存储器，请打开 CPU 的对象属性的“周期/时钟存储器”(Cycle/Clock 
Memory) 选项卡，然后更改 I/O 过程映像的大小。

• 在 CFC 中组态工艺功能，并使用与从符号表获取的信号名称互连的 CH_ 块（或 PA_ 块）：

– 选择菜单命令“插入”(Insert) >“互连到地址...”(Interconnection to Address...)。
• 在 SIMATIC Manager  中，通过菜单命令“选项”(Options) >“图表”(Charts) >“生成模块

驱动程序...”(Generate Module Drivers...) 调用驱动程序生成器，以生成、互连和组态所

有模块驱动程序。自动执行以下步骤：

– 在第一步中，该功能会标识在 CFC 图表使用所有通道块（_AI、_AO、_DI、_DO），然

后在下一步标识互连到在 HW Config 中组态的 I/O 通道的符号的所有 I/O，例如，

Value、O_SP、I_OUT_D。PA_AO/PA_DO 块可能需要若干符号的互连。在这种情况下

只有“前置”符号需要互连，其它符号将通过驱动程序生成器自动识别和互连。通过

使用符号表的符号地址，在硬件配置数据中标识相应的模块和通道。基于模块类型标

识相应的诊断块类型（MOD 或 PDAP），并在系统图表中为每个 I/O 模块创建块实例。

– 诊断块所需的参数从 HW Config 数据中获得，并输入到块实例及在错误 OB 中运行的、

用于优化运行的 SUBNET 功能块中。

– MOD/PADP 块处的通道特定输出将互连到 CH 块处的相应输入。如果支持“值状态”

模块，将获取值状态的地址，并互连到 CH/PA 块。

组态数据（硬件或软件）中所做的更改必须由驱动程序生成器进行处理。将不删除及重建现

有驱动程序块，而是为其分配新参数。不再需要的块将被删除（用户块除外），如果需要添

加其它功能块，系统将从 CFC 数据管理器中而不是功能库中导入。
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记录程序 18
18.1 打印图表、动态显示、I/O

18.1.1 如何打印图表

打印图表    
要打印图表，请选择菜单命令“图表”(Chart) >“打印”(Print)。
将在默认打印机上打印活动图表。

选项

打印选项适用于不同打印输出。在通过菜单命令“文件”(File) >“打印”(Print) >“对象内容”
(Object Content) 从 SIMATIC Manager  打印时，这些选项也适用。

打印内容 (Print what)
可设置以下打印范围：

• 当前表单 (Current sheet)
打印当前表单。

• 当前图表分区 (Current chart partition)
根据选择，只打印当前图表分区的总览和/或表单。

• 所有图表分区 (All chart partitions)
根据设置，只打印当前图表的所有图表分区的总览和/或表单。

如果当前图表包含图表 I/O，则可选择以下打印范围：

• 带有图表 I/O 的图表

• 不带有图表 I/O 的图表

• 仅图表 I/O
如果选择打印图表 I/O，则打印在单独页的表中。此表包含所有相关信息，例如数据类型、初

始值或“不可见”。无论在图表 I/O 窗口中哪些列是可见的，将始终打印图表 I/O 信息（列）。

如果 I/O 过多而无法在一页打印，则将打印多页。
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可通过“总览”(Overview) 和“表单”(Sheets) 选项来决定是否只打印图表总览和/或表单（取

决于图表 I/O 的设置）。如果选择“仅图表 I/O”(Chart I/Os only) 选项，上述选项将被禁用。

仅打印有内容的表单。不管图表是否带有图表 I/O，都至少将打印一个图表页，如果图表仅

包含空表单，也将打印一个空表单。 
从 SIMATIC Manager  打印时，也打印低级图表，即顶级图表的嵌套图表（默认设置）。如

果不想打印低级图表，则取消选择“包含嵌套图表（从 SIMATIC Manager）”(Include nested 
charts (from the SIMATIC Manager)) 复选框。 

说明

此选项仅适用于 SIMATIC Manager。从 CFC 打印时，此设置无效，仅打印打开的图表。这也

可以是一个嵌套图表。

单击此对话框中的“选项”(Options)，以显示更多的打印选项。无论当前图表布局如何，此

对话框允许自定义地址、I/O 和块标题信息的打印布局。可通过菜单命令“选项”(Options) >
“自定义”(Customize) >“布局”(Layout) 来更改图表中的当前布局。

页面设置

可通过菜单命令“图表”(Chart) >“页面设置...”(Page Setup...) 自定义布局。可指定打印机

的纸张格式和页面边距。 

打印预览

菜单命令“图表”(Chart) >“打印预览”(Print Preview) 显示图表（表单或总览）的所见即所

得视图。单击“关闭”(Close) 或按 <Esc> 键以返回到标准显示。

18.1.2 创建脚注

简介    
DOCPRO 附加软件包可用来打印 CFC 图表以及脚注数据。在脚注数据中，对全局数据和图

表特定本地数据做了区分。

可使用 DOCPRO 或 SIMATIC Manager  为项目输入全局数据；本地图表特定数据必须通过 CFC 
编辑器输入。请注意，在特定图表中，图表特定数据将会覆盖全局数据。

即使尚未安装 DOCPRO 附加软件包，也可以输入图表特定数据。尽管保存了这些数据，也

只有安装 DOCPRO 后才能使用。
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脚注中的关键字

可在全局脚注中输入关键字，这些关键字将在打印输出时由当前文本替换。以下所示为可用

关键字及其含义：

关键字 代号 含义 DOCPRO
代码

$$CN$$ 图表名称 图表名称（包括嵌套图表），

即图表属性中输入的内容 $54
$$CC$$ 图表注释 注释文本

图表属性中输入的内容 $60
$$A$$ 作者 名称，

即图表属性中输入的内容 $55
$$DC$$ 创建日期 日期，

即图表属性中输入的内容 $56
$$DM$$ 上次修改日期 日期，

即图表属性中输入的内容 $57
--------- --------- --------- ---------
$$CH$$ 项目路径 路径，即图表属性中输入的内容

$$PP$$ 项目

存储位置

物理存储位置，即图表属性中

输入的内容

在 DOCPRO V5.1 下生成的新项目中，可使用 DOCPRO 关键字来定义关键字。也就是说，无

需在 CFC 脚注中输入关键字。但是这些脚注仍然受支持。对于较早的项目，仍需直接输入

文本。

说明

如果在 CFC 中输入的关键字还指定了其它打印对象（例如，STL 块或 DOCPRO 目录），打

印的副本将显示这些项目的实际关键字，而不是其替代字。如果使用 DOCPRO 代码，则上

述问题将不再出现。

使用 DOCPRO 代码时，必须更改 DOCPRO 的标准布局。打开“修改布局”(Modify layout) 对
话框，使用图表特定脚注替代默认脚注。相关信息，请参见 DOCPRO 在线帮助或

《DOCPRO：依据标准创建文档》(DOCPRO:Creating Documentation in Conformance with 
Standards) 手册。

因为没有对应的 DOCPRO 关键字，因此必须继续使用“项目路径”和“项目位置”的关键字

（表格的下部）。 
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特定图表的脚注数据

按以下所述输入特定图表的脚注数据：

1. 选择菜单命令“图表”(Chart) >“脚注...”(Footers...)。
将打开包含几个选项卡（“第 1 部分”(Part 1) 到“第 4 部分”(Part 4) 以及“自由域”(Free 
Fields)）的对话框。

2. 在激活域中输入相应的条目，例如文档类型、创建日期、文档编号、与修改有关的数据及自
由文本。

脚注中的表单编号

脚注包括一个固定域，用于打印作业的连续页编号。对于不超过 99 页的作业，将同时显示

页的编号和总页数，如 2/14。
如果作业超过了 99 页，将不显示总页数，但会给页码附加“+”字符。这表明还有更多的页，

例如：1+ 至 7+。末页的页码将附加一个“-”字符，例如 127-。

18.1.3 如何打印动态显示

步骤

可通过菜单命令“图表”(Chart) >“打印...”(Print...) 使用标准打印功能打印（激活）动态显

示的内容。 
将打印触发打印时当前显示的值。

列宽设置为打印的最优值。打印输出为横向格式（默认），但可在打印机设置中临时更改。

18.1.4 如何打印块/图表 I/O

可通过“属性 – 块”(Properties – Block) 和“属性 – 图表”(Properties – Chart) 对话框打印 I/O 
表格。“常规”(General) 和“I/O”选项卡中提供了“打印...”(Print...) 按钮。此按钮始终打印 I/O 
表格。

步骤

1. 选择“常规”(General) 或“I/O”选项卡。

2. 单击“打印…”(Print…)。
列宽设置为打印的最优值。打印输出为横向格式（默认），但可在打印机设置中临时更改。
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18.2 打印图表引用数据

图表引用数据与打印的图表一起形成了完整的组态结构文档。     
更多相关信息，请参见“关于图表引用数据应该了解的知识”部分中的图表引用数据在线帮

助。
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18.3 如何显示日志

简介

日志文件不属于完整的组态结构文档。但是在组态和调试期间，如果出错或要检查特定执行

的操作，它们可以提供重要信息。     

步骤

1. 选择菜单命令“选项”(Options) >“日志...”(Logs...)。
将打开一个包含几个选项卡的对话框。只有以前执行过相应功能的情况下，选项卡才可用。

2. 单击“打印”(Print)。
将打印消息。

可使用“页面设置”(Page Setup) 按钮选择布局。 
有关选项卡和按钮的更多信息，请访问对话框的“日志对话框的相关帮助”(Help on the log 
dialog) 在线帮助。

记录程序

18.3 如何显示日志

SIMATIC S7 中的 CFC (V9.0 SP7)
472 功能手册, 05/2022, A5E41356112-AH



附录 19
19.1 S7 的数据类型

19.1.1 ANY，A

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

A ANY；
数据元素的指针 

仅作为与块输出或全局

操作数的互连

更多相关信息，请参见以下部分：

数据类型 A、DT、S 和 ST 的互连规则 
(页 169)

说明

ANY 类型的 I/O（例如，用于 SFB 12/BSEND 的 SD_1）也都可以与完整的数据块（绝对共享

地址如 DB1，或符号共享地址）互连。将传输 DB 的完整长度。

19.1.2 ARRAY
数组包含最多 6 维的分组数据类型。  
CFC 不支持此数据类型。

这意味着包含此数据类型的用户特定块在导入到 CFC 数据库时将被拒绝，并显示错误消息。

19.1.3 BLOCK_DB，DB

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

DB BLOCK_DB；
数据块 (DB) 的编号 

0...65535
（编号取决于目标系统）

123 123
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19.1.4 BLOCK_FB，FB

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

FB BLOCK_FB；
函数块 (FB) 的编号 

0...65535
（编号取决于目标系统）

123 123

19.1.5 BLOCK_FC，FC

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

FC BLOCK_FC；
函数 (FC) 的编号 

0...65535（编号

取决于目标系统）

123 123

19.1.6 BOOL，BO

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

BO BOOL；
逻辑编号 

0-1 0；
1；
False；
True；
F；
T

0；
1；
0；
1；
0；
1

19.1.7 BYTE，BY

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

BY BYTE；
8 位序列 

0...255，(0...FF) 1C; 
16#2a; 
10#123; 
2#10110011

16#1C; 
16#2A; 
16#7B
16#B3
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19.1.8 CHAR，C

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

C CHAR；
单个字符

取决于所组态的 Windows 
字符集，可为“单字节”或

“多字节”

“A”；
“a”；
“0”；
“%”
A；
a；
0；
%

“A”；
“a”；
“0”；
“%”
“A”；
“a”；
“0”；
“%”

19.1.9 COUNTER，CR

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

CR COUNTER；S7 计
数器的编号 

0...65535
（编号取决于目标系统）

123 123

19.1.10 DATE，D

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

D DATE；
日期 

1990-1-1...2168-12
-31

1996-04-29
2000-01-03

96-04-29
00-01-03
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19.1.11 DATE AND TIME，DT

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

DT DATE_AND_TIM
E 
或 DT；
日期和时间  

1990-1-1...
2168-12-31-23:59:5
9.999

1996-03-16-23:56:1
9.123

96-03-16:23:56:1
9

19.1.12 DINT，DI

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

DI DINT；
双精度整数 

-2147483648...2147
483647

12345；
-17385267；
16#3BC9；
10#123456789；
2#10110101010101
01

12345；
-17385267；
15305；
123456789
46421

19.1.13 DWORD，DW

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

DW DWORD；
32 位序列  

0...4294967295，
(0...FFFFFFFF)

23AC43BF; 
16#1a2b3c4d;
10#1234567890;
2#10010010010010010
010

16#23AC43BF;
16#1A2B3C4D
16#499602D2
16#92492
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19.1.14 INT，I

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

I INT；
整数

-32768...32767 4099；
-30123；
16#1AC5；
10#12345；
2#0010110010101110

4099；
-30123；
6853；
12345；
11438

19.1.15 POINTER，P

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

P POINTER；
存储区域的指针

仅作为互连 - - - -

说明

数据类型为 POINTER 时，必须遵循某些限制和规则。请阅读有关 POINTER 数据类型的 SCL 在
线帮助。作为一般规则，可将 POINTER 与任何除了 POINTER 和 ANY 之外的其它数据类型互

连。如果互连不允许，则在编译程序时收到一条消息。 

19.1.16 REAL，R

缩写 关键字，

类型

取值范围（标准化）

从 ... 到
示例条目 图表中的显示

R REAL；
浮点数 

-3.402823e+38... 
-1.175495e-38...
 
0.0...1.175495e-38...3.40282
3e+38

22.78；
-1234522.456789；
-3.456e-3；
2.573e19

2.278e1；
-1.23452e+6；
-3.456e-3；
2.573e19
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注意事项

STEP 7 根据 IEEE 标准（32 位短实数）映射数据类型 REAL。由于自限制，只使用数字的规

格化编码（参见上面）。  
此标准保留以下附加特殊位模式。

• 低于规格化范围（-1.175495e-38 < x < 0.0 和 0.0 < x < 1.175495e-38）的最小数字值的

非规格化编码

• 无穷正数值（+ 无穷）

• 无穷负数值（- 无穷）

• 数字的非法位模式，即所谓的 NaN（不是一个数字）

在 CFC 中使用数据类型 REAL 时，在线数值的显示/评估（例如，在测试模式下值的动态更新

或从 CPU 读回时）始终基于使用特殊位模式的计算。CFC 因而按照如下方式处理这些数值：

值 动态显示 读回期间激活

规格化数字 浮点数 是

非规格化数字 +0.0 或 -0.0 否

+ 无穷 #+Inf 否

- 无穷 #-INF 否

“不是一个数字” #NaN 否

19.1.17 S5TIME，T5

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

T5 S5TIME；
S5 格式的持续时间 

0h_0m_0s...2h_46m_30
s；
0...9990 ms（时间间隔为 
10 ms），

100 ms...99900 ms（时

间间隔为 100 ms），

1 s...999 s（时间间隔为 1 
s），

10 s...9990 s（时间间隔

为 10 s）

1h_30m_0s；
1234567ms；
2h；32m_5s

1h_30m_0s；
20m_34s_567ms
2h；32m_5s
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19.1.18 STRING，S

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

W STRING；
字符串 

视所组态的 Windows 字符集而

定，可为“单字节”或“多字节”

（至少 127 个字符）

"Batch_127";
This is a longer text.

"Batch_127";
"This is a lon»"

19.1.19 STRING[N]，SN

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

SN STRING[N]；
字符串

视所组态的 Windows 字符集而定，

可为“单字节”或“多字节”（至少 
127 个字符）

"Batch_127";
This is a longer text.

"Batch_127";
"This is a lon»"

19.1.20 STRUCT，ST

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

ST STRUCT；  - - - - 第一个基本数据类型的名称和值

19.1.21 TIME，TI

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

TI TIME；
持续时间 

-24d_20h_31m_23s_64
7ms...
24d_20h_31m_23s_64
7ms
(-2147483647...21474
83647 ms)

12d_12h_12m_34s_789
ms；
123456789ms；
2h；
-32m_5s

12d_12h_12m_34s；
3h_25m_45s_678ms
2h；
-32m_5s
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19.1.22 TIMER，TR

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

TR TIMER；
S7 计时器的编号 

0...65535
（编号取决于目标系统）

123 123

19.1.23 TIME OF DAY，T

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

T TIME_OF_DAY 或 
TOD；
日时钟

0:0:0.0...23:59:59.999 12:45:18.012 12:45:18.012

19.1.24 WORD，W

缩写 关键字，

类型

取值范围

从 ... 到
示例条目 图表中的显示

W WORD；
16 位序列 

0...65535，(0...FFFF) 16#bAc1; 
10#12345
2#1000011101011010

16#BAC1;
16#3039
16#875A
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19.2 参考

19.2.1 同步 AS 范围的互连

同步 AS 范围的互连

此菜单命令可用于确定所有单侧 AS 范围的互连。 
• 如果互连伙伴可用，则这两个伙伴之间的单侧 AS 范围的互连将被删除。

• 如果其中一个互连伙伴不可用，该命令对两个伙伴之间的互连没有影响，且单侧 AS 范围

的互连会被保留。

执行该命令之后，会显示一个日志，其中显示已删除和保留的单侧 AS 范围的互连。

说明

如果已手动删除不可用伙伴中的 AS 范围的互连，您仍然需要使用该命令来同步内部时间戳。

19.2.2 减速比和相位偏移实例

下图显示了时钟周期中相位偏移和减速比的示例。         

0 1 2 3 11 19 n

t

Task

cycle

Execution moment

Scan ratePhase offset

Run-time group with scan rate = 8, phase offset = 3
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19.2.3 运行属性框的显示

运行属性框显示在深绿色背景的块标题中（默认）。例外：用作“在此之后作为插入位置”

的块以浅绿色背景显示。  

更多此内容的相关信息，请参见以下部分：

显示运行属性 (页 185)
块执行的显示 (页 209)

19.2.4 “属性 - 块/图表”对话框，“常规”选项卡

“属性 - 块/图表”对话框，“常规”选项卡

在该选项卡上可查看以下对象的常规属性：

• 块

或 
• 嵌套图表

“常规”(General) 选项卡上的块和图表选项

类型 (Type)
在块上：

在此可以查看块的类型名称。如果只看见 FB 或 FC 编号，则应将带有块名称的相关条目从

源文件的符号表导入到当前符号表，或编辑当前符号表中功能块 (FB) 或功能 (FC) 的块名称。

对于嵌套图表：

条目总是显示“图表”(Chart) 类型。

名称 (Name)
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在此框中可查看并编辑块实例或图表的名称。块的最大字符串长度为 16 个字符，嵌入的图

表为 22 个字符。名称中不能包含下列字符：\ / . " %。

说明

请注意以下信息：

• 分配名称时，切记变量名称长度不能超过 128 个字符，以便将变量传输到 OS（“编译 OS”）。
名称由以下元素组成：

– 层级路径中的文件夹名称

– 图表名称

– 块名称

– 分隔符（句点）

– I/O 名称（变量名）

• 传输到 OS 时，除以上所列的非法字符外，名称中不允许有以下字符，如出现将被自动替换为 $ 
字符：空格、?、*、'、:

提示：选择名称时切勿使用以上所列的任何字符。

注释 (Comment)
可在此框中查看并编辑块或图表注释。最多可以输入 80 个字符。标题中只显示前 14 个字符

（大型块和嵌套图表）或 7 个字符（小型块）。 
只有在 OS 编译之前编辑此实例，注释才能被 WinCC 采用。 
组 (Group)（仅用于带有消息的块）

可在此域中将块分配给用于隐藏消息的组。组名称最多可包含 24 个字符。

块的“常规”(General) 选项卡上的选项

以下选项只存在于块属性上。

输入

在此，可查看所选块的块输入的数量。如果块具有可变数量的输入和相同的数据类型，例如，

NAND 和 OR 等，可使用菜单命令“编辑”(Edit) >“I/O 数量”(Number of I/Os)  更改块输入的

数量。

内部标识符（仅 S7）(Internal identifier (S7 only))
在将块类型实现为功能或功能块时，将看到块类型（例如，FC 或 FB）和编号。SIMATIC 管
理器中的块文件夹将此内部块标识符显示为“对象名称”(Object name)。
背景 DB（仅 S7）(Instance DB (S7 only))
程序显示映射到数据块的块的 DB 编号。
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名称（标题）(Name (header))
显示创建块时在内部块标题中所指定的块名称。

系列 (Family)
显示在创建块时在内部块标题中所指定的块的系列名称。系列名称用作块目录中的排序标准

等。

作者 (Author)
显示创建块时在内部块标题中所指定的名称（例如，基本操作“CFC-BOP”或工艺块“TECH”）。

待插入到 OB/任务 (To be inserted in OB/tasks)
有些块必须安装在某些任务中，以确保启动行为、过程控制消息功能和其它属性生效。列表

显示 CFC 已在其中自动安装了块的任务。可稍后使用菜单命令“编辑”(Edit) >“运行顺序...”
(Run Sequence...) 编辑运行顺序。

“允许 OCM”区域

可在此定义可输出消息的块或可从 OS 对其进行控制和监视的块的响应。

选项“允许 OCM”(OCM possible) 不影响到 OS 的消息传送。

• “允许 OCM”复选框

选中或取消选中“允许 OCM”(OCM Possible) 复选框以决定是否在 OS 监视列表中输入此

块，以进行操作员控制和监视。取消选中此复选框时，此组的所有元素都切换为非活动

状态。它们将不再与执行相关，但将保持其设置。

• “操作员控制和监视...”按钮

单击“操作员控制和监视”(Operator Control and Monitoring) 打开对话框，可在其中设置

特殊属性。使用 WinCC 和 PCS 7 库块时，通常不必调用此对话框，因为默认情况下此处

已设置属性。

• “创建块图标”复选框 
选中/取消选中“创建块图标”(Create block icon) 复选框时，可决定是否为此块创建一个

块图标。

可以为 SFC 类型的实例启用块图标。不过，块图标的变体在 SFC 类型的对象属性中组态。
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• 输入字段

可在“块图标”(Block icon) 输入字段中指定此块的 WinCC 图标显示。这样，可以为相同

块类型设置不同的变体（如果存在）。

最多可输入 16 个字符。 
块图标的模板及其变体位于画面“@PCS7TypicalsBasisLibraryV8.pdl”中。 
块图标的变体可以通过图标名称末尾的字符串“/<编号>”进行区分，例如“<名称>/2”。  

变体 备注

1 标准 PCS 7 样式

2 基于 APL 的新样式

<变体名称> 用户自定义变体； 
作为块图标名称的用户自定义变体名称；最多 16 个字符

如果选中“创建块图标”(Create block icon) 复选框，则该输入字段将处于活动状态。如果

取消选中“创建块图标”(Create block icon) 复选框，将禁用输入字段。但是，该条目将保

留。

有关块图标的更多信息，请参见“SFC 可视化”在线帮助或文档的“操作员监控 (页 180)”
部分或“组态 SFC 块图标”部分。   

• 选中/取消选中“MES 相关”(MES-relevant) 复选框时，可决定请求时是否将此块的信息传

送到企业级 MIS/MES。
此输入字段只有在选中了“允许 OCM”(OCM possible) 复选框时才启用。 

“特殊属性”区域

• 单击“消息...”(Messages...) 以打开一个对话框，可在其中编辑块的消息文本。

• 如果选中了“回读已启用”(Read-back enabled) 复选框，此块将包含在回读中（默认）。

块具有系统属性 S7_read_back = ‘true’。
根据“回读”(Read Back) 对话框中设置的范围，可以回读全部块 I/O，或仅回读带有“操

作员控制和监视”系统属性 (S7_m_c := ‘true’) 和/或带有特殊标识 (S7_read_back := ‘true’) 
的块 I/O。 
如果取消选择复选框 (S7_read_back := 'false')，也可以从读回中排除整个块。 

• 使用“工艺分配...”(Technolog. assignments...) 按钮打开一个对话框，在该对话框中列出

了所有已分配的对象。 
选择一个对象并通过“转到”(Go to) 按钮直接跳转到此对象来对其进行确认。只有当存在

分配时，此按钮才存在。

“确定”(OK) 按钮

此按钮应用于对话框中进行的所有更改。对话框关闭。

“应用值”(Apply values) 按钮
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仅在测试模式下更改了“I/O”选项卡“值”(Value) 列中的一个或多个值后，此按钮才处于活动

状态。

此按钮只应用于 CPU 上“值”(Value) 列中的修改值。对话框将保持打开，从而可多次更改值

并在图表的块中跟踪结果。

“打印”(Print) 按钮

使用此按钮可打印输入/输出表。单击此按钮时，选项卡从“常规”(General) 切换到“I/O”。
表按横向格式打印。将列设置为最佳宽度，然后重设回先前设置的宽度。

“取消”(Cancel) 按钮

此按钮放弃所有未保存的更改并关闭对话框。已使用“应用值”(Apply values) 按钮接受的修

改值将被保留。

19.2.5 “属性 - 块/图表”对话框，“I/O”选项卡

“属性 - 块/图表”对话框，“I/O”选项卡

此选项卡上的表显示所选对象的 I/O。 
无论对象类型为何（块实例、嵌套图表、SFC 图表的外部视图、SFC 类型实例），所有现有

的元素都在表列中列出。但是，并非所有列都与每个对象类型全局关联，有些列可能无法更

改。无法编辑变灰的域。

表列的含义

#
此列始终可见。在此列中分配 I/O 编号。打开对象属性对话框后，将看到按升序排列的连续

编号。排序 I/O 将改变次序。退出对话框后将恢复到原始的次序（升序）。

名称 (Name)
此处显示 I/O 的名称。此列始终可见。

I/O
可在此查看 I/O 的类型（IN = 输入、OUT = 输出、IN_OUT = 输入/输出）。

类型 (Type)
此处显示 I/O 的数据类型。

有关详细信息，请参见以下部分：S7 的数据类型 (页 168)
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值 (Value)
可在此查看并编辑 I/O 参数值。根据数据类型，允许不同范围的值和输入。不能修改灰显的

值：

• 互连 I/O 和空域（不包括数值）的值

• 不可组态的 I/O 的值（系统属性：S7_pram := 'false'）
• 文本互连的值

（块类型的）值在此处用作互连伙伴的替代值。

除了绝对数值，也可在此显示数值标识符，前提是为此 I/O 组态了数值标识符且在显示设置

中启用了“数值标识符”(Value identifier) 选项。在这种情况下，可在组合框中选择要显示的

文本，例如，枚举的显示文本。单击组合框时，显示下拉列表的按钮。

互连 (Interconnection)
I/O 互连时，该域显示连接伙伴。当一个输出具有若干互连时，显示连接到此输出的所有输入。

背景：

在 CFC 中每个接口侧最多可显示 160 个 I/O（左侧为 IN 和 IN_OUT，右侧为 OUT）。当每个

接口侧的 I/O 超过 160 个时，多余的 I/O 将切换为不可见。这种情况将从最后一个 I/O 开始。

其中可能包括互连的 I/O。尽管这些互连不再可见，但可在“互连”(Interconnection) 列中识

别它们。 
注：如果一个互连伙伴的 I/O 不可见，则可见 I/O 的互连将被连到表单栏且互连目标被标识为

“(INVISIBLE)”。
如果互连的两个伙伴均切换为不可见，则此互连在图表中将无法再被识别。对文本和符号互

连及到运行组的互连，也是如此。 
如果 I/O 无法互连 (S7_link := 'false')，则会输入文本 <无法互连> (<cannot be 
interconnected>)。

添加强制 (Add forcing)
显示所选的启用了添加强制功能的 I/O。此选项只有在 SIMATIC Manager  中全局启用强制后

才可用。

强制激活 (Forcing active)
显示所选的设置了强制激活功能的 I/O。此选项只有在激活了“添加强制”(Add forcing) 时才

可用。
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强制值 (Force value)
显示强制值。只有在激活了“添加强制”(Add forcing) 时才可编辑该值。该值取决于 I/O 的数

据类型。

SFC 访问 (SFC access)
显示为 SFC 读/写访问而选择的 I/O。此标识符对隐藏的 I/O 具有特殊的含义，因为此 SFC 访
问在图表的块表示中不显示。

工艺分配 (Technological assignments)
在此选择的连接是控制模块的连接。可通过快捷菜单复制和插入连接。

注释 (Comment)
在此可查看并编辑 I/O 注释（最多 80 个字符）。 
互连输入的注释可以是输入注释（I/O 注释）或互连伙伴注释（互连注释）。显示内容取决

于在“自定义显示”(Customize Display) 中进行的设置。使用菜单命令“选项”(Options) >“自
定义”(Customize) >“布局...”(Layout...) 打开对话框。如果要在 CFC 图表中显示互连注释，

请选中该对话框的“参数”(Parameter) 组中的“互连注释”(Interconnection comment) 复选

框。

无法在输入对象属性中修改互连注释。

不可见 (Invisible)
可以在此处决定显示还是隐藏互连或未互连的 I/O。选中复选标记表示隐藏，未选中复选标

记则表示可见。

如果一个互连伙伴的 I/O 不可见，则可见 I/O 的互连将被连到表单栏且通过“INVISIBLE”标识

互连目标。

如果两个互连伙伴或带有符号或文本互连的 I/O 均被切换为不可见，则此互连在图表中将不

再能够被识别，而只能在“互连”(Interconnection) 列中识别。这也适用于到运行组的互连。

说明

如果块包含不可见的互连 I/O，则块标题的右上角出现一个彩色的三角形。这也适用于 SFC 访
问。

受监视 (Watched)
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可在此设置 I/O 以便记录 I/O 以用于测试模式。这允许您查看并编辑 CPU 的实际值。

归档 (Archive)
可以在此处标记数据类型为 BOOL、BYTE、WORD、DWORD、INT、DINT 和 REAL 的 I/O 以
进行以下类型的归档：

• 不归档 (No archiving)
• 归档 (Archiving)
• 长期归档 (Long-term archiving)
要求：I/O 用于操作员监控。

只有当 I/O 用于操作员监控（系统属性 S7_m_c := 'true'）时，才能编辑此列中的框。无论当

前块是否切换为操作员监控都适用。

使用集成的下拉列表，可指定 I/O 与归档无关（“不归档”），或标记 I/O 用于“归档”或

“长期归档”。 
更多相关信息，请参见以下部分：组态归档变量 (页 182)
标识符 (Identifier)
可在此查看类型不为 BOOL 的 I/O 的标识符并可输入最大字符串长度为 16 个字符的标识符，

例如，“Setpoint”或“CP”。OS 将这些文本用于显示和日志。

单位 (Unit)
可在此从下拉列表中为数据类型不为 BOOL 的 I/O 选择最常用的单位。单击组合框时，显示

下拉列表的按钮。

说明

单位集同 CFC 一起安装并可在 SIMATIC Manager  中修改或补充。更多相关信息，请参见以

下部分：组态共享声明 (页 173)。

文本 0 (Text 0)
可在此为数据类型为 BOOL 的 I/O 值“0”输入最大长度为 16 个字符的文本，例如，“关闭”
(Close) 和“已关闭”(Closed)。
在“值”(Value) 列中，可以选择该文本或“文本 1”(Text 1)。

说明

如果 I/O 也分配有系统属性“S7_enum”，则会禁用此框。这种情况下，只有枚举用作数值标

识符。
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文本 1 (Text 1)
可在此查看文本并为数据类型为 BOOL 的 I/O 值“1”输入最大长度为 16 个字符的文本，例如，

“打开”(Open) 和“已打开”(Opened)。
在“值”(Value) 列中，可以选择该文本或“文本 0”(Text 0)。

说明

如果 I/O 也分配有系统属性“S7_enum”，则会禁用此框。这种情况下，只有枚举用作数值标

识符。

枚举 (Enumeration)
如果涉及分配有“S7_enum”系统属性的 I/O，则对数据类型为 BOOL、BYTE、INT、DINT、
WORD 和 DWORD 的 I/O，可从下拉列表选择在当前项目的“共享声明”中创建的枚举。 
如果在“自定义显示”(Customize Display) 中激活了“数值标识符”(Value identifier) 选项，则

可从下拉列表的“值”(Value) 框中选择的显示名称将作为数值分配给各个枚举。 
可以在“枚举”(Enumeration) 下拉列表中选择空域以删除一个枚举。随后，将在“值”(Value) 
框中显示数字值，而不是显示名称。 
注：枚举被删除后，块 I/O 会保留“S7_enum”系统属性，也就是说，将输入一个空字符串，而

不是之前显示的枚举。 
有关枚举的更多信息，请参见以下部分：组态共享声明 (页 173)
参数 (Parameters)
可在此标识要在过程对象视图的“参数”(Parameters) 选项卡上显示的 I/O。可在 SIMATIC 
Manager  中使用菜单命令“选项”(Options) >“过程对象”(Process Objects) >“选择 I/O...”
(Select I/Os...) 更改此设置。

信号 (Signal)
可在此标识要在过程对象视图的“信号”(Signal) 选项卡上显示的 I/O。可在 SIMATIC Manager  
中使用菜单命令“选项”(Options) >“过程对象”(Process Objects) >“选择 I/O...”(Select I/
Os...) 更改此设置。

选项有：“参数”(Parameter) 或“信号”(Signal)，或无。

MES 相关 (MES-relevant)
如果选中了“MES 相关”(MES-relevant) 复选框，当连接 MES 系统时，这将起到一个过滤器的

作用，只传输 MES 相关的控制系统信息。使用此选项，可将带有 OCM 功能的单个 I/O 标记

为与 MIS/MES 相关或不相关。无论“常规”(General) 选项卡上的“MES 相关”(MES-relevant) 
复选框设置如何，都可将这些 IO 标识为相关。

操作员授权级别 (Operator authorization level)
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只有在相应块类型具有“Op_Level”属性时，此选项才可用。在此，可以设置一个 1 到 99 之
间的值。

OS 附加文本 (OS additional text)
可在此处输入面板中按钮的标签文本。可使用此按钮跳转到互连块的面板。此文本可以进行

编辑。

只有相应块在 WinCC 中具有画面跳转功能时，该输入字段才激活。

对列进行排序

可对此表中的 I/O 进行排序。此排序顺序是临时的，在关闭该对话框后，该顺序将恢复为原

始顺序。

单击列标题对所有 I/O 进行排序。每次单击都将切换字母顺序：升序/降序。带有选择框的列

的排序顺序由以下内容来决定：未设置/设置。“#”列指示对排序顺序的更改。 

按钮

“确定”(OK) 按钮

此按钮将应用在对话框中进行的所有更改并关闭对话框。

“应用值”(Apply values) 按钮

仅在测试模式下更改了“I/O”选项卡“值”(Value) 列中的一个或多个值后，此按钮才处于活动

状态。

此按钮只应用于 CPU 上“值”(Value) 列中的修改值。对话框将保持打开，从而可多次更改值

并在图表的块中跟踪结果。

“打印”(Print) 按钮

使用此按钮可打印输入/输出表。表按横向格式打印。将列设置为最佳宽度，然后重设回先

前设置的宽度。

“取消”(Cancel) 按钮

此按钮放弃所有未保存的更改并关闭对话框。已使用“应用值”(Apply values) 按钮接受的修

改值将被保留。
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19.2.6 “属性 - 块/图表”对话框，“类型更新设置”选项卡

“属性 - 块/图表”对话框，“类型更新设置”选项卡

此选项卡上的表显示所选对象的 I/O。 
在此选项卡中，可在某个参数的多个属性中进行选择，以将其从类型实例同步（类型更新）

中排除。同步类型和实例时，所选属性不会更新。

说明

将从类型实例同步中隐式排除部分参数。更多相关信息，请参见“控制模块的类型/实例同

步的更改效果 (页 238)”部分。

表列的含义

#
此列始终可见。在此列中分配 I/O 编号。打开对象属性对话框后，将看到按升序排列的连续

编号。排序 I/O 将改变次序。退出对话框后将恢复到原始的次序（升序）。

名称 (Name)
此处显示 I/O 的名称。此列始终可见。

I/O
可在此查看 I/O 的类型（IN = 输入、OUT = 输出、IN_OUT = 输入/输出）。

类型 (Type)
此处显示 I/O 的数据类型。

有关详细信息，请参见以下部分：S7 的数据类型 (页 168)

如果为某一参数选择以下选项，则会从类型更新中明确排除该参数的相应属性：

• 忽略值 (Ignore value)
针对类型更新忽略参数值并且此参数将在块 I/O 中标记为“粉色”（通常称为“粉色”
(Pink) 参数）。

• 忽略注释 (Ignore comment)
针对类型更新忽略参数的注释文本。

• 忽略 Text0 (Ignore Text0)
针对类型更新忽略参数值 0 的文本（系统属性 S7_string_0）。
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• 忽略 Text1 (Ignore Text1)
针对类型更新忽略参数值 1 的文本（系统属性 S7_string_1）。

• 忽略标识符 (Ignore identifier)
针对类型更新忽略标识符（系统属性 S7_shortcut）。

• 忽略单位 (Ignore unit)
针对类型更新忽略参数的测量单位（系统属性 S7_unit）。

• 忽略枚举 (Ignore enumeration)
针对类型更新忽略枚举符（系统属性 S7_enum）。

• 忽略参数/信号 (Ignore parameter/signal)
针对类型更新忽略“过程对象视图”(Process Object View) 中的显示参数/信号设置（系统

属性 S7_edit）。

对列进行排序

可对此表中的 I/O 进行排序。此排序顺序是临时的，在关闭该对话框后，该顺序将恢复为原

始顺序。

单击列标题对所有 I/O 进行排序。每次单击都将切换字母顺序：升序/降序。带有选择框的列

的排序顺序由以下内容来决定：未设置/设置。“#”列指示对排序顺序的更改。 

按钮

“确定”(OK) 按钮

此按钮将应用在对话框中进行的所有更改并关闭对话框。

“打印”(Print) 按钮

使用此按钮可打印输入/输出表。表按横向格式打印。将列设置为最佳宽度，然后重设回先

前设置的宽度。

“取消”(Cancel) 按钮

此按钮放弃所有未保存的更改并关闭对话框。已使用“应用值”(Apply values) 按钮接受的修

改值将被保留。
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19.2.7 使能属性

功能

使能属性启用或禁用运行组（开 = 1, 关 = 0）并表示一个主站控制。只要设置为“0”，则无论

任何其它条件如何，运行组都不会执行。

动态启用/禁用运行组

使能属性的默认设置为 1。也可动态设置此属性，即，CFC 块的输出值可启用或禁用运行组。

可将块的二进制输出与运行组互连。

在运行编辑器中启用/禁用运行组

可通过运行编辑器窗口启用/禁用运行组。 
要启用运行组，在相应运行组的对象属性中选择“活动”(Active) 复选框。要禁用运行组，在

相应运行组的对象属性中取消选择“活动”(Active) 复选框。也可通过快捷菜单命令“打开运

行组”(Switch on Runtime Group) 和“关闭运行组”(Switch off Runtime Group) 来实现此

目的。这样可不必打开对象属性对话框。

说明

如果运行组与块的二进制输出互连，则此输出值始终控制运行组。在这种情况下，忽略“活

动”(Active) 选项。

19.2.8 通过光标显示工具提示

在测试模式，通过将光标放在 I/O 或互连线上，可以显示作为工具提示的在线值。这里，光

标的作用相当于测量设备的“测试棒”。 
要求：必须可以在线更新 I/O（例如，无断开连接的 FC 输入）。

以下各项是关于工具提示的应用：

• 通过将光标放在 I/O 或互连上，将从 CPU 中动态获取信息，即使 I/O 没有注册为使用监视

功能。每秒执行一次更新，与所选的监视周期无关。

• 这个值被在线值取代，工具提示的背景颜色从浅黄色变为黄色，因为使用了受监视的 I/O。

对于不能由操作员控制和监视的 I/O，例如，当它们不互连时，背景是灰黄色。

• 对于互连显示输出值。例外：对于与共享地址的互连，显示输入值。在这种情况下，考

虑取反。
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19.2.9 在目录中搜索对象

在目录中搜索

可在目录的输入字段中指定文本并通过单击以下按钮来搜索文本：

如果对所输入的文本未找到相应的对象名称，则 CFC 将搜索带有相应注释的块。将打开存

放块的文件夹（例如块系列文件夹）或库并选择块。

将从活动目录窗口中的所选对象（库、文件夹或块）开始搜索块。搜索所有库和文件夹，直

到找到所需对象或直到搜索返回到所选对象。 
使用“查找首字母”(Find initial letter) 复选框可决定搜索是始于首字母（受限搜索），还是

应搜索名称或注释的任意部分（自由搜索；默认设置）。

搜索期间，显示一个带有进度的对话框。如果搜索时间过长（例如，在初次搜索库时），可

在此停止搜索。

当找到带有指定字母的对象时，搜索停止。

单击上述按钮，可搜索含有这些字母的其它对象。当搜索返回起始点时，搜索完成。

19.2.10 相位偏移

功能

相位偏移使负载在 CPU 中均匀分布。该参数必须与“n”（减速比）配合使用。按照指定的周期

“n”执行组，每种情况下偏移“m”个单位的任务周期。“m”为整数，其中 0 <= m <= (n-1)。 
默认值：0，无相位偏移

更多信息

更多相关信息，请参见以下部分：

减速比 (页 499)
减速比和相位偏移实例 (页 481)
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19.2.11 V5.2 及更低版本的驱动程序概念的信号处理

  
如果要使用或继续使用版本低于 2.0 的 CH 块，则此处所述的驱动程序和消息概念是适用的。

驱动程序和消息概念

对于此功能性，块类型用于隔离硬件数据和软件组态数据：

• 用户将 CFC 图表的通道特定块（CH 块）互连，并分配来自符号表的相应信号名称。

CH 块用于信号预处理，可独立于硬件进行组态和互连。因此它是系统功能的一个对象，

且始终与这些功能一起接受处理。

四种不同的类型可用于信号预处理：

– 模拟输入值的信号预处理 (CH_AI)
– 模拟输出值的信号预处理 (CH_AO)
– 数字输入值的信号预处理 (CH_DI)
– 数字输出值的信号预处理 (CH_DO)
更多关于 CH 块的功能和操作原理方面的信息，请参考块的上下文相关帮助（按 <F1> 
键）。

• 系统会自动为模块特定功能生成多通道块（MOD 块），也就是说，系统会从块库导入块，

然后将这些块插入到系统图表中，并对它们进行编程和互连。

MOD 块也称为诊断块。它处理诸如启动和错误事件等所有特殊情况，举例来说，它通过

提供过程控制消息及信号值状态（1 = 好、0 = 坏）来进行处理。

• 除了诊断块外，为确保机架发生故障时不是所有 MOD 块都报告机架故障，会为每个机架

自动添加一个 RACK 块。

RACK 块在这种情况下负责发送信号。MOD 块在 OB 86 中识别到该事件已处理，从而不

进行报告。

• SUBNET 块控制每个已配置 DP 链的运行组，用于减少非周期性 OB 执行时间。事件发生

时，将只调用实际受到影响的块。SUBNET 块也会自动安装。

• PO_UPDAT 块确保 CPU 重新启动期间通过 CH_AO 和 CH_DO 块写入到过程映像的起始值

传送到输出模块。这意味着 CPU 转入 RUN 模式时这些值将立即生效。

• 将在 PCS 7 过程控制系统中实现 MSG_CSF 消息块，以防止机架故障、模块故障之类的错

误触发 CPU 转入 STOP 状态，也就是说，它是通过在系统生成的特殊 OB 中安装 MSG_CSF 
块来实现的。

更多关于 RACK 与 SUBNET 块的功能、功能性及消息能力的信息，请参考相关块的上下文相

关帮助（按 <F1> 键）。
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“生成模块驱动程序”功能如何工作

系统图表将自动生成，并插入 MOD、RACK、SUBNET 块和过程控制消息块 MSG_CSF 以及

用于输出过程映像的 PO_UPDATE 块。将给系统图表分配名称“@1”，系统图表最多可包含 52 
个块，每个图表分区 2 个块。如果生成附加块，将创建另一个系统图表，并为其分配名称

“@2”。 
最初生成模块驱动程序时以及 CFC 数据库尚未包含相应的驱动程序块或 MSG_CSF 时，将从

库中导入块。自“设置 – 生成块驱动程序”(Settings – Generate Block Drivers) 对话框中定义

的路径起执行块搜索。如果未找到块，它会在 PCS 7 Library 安装期间指定的默认路径中搜索。

说明

如果 CFC 数据管理中已存在同名块，则此方法会使新版本的块类型无法在程序中使用。它

还会导致无法对这些块进行全局块类型更改。

每个机架的 MOD 块都将安装在运行组中，其中包括 RACK 块。这些块和运行组在运行顺序

中通过“@”前缀进行标识。 

说明

请注意以下信息：

• 用户不应修改由“@”字符标识的对象，而只应使用“生成模块驱动程序”功能对其进行处理。
手动插入 MOD、RACK 和 SUBNET 块时也要遵循此规则。

• 必须从块目录中插入用户创建的驱动程序块。复制“@”块后，下次执行“生成模块驱动程序”
功能时会将它们删除。

非周期性错误 OB 以及 OB 1 中都安装了 MOD 块。这确保在线块下载后也会执行这些块（因

为在这种情况下将不再执行 OB 100）。将为运行组分配 16 这一减速比。每执行 16 次 OB 1 
才会调用一次块，以避免不必要的 CPU 负载。

系统会在 CFC 中验证 PO_UPDAT 块是否存在。如果不存在，则从库中将其导入，并插入到

系统图表中。此块在 OB 100 中安装在运行顺序的最后位置。如果该块已存在，系统会验证

其是否在驱动程序块后安装到 OB 100 中，以及是否已从所有其它 OB 中删除。

系统会检查 CFC 中是否存在 MSG_CSF。如果 MSG_CSF 不存在，将从“PCS 7 工艺\块”库中

导入它，并将其插入到系统图表、循环中断 OB 32 的运行顺序以及下列启动/特殊 OB 中：

OB 72、OB 81、OB 83、OB 84、OB 85、OB 86、OB 87、OB 100、OB 121 和 OB 122。
存在多个 MSG_CSF 时，不会发出警告。

过程映像分区

CH 块通过过程映像 (PI, process image) 接收和输出其信号。
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PO_UPDAT 块确保 CPU 重新启动期间由 CH_AO 和 CH_DO 块写入到过程映像中的启动值传

送到输出模块，并确保这些值立即生效。 
在周期控制点（无持续扫描周期时间）更新 OB 1 PI。可使用过程映像分区 (PIP, process image 
partition) 获得持续扫描时间。在 HW Config 中通过将 PIP 分配给 OB 来组态 PIP 更新时间。PIP 
更新涵盖 OB 执行开始的输入和 OB 执行结束的输出。过程映像分区是模块相关的，即速度

最快的信号决定所有模块信号的更新。

实现新版本块

安装包含已修改块类型的新 PCS 7 Library 最初不会影响已使用的块。 
请按以下步骤更新块： 
1. 从图表文件夹中删除所有 @ 系统图表。

2. 选择菜单命令“选项”(Options) >“块类型...”(Block Types...)。
3. 选择相关块并单击“确定”(OK)。

将在“图表文件夹”(Chart folder) 窗口中删除这些块。

4. 调用 SIMATIC Managers  组件视图中的“生成模块驱动程序”功能。
将会创建新系统图表。由于驱动程序块在 CFC 中不再可用，因此将安装新库的驱动程序块。在
“定制”(Customize) 对话框中输入库。如果在此库中未找到 MSG_CSF，则在设置期间输入的
默认路径中搜索。

版本 1 模型会话

• 配置硬件并将符号名称分配给 I/O 信号。HW Config 将直接在符号表中输入信号名称：

选择模块

在 HW Config 中选择菜单命令“编辑”(Edit) >“符号...”(Symbols...)。
• 使用必须通过从符号表中获取的信号名称进行互连的 CH 块在 CFC 中组态工艺功能。

选择菜单命令“插入”(Insert) >“互连到地址...”(Interconnection to Address...)。
• 在 SIMATIC Manager  中，通过菜单命令“选项”(Options) >“图表”(Charts) >“生成模块

驱动程序...”(Generate Module Drivers...) 调用驱动程序生成器，以生成、互连和组态所

有模块驱动程序。自动执行以下步骤：

– 系统首先标识 CFC 图表的所有通道块（CH_AI、CH_AO、CH_DI、CH_DO、CH_CNT、
CH_CNT1、CH_MS），然后标识所有互连到“值”I/O 的符号（名称和地址）。系统使

用符号表的符号地址标识硬件组态数据中的相应模块和通道。系统根据模块类型决定

相应的 MOD 块类型，并在系统图表中为每个 I/O 模块生成块实例。

– 将从硬件配置数据中获取 MOD 块所需参数，并将其输入到块实例和用于优化错误 OB 
中的运行的 SUBNET 块中。

– MOD 块处的通道特定输出将互连到 CH 块处的相应输入。如果支持“值状态”模块，

将会获取值状态的地址，并将其互连到 CH 块。
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必须通过“生成模块驱动程序”功能来计算组态数据（硬件或软件）中进行的更改。将不删

除及重建现有驱动程序块，而是为其分配新参数。将删除不再需要的块（用户块除外），并

使用从 CFC 数据管理而非库块导入的块根据需要创建其它的块。

版本 2 模型会话

• 使用必须通过从符号表中获取的信号名称进行互连的 CH 块在 CFC 中组态工艺功能。

选择菜单命令“插入”(Insert) >“与地址的互连...”(Interconnection to Address...)。
在对话框中输入信号名称

• 配置硬件并将符号名称分配给 I/O 信号。HW Config 将直接在符号表中输入信号名称：

选择模块

在 HW Config 中选择菜单命令“编辑”(Edit) >“符号...”(Symbols...)。

硬件配置提示：

如果已经先组态了软件，并已使用菜单命令“互连到地址...”(Interconnection to 
Address...) 将块 I/O 互连到 I/O 信号的符号名称，之后想要配置硬件，则可从“地址的交叉

索引”(Cross-References of Addresses) 列表中复制符号名称，并将其粘贴到 HW Config 数据

中。

19.2.12 减速比

功能

减速比指定运行组是在每执行一次 OB 时处理，还是仅在每执行 n 次 OB 时处理。“n”为整数

（n = 2t，其中 0 <= t <= 15）。运行周期是时基的倍数。

默认值：1，每个运行周期中都执行运行组。

示例：

循环中断的基本周期：1 s
使用减速比时的可能时钟周期：2、4、8、16 等。 

更多信息

更多相关信息，请参见以下部分：

相位偏移 (页 495)
减速比和相位偏移实例 (页 481)
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19.2.13 “属性 - 输入/输出”对话框

“属性 - 输入/输出”对话框

可在此对话框中编辑从图表中选择的块、嵌套图表或 SFC 图表的 I/O。

说明

此处所描述的元件与上述对象类型不相关或可能根本不存在。无法编辑变灰的框。

“属性 – 输入/输出”(Properties – Input/Output) 对话框中的选项

块 (Block) 或图表 (Chart)
可在此查看所选 I/O 的以下信息：

• 块类型名称及分隔符后的块名称，或者

• 嵌套图表名称或 SFC 图表名称

I/O
可在此查看当前 I/O 的以下信息：

• I/O 名称

• I/O 类型（IN = 输入，OUT = 输出，INOUT = 输入/输出参数）

• 数据类型（在括号中）

值 (Value)
可在此编辑所选 I/O 的值。I/O 不应互连且必须可组态。

支持不同的取值范围和输入，具体取决于数据类型。 
例外：在文本互连中，（块类型的）此值用作真实互连伙伴的替代值。此域变灰，也就是说，

无法编辑该值。

如果 I/O 带有数值标识符，并且在“自定义显示”(Customize Display) 中激活了“数值标识符”
(Value identifier) 选项，则“值”(Value) 框包含一个具有文本的下拉列表。
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可使用“自定义显示”(Customize Display) 对话框中的菜单命令“选项”(Options) >“自定义”
(Customize) >“布局...”(Layout...) 来启用或禁用数值标识符。 

说明

如果文本的字符数多于 8 个，则可定义要显示的字符。可通过在文本中包含“=”字符实现此

目的。如果文本中有一个等号，则显示等号右边的前 8 个字符。如果文本中没有等号，则显

示前 8 个字符。

无法更改以下 I/O 的值：

• 互连的 I/O
• 带有“不可组态”(Not configurable) 属性的 I/O（例如，事件 ID 等系统输入）

• 数据类型为“ANY”的 I/O（只有当“ANY”数据类型连接到一个已定义数据类型的 I/O 时,才确定
“ANY”数据类型）

取反

通过“取反”(Inverted) 单选按钮可取反“BOOL”数据类型的互连输入。

不可见 (Invisible)
使用“不可见”(Invisible) 复选框，可在图表显示中隐藏已连接或未连接的 I/O。

如果只有一个互连伙伴的 I/O 不可见，则可见 I/O 的互连被引向表单栏，且互连目标被标识为

“不可见”(INVISIBLE)。
如果两个互连伙伴或带有符号或文本互连的 I/O 都被切换为不可见，则此互连在图表中无法

再被识别，而只能在“I/O”选项卡的“互连”(Interconnection) 列中的块对象属性中被识别。这

也适用于到运行组的互连。

说明

如果块包含不可见的互连 I/O，则块标题的右上角出现一个彩色的三角形。

受监视 (Watched)
可使用“受监视”(Watched) 复选框设置 I/O，这样 I/O 将在测试模式期间显示 CPU 的实际值。

状态 0 的文本 (Text for state ０)
只有在编辑其系统属性设置为“S7_string_0”且数据类型为“BOOL”的 I/O 时，此选项才可见。

可为“0”值输入最多 16 个字符。OS 将这些文本用于显示和日志，例如“关闭”(Close) 和“已

关闭”(Closed)。
在“值”(Value) 框中，可以选择该文本或“文本 1”(Text 1)中的文本。

状态 1 的文本 (Text for state 1)
只有在编辑其系统属性设置为“S7_string_1”且数据类型为“BOOL”的 I/O 时，此选项才可见。

可为“1”值输入最多 16 个字符。OS 将这些文本用于显示和日志，例如“打开”(Open) 和“已
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打开”(Opened)。
在“值”(Value) 框中，可以选择该文本或“文本 0”(Text 0) 中的文本。

枚举 (Enumeration)
仅当为 I/O 分配系统属性“S7_enum”时，此选项才可见。可从下拉列表中为数据类型为 BOOL、
BYTE、WORD、DWORD、INT 和 DINT 的 I/O 选择一个枚举，这些枚举创建于当前项目的“共

享声明”中。 
如果在“自定义显示”(Customize Display) 中激活了“数值标识符”(Value identifier) 选项，则

可从下拉列表的“值”(Value) 框中选择的显示名称将作为数值分配给各个枚举。有关枚举的

更多信息，请参见以下部分：组态共享声明 (页 173)
可以在“枚举”(Enumeration) 下拉列表中选择空域以删除一个枚举。随后，将在“值”(Value) 
框中显示数字值，而不是显示名称。 
注：枚举被删除后，块 I/O 会保留“S7_enum”系统属性，也就是说，将输入一个空字符串，而

不是之前显示的枚举。

注释 (Comment)
互连输入的注释可以是输入注释（I/O 注释）或互连伙伴注释（互连注释）。显示内容取决

于在“自定义显示”(Customize Display) 中进行的设置。使用菜单命令“选项”(Options) >“自
定义”(Customize) >“布局...”(Layout...) 打开对话框。

如要显示互连注释，请选中该对话框的“参数”(Parameter) 组中的“互连注释”
(Interconnection comment) 复选框。不能在输入处修改互连注释。

如果注释不是互连注释，可在此为 I/O 输入最多 80 个字符的注释。如果使用菜单命令“选项”
(Options) >“自定义”(Customize) >“布局”(Layout) 选择了“I/O”组中的“注释”(Comment) 选
项，则在图表中显示 I/O 注释的前 12 个字符（宽块显示）或前 8 个字符（窄块显示），而

不显示 I/O 名称。

操作员授权级别

只有在相应块类型具有“Op_Level”属性时，此选项才可用。在此，可以设置一个 1 到 99 之
间的值。

标识符 (Identifier)
只有在编辑数据类型不为“BOOL”且系统属性设置为“S7_shortcut”的 I/O 时，此选项才可见。

所输入的标识符不能超过最大字符串长度（16 个字符）。OS 将这些文本用于显示和日志，

例如“设定值”。

单位

只有在编辑数据类型不为“BOOL”且系统属性设置为“S7_unit”的 I/O 时，此选项才可用。 
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可在此从下拉列表中为 I/O 选择最常用的单位。选择组合框时，显示下拉列表的按钮。

说明

单位集同 CFC 一起安装并可在 SIMATIC Manager  中修改或补充。更多相关信息，请参见以

下部分：组态共享声明 (页 173)

归档 (Archive) 
仅当 I/O 用于操作员监控时（系统属性 S7_m_c : = ‘true’），此选项才可用。

可以通过此下拉列表指定以下内容：

• 如果 I/O 不再与归档相关：“不归档”(No Archiving) (S7_archive := 'false')
• 如果要将 I/O 标识为用于“归档”(Archiving) (S7_archive := ‘shortterm’)
• 如果要将 I/O 标识为用于“长期归档”(Long-term archiving) (S7_archive := ‘longterm’)
在 OS 项目中编译 OS 期间，标识为与归档相关的 I/O 将被创建为归档变量，如果过程值归

档尚不存在，也将创建一个过程值归档。如果后来删除了与归档相关的 I/O，或将其更改为

“不归档”(No Archiving)，则下次编译 OS 时，相应的归档变量也将被删除。

更多相关信息，请参见以下部分：组态归档变量 (页 182)

OS 附加文本

可在此处输入面板中按钮的标签文本。可使用此按钮跳转到互连块的面板。此文本可以进行

编辑。

只有相应块在 WinCC 中具有画面跳转功能时，该输入字段才激活。

“工艺分配...”(Technolog. assignments...) 按钮

使用“工艺分配...”(Technolog. assignments...) 按钮打开一个对话框，在该对话框中列出了

所有已分配的对象。选择一个对象并通过“转到”(Go to) 按钮直接跳转到此对象来确认。只

有当存在分配时，此按钮才存在。
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强制

只有在 SIMATIC Manager  的组件视图（对话框“图表文件夹属性”(Chart folder properties) 
的“高级”(Advanced) 选项卡）中设置了全局“支持强制”(Support forcing) 选项之后，这些

选项才可用。

• 添加强制 (Add forcing)
通过设置此选项可启用 I/O 的增加强制功能。无法将图表输入/输出注册为强制。

• 强制激活 (Forcing active)
通过设置此选项可启用 I/O 的强制。此选项只有在选择了“添加强制”(Add forcing) 功能

后才可用。

• 强制值 (Force value)
在该域中可输入 I/O 的强制值。要输入的值取决于 I/O 的数据类型。此选项只有在选择了

“添加强制”(Add forcing) 功能后才可用。

MES 相关 (MES-relevant)
仅当 I/O 用于操作员监控（系统属性 S7_m_c := ‘true’）且在块的对象属性中激活“允许 OCM”
(OCM possible) 选项时，此选项才可用。 
设置“MES 相关”(MES-relevant) 选项后，当 MES 系统连接时，这将起到一个过滤器的作用，

只传输 MES 相关的控制系统信息。

过程对象视图 (Process object view)
• 参数 (Parameter)：

如果要设置参数或将某 I/O 与另一个 I/O 互连，则可在此对其进行标记。随后该 I/O 将显

示在过程对象视图的“参数”(Parameter) 选项卡中。可在 SIMATIC Manager  中使用菜单

命令“选项”(Options) >“过程对象”(Process Objects) >“选择 I/O...”(Select I/Os...) 更改

此设置。

• 信号 (Signal)：
如果要在过程对象视图中将 I/O 与一个信号互连，则在此标记该 I/O。该 I/O 随后将显示在

“信号”(Signal) 选项卡上。可在 SIMATIC Manager  中使用菜单命令“选项”(Options) >
“过程对象”(Process Objects) >“选择 I/O...”(Select I/Os...) 更改此设置。

选项有：“参数”(Parameter) 或“信号”(Signal)，或无。

SFC 访问... (SFC Access...)
仅当此 I/O 上存在 SFC 访问时，该按钮才可用。此访问在 CFC 图表的 I/O 处用彩色标记表示：

• 写访问 = I/O 下方的标记

• 读访问 = I/O 上方的标记
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使用此按钮打开一个包含当前 SFC 访问列表的对话框。双击图表名称打开所选 SFC 图表。访

问的图表元素将加亮显示。

参见

控制模块的类型/实例同步的更改效果 (页 238)
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测

测试模式, 431

插

插入, 100, 127, 128, 129, 146
CFC 图表中的 SFC 类型, 146
块, 127, 128
块类型, 116
图表分区, 100
未放置的块, 129

插入位置, 196
查找, 196
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查

查找 (Find), 196
插入位置, 196

拆

拆分, 162
项目, 162

持

持续时间, 479

处

处理, 91, 92, 96, 165
CFC 编辑器中的块, 210
SIMATIC Manager 中的图表, 212
从互连, 165
图表, 91, 92, 96
运行编辑器中的块, 211

窗

窗口, 52, 443, 445
动态显示, 443
趋势显示, 445

创

创建, 91, 102, 105, 417
CFC 中的块类型, 111
V5.2+SP1 及更高版本的驱动程序生成器, 457
带有图表 I/O 的图表, 105
块驱动程序, 400, 417
嵌套图表, 102
新图表, 91
运行组, 196

从

从表单栏跳转, 93, 165
从监视列表中移除, 436

要测试的 I/O, 436
从先前版本移植, 40

存

存储器需求, 417

打

打开, 52, 92, 438
监视 I/O, 438
目录, 52
图表, 92

打印, 467, 470, 471
动态显示, 470
块/图表 I/O, 470
图表, 467
图表引用数据, 471

带

带有图表 I/O 的图表, 105
创建, 105

单

单个字符, 475
单位, 176

组态, 176
单元

输入, 141

导

导航
在图表中, 93

导入
块类型, 113

导致 CPU 停止工作的因素, 417
避免, 417

登

登录服务, 431, 447

递

递归块调用, 400
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定

定位, 129
较长的块, 129

动

动态显示, 443, 470
打印, 470

对

对齐, 141
块, 141

对象
编译和下载, 420

对象属性, 133
指定, 133

多

多背景块, 28
多个 I/O, 134
多个用户

在项目中, 45
多用户, 45
多用户工程, 47

访

访问保护, 448

放

放置
目录, 52

分

分布式工程, 162

浮

浮点数, 477

符

符号寻址, 155

复

复制, 96, 104, 166
互连, 166
块, 135, 137
嵌套图表, 104
图表, 96

概

概念
安装指针, 189
块安装指针, 189
图表安装指针, 189

更

更改, 166
安装指针, 191
互连, 166
显示类型, 88
运行顺序, 191

更改日志, 431, 447
更新

单项目中的 SFC 类型, 119
单项目中的块类型, 119
多项目中的 SFC 类型, 117
多项目中的块类型, 117
使用 CPU 410-5H 的多项目中的块类型, 117, 120

更新多项目中的共享声明, 178

工

工厂设备阶段, 329
创建和管理, 343
复制或创建实例时的属性, 358
根据 ISA-88 标识 PH 中的节点, 358
可选控制模块, 336
控制模块作为下级对象, 332
数据对象, 335
数据交换中的顺序控制, 369
通过 XML 的数据交换, 365
组态类型, 344

工厂设备模块
创建和管理, 307
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基础知识, 290
可选控制模块, 295
控制模块作为下级对象, 292
类型和实例, 292
名称, 293
数据对象, 294
数据交换, 362
数据交换中的顺序控制, 369
顺序控制, 310
通过 XML 的数据交换, 365
同步类型和实例, 313
主数据库中的名称空间, 293
子控制模块, 294
组态类型, 308

工具栏, 57
工具提示, 87

日志, 494
工作窗口, 52
工作原理

对于使用 V5.2+SP1 及更高版本创建的模块驱动程
序, 463

共

共享地址, 151
共享声明, 173

单位, 173
枚举, 173

故

故障安全控制模块类型 (F-CMT), 389

关

关闭, 400
目录, 52

归

归档变量, 182
组态, 182

合

合并, 162
项目, 162

互

互连, 81, 156, 166
彩色显示, 82
到 SFC 图表, 156
到图表 I/O, 163
复制, 166
更改, 166
块, 147
删除, 167
文本, 157
显示, 82
显示互连信号处理的反馈, 84, 186
颜色, 83
与共享地址, 151
重新链接, 166
组态/删除运行组, 163

互连的彩色显示, 82
互连规则

图表 I/O, 164
用于数据类型 A  DT  S  ST, 

互连模型, 462
V5.2+SP1 及更高版本的驱动程序生成器, 462

回

回读, 453

会

会话模型, 465
对于以 V5.2+SP1 及更高版本创建的模块驱动程
序, 465

基

基于图表的运行组管理, 203
复制 CFC, 206
集成新 CFC, 205
删除 CFC, 205
使用 F 块：, 204
移动 CFC, 206
移植现有 CFC, 205
运行组的符号, 204
在 CFC 间移动块, 206
在 CFC 中禁用, 206
重命名 CFC, 205
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集

集中类型更新
CPU 410-5H PA, 124
RUN 模式下的类型更新, 120
概述, 112
在单项目中, 119
在多项目中, 117

监

监视
块 I/O, 435

监视 I/O, 438
打开/关闭, 438

监视周期, 431

兼

兼容性, 21

检

检查共享声明的似然性, 179

减

减速比, 499
实例, 481

简

简介, 21
CFC, 21

键

键盘布局
国际/德国, 70

交

交换文件, 38
文件, 38

脚

脚注, 468
组态, 468

结

结构, 170

禁

禁用, 438
监视 I/O, 438

旧

旧项目, 42
切换到增强型运行模型, 42

绝

绝对寻址, 155

可

可能的互连, 156
可选块, 277

控

控制块, 43
在外部视图中移植, 43

控制模块
CFC 编辑器中的显示, 220
分配设备阶段, 284, 286
分配设备模块, 284, 286
复制和移动, 216
将实例分配给设备模块, 288
可选, 282
可选块, 277
数据对象, 301, 342
数据交换, 362
通过 XML 的数据交换, 365
同步类型和实例, 234, 238
信号, 250, 259
在类型/实例之间同步, 235
在类型中组态命令, 222
在类型中组态状态, 222
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作为某类型的实例, 213
作为下级对象, 282

控制模块类型
编辑, 218
创建, 213, 218
可选块和互连, 213
控制变量的数据类型, 219
名称, 214
在类型/实例之间同步, 235
主数据库中的名称空间, 214

控制模块实例, 221
创建, 221

库

库
目录, 52

块

块, 28, 76, 127, 128, 129, 134, 138, 140, 141, 209
CFC 表示, 76
编辑, 127
插入, 127, 128
带有可变数量的输入, 134
定位, 129
对齐, 141
复制, 137
互连, 147
目录, 52
删除, 140
图表中的宽表示, 78
图表中的窄表示, 79
显示执行, 209
移动, 138
运行属性, 184
在 CFC 中, 28
重叠块的颜色, 76

块 I/O
监视, 435

块/图表 I/O, 470
打印, 470

块安装指针, 190
设置, 191

块互连
组态, 147

块类型, 28
CPU 410-5H 的更新, 120
插入, 116
导入, 113
目录, 52

清除, 126
删除, 126
使用 CPU 410-5H 时的更新, 117
使用新版本, 115
在单项目中更新, 119
在多项目中更新, 117

块类型 [S7]
清除, 126
删除, 126

块类型更改, 115
块名称, 128, 133

输入, 133
块驱动程序, 417

创建 V5.2+SP1 及更高版本, 457
生成, 400, 417

块实例, 28
块图标, 134

分配, 134
块系列, 28
块注释, 134

输入, 134

快

快捷菜单, 58
快捷键, 60, 67

用于菜单命令, 60
在 CFC 图表中, 60
组态, 67

类

类型/实例同步, 377
对于下级类型, 377

类型导入, 417
类型更改的影响, 130
类型更新

本地类型更新, 112
集中类型更新, 112

类型-实例同步
控制模块, 315
设备模块, 315
相关属性和关系, 315

连

连接器, 82
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逻

逻辑编号, 474

枚

枚举, 174
组态, 174

名

名称, 133, 379
块, 133

命

命令
在控制模块的类型中组态, 222
组态全局命令, 378

命名, 31
运行组, 201
自动, 31

默

默认名称, 31

目

目录
打开, 52
放置, 52
关闭, 52
库, 52
块, 52
块类型, 52
图表, 52

启

启动, 51
CFC 编辑器, 51

启动特征, 147

前

前一个块
用于插入位置, 190, 191

嵌

嵌套深度, 417
嵌套图表, 75, 102, 104

创建, 102
复制, 104
删除元素, 104
替换, 104

强

强制, 440
CFC 表示, 441
参数数目, 440
设置, 440

切

切换, 40, 42
从 CFC 库块到 BOP, 40
从旧项目到增强型运行模型, 42

清

清除
块类型, 126
块类型 [S7], 126

驱

驱动程序生成器, 457, 462, 463, 465
所用块的简短说明, 460
支持的设备, 459

趋

趋势显示, 445

取

取反, 143
输入, 143
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取消注册过程对象, 35

全

全局块类型更改, 130
全局命令

各种条件下的特性, 379
名称, 379
数据对象, 382
组态, 378

全局状态, 379
各种条件下的特性, 379
数据对象, 382
组态, 378

日

日期, 475
日期和时间, 476
日志

~“下载”(Download) 选项卡中, 450
ES 日志, 447
显示, 472

入

入门指南, 23

删

删除, 91, 100, 104, 140
单个互连, 167
多个互连, 167
块, 140
块类型, 126
块类型 [S7], 126
嵌套图表, 104
图表, 91
图表分区, 100
文本互连, 167
与运行组的互连, 163
运行组, 196

设

设备, 459
驱动程序生成器支持的, 459

设备阶段
带有“派生接口”, 346
分配控制模块, 284, 286

分配请求和分配状态, 354
分配设备模块, 352
控制模块作为下级对象, 357
顺序控制, 350
同步类型和实例, 359

设备模块
按照 ISA-88 标准, 304
分配控制模块, 284, 286
分配控制模块实例, 288
分配设备阶段, 352
复制或创建实例时的属性, 312
根据 ISA-88 标识 PH 中的节点, 312
控制模块作为下级对象, 311
类型-实例同步, 315

设备属性, 176
组态, 176

设置, 128, 144
安装指针, 191
编译/下载, 398
块安装指针, 191
适用于插入块, 128
数值标识符, 144
图表安装指针, 191

时

时间, 480
时间戳, 427

比较, 427

实

实例
减速比, 481
相位偏移, 481

使

使能属性, 494
使用, 431

使用文本互连, 157
在测试模式下, 431

使用键盘, 60, 64, 65, 66, 70

似

似然性检查, 174
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输

输入, 133, 134, 143
单元, 141
块名称, 133
块图标, 134
取反, 143
注释, 134

属

属性, 494
对于参数（工厂设备模块）, 318
对于工厂设备阶段, 318
对于工厂设备模块, 318
对于控制模块（工厂设备模块）, 318
对于控制模块的分配, 318
对于控制模块的基本要求, 318
对于消息（工厂设备模块）, 318
对于信号（工厂设备模块）, 318
使能, 494
用于控制模块, 224
运行组, 208

鼠

鼠标操作, 68
鼠标指针, 64, 65

在菜单栏/快捷菜单中移动, 64
在对话框中移动, 65

数

数据对象
工厂设备阶段, 335
工厂设备模块, 294
控制模块, 301, 342
全局命令, 382
全局状态, 382
顺序控制, 298
组态顺序控制, 339

数据交换
PCS 7 中的限制, 365
XML 格式, 365
导出到 XML 文件, 369
导出所选的工艺对象, 369
导入 XML 文件, 368
工厂设备阶段, 369
工厂设备模块, 362, 369

控制模块, 362
扩展硬件参数, 364
与 PAA 进行交换时的信号处理, 374

数据类型扩展, 132
数据类型扩展后的容许类型导入, 132
数值标识符, 144

设置, 144
数字上溢/下溢 (S7), 39

双

双精度整数, 476

顺

顺序控制
数据对象, 298

替

替换, 104
嵌套图表, 104

添

添加到监视列表, 436
要测试的 I/O, 436

调

调用, 66
通过快捷键调用帮助, 66

调用层级, 417

停

停止工作的原因, 417

通

通过表单栏互连, 165
显示, 165

同

同步
工厂设备模块的类型和实例, 313
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控制模块的类型和实例, 234, 238
设备阶段的类型和实例, 359

图

图表, 52, 71, 91, 92, 96, 467
处理, 91, 92, 96
创建, 91
打开, 92
打印, 467
复制, 96
目录, 52
删除, 91
移动, 96

图表 I/O, 105
互连规则, 164

图表 I/O（互连规则）, 169
图表安装指针, 190

设置, 191
图表分区, 72, 100

插入, 100
删除元素, 100

图表名称, 99
图表属性, 99

修改, 99
图表引用数据, 471

打印, 471

退

退出, 51
CFC 编辑器, 51

未

未放置的块, 129
插入, 129

文

文本, 66, 80
通过快捷键进行选择, 66

文本光标, 64
移动, 64

文本互连, 157
表单栏中的表示, 158
更改, 160
关闭打开的互连, 160
日志中的警告, 402
删除, 160, 167

说明, 161
在过程对象视图中, 161
作为块互连, 147

文件, 38
交换文件, 38

系

系统属性, 105, 403
对于参数和块, 403

系统支持, 417
避免导致 CPU STOP 的因素, 417

下

下载, 414
单个图表, 421
到测试 CPU, 414
对象, 420
更改, 410
下载前显示更改, 412
下载用户程序到目标系统, 407
在 RUN 模式下下载更改, 412
整个程序, 409

下载功能, 414, 415
保持, 414, 415
丢失, 415

显

显示, 71, 74, 85, 165
表单, 73
工具提示, 494
互连, 82
块/图表 I/O 的状态, 79
块的下载状态, 78
日志, 472
通过表单栏互连, 165
运行属性, 185
运行属性框, 482
组态数据, 71, 73, 74, 76, 81, 85, 88, 89

显示类型, 89
更改, 88

显示执行, 209
块, 209
运行属性, 209
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相

相位偏移, 495
实例, 481

响

响应, 39
S7 CPU 对错误的, 39

项

项目, 162
拆分和合并项目数据, 162

项目数据
拆分, 45
合并, 45

新

新版本块类型, 115
新增功能

CFC V8.2, 19
CFC V8.2 SP1, 19
CFC V9.0, 18
CFC V9.0 SP1, 18
CFC V9.0 SP2, 17
CFC V9.0 SP3, 17
CFC V9.0 SP4, 16
CFC V9.0 SP5, 16
CFC V9.0 SP6, 16
CFC V9.0 SP7, 15

信

信号处理, 496
V5.2 及更低版本的驱动程序概念, 496
控制模块的信号, 250, 259
以 XML 格式实施的原则, 259
硬件信号（I/O 变量）, 250
与 PAA 进行数据交换, 374

信号处理的反馈, 186
信号跟踪, 165

修

修改, 99
图表属性, 99

序

序列
16 位, 480
32 位, 476
8 位, 474

选

选择, 66
通过快捷键选择文本, 66

选择性下载
概述, 421
过程符合性, 424
下载更改功能, 422
在运行组中基于图表插入块, 423

寻

寻址, 155
符号, 155
绝对, 155

移

移动, 64, 65, 96
菜单栏/快捷菜单中的鼠标指针, 64
对话框中的鼠标指针, 65
块, 138
图表, 96
用于编辑文本的文本光标, 64

移植, 40, 43
外部视图中的控制块, 43

溢

溢出页, 74

引

引用
“引用 CM 参数”类型的复制行为, 267
控制变量参数的组态, 263
控制变量参数上的工艺引用, 262
完成“引用 CM 参数”类型, 267
完成“引用块变量”类型, 268
完成“引用全局变量”类型, 269
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语法, 265
针对数据交换, 266

用

用户程序
下载到目标系统, 407

用于数据交换的 XML 文件, 365

优

优化
运行顺序, 194

与

与 DB 互连, 151

运

运行属性, 128, 208, 209
编辑, 185
块和组, 184
显示, 185
显示执行, 209

运行属性框
显示, 482

运行顺序
更改, 192
优化, 194
运行模型概念, 189

运行组, 202
编辑, 196
创建, 196
打开/关闭, 163
命名, 201
删除, 196
重命名, 202

在

在 HW Config 中应用对采样时间的更改, 401
在此之后作为插入位置, 482

块的标识符, 482
在网络中组态, 47

整

整数, 477

支

支持类型实例行为, 227

指

指定, 133, 134
I/O 数量, 134
对象属性, 133, 134

指针
A，ANY 与数据元素指针, 473
指向存储区域, 477

重

重命名, 202
重新链接, 166

互连, 166

注

注释, 134
关于块, 134

转

转到 (Go To), 93

状

状态
在控制模块的类型中组态, 222
组态全局状态, 378

状态栏, 57
状态显示

CFC 中的块处, 76

字

字符串, 479

总

总览（图表视图）, 89
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组

组
运行属性, 184

组态, 23, 67, 174, 176, 182, 183, 439, 468
I/O, 141, 439
I/O 的颜色表示, 143
单位, 176
到图表 I/O 的互连, 163
对 MIS/MES, 183
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